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| ntroduction

With Mac OS X, Appleisassured of assuming leadership in operating system market
share. Alright, maybe not. However, the winds of change are certainly in the air. The Mac
finally has an operating system that lays claim to all the key buzzwords. Take a deep
breath, and then repeat after me: Mac OS X includes preemptive multitasking, protected
memory, dual-processor support, multithreading, superior stability, and advanced virtual
memory management, and is industrial-strength, UNIX-based, and open source. Anyone
who in the past had a Mac will want Mac OS X-and a few people and businesses who
didn't have Macs will too. Its UNIX underpinnings will capture the curiosity of many
UNIX programmers, and it will make the Macintosh arealistic choice for many UNIX-
based businesses too. Cool, lower-priced Apple hardware running Mac OS X, such asthe
iMac desktop computers and the iBook portable computers, keep Macs, and now Mac OS
X, inthe educational market.

What does al this glowing praise, and possible market expansion, mean to you, the
computer programmer? Opportunity! Whether you want to develop freeware to make a
name for yourself, write shareware to make some money on the side, port existing code to
Mac OS X, or smply be able to include "Macintosh programming" on your resume, now is
the timeto learn (or improve on your existing) Macintosh programming techniques.
Whether you're an old hand at Mac programming or new to the platform, this book will
help you learn to program in Mac OS X.



Target Audience

If you've never programmed before, this book is not for you. If, however, you're interested
in developing Mac OS X applications and you know C or C++, and if you have written
(even very basic) programs for any platform, this book will serve as an excellent resource.

If you're coming from aMac OS programming background, this book will fill youinon all
the new technologies that come with Mac OS X, and it will help you make the transition
from using the original Macintosh Toolbox API to using the Carbon API. If you're coming
from adifferent platform, such as UNIX or Windows, this book will quickly bring you up
to speed on the basics of Mac OS X programming. It then will propel you into the realm of
developing real-world, full-fledged Mac OS X applications.



Necessary Software

To get the most from this book, you'll need a Macintosh computer running any version of
Mac OS X. You'll also want to have Apple's Project Builder integrated devel opment
environment (IDE) software to create and edit source code files and to compile and build
applications. In addition, you'll want to have Apple's Interface Builder software to create
and edit interface elements such as menus and windows. Here's the really good news: If
you have Mac OS X, you have both Project Builder and Interface Builder. They're on the
Developer Tools CD that comes with every copy of Mac OS X.



Organization of ThisBook

This book consists of eleven chapters organized in such away that they should be read
sequentially. The first chapter provides a broad overview of the new Mac OS X system
software. The second chapter introduces basic Mac OS X programming concepts and
software tools and has you developing several, albeit smple, Mac OS X applications from
start to finish. Chapters 3 through 7 deal with events, windows, controls, menus and
graphics, respectively, and provide afoundation for any and all the programs you'll write.
The remaining chapters deal with slightly more esoteric, though still important, topics such
as readying your program for other languages, QuickTime movies, application icons, and
porting older code to Mac OS X. Additionally, at the end of each chapter you find a"For
More Information” section, which provides additional resources related to topics discussed
in theindividual chapters.

Chapter 1, "System Components and Programming Technologies," presents an overview of
the layout of the Mac OS X system software. Aqua is the name of the new user interface,
but Mac OS X consists of much more than a pretty face. Here you read about the
conceptual layers of system software such as the application environments (including
Carbon and Cocoa), application services (such as Quartz and QuickTime), core services
(such as Apple Events and Open Transport), and the kernel environment (which includes
Mach and BSD).

Chapter 2, "Overview of Mac OS X Programming,” examines the IDESs (integrated
development environments) available to Mac OS X programmers. Here the focusis on
Apple's Project Builder IDE and Interface Builder interface layout software. Both
applications are free from Apple, so you're all set to follow along with this chapter's short,
straightforward examples. Here you see the basic code common to all Mac OS X
applications, and you compile and build applications that display functioning windows,
menus, alerts, and graphics.

Chapter 3, "Events and the Carbon Event Manager,” covers a set of API (application
programming interface) routines that are entirely new to Mac OS X. Mac programs always
have been event-based. A user action such as aclick of the mouse generates an event to
which the program responds. Now, with the new Carbon Event Manager, setting up your
program to recognize and handle various events is easier than ever. For a programmer, this
isvery powerful stuff.

Chapter 4, "Windows," contains al the information you need to implement fully functional
windows. Here you see how your program supports multiple windows of the same type,
multiple windows of different types, and how your program can let the system handle basic
window management tasks (such as closing awindow) or how you can alternatively take



control and add special behavior to the handling of these tasks.

Chapter 5, "Controls," shows how your program's windows include controls. The subject of

controls, including push buttons, radio buttons, checkboxes, and text input fields, is an
important one because it is one of the two primary means by which a user interacts with
your program. The other user-input system is the subject of the next chapter.

Chapter 6, "Menus," shows you how your program fully supports menus and menu items.

Here you see how to add and remove menus and menu items, implement hierarchical
menus (submenus) and pop-up menus, and change the characteristic of menus and menu
items (by enabling, disabling, or altering the font of menus or items).

Chapter 7, "QuickDraw Graphics,” demonstrates how your program draws text and
graphics to windows. QuickDraw issimply a set (albeit alarge set) of drawing routines
that make it easy to draw stylized text (words that appear in afont, typeface, and size of
your choosing) and to draw avariety of 2-D shapesincluding lines, ovals, and rectangles.
Here you'll also see how to add patterns and colors to any shape you draw.

Chapter 8, "Text and Localization," explains how your program can be properly set up so
that trandlation of its text to another language becomes an easy task. Don't think your
program will ever ship to foreign markets? Don't be so sure! If it happens, you want to
have the language trandlation require minimal effort. Even if your application is suited only
for customers of one language, you'll want to read this chapter. It explains how you can
store al your program's text in one easy-to-edit file and how your program can make use of
that text on demand.

Chapter 9, "QuickTime Movies and File Handling," covers the details of how your

program can open awindow and play any QuickTime movie within that window. Where
does that movie come from? It comes from afile on the user's disk. Thus, this chapter also
covers the details of Navigation Services, which is the set of routines that make it easy for
your application to display the standard Open window that let's a user navigate through
folders and select afile.

Chapter 10, "Bundles and Icons," exposes the details of how your program is packaged and
how your program can display its own icon on the desktop. When you build an application,
you're actually bundling several files together in a directory. Although hidden from the
user, they're al there on the user's desktop. Here you see how your application'sfiles are
organized. Y ou also get tips and information on creating an icon and the low-down on
associating that icon with your application.

Chapter 11, "Porting Mac OS 8/9 Code to Mac OS X," deals with the process of moving an
existing code base from Mac OS 8 or 9 to Mac OS X. Here you see how to determine
which routines need to be replaced or modified, and you read about techniques and caveats
for porting an application so that it runs native under Mac OS X.



Appendix A, "Carbon APl Summary," lists and describes the calling convention for many
commonly used Carbon API routines. Developing aMac OS X program means knowing,
and making use of, many of the thousands of Apple-written routines that comprise the
Carbon API. This book discusses well over a hundred of these routines. This appendix
serves as a handy reference to many of those functions.

Appendix B, "UNIX and the Terminal," explains the basics of UNIX. Yes, the
underpinnings of the Macintosh operating system are now realy, truly Unix. This book
does not rely on your knowing how to be a UNIX end user or aUNIX programmer, but if
you're neither, your curiosity may get to you! Here you see how to navigate through
directories and write and compile a very simple program, all from the command line
through the Terminal application.



Conventions Used in This Book

This book uses the following conventions:

. ltalics: Used to emphasize new terms and important ideas when they're first

introduced.
. Constant width font: Used to represents code, such as names of variables,

functions, arguments, and so on.
. Abbreviations and acronyms: Used freely throughout the book, but each is

written out when it isfirst introduced in a chapter.



Chapter 1. System Components and Programming
Technologies

THE ORIGINAL MACINTOSH OPERATING SY STEM (OS) was introduced in January
1984. Since then, the OS has been modified, enhanced, and nipped and tucked to bring it
from version 1 to version 9. More than a decade and a half of work has brought about
numerous look-and-feel improvements, but core system changes have been minimal. Mac
OS X put an end to that. Not only has the graphical user interface (GUI) taken on a
dramatic new look, the OS core itself has been completely revamped. For the first time,
UNIX powers the Macintosh OS.

Note

Although the nameis"Macintosh," you'll see plenty of referencesto "Mac" in
this book and elsewhere. It's an accepted shorthand.

Whether you're an experienced Mac software developer or a first-time Mac programmer,
you need to become familiar with the new components and technologies of Mac OS X. In
this chapter, you'll read about the OS software, and you'll see how this code is conceptually
divided into layers. When it comes time to start looking at the higher-level code for
building applications (you need only wait until Chapter 2, "Overview of Mac OS X
Programming,” for that), this overview of the system software will help you understand
what application code is intended to do. In this chapter, you also read about the pros and
cons of Carbon and Cocoa, which are the two primary means of creating a Mac OS X
application, and why the focus of this book is on Carbon.



System Software Layers
The components, or technologies, that make up the Macintosh OS are illustrated in Figure 1.1.

Figure 1.1. An overview of thefivelayersof Mac OS X.

User Interface

Agqua
Application Environments

Classic Carbaon Cocoa Java BSD

Application Services
Quartz  Windows  CuickDraw  OpenGL  QuickTime

Moving from an upper layer to alower layer in the OS model pictured in Figure 1.1 takes you from

more directly accessible code to less directly accessible code. For instance, the code in the highest
layer, the User Interface, produces Aqua-the interface with which a Mac user interacts directly.
Conversely, the code in the lowest layer, the Kernel Environment, produces Darwin-the core OS that
is most often accessed only by code in the layer just above it (the Core Services layer).

In Figure 1.1, the lines that |eave the bottom of the Classic box and the line that |eaves the bottom of

the BSD box ("BSD" stands for Berkeley Software Distribution ) hint that code in one layer can
interact with code in a non-adjacent layer (more on this later in this chapter). However, it'samore
likely scenario that code within one layer interacts with code in an adjacent layer. Figure 1.2 provides

an example of this.

Figure 1.2. An example of theinteraction of codein different layers.
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On theleft side of Figure 1.2, auser clicks a Draw button in awindow. The code that's responsible for
the display of the button that is a part of the Aquainterfaceisin the User Interface layer. A click on
the button results in the application invoking a function in the Carbon API (which is code in the
Application Environments layer). That function in turn accesses QuickDraw code (which existsin the
Application Services layer) to perform the drawing of a shape (refer to the right side of Figure 1.2).

The representation shown in Figure 1.1 isa simplification of the enormous complexity of the code that
makes up the Macintosh OS-but this figure does provide a means of understanding the roles different
components play and how these various components interact with one another. The next several pages
describe the five layers. As you read these pages, you'll want to frequently refer back to Figure 1.1.

User Interface

In Mac OS X, the GUI has been given the name Aqua. To the average end-user, Aquais Mac OS X.
Figure 1.1 reveals just how much more thereisto Mac OS X, but that information can be kept among

us programmers! If an application you develop has the Aqualook, a user of your application is
satisfied, he or she won't be the least bit interested in technologies such as Carbon and QuickDraw.

Fortunately, and of course, by no accident, Apple has made the Aquainterface easy to integrate into
any Mac OS X application that a programmer develops. A program's interface elements, such as
windows and menus, can be visually designed using one software tool, while the program's source
code can be written in another software tool. When it comes time to build the application, the source
code file gets compiled and the resulting compiled code gets linked with the interface elements.

Figure 1.3 shows awindow being constructed using Apple's Interface Builder program (afree
application included with every copy of Mac OS X and an application discussed throughout this
book). In Interface Builder, a programmer simply uses drag-and-drop to copy interface elements such
as buttons, diders, and text boxes from a palette to awindow. After saving the Interface Builder file,
its contents can easily be used in aprogram. Note in Figure 1.3 that the elements that are displayed in
Interface Builder al have the look of Aqua. When it comes time to write the code that displays the
window, there's no need to write any special Aqua code.

Figure 1.3. Using I nterface Builder to define an Aqua interface for a program.
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Figure 1.4. Using ResEdit to define an Aqua interface for a program.

When aMac OS X program runs, it automatically displays the Aquainterface. Thisistrue even if you
use an older interface-designing tool that hasn't been updated for Mac OS X. Appl€e's resource editor
ResEdit is one such tool. Before Interface Builder arrived, ResEdit was the interface design software
most commonly used by Macintosh programmers. A programmer still can use ResEdit to design a
program's interface, even though ResEdit runsin the Classic (Mac OS 9) environment.

At the top of Figure 1.4, an alert isbeing laid out in ResEdit where it will be saved to afile (note the
non-Aqualook of thetitle bar of the window holding the alert, as well as the non-Aqualook of the OK
button in that window). When aMac OS X program is built using the contents of thisfile, the running
of the program results in the alert taking on the Aqua look-as shown in the bottom of Figure 1.4.

I:'_I'I'I_!I !’rul“ Y _FesoLrcersre E::::::::::::::::::::
13 Sire Name | _IEI.E.HI'I'M. .......
128 66 B Chck Bux
[ = DML iD= 128frem ny_resourcessre —— @Hdluﬂuttﬂn
— [l contral

File has been successfully saved. T Stafie Test |

Edif Text

Ay lean
| | Eﬂ Uaer Iiem

File has been successfully saved.

ol

Chapter 2 includes a walk-through of the process of creating asimple Mac OS X application. There
you'll see adetailed example of how interface elements are created and made use of by source code.

Application Environments



Just under the User Interface layer are the Application Environments (see Figure 1.1). In other Mac
OS X documentation, you might have seen a more abbreviated version of Figure 1.1 that displayed

only three application environments. Classic, Carbon, and Cocoa. This is done because Apple's
emphasis has been on those three. The following is a brief introduction to these environments. Later in
this chapter, we cover them- and two additional environments-in greater detail.

Classic

The Classic environment exists for one specific reason: backward compatibility. A Mac user with a
computer running Mac OS X most likely owns at |east one application that hasn't been upgraded to
become a native Mac OS X application. Such a program isn't capable of displaying the Aqualook and
it won't support Mac OS X enhancements such as protected memory. To enable Mac usersto preserve
their investment in Mac OS 8 and OS 9 applications, Apple has included the Classic environment as a
part of Mac OS X. When the user runs an older Mac program, that program runs in the Classic
environment, where it displays the look and feel of a program running in Mac OS 9.

Y ou might have heard the Classic environment referred to asa"Mac OS 9 emulator.” That's not quite
right. For aMac user running Mac OS X to launch an older program, that user's Mac must have a copy
of Mac OS 9.1 installed. Mac OS 9.1 can be installed either on the same drive as Mac OS X, though
on adifferent partition, or on a different drive altogether. In any case, for Classic to work, the user's
Macintosh must have two complete, separate OSsinstalled: Mac OS 9.1 and Mac OS X.

When a program runs (on any computer), it is a process. The OS sets aside a block of memory
devoted to that one process. If you double-click the TextEdit program icon on your Mac, for example,
Mac OS X considersit a process and |oads the TextEdit code into a block of memory. If you then run
Internet Explorer, Mac OS X considers that another process, and it loads the Internet Explorer code
into a separate block of memory. To make use of the Classic environment, Mac OS X runs Mac OS
9.1 asif the OSitself were aprocess. It'sasif one OS (Mac OS 9.1) is functioning within another
(Mac OS X).

The Classic environment is awonderful bit of technology and trickery that makes Mac OS X all the
more useful. Because of Classic, just about any Mac program written within the last few years-and
some older applications as well-can be run on a Macintosh sporting Mac OS X. Asnifty asClassicis,
though, Apple strongly discourages programmers from writing applications specifically designed to
run in Classic. In other words, don't get an older copy of an integrated devel opment environment
(IDE), sit down at aMac running Mac OS 8 or OS 9, and set about developing a program that runs on
that machine. Rather than expending effort devel oping a program that isimmediately dated (won't run
native on Mac OS X), you should devote the same effort to devel oping a Macintosh program that runs
native on Mac OS X. In certain circumstances, you can create such a program that also can execute on
a computer running Mac OS 8 or OS 9. To do that, you'll make use of the Carbon environment.

Carbon

For years programmers wrote Mac programs using the Macintosh Toolbox. The Macintosh Toolbox is
an application programming interface (API), which is a set of thousands of functions that relieves a
programmer of much of the busy work of writing the code most programs need. The Macintosh
Toolbox still exists, and it's still possible for a programmer to use it to write what is now called a
Classic program. However, there's no reason for a programmer to do this. With Mac OS X, Apple has



created the Carbon API, which is an enhanced subset of the Macintosh Toolbox API. The term
enhanced subset is one that I've just coined, and it requires a little explanation!

Why Carbon API isan Enhanced Subset

As Apple was developing Mac OS X, it was modifying the Macintosh Toolbox. The result
was the Carbon API. Apple examined each of the thousands of Macintosh Toolbox
functions and eliminated the ones that could not be adapted to work in Mac OS X. The
Carbon API includes about 70 percent of the functions of the Macintosh Toolbox; thisis
the reasoning for calling it a subset of the Toolbox. Of the thousands of functions that were
salvaged, many had to have some of their code rewritten to work properly in Mac OS X
thisiswhy Carbon is an enhancement.

Fortunately for Mac programmers, most of the code changes Apple made to Macintosh Tool box
functions are kept hidden. For instance, the Macintosh Toolbox API Fr aneOval function exists by
the same name in the Carbon AP, and it isinvoked by a programmer in the same way now asin the
past. In both cases, the result of making acall to Fr aneOval isyou guessed it-the drawing of a
framed oval. Exactly what does the code that comprisesthe Fr aneOval function look like? A
programmer didn't know that information when using the Macintosh Toolbox API, and he or she
doesn't know that information now when using the Carbon API. To make use of a Carbon API
function, a programmer need only know how to invoke the function. The "internals’ of the function
are unimportant.

There are some features of Mac OS X that aren't present in Mac OS 9. These features are not
addressed by any function in the original Macintosh Toolbox. To address this issue, Apple has added a
number of new routines to the Carbon API. These routines didn't exist in the original Macintosh
Toolbox API (which is another reason for saying that Carbon is an enhanced version of the Toolbox).

When you develop a Carbon application, you're creating a program that runs native in Mac OS X.
Building this application under certain conditions in certain development environments (namely
including the CarbonL.ib library in a Metrowerks CodeWarrior project) enables this same program to
run on a computer that's running Mac OS 8 or 9. Such a program won't, however, have the Aqualook
when running under Mac OS 8 or 9. For a programmer with an existing body of Mac code, Carbon is
the way to go. The effort to port code from Mac OS 8/9 to Mac OS X through the Carbon API is
minimal. For a programmer new to Mac programming, Carbon again might be the best bet. Cocoais a
good programming environment, but it is an object-oriented framework that must be programmed in
Objective-C or Java. If you aren't experienced in the techniques of object-oriented programming, the
Cocoa learning curve might be too steep for you.

Cocoa

The Cocoa environment is an environment that exists specifically to run native Mac OS X
applications. When Apple bought NeXT, Apple used much of the NeXT OSin Mac OS X. Apple also
used much of the NeXTSTEP object-oriented framework as the basis for Cocoa. A programmer uses
the Cocoa object-oriented programming framework to create programs that run native on Mac OS X.
A program designed as a Cocoa application runs native in Mac OS X, but does not run at al on a



Macintosh running Mac OS 8 or OS 9.
Carbon or Cocoa?

Cocoa and Carbon are the two primary environments for creating native Mac OS X applications, and a
programmer who sets out to develop a program capable of running native on aMac OS X computer
needs to choose between environments. The choice is based on a combination of factors, including the
programming background of the programmer and the version of the Mac OS that is expected to
represent the majority of the target customers.

One key issue in choosing a programming environment is the learning curve associated with the
chosen environment. A programmer with a procedural programming background (namely the C
language) should consider Carbon. A programmer with a strong object-oriented programming
background might consider Cocoa. Here's why:

. A Carbon application can be written in an object-oriented language such as C++, but it is
typically written in C. Most Macintosh programming books (including this one) use the C
language in explanations and example source code listings. Almost all of Apple's thousands of
pages of online Carbon documentation use C, as do the Apple-supplied Carbon header files.

. A Cocoa application, on the other hand, is created using an object-oriented framework, and is
written in an object-oriented language: either Objective-C or Java. If aprogrammer haslittle
or no object-oriented experience, it might make the sense to choose Carbon over Cocoa. If a
programmer has previous Macintosh programming experience, it again makes sense to
consider Carbon. The Carbon API looks familiar to a programmer who's worked with the
Macintosh Toolbox API, which serves as the foundation of the Carbon API. If a programmer
is strong in object-oriented programming, making use of the power of an object-oriented
framework makes Cocoa alikely choice.

Another factor in choosing a programming environment is the projected OS makeup of the target
audience. If aprogrammer expects a hefty percentage of intended users to be running Macs that aren't
running Mac OS X, Carbon becomes the environment to use. It's the one to use because it's possible to
build a Carbon application that can run native on aMac OS X computer and on a computer equipped
with Mac OS 8 or Mac OS 9. The same is not true of a Cocoa-built application. It can run only on a
Mac OS X computer. A Cocoa-built application does not launch if it'sinstalled on a computer without
arunning Mac OS X. At thiswriting, Mac OS X isjust being introduced. Although Mac OS X now is
being included on all new Macintosh computers, the phase-in period might still take some time
(considering that new Macs will also ship with aversion of Mac OS 9, and because many owners of
older Macs won't immediately [or ever] upgrade to Mac OS X).

Application Services

Directly beneath the Application Environments layer is the Application Services layer, as shownin
Figure 1.1. The main system services that exist in this layer-Quartz, Windows, QuickDraw, OpenGL,
and QuickTime-are primarily graphics-related. These system services are available to, and crucia to,
all application environments except BSD. Asyou'll see later in this chapter and in Chapter 2, BSD is
an environment used to write UNIX programs that run in a Terminal window. As such, these
applications don't require access to the graphics-related services.



Quartz and Windows

The primary contributions of the Application Services layer are the drawing of graphics and the
implementation of windows. Both services are made possible largely by Quartz-system software that's
new to the Macintosh OS. Quartz is made up of agraphics rendering library (Core Graphics
Rendering) that supports two-dimensional shapes, and a windows component (Core Graphics
Services, which can be referred to as Quartz Windows Server) that's responsible for the graphical
display of windows. Figure 1.1 shows how the Application Services layer fitsinto the overal

hierarchy of system software. Figure 1.5 shows a more detailed look at just the Application Services
layer.

Figure 1.5. A detailed look at the Application Services software layer.

Application Serdces

Core Graphics Aendering

[qua_i Iz Elfa'l‘-"."lg:l QuickDraw HFBHGL BuickTima

Cora EFEPHIEE Sarvices
(Quartz Windows Servier)

Figure 1.1 generalizes things a bit by showing Quartz and Windows side-by-side. Here in Figure 1.5,
you see that the software that services Windows is part of Quartz and that it extends under the other
graphics components of Mac OS X. The implication is that, to varying degrees, these other "non-
Quartz" graphics components work with the Core Graphics Services (or Quartz WindowsServer)
portion of Quartz.

Quartz, like QuickDraw, is graphics rendering software for two-dimensional shapes. Unlike the older
QuickDraw software, though, Quartz is based on PDF (Portable Document Format). Being built on
PDF gives Quartz the capability to offer programs features such as automatic PDF generation (save-as-
PDF), high-quality screen display, and on-screen graphics previews.

The interrel ationships and dependencies of the graphics systems (Quartz Core Graphics Rendering,
QuickDraw, OpenGL, and QuickTime) and the Quartz Core Graphics Servicesis atricky business.
Fortunately, you don't need to know the details. Once again, it's the application environment you use
(such as Carbon) that shields you from the technical aspects of how your program does what it should
do (such as enable a user to drag a window and have that window properly update when the user
finishes the drag operation). Quartz is an important part of the system software that makes windows
work in your application!

QuickDraw

Both the Quartz and QuickDraw sets of system software include the capability to render two-
dimensional shapes. Quartz is used primarily by other system software, and much of the Quartz
software isn't directly accessible to programmers by way of function calls. QuickDraw too is used by
other system software. An application uses QuickDraw indirectly when interface elements such as
windows, controls, and menus need to be drawn. Unlike Quartz, though, the full functionality of



QuickDraw isreadily available to programmers. Thisis achieved through a huge set of routines that
were a part of the original Macintosh Toolbox APl and that now are a part of the Carbon API.

Asyou'll see throughout this book, including QuickDraw graphics in your own program is relatively
easy. All that's needed is the knowledge of which QuickDraw functions to use and the calling
conventions for those functions. A function's calling convention is the format of the function call, such
asitsreturn type and parameter types. For instance, if your program needs to draw the frame of a
rectangle in awindow, you need to know that the SetRect function defines the boundaries of a
rectangle and the FrameRect function draws the frame of a rectangle specified by the just-defined
rectangle. Here's the information you need to know about these two QuickDraw routines:

Set Rect( Rect * r, short left, short top, short right, short
bottom)
FranmeRect ( const Rect * r )

To define the boundaries of arectangle, pass SetRect a pointer to a variable of type Rect along with
the pixel coordinates (relative to the top-left corner of the window in which the rectangle will exist). A
call to SetRect defines arectangle, but doesn't draw it. To actually draw the frame of this rectangle,
call FrameRect and pass a pointer to the rectangle to draw. The following is a code snippet that does
just that. Figure 1.6 shows the results of executing this code.

Figure 1.6. Using QuickDraw routinesto frame a rectangle.
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Rect t heRect ;

Set Rect ( & heRect, 50, 20, 250, 120 );
FranmeRect ( &t heRect

Figure 1.6 shows the result of running the code snippet. For clarification, |I've added a few references
to pixel coordinates. This figure should make clear that the QuickDraw frames a rectangle with a
width of 200 pixels (extending from pixel 50 to pixel 250) and a height of 100 pixels (extending from
pixel 20 down to pixel 120). This brief example isn't intended to give you a comprehensive picture of
how your program creates a window and draws it-you are, after all, only in Chapter 1! It does show,
however, that your program needs very little code to draw graphics and that the code isfairly easy to
comprehend (provided you're shown the format of how to use it).



QuickDraw is very important to Mac programmers. I'll have alot to say about QuickDraw in this
book. In fact, an entire chapter (Chapter 7, "QuickDraw Graphics') is devoted to using QuickDraw to

include graphics in your own applications. To summarize, QuickDraw is a set of system routines that
provide programmers with the ability to define and draw two-dimensional shapes and text.

OpenGL

Mac OS X relies primarily on Quartz and QuickDraw for the rendering of two-dimensional graphics.
For three-dimensional graphics, Mac OS X makes use of OpenGL. OpenGL is new to the Mac OS,
but this software library itself isn't new. OpenGL was introduced in 1992, and since then, it has
become the industry standard for three-dimensional graphics.

OpenGL isan API designed to make it possible for programmers to include sophisticated graphics
(such as texture mapping and special effects) in their programs. All programs don't need the functions
that make up the OPENGL API. They're designed for graphics-intense programs such as animation-
rich games and medical imaging software.

OpenGL programming is beyond the scope of this book. However, the Mac programming knowledge
you gain from this book enables you to set up a program that is ready to support OpenGL. That is,
after reading this book, you can create a program that includes menus, QuickTime movie playing
capabilities, multiple windows, and controls in those windows. With these foundations, you then can
focus on adding OpenGL three-dimensional functionality to your application.

QuickTime

QuickTime isthe name of the system software that provides applications with the capability to include
several multimedia capabilities. Most notably, QuickTime enables an application to play back
QuickTime movies. QuickTime, however, also gives a program the capability to play music, display
animations, and compress and expand files.

For programmers, Apple has made the inclusion of QuickTime functionality easy. The original
Macintosh Toolbox API, and now the Carbon API, includes a huge number of QuickTime-related
routines. These routines are conceptually divided into categories within the Carbon API-the two most
notabl e categories being the Movie Toolbox and the Component Manager.

Although the number of QuickTime functionsislarge, accomplishing a single QuickTime-related task
requires the knowledge of just afew routines. For instance, if you want your own application to have
the capability to play an existing QuickTime movie in awindow that displays standard QuickTime
controls (such as the play and stop buttons), you need add only a couple dozen lines of code to your
program. That code includes all the function calls your program makes to do the following:

. Open thefilethat holds the QuickTime movie

. Load the movie datafrom the file on disk into memory
. Create awindow in which the movieisto play

. Play the movie from start to finish



Take alook at this snippet to get a short preview of what QuickTime code looks like:

Movi e theMvie;

do {
Movi esTask( theMovie, 0 );
} while ( IsMvieDone( theMovie ) == false );

The Carbon API function MoviesTask plays one frame of the specified movie, so thisroutineis called
repeatedly until the movie isfinished playing. Another Carbon API function, the very appropriately
named | sVovi eDone, iscalled after each call to Vovi esTask to verify whether the specified
movie has finished playing. When | s\Vbvi eDone returns true, the program knows that movie play
has completed and that thereisno need to again call Vbvi esTask.

This book exists primarily to get a programmer up to speed in creating an application that runs native
on Mac OS X. Assuch, Mac OS X programming basics are thoroughly covered. The Macintosh OSis
anything but basic, so why should this book stick to just the basics? Well, you'll note that an entire
chapter- Chapter 9, "Playing QuickTime Movies'-is devoted to the techniques necessary to include

movie-playing capabilitiesin your own applications. With some good code snippets and plenty of
detailed explanations on the use of key Carbon API QuickTime-related functions, even someone new
to Mac programming will find that it's not too challenging to spice up an application with QuickTime
movie-playing features.

Other Application Services

Figure 1.1 shows the primary components of the Application Services layer, but there are other, lesser,

components aswell. A cursory mention of some of these will help define terms that appear elsewhere
in this book and in other Mac OS X documentation.

The first technology is the Process Manager. It manages the processes executing in Mac OS X. Each
running application has its own execution environment consisting of its own protected area of
memory. This environment-referred to as a process or an execution context-is maintained by the
Process Manager system software. The Process Manager is responsible for launching an application
and then scheduling the CPU time used by the executing application.

Another Application Services technology is the Event Manager. In aMac program, an action is
referred to as an event. For instance, when the user clicks the mouse button, the program interprets
that action as an event. However, an event is more than simply an action. It is the composite of an
action and additional information that's descriptive of the action. For example, where the cursor was
located at the moment the user clicked the mouse button is information that's encoded in a mouse-
down event. In Chapter 3, "Events and the Carbon Event Manager,” you'll read about events and how
your program makes use of the functions that comprise the Event Manager portion of the Carbon API.
In that chapter, Event Manager refersto a set of API functions that a programmer can use. The other
use of the term "Event Manager" describes the actual event-handling system software in the
Application Services layer.

Another Application Services technology isthe Clipboard. If you've used a Macintosh running Mac



OS 9 or earlier, you know about the Clipboard. The Clipboard is the behind-the-scenes software utility
that makes it possible to copy one element (such as selected text or graphics) from a document and
paste that element el sewhere in the document-or even into a document belonging to another
application. In Mac OS X, the Clipboard is referred to as the Pasteboard, and the system software that
handles this data transferring exists in the Application Services layer.

Core Services

Under the Application Services layer is the Core Services layer, as shown back in Figure 1.1. Moving

deeper into the system software means moving into system code that has little or no effect on the user
interface. Unlike components of the Application Services layer (such as QuickDraw and QuickTime),
components of the Core Services layer don't produce results that a user can see or hear. Instead, this
system software handles more mundane (but important) tasks such as memory management and file
system management. We discuss each in turn next.

Carbon Managers

When your application invokes a Carbon API function, the code that actually carries out the function's
task might be located in the Core Services layer. In this layer, you find that code for several Carbon
Managers, including Alias Manager, Component Manager, File Manager, Memory Manager,
Resource Manager, and Thread Manager. As the names of some of these managers hint, their low-
level services are available to, and used by, most applications.

Apple Events

An Apple event is a high-level event that an application can make use of to communicate with the
Finder, another application, or itself. One type of Apple Event that most applications support is the
Quit Application event. A Mac user who chooses the Restart or Shut Down menu item from the
Finder will notice that the computer won't turn off until each running application quits. This graceful
shutdown process is achieved through the use of the Quit Application event. When an Apple Event
occurs, it's Core Services code that gets executed. The Core Services layer holds the Apple Event
system software.

Open Transport

When a Mac user connects to the Internet, it is the Open Transport code in the Core Services layer
that's being executed. Open Transport is the networking and communications system software that
was used in Mac OS 9 and that is now a part of Mac OS X. Open Transport enables simultaneous
networking systems (such as a program's use of AppleTalk to communicate with a printer and TCP/IP
to make an Internet connection). Open Transport also enables a user to create different networking
profiles (such as a set of 56K modem settings and a set of cable modem settings) and then switch
among them.

Core Foundation

Core Foundation is the Core Services layer code that supports basic services used by most
applications. For instance, the Utility Services code offers date and time computations that a program



can use, while String Services code provides string manipulation and conversion services that many
programs find useful.

A programmer, by way of the Carbon API, can indirectly access much of the code that makes up the
Core Foundation. In particular, the API functions that are grouped and that fall under the same
heading (Core Foundation) offer a programmer an easy and useful means of including strings, dates,
and numbersin his or her applications.

Kernel Environment

The lowest level of the Mac OS X system software-the true core of the OS-is the Kernel Environment.
As shown back in Figure 1.1, the Kernel Environment's five major components are Mach, BSD,

Networking, I/0O Kit, and the File Systems. Collectively this software is the Kernel Environment.
You'll also hear this same set of system software referred to as Darwin (with the reference being to the
idea that this core software is the origin of the "life" of Mac OS X).

Darwin itself isa complete OS. What Apple has done is enhance its UNIX code and add layers of
software to it to lead to the Aquainterface that Mac OS X users experience. Darwin is an interesting,
exciting, reliable, and stable foundation for the complete Mac OS X package. The components of
Darwin support advanced memory protection and management, multiprocessing and multithreading,
and multiple file system support.

M ach

Any OS requires core software that handles the system's most basic and most critical functions. For
Mac OS X, this core software is named Mach. Mach technology is new to the Macintosh OS, but the
code itself isn't entirely new-Mach itself has been around for well over a decade. The version of Mach
that is at the core of Mac OS X is based on code from a combination of the origina Mach, Apple's
years-old MKLinux project, Mac OS X Server software, and the NeXT OS (NeXT having been bought
by Apple afew years ago).

Like the rest of the components of Darwin, the tasks that Mach carries out are all behind the scenes.
The details of how Mac OS X handles services such as memory management and protection, schedule
handling, and interprocess communication (the act of one running application communicating with
another) are unimportant. The Mach code takes care of these tasks in a manner transparent to both the
programmer and the end user.

Every previous version of the Macintosh OS has of course had core software, so what's so exciting
about the Mach software that serves as the heart of Mac OS X? Mach doesn't simply handle the
mundane system-level OS tasks. It carries them out with vast improvements over the methods used by
the core software of previous versions of the Mac OS. Consider the following core-level features that
Mach implements:

. For thefirst time, the Macintosh OS has true protected memory-a memory scheme that denies
asingle application the power to crash the entire system. An OS can be stable only when the
OS places each process in its own area of memory and then enforces the concept that each
process must not write data to the memory area of another process. The Mach software does



this, which means that even if one application crashes, other processes are unaffected.

. Today's OSs enable several applications to run concurrently. How efficient an OSis at
multitasking, or sharing CPU time, can vary quite a bit, though. Mac OS 8 and 9 did only afair
job of multitasking. The Mach code of Mac OS X uses preemptive multitasking to do a much
better job of allocating CPU resources. Mach includes sophisticated algorithms that rank the
importance of various tasks and then prioritize CPU time to ensure that each process runs
smoothly and efficiently.

. Mac OS X, like Mac OS 8 and 9, makes use of virtual memory. In a system using virtual
memory, physical memory (such as RAM) and storage space (such as a hard drive's disk
space) are used in conjunction to provide the effect of almost unlimited memory. For instance,
asystem that includes 128MB of RAM and a large capacity hard drive can act asif it had
severa gigabytes of RAM. The Mach codein Mac OS X takes the implementation of virtual
memory to a higher level, making it more efficient than virtual memory in previous versions of
the Macintosh OS.

BSD

Earlier in this chapter (in Figure 1.1 and elsewhere), you saw that BSD is one of the five application
environments. A programmer uses an application environment (such as Carbon or BSD) to access
system code. The BSD application environment enables access to BSD system code. The Mach kernel
is the foundation of Mac OS X. It provides the lowest-level services, such as memory allocation and
process management. Mach, however, doesn't provide the OS with all the basic services. For other
low-level services, such as device input and output (1/0), networking, and file system support, the OS
kernel relieson BSD.

An OS can use BSD UNIX asitsentirekernel. That is, BSD is capable of handling al low-level OS
services. Apple has opted to not have BSD handle all the low-level tasks of Mac OS X. Instead, Apple
modified FreeBSD (itself aversion of BSD) and combined it with Mach. Together Mach and Apple's
version of BSD handle the chores that BSD handles alone in some OSs. Although this separation of
duties might seem allittle more complex, Apple feels that segregating some of the core level duties
makes for a more robust operating system. In Figure 1.1, Mach and BSD are shown in the Kernel
Environment layer. If the Kernel Environment layer were to be further subdivided, it would be
redrawn with aBSD layer on top of a Mach layer.

Networking

The Kernel Environment includes advanced networking support, and Mac OS X takes full advantage
of that support. Included in the Networking component of the Kernel Environment layer are Network
Kernel Extensions (NKEs). An NKE offers a means of dynamically extending (modifying) the
networking abilities of the Networking component.

1/0 Kit

The Kernel Environment iswhere drivers are supported. A driver is the software that enables a
hardware device (such as hard drive or CD drive) and the OS to communicate with one another. The I/
O Kit of the Kernel Environment includes an object-oriented development framework that assists
programmers in the creation of new drivers. Although driver development can be viewed as a
mundane programming task (and one well outside the scope of this book), it isatopic of great



importance to the success of an OS. The more third-party devices an OS supports, the more popul ar
the OS can become. In addition, it's unlikely that a computer user will want to purchase an OS that
won't work with the user's existing hardware or with much of the new, state-of-the-art hardware that
the user plans on buying.

File Systems

If you're aMac user, you might be familiar with the terms HFS (Hierarchical Filing System Standard)
and HFS+ (Hierarchical Filing System Extended). These two filing systems are the ones used by the
last several versions of the Macintosh OS. Of course, Mac OS X supports these file systems, but this
OS a so supports numerous other file systems, including UFS (UNIX file system, the standard file
system of BSD), NFS (networked file system, the industry-standard for file systems that are a part of a
network), and I SO 9660 (the quality management standard of the International Organization for
Standardization, used primarily for CD-ROMSs).



Application Environments and Programming L anguages

For the remainder of this chapter, the focus is on going further into one layer-the
Application Environments layer. From a programmer's perspective, this makes sense. It's
the application environment that defines which APl a programmer uses and, possibly,
which development tools the programmer uses as well.

If you've read al the preceding pages, don't feel asif you've wasted your time. A little extra
knowledge of the other system software layersis of benefit. In fact, knowing the system
code that your program is accessing enhances your understanding of how your program is
doing what you intend it to do!

Classic

Thisisacompatibility environment that enables programs initialy designed to runin Mac
OS 8 or 9 to run on amachine running Mac OS X. A non-native Mac OS X program runs
in Classic, and does not take on the Aqua look of Mac OS X and does not inherit the many
enhancements found in Mac OS X, such as protected memory.

BSD

This environment is a shell that enablesaMac OS X user to use atypica UNIX command
line interface to execute BSD commands and programs. The BSD environment will be of
benefit to UNIX programmers who are used to moving about in acommand line interface,
but this environment is of much less interest to a programmer intent on writing Mac OS X
applications that sport the Aqualook and that behave as typical Macintosh applications.

Carbon

The Carbon environment is of great interest to Mac programmers. A program running in
the Carbon environment has the Aqua look and takes full advantage of the features of Mac
OS X. This same program, when built under certain conditions, will execute on a
Macintosh running Mac OS 8 or 9 (though it then won't take on the Aqualook). A Carbon
application is created using the Carbon API, which is an enhanced version of the
Macintosh Toolbox API. A programmer who has familiarity with pre-Mac OS X
programming should strongly consider using the Carbon API because the learning curve
will not be steep.

Cocoa



Thisis another environment of interest to Mac programmers. Like a program running in the
Carbon environment, a program running in the Cocoa environment has the Aqualook and
takes on the improvements associated with Mac OS X. A Mac OS X end user will not be
able to distinguish between a Carbon and Cocoa application (that is, the user won't know
which environment was used to develop the application). A Cocoa-devel oped application
will not, however, run at al on acomputer running Mac OS 8 or 9. Cocoa is an object-
oriented application framework that is an excellent environment for a programmer with a
strong object-oriented background.

Java

This environment is of interest to Mac programmers who are knowledgeable in the Java
programming language and who are looking to create portable applications or applets.

With the environment summary complete, let's take alonger ook at each of the five
environments.

BSD

At the core of Mac OS X isBSD UNIX. This means that a programmer working on a
computer running Mac OS X can develop and execute a UNIX application. From the
Terminal application, a programmer can use standard BSD tools, utilities, and scripts, just
asif the programmer were working in ashell on a"typical" UNIX machine. From the
command line, a programmer can edit source code files, run the gcc or g++ UNIX
compilers, and execute UNIX programs.

Because a Mac programmer that's interested in creating atrue Mac OS X application (one
that sports the Aqua interface) will most likely use an Apple API such as Carbon or Cocoa
rather than BSD, this book touches lightly on UNIX and the BSD environment. However,
because UNIX is new to the Macintosh, I've tried to satisfy the curiosity many readers will
have by walking through the command line development of avery simple UNIX
application in Chapter 2. If you've never worked in a UNIX environment, you might want
to first read through Appendix B, "UNIX and the Terminal," to see how to use the

Terminal command line shell application that's included on every Macintosh running Mac
OS X. Using the Terminal, you can execute UNIX commands to move about the directory
hierarchy and run programs (such as atext editor or a C or C++ compiler).

Classic

Thisiswhereit al started. The Classic environment is based on the Macintosh Toolbox,
which isan API that has existed (and has been continually upgraded) since the inception of
the Macintosh computer. If an application is devel oped using the Macintosh Toolbox API,
and that application is launched on a Macintosh running Mac OS X, the application runsin
the Classic environment. Classic is a compatibility environment only. It isMac OS 9



running within Mac OS X. Classic is awonderful supplement to Mac OS X in that it
enables usersto preserve their investmentsin older software. However, because an
application developed using the Macintosh Toolbox API can't run nativein Mac OS X, no
programmer developing a new application should use the Macintosh Toolbox API. If the
desired result of a new programming project is a native Mac OS X application that is
capable also of executing on aMacintosh running Mac OS 9 or 9, Carbon is absolutely the
route to take.

Carbon

The vast majority of programmers developing native Mac OS X applications will do so
using either Carbon or Cocoa. The focus of this book is the Carbon environment and the
Carbon application programming interface (API).

Carbon API

Apple has expended considerable resources to modify the functions of the Macintosh
Toolbox API so that they work on Mac OS X. The result of this effort is arevamped
Toolbox API that is now referred to as the Carbon API. Thus, the API used to develop a
program that runs in the Carbon environment is a derivative of the APl used to develop a
program that runsin the Classic environment. In upgrading the Macintosh Toolbox, Apple
preserved roughly 70 percent of the original Toolbox functions. The body of such a
salvaged function (the code that makes up the function itself) might have required change,
but the interface to the function (the calling convention to invoke the function) remained
static. Thisuseful trick of hiding code changes from programmers means that programmers
knowledgeable in using the Macintosh Toolbox will be able to keep most of their existing
code and be able to make use of much of their existing knowledge of the Macintosh
Toolbox.

Although Apple was able to port thousands of the Macintosh Toolbox routines to run under
Mac OS X, many routines had to go. To regain the functionality of these lost routines, and
to add programmer support for the new functionalities accompanying Mac OS X, Apple
needed to add a number of new routines to the Carbon API. This book includes coverage of
many of these routines, with emphasis on the ones that are a part of the much-changed
Event Manager (the Event Manager being the name of the large set of event-related
routines that we describe in Chapter 3).

In the original Macintosh Toolbox, routines were conceptually grouped into managers. A
manager is simply a category of related routines. Managers exist mostly as an
organizational tool for programmers. For instance, if a programmer needs to add some new
window-related functionality to a program, the programmer knows that to determine how
to add that functionality, he or she should search through the descriptions of the routines
that are said to be a part of the Window Manager. The Carbon API retains this
organizational scheme. Throughout this book (and in any other Macintosh programming
documentation), you'll find references to various managers.



Experienced Mac Programmer

The porting of Macintosh Toolbox routines and the addition of new routines has,
for the most part, not affected the naming of managers. For instance, the origina
Macintosh Toolbox APl had a Window Manager, a Menu Manager, and aFile
Manager-and the Carbon API does too. In afew cases, changes to a manager
were so large that Apple renamed the manager by prefacing its name with
Carbon. Be aware that the Event Manager, the Printing Manager, and the Help
Manager now are named the Carbon Event Manager, the Carbon Printing
Manager, and the Carbon Help Manager.

Programming L anguages and Carbon

The Carbon application programming interface includes different sets of header files so
that a programmer can use C, Pascal, or assembly language to develop Carbon
applications. Because C isafar more popular language than Pascal or assembly, and
because almost all of Apple's thousands of pages of documentation provide C language
examples, C isthe language of choice for most Mac programmers who use the Carbon API.
Because C is so popular with Mac programmers, examples throughout this book will bein
the C language.

Object-oriented programmers aren't excluded from using the Carbon API. If you know C+
+, you'll find that you too can develop a Carbon application. In short, to do this, your
program will make callsto C language Carbon API functions from within the body of a C+
+ class member function. The major difficulty a C++ programmer facesis finding good
documentation on programming the Macintosh using object-oriented techniques.

Cocoa

Carbon and Cocoa are the major programming resources for Mac OS X developers. Cocoa
is an object-oriented framework. Using Cocoa, a developer creates an application that runs
native on Mac OS X, but will not run at all on Mac OS 8 or 9. Because most Mac
programmers use a procedural programming language rather than an object-oriented
language, and because Cocoa applications don't run on non-Mac OS X computers, the
focus of this book ison Carbon rather than Cocoa.

Cocoa API

The Cocoa application environment is based on two object-oriented frameworks: the
Foundation framework and the Application Kit framework. The classes that make up the
Foundation framework provide an application with core-level services, which are not
related to the user interface. The classes of the Application Kit framework supply an



application with user interface elements such as windows and menus.
Programming L anguages and Cocoa

The Cocoa frameworks (Foundation framework and A pplication Kit framework) are
written in Objective-C. Although Cocoa is object-oriented, you can't use just any object-
oriented language to develop Cocoa applications. Instead, you must use either Objective-C
or Java (C++ can't be used). The original Cocoa API is Objective-C, but Apple has added a
Java API aswell (with the Java classes ssmply "trandating” to their Objective-C
counterparts).

Like C++, Objective-C is an extension of the C language. Because Objective-C isan
extension of ANSI C, and because its additions to C are relatively few, C programmers
might find learning Objective-C easier than learning C++. With that said, moving from a
procedural language such as C to an object-oriented one (whether it is C++ or Objective-C)
can be difficult for many programmers. This book teaches Macintosh programming
techniques rather than a programming language. It makes the assumption that the reader
knows a programming language; that language is assumed to be C. If you'd like to learn
both a new programming language and a new Macintosh development method, you'll need
to study both Objective-C and Cocoa.

Java

The previous section, Cocoa, mentioned the Java programming language. The Cocoa
frameworks are written in Objective-C and offer a Java "wrapper" to that code so that Java
programmers can make use of the frameworks. A Java programmer doesn't have to use the
Cocoa framework, though. For Java programmers, Apple provides the Java application
environment.

Like the other application environments, the Java environment is for both creating
applications and running applications. The Java environment is based on the Java
Development Kit (JDK) and the Java virtual machine (VM). Thisisthe industry standard.
Any other PC that supports Java includes this type of Java environment aswell. This
means that a Java application or applet developed in Mac OS X is portable to any other PC
that supports the industry standard Java.

A Javaapplication or applet can be created from the BSD command line (using the Mac
OS X Termina application) to run Javatools such as the Java compiler, debugger, and
appletviewer. Alternately, a programmer who prefers to work in a graphical interface can
use Apple's Project Builder IDE (discussed throughout this book) to develop Java
applications and applets.

To make Java devel opment possible, Apple includes an application framework that
contains the classes (such as Swing and the Abstract Windowing Toolkit [AWT]) needed
for building Java applications and applets.






For More Information

For extrainformation about any of the topics covered in this chapter (or, for that matter, in
this book), you're best bet is to search the web. For more information on the system
software that makes up Mac OS X, consider these sites:

Darwin: http://www.opensource.apple.com

UNIX and Mac OS X: http://arstechnica.com/reviews/01g2/macos-x-final/macos-
X-15.html

Objective-C: http://www.stepwise.com


http://www.opensource.apple.com/
http://arstechnica.com/reviews/01q2/macos-x-final/macos-x-15.html
http://arstechnica.com/reviews/01q2/macos-x-final/macos-x-15.html
http://www.stepwise.com/

Chapter 2. Overview of Mac OS X Programming

CHAPTER 1, "SYSTEM COMPONENTS AND PROGRAMMING TECHNOLOGIES/"

described the Mac OS X system software and the application environments and
programming languages that can be used to create applications that run on this system
software. Now it'stime to move from the theoretical to the application of that theory. In
this chapter, you'll read about the integrated development environments (IDEs) available to
Mac OS X programmers. In particular, you'll learn about two software devel opment
applications from Apple: Project Builder and Interface Builder. This pair of software tools
enables you to graphically design the elements of your application's user interface
(windows, menus, and so forth), write the code that makes use of those interface elements,
organize al your files, and build a standalone native Mac OS X application.

In this chapter, you'll walk through the creation of four applications-each one a variation of
the Hello World program that typically serves as a programmer's introduction to a new
programming language or a new operating system (OS). Although at first glance each
example might seem trivial, the discussion of the code that makes up each program
provides you with an understanding of many concepts common to all Mac OS applications-
including programs far more complex than the ones introduced here. Included in this
chapter, you'll find coverage of the organization of source code files, resource files, and
librariesin a project, the design and creation of menu and window resources, the purpose
and power of events and the event loop, the implementation of error-handling, and ssimple
techniques for adding alerts and pictures to any of your applications.

Before jumping into our four examples, we'll go through some background on devel opment
environments.



Development Environments

From Chapter 1, you know that there are a variety of application environments in which a
Mac OS X application runs. Carbon, Cocoa, and Java are the three application
environments that enable the running of native Mac OS X applications. For a programmer
to create an application that runsin one of these environments, some software
programming tools are needed. In particular, a resource editor, text editor, compiler, and
linker are the tools that make interface layout, source code editing, and application building
take place. It's possible to carry out these activities using individual tools, but more
typically, a Macintosh programmer uses just two programming applications: a resource
editor and an IDE.

A resource editor is used to create and edit resources that are the interface elements of a
program, such as menus, windows, and controls that appear in windows. The IDE isa
single application that integrates all other facets of developing a program. From the IDE, a
programmer edits source code, compiles that code, and links the compiled code with the
resources created in the resource editor to build a standalone application.

There are afew IDEs from which a programmer can choose. However, the vast majority of
Mac OS X programmers will pick from the two best offerings. Metrowerks CodeWarrior
and Apple Project Builder. Both of these tools use the concept of a project-afile that serves
as aprogrammer's command center of sorts-in place of a makefile and command line
application building.

M etrowerks CodeWarrior

Metrowerks IDE is named CodeWarrior. Introduced several years ago for Macintosh
program development, it now runs on several mgjor platforms, including Mac OS,
Windows, and Solaris. CodeWarrior comes with a number of compilersto give
programmers a choice of languages: C, C++, Object Pascal, Java, and Objective-C are all
supported.

CodeWarrior Projects

CodeWarrior is aproject-based IDE. To develop a program, you create a single project file
that holds the files that collectively become an application. Typically, a project file holds
source code files, resource files, and libraries.

CodeWarrior walks you through the two-step process of creating a new project. In Figure
2.1, you see that CodeWarrior lets you choose a category of stationery for the project.
Stationery is like atemplate that tells which starter files CodeWarrior should place in the



new project. Letting CodeWarrior decide which filesto include in the new project saves

you the effort of determining the appropriate libraries that are necessary for the type of
program you're devel oping.

Figure 2.1. Choosing stationery for a new CodeWarrior project.
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In Figure 2.1, I'm choosing Mac OS C Stationery because I'll be developing a program

using the C programming language. After naming the project and setting a disk location for
the project, it's on to the second new project window-the one shown in Figure 2.2. Here |
get to specify the environment for my application. I'll choose MacOS Toolbox Carbon.
Figure 2.3 shows the new project that results from my stationery choices. The new project
isawindow that lists the files that comprise the project.

Figure 2.2. Specifying the Mac OS stationery in CodeWarrior.
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Figure 2.3. The project window of a new CodeWarrior project.
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From the project window, it's easy to add or remove files, edit source code files, or start up
aresource editor to edit resourcefiles. It's also easy to compile code and build and debug
executables. A new project starts with a source code file and resource file that enable the
building of avery ssmple application.

To build and run an executable, choose Run from the Project menu. Figure 2.4 shows that
the resulting application displays an aert that includes an icon, text, and a button. Clicking
the OK button dismisses the aert, ends the program, and returns you to the project
window.

Figure2.4. Thealert displayed by the application built from a new CodeWarrior
project.
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To view or edit the source code file, you double-click the file's name in the project
window. Double-clicking the SimpleAlert.c source code filename opens awindow like the
one shown in Figure 2.5.

Figure 2.5. The source code file from the new CodeWarrior project.
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CodeWarrior and Resour ces

Y ou can display the contents of aresource file by double-clicking the file's name. The
CodeWarrior IDE doesn't have a built-in resource editor, so double-clicking a resource
filename results in the file being opened by a separate resource editor. This editor is
typically Apple's ResEdit resource editing application. Figure 2.6 shows how the
SimpleAlert.rsrc file looks when opened by ResEdit.

Figure 2.6. The ResEdit resource file from a new CodeWarrior project.
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A resource is code that defines an interface element. Asyou seein Figure 2.6, aresource

can define the size and screen position of an alert as well astheitemsin the aert (such as
text and a button). Resources typically are used to define interface elements. Interface



elements are visual entities, so it's of great help to a programmer to have atool that enables
him or her to design and lay out an application's visually. ResEdit is such atool.

When working with a program such as ResEdit, it becomes easy to think of aresource as
some sort of special object. It really isn't. A resource is ssmply a data structure comparable
toaClanguagest r uct . Theinteresting thing about a resource isn't that the resource
itself is special, but that software tools exist to display the resource code in a manner that's
visually appealing and easy for humans to work with. Before tools such as ResEdit existed,
aMac programmer had to create a resource by using code. Some programmers still prefer
that method-they use Apple's Rez language to define resourcesin atext file.

Consider the alert pictured in Figure 2.4. In Figure 2.6, you see the alert (aresource of the

type ALRT) and dialog item list (aresource of the type DI TL) resources that define the
alert and itsitems. Example 2.1 shows how the same alert pictured in Figure 2.4 could be

defined in code using the Rez language.
Example 2.1 Alert Resour ce Sour ce Code

#i ncl ude <Di al ogs. r>

resource 'ALRT' (128, purgeable) {
{50, 50, 170, 430},

128,

{
XK, visible, silent,
K, visible, silent,
K, visible, silent,
K, visible, silent,

}

al ert Posi ti onMai nScr een

b

resource 'DITL" (128, purgeable) {
{ {80, 300, 100, 360},

Button {
enabl ed,
" K"

}s

{15, 70, 85, 350},
StaticText {
di sabl ed,
"Hello World, this is CodeWarrior!"



A resourcefile that is created using a graphical resource editor such as ResEdit is usually
given a.rsrc extension. The SimpleAlert.rsrc file is an example of such afile. A resource
filethat is created in atext file isusually given a.r extension. If the code in Example 2.1
were saved in atext file, the filename of SimpleAlert.r would be appropriate. If one
removed the SimpleAlert.rsrc file from the project shown in Figure 2.3 and replaced it with
afile that held the code shown in Example 2.1, the application that results from a build of
the project would be the same. Running the new version of the application would again
result in the display of an alert like the one shown in Figure 2.4.

A Macintosh programmer could take the time to learn the syntax of defining resourcesin
code. However, a comparison of Figure 2.6 to Example 2.1 should convince you that for

most people, agraphical resource editor isthe easier method for creating and editing
resources.



Apple Project Builder and I nterface Builder

Apple'sIDE is Project Builder. Project Builder is designed specifically to generate native
Mac OS X applications. Programmers who use Project Builder can program in C, C++,
Java, or Objective-C. As of thiswriting, Project Builder and its companion resource editor,
Interface Builder, are free applications that are bundled with every copy of Mac OS X.
Again, as of thiswriting, these tools don't come preinstalled; they exist on a companion
developer tools CD. After they areinstalled, the tools will be in the Applications folder
located in the Developer folder. The examplesin this book use Project Builder and
Interface Builder.

Project Builder Projects

Like Metrowerks CodeWarrior, Apple's Project Builder is a project-based IDE. An
application begins as a project file that organizes the source code files, resource files, and
libraries that are compiled, linked, and combined into a standal one application. Project
Builder enables you to set up a new project by prompting you for the type of application
you'll be building (see Figure 2.7). The examplesin this book are created from projects that
make use of nib files (which are discussed just ahead in this chapter), so the Carbon
Application (Nib Based) option is the project type with which you'll become familiar.

Figure 2.7. Choosing a project typein Project Builder.
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After you select a project type, Project Builder asks that you enter a project name (to which



Project Builder will append a .pbprj extension) and the path for the folder in which the new
project should be placed (as shown in Figure 2.8). Y ou won't need to create a new folder to

hold the new project and its associated files-Project Builder automatically handles that task.

Figure 2.8. Naming the new Project Builder project and specifying itslocation.
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Selecting a project type tells Project Builder which files to include in the new project. This
saves you the work of determining the proper libraries that are needed to support the type
of application you'll be developing. In Figure 2.9, you see the window that appears when a
new project is created.

Figure 2.9. The project window of the new Project Builder project.
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The project window is the place from which you manage your project. Here it's easy to add
or deletefiles, edit and compile source code, and build and debug executables. To build
and run an executable, choose Build and Run from the Build menu. Y ou can do this
immediately upon creating a new project because Project Builder adds a ssimple source



code file (main.c) and resource file (main.nib) to any new project. The resulting application
displays an empty window that can be moved, resized, minimized, and closed.

A Project Builder project organizesfilesinto groups. In Figure 2.9, you see the group
headings are Sources, Resources, External Frameworks and Libraries, and Products.
Project Builder supplies a new project with files of each type-these are the files that are
needed to create a basic application of the specified type (such as a nib-based Carbon
application). Y our programming efforts will primarily focus on the filesin the Sources and
Resources groups.

The Sources group is where you store the source code files you write. Project Builder starts
aproject with avery ssimple main.c source codefile. You're free to edit thisfile, or remove
it and replace it with one or more .c files of your own making. Clicking a filenamein the
Sources group (such as main.c) displays the contents of that file in the area on the right side
of the Project Builder window. If you'll be writing .h header files, it makes sense to include
those files in the Sources group as well.

The Resources group is where you store the resource files that define the interface of your
program. Of most interest here is the main.nib file that Project Builder placesin the new
project. A .nibfileisonethat is created and edited using Apple's Interface Builder
programming tool. Interface Builder, nib files, and the nib resources within these files are
discussed throughout the remainder of this chapter.

To view or edit a .nib file (such as main.nib), you double-click the file's name. The double-
clicking opens thefile in Interface Builder. If your project has other types of resourcefiles,
you'll store them here in the Resources group. For instance, a.r Rez file or a.rsrc resource
file could be placed in this group.

Note

The .r file type (created as a source code file using the Rez programming
language) is discussed in the "Metrowerks CodeWarrior" section of this
chapter.

An example of the creation of a.rsrc file type (as created in ResEdit or some other
program) appears in this chapter's HelloWorldPict example program.

The External Frameworks and Libraries group holds libraries and frameworks (a
framework being simply adifferent type of library). When you create a new project,
Project Builder places the necessary filesin this group, and you will seldom need to add
any other files here.

The Products group holds the targets of your project. A target is the result of performing a



build and is typically a standalone application. Each example project in this book has just
onetarget, but it is possible to have more than one target associated with one project. An
example of thiswould be having two similar versions of a program: one that includes
specia error-checking code for debugging purposes and one production-quality program
that's stripped of all debugging code.

I nterface Builder and Resour ces

As described in the "Metrowerks CodeWarrior" section of this chapter, aresource is code
that defines an interface element such as a menu or window. The same resource can be
defined either textually in source code (see Example 2.1) or graphically in aresourcefile
(see Figure 2.6). In the past, resources defined graphically were typically done so using

Apple's ResEdit resource editor application. With Mac OS X, programmers have a new
way of working with resources-Interface Builder.

Interface Builder is an Apple programming tool that enables a programmer to create and
edit interface elements such as menus, windows, and the items in windows in a graphical
manner. Interface Builder is an adaptation of an older tool developed by NeXT. When
Apple acquired NeXT and the NEXTSTEP OS, they aso acquired Interface Builder.

Interface Builder was initially designed as atool for developing the interface elements for
NeXT applications. A file created with Interface Builder is given an extension of .nib, with
thenin nib standing for NeXT. A nib fileisaNeXT Interface Builder file. Figure 2.10
shows how Interface Builder displays the contents of a nib file that holds a menu bar
resource and awindow resource.

Figure 2.10. The Interface Builder resourcefile from a Project Builder project.
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Interface Builder islike ResEdit in that it too displays resource information graphically, but
stores that same information as text. Although ResEdit stores resource information in Rez
source code, Interface Builder stores resource information in extensible markup language



(XML) format. XML isamarkup language for documents containing structured
information. Unlike Hypertext Markup Language (HTML), which has fixed tag semantics
and afixed tag set, XML enables programmer-defined tags and tag relationships. Just as
you don't need to know the Rez language if you're defining resources in ResEdit .rsrc files,
you don't need to know XML if you're defining resources in Interface Builder .nib files.

This book's example programs use Project Builder projects and Interface Builder nib files.
If you've never used either of these programming tools, you'll want to ook over the four
example programs in this chapter. They provide a good introduction to working with
Project Builder, Interface Builder, and nib files.



Helloworld: Walking Through a Simple Example Program

Just about any tutorial-style programming book I've ever read included a very simple introductory
program, typically named something akin to HelloWorld. Thisis atutorial-style book as well, and
who am | to buck tradition? In this section you'll walk through the creation of a standalone Mac OS X
application named HelloWorld. If you've never programmed the Mac, or have programmed the Mac
but have never used Apple's programming tools (Project Builder and Interface Builder), you won't
want to skip thismaterial. As simple as HelloWorld is, it covers a number of fundamental issues that
arise throughout the rest of this book.

Creating the HelloWorld Project

Before creating a new project, you might find it convenient to make a new folder in which you'll store
all your projects. Many devel opers choose the Documents folder as the directory that's to hold their
projects, so that'swhat I'll do. Mac OS X provides a Documents folder off the root folder (the drive on
which Mac OS X isinstalled). Within that folder is a nice place to store al your projects. Within my
Documents folder, I've created afolder cleverly named MyProjects. Y ou might want to do the same.

Run the Project Builder application (it's located in the Applications folder in the Developer folder).
Now choose New Project from the File menu. Doing that displays the window shown in Figure 2.11.

Asshown in Figure 2.11, click the Carbon Application (Nib Based) list item located under the
Application heading. Then click the Next button.

Figure 2.11. Selecting a new Project Builder project typefor the Helloworld project.
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Now supply the new project with a name and alocation. In Figure 2.12, I've named my project
HellowWorld. Don't bother adding an extension to the name. Project Builder will automatically append
a.pbproj extension to the name you supply. Now click the Set button to specify the folder into which
this project should go. The window that appears lets you click your way through the folder hierarchy
until you reach the folder to which you want the new project saved. Click that folder's name, and then



click the Choose button. For my new project, | chose the MyProjects folder in my Developer folder.

Figure 2.12. Naming the new Project Builder project.
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In Figure 2.12, you see that Project Builder then automatically created a new folder with the same

name | gave my project (Helloworld) and placed that new folder in the selected folder (the
MyProjects folder). Now click the Finish button to tell Project Builder to finish the process of creating
the new project.

Now Project Builder opens awindow that displays the newly created project. Figure 2.13 shows the
window for the HellowWorld project. On the left side of the window I've clicked each Group heading
(Sources, Resources, and so forth) to display the files that Project Builder has automatically placed in
each group. Project Builder determines the files that are to appear in this project based on the type of
project selected (which was Carbon Application [Nib Based], as shown back in Figure 2.11).

Figure 2.13. The project window of the Helloworld project.
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For most projects, your interest will be with the main.c source code file and the main.nib Interface
Builder nib resourcefile. To start you out, Project Builder supplies a new project with alittle source
code in the main.c file. Project Builder also includes afew nib resourcesin the main.nib file it
includes with a project. I'll make afew changes to each file to demonstrate the process of editing



source code and nib resources and to provide an example of how source code and resource changes
affect the application that I'll soon build.

Nib Resour ces and the main.nib File

As mentioned earlier in this chapter, anib file is one that holds the definitions for interface elements
such as menus and windows, and it is editable using Appl€e's Interface Builder program. If you use
Apple's programming tools, you use Interface Builder to create your program's interface elements and
Project Builder to write your program'’s source code. There is no required order to carrying out these
tasks, but it typically makes the most sense to first use Interface Builder to design your program's
interface.

When you create a new nib-based project (as I've done here with the HelloWorld project), Project
Builder adds a nib file to the new project. Y ou can double-click the main.nib filename in the project
window to open that file in Interface Builder. Figure 2.14 shows how Interface Builder displaysthe

main.nib file that is used in each new Project Builder project.

Figure 2.14. The main.nib filethat's part of the HelloWorld project.
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Nib File Windows

Figure 2.14 shows that Interface Builder displays four windows. Y ou'll want to become familiar with
these windows, as they'll be present in just about any nib file with which you work.

The following bulleted list contains the name of each window, followed by the window's title (as it
appears in the window's title bar) and a description.

Nib filewindow (main.nib): In the lower left of Figure 2.14 is the window titled main.nib.
Thiswindow displays athumbnail view of the main (top-level) elementsin the nib file. In this



example, the nib file holds one menu bar and one window. The Instances tab (active in the
figure) is used to display the thumbnail view of the main interface elements. The Imagestab is
used to display images that can be used by window elements.

Double-clicking athumbnail image in the main.nib window resultsin the full-sized display of
that element within its own window. For instance, clicking the image above the MainMenu
title displays an actual-size view of the menu bar that the thumbnail image represents, as
shown in the upper-right corner of Figure 2.14.

Menu editor (main - MainMenu): Each element in the main.nib window can be edited
within its own window. Double-click the menu bar thumbnail image (labeled MainMenu in the
main.nib window) to display the menu bar. In Figure 2.14, that window has a title of main -

MainMenu. In the Menu Editor, you have full control over the content of your program’'s menu
bar.

Y ou can view the items in the menu of a menu bar by clicking the menu name. Doing that
drops that menu down to reveal theitemsin the menu, just asif the menu were a functional
menu in a program. The main.nib file that is the basis of each Project Builder nib-based project
includes a menu bar that holds a number of menus and menu items common to most programs.

Although a menu item might automatically have the functionality that accompanies its name
(the Quit item in the File menu is functional, for instance), most menu items need source code
support to work. Consider the File menu shown in the main - MainMenu window in Figure

2.14. Among its menu itemsis New. Building an application that makes use of thisnib file

will result in a program that includes a File menu with a New menu item, but it won't result in
this menu item actually doing anything. To add functionality to menu items, you need to
supplement the menu items created in Interface Builder with menu-handling source codein
Project Builder (we'll do that throughout this book). Although Interface Builder isn't amiracle
solution that stamps out a fully functional program, it is a superior programming tool that
makes it easy to quickly design the menus and menu items (and, as you're about to see, the
windows) that your program will use.

Design window (Window): Just as double-clicking a menu bar thumbnail image in the main.
nib window displays afull-sized, editable menu bar, double-clicking a window thumbnail
image in the main.nib window displays afull sized, editable window. This window represents
the window your program will display when it's launched. In Figure 2.14, that window has a
title of Window. As shown in that figure, the window that's provided for you in the main.nib
fileisinitially empty. When Project Builder added the main.nib file to your new nib-based
project,it took a guess as to what menus and menu items your program might need. That's not
too daunting of atask. Many menus (File, Edit, and so forth) and menu items (Quit, Copy,
Paste, and so forth) are common to most Macintosh programs. When it comes to windows,
though, Project Builder won't make much of an attempt to guess your program's needs because
window content is often the heart of a program, and it varies tremendously from one program
to another. Thus, the main.nib file simply includes one empty window as a starting point. As



you'll soon see, adding the items (buttons, text edit boxes, and so forth) that your program's
window needs is a simple task.

Palette (Carbon-Controls Palette): Did | mention how easy Interface Builder makes it for
you to add items to a window? The window titled Carbon-Controls Palette holds just about
every type of window-related feature you might want to include in your program's windows.
To add an item (such as a push button) to awindow, you simply click the item in the pal ette
window and drag and drop it onto the main window (the window titled Window in Figure
2.14). The exact title of this palette window changes depending on which of the five buttonsis

currently selected from the row of five buttons along the top of the window.
Editing the Menu Bar

The Helloworld program that you're creating doesn't need any new menus or menu items. However,
aslong asyou're here in Interface Builder, you might as well see how menu editing works. Here I'll
add a new menu that holds one menu item. | won't make use of that menu item in the Helloworld
program. However, in the next example program (the HelloWorldBeep program discussed in Chapter
3, "Events and the Carbon Event Manager"), | will give this menu item some functionality, so go

ahead and follow aong now.

Click the menu button in the palette window. That's the left-most button of the five buttons running
along the top of the window. Then click the blue Submenu item and drag it from the pal ette window to
the main-MainMenu window, dropping it between the Window and Help menus, as|'m doing in
Figure 2.15.

Figure 2.15. Adding a new menu to a menu bar.
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The result of the drag and drop is a menu titled Submenu. Interface Builder has included one menu
item named Item in the menu, as shown in Figure 2.16. To give the new menu a more suitable name,

double-click the Submenu name in the menu bar and then type a name for the menu. In Chapter 3, I'll
add some very simple sound-playing capabilities to the HelloWorld program, so in Figure 2.17, you

see that I'm in the process of naming the menu Sound. Changing a menu item name worksin a similar
manner: click the new menu to expose its one item, and then double-click the menu item name and
type in anew name for the item. In Chapter 3, thisitem will cause the program to sound a single beep,

so I've named this menu item Beep (see Figure 2.18).



Figure 2.16. The newly added menu befor e editing the menu name.
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Figure 2.17. Changing the name of a menu.
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Figure 2.18. Changing the name of a menu item.
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Now that you know the trick to editing menu and menu item names, you can hone your skills by
changing the name of the NewA pplication menu to HellowWorld, and change the name of the About
NewA pplication menu item in that menu to About HelloWorld. Figure 2.19 shows how the menu bar

should now look.

Figure 2.19. The completed menu bar.
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A little later in this chapter, you'll see which menu items Project Builder automatically implements for
you (such as the Quit item in the File menu). In Chapter 3, you'll reuse much of the Hello World code

as a base for adding and examining other features.
Editinga Window and Its Contents

Interface Builder makes window editing as easy as menu editing. Begin by clicking the main window
(the one titled Window), and then choose Show Info from the Tools menu. Doing that displays a
window like the one shown on the left side of Figure 2.20. For the HelloWorld program, I'll leave
these window attributes in their default settings, but feel free to take alook at the window features of
which you have control. Before closing the window, click the pop-up menu located at the very top of
the window. This menu lets you toggle between the display of different panes of window information.
On the right side of Figure 2.20, you see the Size pane being selected. If you'd like to change the
initial placement and the initial size of the program's window, go ahead and edit any or all of the four
text boxes of the Size pane.

Figure 2.20. The Attributes and Size panes of the Info window.



Aliributey X
L 1 Al bk i)
2 L4, = L4 I Commgl 4
Astribariea :1
+ Halp -
Canter® Neck
.-
Fithe: | Wik Tea/Left = “wadihiveight | Fel
Wirdow Ol | Dopimssal 3. - &4 | = 11
Therrs: Brunh | Dufault . Fjll h: 144
Caniok
"I_" Llzap Bax "!‘ Werlical Lzom

W Cotape B B Horizarmal Zoom

A1 bagred
W Epuicable ] Live Reaize
P Standard tadier
LI
! Updifae 'ﬂ LAY

Interface Builder provides an easy and powerful means of adding items such as push buttons,
checkboxes, and radio buttons to awindow. Click the second-from-left button in the row of five
buttons along the top of the pal ette window. Doing that results in a palette window that ooks like the
onein Figure 2.21.

Figure 2.21. Adding a static text item to a window.
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To add an item to a window, click the item in the palette window, drag it over to the window that the
item isto appear in, and drop the item in place. In Figure 2.21, | clicked "StaticText" in the palette and
now am about to drop that text into the window. After an item isin place, you can reposition it by
clicking the item and dragging it. If an item has text accompanying it (such as the label of a button),
edit that text by double-clicking the text and typing new text. I'm changing StaticText to Hello, World!
in Figure 2.22.

Figure 2.22. Editing a static text item in a window.
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With the window's text in place, you can save the main.nib file and return to Project Builder and the
HellowWorld project. Now it's time to take alook at the source code to see how it makes use of the
resourcesin the nib file.

Source Code and the main.c File

When a new Carbon nib-based project is created, Project Builder supplies the project with the
appropriate libraries, anib file (main.nib), and a source code file (main.c). Y ou've just seen the nib file
and how it serves as a nice, simple starting point for your project's resources. Now you'll take alook at
the source code file and see how it serves as a good starting point for your project's source code. Think
of this as a sort of Apple-supplied template that gives you a start on the code you'll be writing for your
own program.

Example 2.2 shows the code. I've stripped out the error-handling lines because the code runs fine
without them and because | want to emphasize how just afew lines of code can result in a program
that displays a menu and opens a fully-functional window.

Example 2.2 HelloWorld Sour ce Code

#i ncl ude <Car bon/ Car bon. h>

int main(int argc, char* argv[])

{

| BNi bRef ni bRef ;

W ndowRef Wi ndow,

OSSt at us err;

err = CreateN bReference( CFSTR("nmain"), &nibRef );

err = Set MenuBar FromNi b( ni bRef, CFSTR(" Mai nMenu") );

err = CreateW ndowFromNi b( ni bRef, CFSTR(" Mai nW ndow") ,
&w ndow ) ;

Di sposeNi bRef erence( ni bRef );



ShowwW ndow( wi ndow ) ;
RunAppl i cati onEvent Loop() ;

return err;

The Source Code and Carbon APl Managers

Example 2.2 has only one function- mai n. There are no application-defined routines (programmer-

written routines), so you know that all the function calls within the example are calls to Carbon
application program interfaces (API) functions. Recall from Chapter 1 that the Carbon API is
conceptually divided into managers and that managers are simply an organizational scheme that helps
programmers keep track of the thousands of routines that make up the Carbon API. In fact, an
application doesn't care about which manager aroutine "belongs" to. Instead, the managers exist to
make it easier for you to determine which routines are needed to accomplish your various
programming goals and to make it easier for you to find documentation concerning the Carbon API
functions you use.

All the routine names that include nib (Cr eat eNi bRef er ence, Set MenuBar FromiNi b,
Creat eW ndowFr omNi b, and Di sposeNi bRef er ence) are Nib Manager routines. The Nib
Manager is the collection of routines used to access nib files and to work with the resources within
such files. ShowwW ndowisaWindow Manager routine. Window Manager routines are used to-you
guessed it-work with windows. RunAppl i cat i onEvent Loop isaCarbon Event Manager
function. The Carbon Event Manager holds routines that enable an application to respond to user
actions.

Walking Through the Source Code

The HelloWorld example starts by including Carbon.h. Y ou'll want to have such an #i ncl ude
statement in every Project Builder project you create.

#i ncl ude <Car bon/ Car bon. h>

The preceding statement gives a project's code access to the entire Carbon framework. The Carbon
framework is aset of libraries and resources that together implement Carbon.



Experienced Mac Programmer

Y our previous Mac projects might have included a number of #i ncl ude statements for
universal header files such as Controls.h, Dialogs.h, Menus.h, and so forth. Including
<Car bon/ Car bon. h>inyour Mac OS X projects replaces aimost al those

#i ncl udes. Most programs won't need to include any other universal header files. One
exception (demonstrated in Chapter 10, "Bundles and Icons") is a program that uses
QuickTime. Car bon/ Car bon. h doesn't cover Movie Toolbox prototypes, so a separate
include of Qui ckTi nme. h isneeded.

After the #I ncl ude statement comes the main routine. This routine declares three variables. If
you've never programmed the Mac, the data types of these three variables are new to you. These types
aren't apart of ANSI C. Instead, they're types defined in the Carbon API.

| BNI bRef ni bRef :
W ndowRef w ndow,
OSSt at us err;

Thefirst declaration, ni bRef , isof typel BN bRef . To make use of the resourcesin anibfile, a
program needs first to open that file. Doing that supplies the program with anib file reference value

that the program can subsequently use to access the contents of the opened file. The | BNI bRef type
is defined as follows:

t ypedef struct Opaquel BN bRef * | BNi bRef ;

Note the Opaque inthe name of the Opaquel BNi bRef structure. Opague meansto be
impenetrable or obscure. How very cryptic! Here we are on only thefirst line of code in the main
routine and already we need to digress.

Digressing Into Opaque

The IBNibRef type is a structure. What that structure looks like can be known only by
finding the definition of the Opaquel BNibRef type-and that's something Apple
discourages. Apple reserves the right to change the makeup of Carbon API data structures,
so Apple wants to prevent programmers from attempting to directly access the fields of
these structures. By including Opaque in the data type name, Appleisissuing afair
warning that this data type is subject to change and that your code should not rely on the
organization of the fields of this data type. If your code directly accesses a Carbon data
structure field, that code is dependent on an unvarying field size and order of that structure.
Such code will most likely break should Apple alter the datatype definition at alater date.
With that said, you shouldn't in any way fear using an opaque data type. Apple will seeto
it that any changes to that type won't affect your code. For instance, if your code uses the
IBNibRef type, and Apple changes something about the Opaquel BNibRef type on which
IBNibRef is based, you wouldn't need to update your code that uses IBNibRef . It will
remain working as expected.




Experienced Mac Programmer

Y ou might be used to examining the universal interface header files to see the fields that
comprise a structure of an Apple datatype. For instance, the WindowRec data structure is
awindow record, and an examination of the WindowRec structure type tells the order and
size of window-related information (such as the window's size and position on the screen).
Y ou might have then accessed some of thisinformation by dereferencing the pointer. As
mentioned, you now need to be aware that for the most part, this kind of direct access of a
data structure isn't allowed! Instead, Apple supplies you with several new accessor routines
that give you access to the fields of opague data structures. By using these accessor
routines, your code is assured of working even in the event Apple changes the structures
with which these accessors work. The important accessor routines are covered where
applicable in this book. For instance, you'll read about window accessor routinesin the
windows chapter-Chapter 4, "Windows."

Thew ndowvariableis used to hold areference to awindow. After a program creates a window, it
will need to refer to that window often. For instance, if a program opens awindow and then at a later
time wants to close the window, the program needs some means of specifying the particular window
to close. A variable of typewi ndowRef servesasthiswindow reference. The W ndowRef typeis of
type W ndowt r, and the W ndowPt r typeisof type Opaque W ndowPt r . Yes, here's another
example of an opaque data type-a data type whose specifics are hidden from you:

t ypedef struct OpaqueW ndowPtr* W ndowPt r ;
t ypedef W ndowPtr W ndowRef ;

Theer r variableisused to hold the return value of afew of the program'’s calls to Carbon API
routines. The OSSt at us typeissimply a 32-bit integer that serves to hold an error value, or code.
The Carbon APl makes liberal use of the OSSt at us t ype- quite afew Carbon routines have a
return value of thistype. If a Carbon routine returns an OSSt at us value of 0, no error occurred in
the execution of the routine. If a nonzero value is returned, your application knows an error occurred
and can respond accordingly. For the sake of brevity, in thisfirst example program, the value of er r
isalwaysignored. This chapter's HelloWorldDebug and HelloWorldAlert programs provide a couple
of examples of handling such errors.

After the variable declarations come calls to six Carbon API routines. Here's aline-by-line look at
those calls and what they do.

err = CreateN bReference( CFSTR("main"), &nibRef );

Creat eNi bRef er ence searches an application’s package for the nib file named in the first
parameter and then opens that file. The call specifies that the file main.nib fileisthe nib file to find
and open. After opening thefile, Cr eat eNi bRef er ence assigns areference value to that file and
returns that value in its second parameter. When complete, Cr eat eNi bRef er ence returns an error



valueto let your program know if the operation was successfully performed. Here | chose to ignore
the error value. Later in this chapter, you'll see how to handle an error resulting from acall to a
Carbon routine.

Two points about the first parameter to Cr eat eNi bRef er ence bear further explanation. The first
point is the reasoning for embedding the nib filename in acall to C-STR. Many Carbon routines that
require astring as a parameter don't directly accept aliteral string. Instead, a routine might require a
referenceto a CFSt r 1 ng, which isan object that holds a string. Passing CFSTR aliteral string results
in the creation of such a string object and a reference to that object. The " String Services and CFString
Objects' section in this chapter provides more information about CFSTR and CESt r 1 ng objects.

The second point of interest regarding thefirst Cr eat eNi bRef er ence parameter is the concept
that Cr eat eNi bRef er ence searches the application package for anib file. Y ou might have been
under the impression that building an application means that all the code and resources that become
that application end up merged into a single standalone file. That's the appearance of what occurs, but
itisn't the redlity.

In Mac OS X, an application is actually a package consisting of afolder that holds files and other
folders. This situation is hidden from the user. A quick look at the desktop of your own Mac shows
you that a program appears as a single application icon. Double-clicking an application icon doesn't
reveal the fact that the icon actually represents a folder. Double-clicking doesn't open afolder; it
launches the application.

A packageisavery clever scheme that enables all sorts of interesting tricks that can be hidden from
the user. For instance, a package makes it possible to store multiple versions of a program (such as an
English version and a Japanese version) in what appears to be asingle application. A package aso
enables the easy transfer from one machine to another of the several files that make up an application.
The user simply copies what's thought to be a single application file and the job's done.

Examine this code:
err = Set MenuBar FromNi b( ni bRef, CFSTR(" Mai nMenu") );

Creating aresource in anib file defines the look of that resource. To have a program "bring to life"
that resource requires that the program make a function call. For instance, the main.nib filein this
Helloworld example holds a menu bar resource. Back in Figure 2.19, you see what this menu resource
looks like. In the main.nib window back in Figure 2.14, you see that the thumbnail image of this menu
resource has the name MainMenu. To set up a menu bar based on this menu resource, acall to

Set MenuBar FromiNi b ismade. Thefirst Set MenuBar Fr onNi b parameter is areference to the
open nib file that holds the menu bar resource. The preceding example call to

Set MenuBar Fr omiNi b usesthe reference returned by the Cr eat eNi bRef er ence cal. The
second Set MenuBar FroniNi b parameter is areference to astring object. This string object holds
the name of the menu bar resource to use for the menu bar.

Consider this code;

err = CreateW ndowkromNi b( ni bRef, CFSTR("Mai nW ndow'), &w ndow );



The act of creating awindow is similar to that of creating a menu bar. The

Creat eW ndowtr o\l b routine sets up a window based on awindow resource stored in anib file.
Thefirst Cr eat eW ndowr onNi b parameter is areference to the open nib file that holds the
window resource. The second parameter is a reference to the name of the window resource (as
specified in the nib file). The final parameter will befilled in by Cr eat e\W ndowfr oniNi b and
holds a reference to the window that Cr eat e\W ndowr oniNi b creates.

Examine the following code:
Di sposeN bRef erence( ni bRef );

Before making use of resourcesin anib file, the program needs to open that file. After a program has
accessed resourcesin anib file, it should close the resourcefile. A call to

Di sposeNi bRef er ence, with areference to the nib file to close as the only parameter, does the
job. If aprogram has references to nib resources, it can make use of those references even when the
nib fileisclosed. Thisis possible because the references will be to resource information copied to
memory (and now held in memory), not to the actual resourcesin the nib file.

Examine this code:
ShowwW ndow( wi ndow ) ;

A cal to Cr eat eW ndowkr oniNi b creates awindow and returns areference to that window, but it
doesn't display the window. This might seem odd, but the reasoning is simple.

Creat eW ndowkr omNi b doesn't want to make the assumption that your program will immediately
show the window, so it playsit "better safe than sorry” and leaves the window invisible. Showing a
hidden window is a simple matter of calling ShowW ndow. Pass awindow reference (a\W ndowRef
variable) and the invisible window becomes visible. In the previous paragraph, | mentioned that anib
resource reference can be used even after the nib file that holds the referenced resource has been
closed. Thiscall to ShowW ndow, which followsthe cal to Di sposeN bRef er ence, provides an
example of this.

Consider the following code:
RunAppl i cati onEvent Loop() ;

A Macintosh application is event-based; that is, it watches for an event (such as a user's click of the
mouse button), and then responds to that event. This watching-and-responding takes place repeatedly
until the application terminates, and this process occurs within aloop that runs for the entire duration
of application execution. RunAppl i cat i onEvent Loop isthe powerful Carbon routine that runs
such an event loop.

A cal toRunAppl i cat i onEvent Loop actually suspends the application’s execution until an
event occurs. At first blush, having your program'’s execution suspended might sound like a bad thing,
but it's not. If no events are reaching your program, your program has nothing to do. Thus, it should be
a"cooperative citizen" in the machine's Mac OS X world and relinquish control of the processor so



that other running applications can execute as efficiently as possible. After an event does occur (for
instance, if the user clicks one of your program's windows), your program resumes execution to
process (handle) the event.

Experienced Mac Programmer

RunAppl i cati onEvent Loop isnew to Carbon. It didn't exist in the preCarbon
Macintosh Toolbox API. In the past, you've used \\ai t Next Event withinaloop to
obtain events. Using RunAppl i cat i onEvent Loop ismore efficient and more
powerful than your using repeated callsto \\ai t Next Event because

RunAppl i cati onEvent Loop isbetter at giving up processor time and is able to
automatically handle several event types. Chapter 3 provides much more information on

event types, event handling, and using Run/Appl i cat i onEvent Loop.

RunAppl i cati onEvent Loop knows how to handle afew events on its own, including
the event that generates when the user selects Quit from the File menu. When the user
makes that menu selection, aquit event is generated, the application receives that event,
and the RunAppl 1 cat i onEvent Loop routine terminates. In general, your application
will call RunAppl i cati onEvent Loop and have the routine run until the application
quits. In other words, when RunAppl | cat i onEvent Loop ends, the application ends.

In the HelloWorld example, the line of code that followsthe call to RunAppl | cat i onEvent Loop
includesacall tor et ur n:

return( 0 );

Ther et ur n statement causes mai n to end, which means the application ends. The nai n routine has
areturntypeof i nt, so herel simply pass avaue of 0 to return to fulfill the rai n routine's
requirement of returning an integer.

Running the HelloWorld Program

To build and then run a program from within the Project Builder environment, choose Build and Run
from the Build menu. Project Builder compiles main.c and builds an application from the compiled
code, the main.nib resources, and the libraries that are a part of the project. Then the executable runs.
For HelloWorld, that means a window with the phrase Hello, World! appears, as shown in Figure

2.23.

Figure 2.23. Thewindow and menu resulting from running the HelloWorld program.
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If you look at the main.c source code example for HelloWorld, you see that there is no menu-handling
code. Y et the application responds to a click on a menu-the menu drops down to reveal theitemsin
that menu. Additionally, some of the menu items are functional. For instance, in the Helloworld

menu, the functioning items include Hide HelloWorld (the HelloWorld window disappears), Hide
Others (open windows from running applications other than HelloWorld disappear), Show All (open
windows from all running applications appear), and Quit HellowWorld (the application quits). Y ou have
the RunA pplicationEventL oop routine and the Carbon Event Manager to thank for the automatic
handling of these items.

When an event occurs (such as amenu item being selected), RunAppl i cat i onEvent Loop
(which you'll recall isrunning for the duration of a program's execution) checks whether an event
handler existsfor that particular event. Carbon event handling relies on event handlers. Each event
handler is aroutine that holds the code that handles one type of event. When an event occurs, the
Carbon Event Manager notifies RunAppl | cat i onEvent Loop, and the receiving application then
calls the appropriate event handler for that event. Some event handlers are prewritten for you, making
the handling of some events automatic (asis the case of a quit event resulting from a selection of the
Quit item from the HelloWorld menu).

Besides being able to automatically handle the Hide HellowWorld, Hide Others, Show All, and Quit
HelloWorld itemsin the HelloWorld menu, the HelloWorld application automatically handles the
Window menu Minimize item (it sends the Helloworld window to the dock) and the Arrange in Front
item (it moves the HelloWorld window to the upper-left corner of the screen). Again, the existing
event handler routines make this possible. All the itemsin the File, Edit, and Help menus, on the other
hand, aren't automatically functional. That makes sense because athough items in these menus might
have similar behavior from application-to-application (such as Copy in the Edit menu), they don't have
an absolutely standardized behavior (one application might need the capability to copy a nontext
selection, while another application might not).

Besides handling some menu items, HelloWorld automatically handles several window-related events.
Note that other than the call to Cr eat e\W ndowir onNi b, main.c does not include any window-
related code. Y et the application handles a user's dragging and resizing of the window. Additionally,
the application handles a mouse click on the window's Close, Minimize, and Zoom buttons.

The HelloWorld project's main routine consists of |ess than a dozen lines of code, but from those few
lines comes a program that interacts with the user in most of the ways the user has come to expect
from a Macintosh application. The Carbon Event Manager is the powerful system software that makes
this possible. Chapter 3 provides an in-depth examination of events.






Handling Program Errors

What happens when a user runs your program and then performs some action that your program
isn't adequately set up to handle? The correct answer isthis: The program informs the user of the
error and then resumes execution or, if continuing execution isn't possible, it exits gracefully. With
that said, you might expect this book to contain examples that are rich in error-handling code.
However, it does not. There are two primary reasons for this. First, anticipating and handling errors
are topics worthy of their own voluminous book. Second, if appropriate error-handling code were
included in each source code example, the gist of each example would be harder to surmise. For the
sake of brevity, most of this book's examples omit error handling.

Rather than fill each code snippet and example source code listing with error-handling code, I'll
present one study of error-handling here. The information and techniques covered here can be
applied to the code presented throughout this book. Read through this section's text and, if you're
seated by your Mac, follow along as | convert the HelloWorld project to the HelloWorldDebug
project.

Creating the Project

This section's example project is based on the HelloWorld project. Rather than altering the original
project (you might want to refer back to it later), make a copy of it. To do that, make a copy of the
entire HellowWorld folder. Go to the Finder, click the HelloWorld folder, and then choose Duplicate
from the File menu. Change the name of the copied folder from HelloWorld copy to
HelloWworldDebug. Open the HelloWorldDebug folder and change the name of the project file
itself from HelloWorld.pbproj to HelloWorldDebug.pbproj.

Open the HelloWorldDebug project. To avoid confusing this project with the original HelloWorld
project, you'll want to change the name of the executable that gets built from the project, aswell as
the name of the project itself.

To rename the executable, begin by clicking the Targets tab in the group of tabs that runs vertically
in the project window (see Figure 2.24). Click the target name listed in the Targetslist (that nameis

HelloWorld in this example). Now click the Build Settings tab in the group of tabs that runs
horizontally in the project window. Then type Hel | o\V\or | dDebug in the Product name text box,
as shown in Figure 2.24. Each time you build an application from this project, it will have this

name.

Figure 2.24. Specifying a new name for the executable that's built from the project.
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The target includes specifics about the executable that gets built from the project. For instance, in
Figure 2.24, you see that the executable name will be HelloWorldDebug and that the executable
will be placed in the Applications folder in the home directory (the drive on which Mac OS X is
installed). Project Builder lets you have more than one target in a single project. This multiple-
target option can come in handy. Y ou might want to generate different executables with, say,
different names, or that have slight (or even major) code differences.

Because more than one target can exist in asingle project, Project Builder supplies a name for each
target. That way, as you jump between targets, you know where you are at all times. The default
name for the one target Project Builder includes in anew project is the name of the project itself.
Asyou can seein Figure 2.24, the target name is HelloWorld because this project is a copy of the
HellowWorld project. The HelloWorldDebug project includes only one target, so its name isn't
critical, but | till want the name to be more in line with the application I'm building. To rename the
target, choose Rename from the Project menu. Project Builder highlights the target name in the
Targetslist and lets you type in anew name. Type Hel | oVr | dDebug to rename the target.

Now you'll want to add some error-handling code to the source code in main.c and then, after atest
run, alter the resources in main.nib. Let's begin with the source code.

Error-Handling Code

For any programming task, there are usually numerous solutions. Y ou'll find that to be true for the
task of adding error handling to a program. One simple method that works well isto make use of
the Apple-defined routiner equi r e _noer r. Thisroutine has two parameters:. the error value
returned by afunction call and alabel indicating where program execution should jump to in the
event an error has occurred:

require_noerr(error, |abel)

Withinr equi re noerr, theerror value is ssimply tested against the Apple-defined constant
noEr r . Thetest looks something like this:



if ( (error) !'= noErr )
goto | abel ;

Many Apple-defined functions return an OSSt at us valuethat indicatesif an error occurred
during the execution of the function. If the returned value is O (which matches the constant

nokr r), no error has occurred. If the returned value is any nonzero number, an error has occurred.
Creat eW ndowr omNi b, which was called in the HelloWorld project, is an example of a
routine that returns the status of the function's execution:

OSSt at us err:

err = Creat eW ndowrr omNi b( ni bRef, CFSTR("Mai nW ndow"), &w ndow) ;

To keep HelloWorld as simple as possible, | chose to ignore the error value returned by

Creat eW ndowrr onNi b. A wiser thing to do isto passthiserror valuetor equi re _noerr.
If requi re noerr determinesthat no error has taken place (the error value passed to it had a
valueof 0), r equi re_noerr simply returns and program execution resumes at the point at
whichrequi re noerr wascaled. Ifinsteadr equi r e _noer r determinesthat an error has
occurred (the error value passed to it had a value other than 0), r equi r e _noer r redirects
program execution to the location of the label value. This snippet shows a call to require_noerr:

OSSt at us err;

err = Creat eW ndowFr omNi b( ni bRef, CFSTR(" Mai nW ndow'), &w ndow) ;
require_noerr( err, CantCreateW ndow );

Il ...
/] other code here
[/

Cant Cr eat eW ndow.
return err;

In this snippet, you seethat if r equi r e _noer r encounters an error, all the code that would be in
place of theot her code her e comment would get skipped and instead execution would jump
tothereturn |ine.

Ther equi re _noerr routineissimpleto use. If you're going to use it, use it liberaly. If an
Apple-defined routine returns an error value, follow the function call with acall to

requi re noerr.Youcan have each cal jJump to adifferent label, or you can have al calls
jump to the same label. In the HelloWorldDebug example, | include asingle call to

requi re_noerr. Forasimple example that uses morethan onecall tor equi re_noerr,just
create a new Project Builder Carbon nib-based project and look at the main.c file included in that
project. Finaly, for alook at how to give the user some feedback on the error, the
HelloWorldErrorAlert project supplies you with that information.



Adding the Error-Handling Code

With the HelloWorldDebug project open, display the source code by clicking the main.c filein the
project window's filelist. Scroll down to the call to Cr eat eW ndowr onNi b. Immediately after
that line of code, add acall tor equi re_noer r. Theoneold line and one new line then should
look like this:

err = Creat eW ndowFr omNi b( ni bRef, CFSTR(" Mai nW ndow"), &w ndow) ;
require_noerr( err, CantCreateW ndow );

Now scroll down to the end of the nmai n routine and, just abovether et ur n line, add alabel
named Cant Cr eat eW ndow. Here's how the one new line and one old line should now look:

Cant Cr eat eW ndow:
return err;

To put these changes into context, take alook at Example 2.3. Thislisting shows all the source
code that makes up the HelloWorldDebug error-handling program.

Example 2.3 HelloWorldDebug Error-Handling Sour ce Code

#i ncl ude >Car bon/ Car bon. h>

int main(int argc, char* argv|[])
{

| BNi bRef ni bRef ;

W ndowRef wi ndow;

OSSt at us err;

err Creat eNi bRef erence( CFSTR("nmai n"), &ni bRef);

err Set MenuBar Fr omNi b( ni bRef, CFSTR(" Mai nMenu"));

err = Creat eW ndowFr omNi b( ni bRef, CFSTR("Mai nW ndow") ,
&w ndow) ;

require_noerr( err, CantCreateW ndow );

D sposeN bRef er ence( ni bRef);

ShowW ndow( W ndow) ;

RunAppl i cati onEvent Loop() ;

Cant Cr eat eW ndow.
return err;



Ther equi re_noerr routine determinesif an error has just occurred. It does this by examining
the value of the first argument. In this example, that first argument isthe variable er r , an error
value returned by the call to Cr eat eW ndowFr onNi b. If Cr eat eW ndowfr o\l b
encounters an error, it returns a code that specifies the type of error encountered. If

Creat eW ndowrr omNi b executes successfully, it returnsavalue of noEr r (the constant
defined to be 0).

If after examining the first argument r equi r e _noer r determinesthat no error occurred, the
routine returns without taking any action, and it's on to the next line of code (the call to

Di sposeN bRef erence getscalled). If requi re _noer r instead determines that an error has
occurred (the first argument a value other than the constant noEr ), the routine returns, but not to
the point from whichr equi re_noer r wascaled. Instead, program execution jumps to the
location of the label that's passed as the second argument tor equi r e _noer r. Inthis example,
that label isCant Cr eat eW ndow, so execution jumpstother et ur n statement at the end of the
mal n routine.

Using the Debugger to Check the Error-Handling Code

Now let'sseehow r equi re noerr worksin the example program. Here I'll make use of the
Project Builder debugger to verify that my error-handling code is doing what it should do. If it
works, | know that I'll be ableto add callstor equi re _noer r inother placesin my source code
listing.

Project Builder has a built-in debugger that's easy to use. Y ou simply determine where in your
source code listing you'd like execution to pause. Y ou then set a breakpoint at the point. Y ou'll
typically pause at aline of code so that you can examine the current value of one or more variables
to verify whether the execution of the code is proceeding as expected or whether program
execution hasin fact made it to a certain statement. The breakpoint that you set is a marker that
tells the debugger where to halt program execution.

In Project Builder, you set a breakpoint at aline of code by simply clicking to the left of the line. In
Figure 2.25, I've clicked to the | eft of the linethat calls Cr eat e\W ndowfr oniNi b. Thefigure

shows the result-a small, pointed bar appears by the designated line.

Figure 2.25. Setting a breakpoint in the HelloWorld project window.
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To start a debugging session, choose Build and Debug from the Build menu. After just a moment,
the executable will start running (the executable will first be rebuilt if you've made any changesto
the source code). After the breakpoint is reached (which only takes a moment), execution pauses.
When that happens, the breakpoint line is highlighted, and you gain control (through the debugger)
of the program'’s execution.

In this example, the breakpoint has been set at the call to Cr eat eW ndowkr onNi b, soit's at the
cal to Cr eat eW ndowr onNi b where execution pauses. To execute the current line of code,
choose Step Over from the Debug menu. That has the effect of executing the call to

Creat eW ndowrr omNi b. After that function finishes and returns, execution pauses at the next
line-thelinethat callsr equi r e _noer r . Again choose Step Over from the Debug menu. The call
torequire noerr executes. Ther equi re noerr routine checksthevalueof theer r
argument. If er r hasavalue equal to the constant noEr r (avalue of 0), it's assumed no error
occurred and program execution resumes at the next line of code. If you follow these steps, no error
occurs and program execution does indeed move to the line of code that calls the

Di sposeN bRef er ence function. Y ou can end the debugging session by choosing Stop
Debugging from the Debug menu.

Y our short debugging exercise has completed. We demonstrated that r equi re _noerr will let a
program carry on with its execution if no error occurs. However, the session didn't prove that
requi re noerr catchesand handlesan error, so it'stime for asimple test.

Make sure the HelloWorldDebug project is open and then double-click the main.nib file to open it
in Interface Builder. In the main.nib window, you see a picture of amenu and a picture of a
window. As shown back in Figure 2.14, the picture of the window has the name MainWindow
under it. Click the picture of the window, and then press the Delete key to remove the window.

Y ou've just removed the definition of this window resource from the nib file. Now save the main.
nib file and return to the HelloWorldDebug project in Project Builder.

Now you'll repeat the debugging session that you performed before the nib file changed. Look at
the source code in the main.c file and make sure the breakpoint is still set at the line of code that
includesthe call to Cr eat eW ndowrFr onNi b (see Figure 2.25). Start the debugging session by



again choosing Build and Debug from the Build menu. The executable starts running and the
breakpoint is soon reached. With the program now paused, choose Step Over from the Debug menu
to execute the call to Cr eat e W ndowrFr oniNi b. When that function executes and returns,
execution pauses at thecall tor equi re_noerr.

Choose Step Over from the Debug menu to causer equi re _noer r to execute. Recall that
requi re noerr checksthevalue of the err argument. If er r has any value other than O, it's
assumed an error has occurred and program execution should be sent to the label specified in the
secondr equi re_noerr argument (Cant Cr eat eW ndowin thisexample). As shown in the
Variablelist of Figure 2.26, er r hasavalue of -10962. According to the Carbon header file
IBCarbonRuntime.h, the value -10962 isa k| BCar bonRunt i meCant Fi ndObj ect error. That
makes good sense here because | removed the window resource from the nib file. This nonzero
value sends program execution to the Cant Cr eat e\W ndow label. Figure 2.26 shows the break
arrow now pointing to thefirst line of code following the label (ther et ur n statement). Y ou can
end the debugging session by choosing Stop Debugging from the Debug menu.

Figure 2.26. Using the debugger to step through the HelloWworld code.
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As expected, the error checking worked. We learned that there was no window resource for

Creat eW ndowrr omNi b to use, and program execution was diverted. Although skipping the
code that follows the bad call to Cr eat eW ndowrr onNi b isagood thing, not providing the
program user with a clue as to what happened isn't agood thing. The next section remedies that by
adding an informative alert to the program.



Adding an Alert to the HelloWorldDebug Program

The HelloWorldDebug application detects an error and then exits. For your own application, you'll want to
determineif the program needsto exit, or if the error can be handled in some less dramatic manner. In either case,
you'll want to provide a user with some feedback as to what's taking place. In this section, you see how to do that.

In this chapter, you've already learned alittle bit about menus and windows. In improving error-handling, you'll
learn how your application can display another interface element-an alert. Additionally, you'll see that an interface
element can be created and displayed without the use of resources.

Creating the Project

This section's example project is based on the HelloworldDebug project. Asyou did for the debug project, here
you'll create the new project by copying an existing project. To do that, make a copy of the entire
HelloWorldDebug folder. Give the copied folder the name HellowWorldErrorAlert. Now open this
HelloworldErrorAlert folder and change the name of the project file to HelloworldErrorAlert.pbproj.

Open the HelloWorldErrorAlert project and change the name of the executable to that which gets built from the
project. Y ou can give the executable any name, but to keep things organized, you'll want to give it a name that's the
same as, or similar to, the project name. Thus, telling the project to name the executable HelloWorldErrorAlert
makes sense. Recall that to do this you follow these steps:

1. Click the Targetstab.

2. Click the target name listed in the Targets list.

3. Click the Build Settings tab.

4. Type the new executable name in the Product name text box.

The project includes one target. It's currently named HelloworldDebug. To rename the target, choose Rename from
the Project menu. Project Builder highlights the target name in the Targets list and lets you type in a new name.
TypeHel | oVWor | dError Al ert to rename the target.

Alert Code

An aert isatype of window, which hints at the idea that an alert could be designed in Interface Builder and be
included in the main.nib file that's part of a project. Thisisindeed true. However, there's another way to create an
aert. You can let the Carbon API do the work for you. I'll tackle the task this way so that you gain more familiarity
with using the Carbon API and so that you see an aternate means of creating an interface element (code versus nib
resource).

The purpose of an alert isto inform the user of asituation. That's al it isintended to do. Thus, an alert is meant to
be very plain. Figure 2.27 shows the alert that the HelloWorldAlert application will display should it encounter an

error attempting to display the program's window.

Figure2.27. The alert displayed by the HelloWorldAlert program.
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Because an alert doesn't have a sophisticated layout (there are no controls, scroll bars, and so forth in it), it'sagood
candidate to be created in code. There's a second good reason to let the Carbon API create the alert. In this example,
I want to display an alert in the event that a nib-based window can't be opened. Such an error could occur if the nib
fileis corrupt or if the window resource in the nib file ismissing or corrupt. If such resource-related problems exist,
there might also be an issue with the display of the alert. If the application fails to display anib-based window, it
also might fail to display anib-based aert! That pitfall can be avoided through the use of a single Carbon API
routine: Cr eat eSt andar dAl ert.

Creating the Alert

The Cr eat eSt andar dAl er t routine does just what its name implies: it creates asimple alert that contains
standard aert elements. Those elements are some informative text and a button to dismiss the aert. This routine
uses standard formatting rules when doing this, so, for instance, the alert will be properly sized to accommodate the
itemsintheaert. Cr eat eSt andar dAl er t hasfive parameters:

CreateStandardAl ert( al ert Type, error, explanation, param outAlert );

Thefirst parameter, al ert Type, specifiesthe type of alert to create. Here you pass in one of four Apple-defined
constants: kAl ert St opAl ert, kAl ert Not eAl ert,kAl ert Cauti onAl ert,kAl ert Pl ai nAl ert.The
resulting alert will look similar regardless of which constant you use. The first three constants yield an alert that
includes the application icon on the far left of the alert (as shown in Figure 2.27), while the last constant omits the

icon.

Theer r or parameter iswhere you supply the text that makes up the main message. This message appearsin bold.
In Figure 2.27, the string is this:Window Couldn't Be Opened.

Theexpl anat i on parameter iswhere you supply additional text, which is the wording that supplies the user with
details about the problem stated inthe er r or parameter. In Figure 2.27, the text is this: The program can no longer
run. Click the OK button to quit. This secondary text is optional. If you don't want a second line of text in the alert,
pass avaue of NULL for the explanation parameter.

The fourth parameter, par amn isarecord that holds additional information about the design of the aert. Although
an alert is meant to be a simple interface el ement, it can be more involved than the one pictured in Figure 2.27. For
instance, an aert might have more than one button (such as an OK button and a Cancel button). By defauilt,

Creat eSt andar dAl ert designs an alert that has one button-an OK button. If you want a more sophisticated
alert, you'll create arecord of additional aert information and use it here as the value of param. This extra
information is optional, so if it's not needed in your alert, pass avalue of NULL here.

The last parameter isout Al ert . When Cr eat eSt andar dAl er t finishes, it will have created anew alert. The
out Al ert parameter isareferenceto thisalert, and it is your application's means of making use of the alert.

The following snippet includesthe call to Cr eat eSt andar dAl er t that resultsin the alert pictured in Figure
2.27.

Di al ogRef alert;

Creat eSt andar dAl ert (
kAl ert St opAl ert,



CFSTR("W ndow Coul dn't Be Opened"),

CFSTR(" The program can no longer run. Click the OK button to quit."),
NULL,

&al ert );

This snippet lists each argument on its own line so that you can easily match the \five example arguments to the five
parameter descriptions. The first argument, KAl ert St opAl er t, simply places the application'sicon in the alert
(avalueof kAl ert Pl ai nAl ert omitstheicon). The fourth argument, NUL L, omits the record of additional alert
information. The last argument, al er t , tells Cr eat eSt andar dAl er t to create an alert that can be later
referenced by using the Di al ogRef variableal ert .

Earlier in this chapter, you read a description of the W ndowRef datatype. A Di al ogRef isessentially the same.
A variable of thistypeisused to reference awindow. An alert is considered a dialog, but a dialog is nothing more
than atype of window. The second and third arguments are worthy of alittle more discussion.

String Services and CFString Objects

Text characters and strings (groupings of text characters) are important topicsin programming. An application
might need to display, format, manipulate, or search through text. An application's text might need to be converted
to another language. The Carbon API includes a number of routines devoted to string handling.

The Carbon API includes a number of routines categorized into what's called the Core Foundation. As the name
implies, Core Foundation is a set of routines that are useful for core, or common, programming tasks. In Core
Foundation, you won't find any functions that work with fancy interface elements or display multimedia effects.
Instead, you get just the basics. Core Foundation routines exist to make OS independence (to an extent), to support
data and code sharing among libraries, and to enable the internationalization of strings. The Core Foundation
routines that support string internationalization (the easy trandation of strings from one language to another) exist
within the String Services group of routines.

Sring Servicesisin part based on the CESt i ng datatype. A program can create a C=St i ng object to hold an
array of Unicode characters. Unicode is an international standard that defines a uniform means of representing text
characters. The Unicode standard exists to provide away to encode all the charactersin any written language (we're
talking 39,000 characters as of thiswriting, with the capability to represent tens of thousands more).

When a program creates a CFSt r i ng object, it can be either mutable or immutable. A mutable string is an object
that can be manipulated by other String Services routines. Manipulation of such a string can include converting that
string to a different programming format (such asa C or Pascal string), trandating that string to a different written
language, or appending another string to it. An immutable string is one that can't be altered. Such a string is usually
used as a constant that gets passed to some other Carbon API routine.

One simple means of creating an immutable string is to use the CFSTR macro. A macro is simply a shorthand
means of carrying out some programming task. In this case, the CFSTR macro calls a private Carbon API function
(one that Apple restricts programmers from using directly) to create an immutable CFSt r i ng object. Pass CFSTR
a constant string (text surrounded in double quotes) and CFSTR returnsa CFSt r i ng object. That's exactly what |
did in the second and third arguments of the call to Cr eat eSt andar dAl ert :

Cr eat eSt andar dAl ert (
kAl ert St opAl ert,
CFSTR("W ndow Coul dn't Be Opened"),
CFSTR(" The program can no longer run. Click the OK button to quit."),
NULL,
&al ert );



Using the CFSTR macro as part of the argument generates areferenceto a CFSt r i ng, and that reference is passed
to Cr eat eSt andar dAl er t . Using CESTR in this manner does the trick, but it doesn't allow for any future
reference of this particular string. If | wanted to make use of astring (such as\W ndow Coul dn' t Be Opened)
more than once, | could instead do something like this:

CFStri ngRef cant OQpenW ndowStr = CFSTR("W ndow Coul dn't Be Opened");

The preceding declaration creates a CFSt r i ng object and assigns that object avalue of W ndow Coul dn' t
Be Opened. | then could passcant OpenW ndowSt r asthe second argument to Cr eat eSt andar dAl ert :

Cr eat eSt andar dAl ert (
kAl ert St opAl ert,
cant CpenW ndowst r ,
CFSTR(" The program can no longer run. Click the OK button to quit."),
NULL,
&alert );

Make sure you understand how the CFSTR macro is used. Y ou'll see CFSTR used throughout this book, and
throughout A pple sample source code as well.

Displaying and Controlling the Alert

A cdl to Cr eat eSt andar dAl ert creates an alert, but it doesn't do anything with that alert. Y our program now
needs to display the alert and then go into aloop that awaits the user's dismissal of the alert. That's easily
accomplished with a call to just one more Carbon API routine- RunSt andar dAl ert . A call to

RunSt andar dAl er t makesthe previously hidden alert visible. It also runsamodal dialog loop that processes
alert-related events.

RunSt andar dAl ert posts (displays) the specified alert as modal. A modal dialog is one that isin one particular
mode. That mode is fixed; amodal dialog can't be moved, and its presence takes control of the application to which
it belongs. A dialog that can be moved, and that enables other operations to take place in an application, is referred

to asamodeless dialog (it has no single mode).

RunSt andar dAl ert processes events that occur in the specified alert. For a simple one-button alert like the one
shown in Figure 2.27, the only event that needs processing is a mouse button clicking the OK button. When the user
doesthat, RunSt andar dAl er t dismisses the aert and enables program execution to resume.

RunSt andar dAl ert hasthree parameters:

RunSt andardAl ert( inAlert, filterProc, outltenHt );

Thefirst parameter, | nAl er t, isaDiaogRef variable that references the alert created in aprior call to
Creat eSt andar dAl ert. Inshort, you're using the output of Cr eat eSt andar dAl ert astheinput to
RunSt andar dAl ert.

Thefi|terProc parameter isan event filter function, which is an application-defined routine (a function you
write) that handles events that don't apply to the aert. This parameter usually can be safely ignored.Y ou can do that
by passing avalue of NULL inits place.

When the user clicks abutton in the alert to dismissthe dert, RunSt andar dAl er t terminatesits modal dialog
loop and returns to the program an item index for the button the user clicked. For a simple one-button alert, this
valueisn't of importance, but for a multiple-button alert (such as one that has both a Cancel and OK button), it is of
value. Y our program will want to react in different ways depending on which button the user clicked.



The following code snippet includes acall to RunSt andar dAl er t . Thefirst argument is the DialogRef variable
that was returned by the recent example call to Cr eat eSt andar dAl er t . The value of NULL passed as the
second argument indicates that there are no events outside the modal dialog loop that are of concern. The final
value-the address of aDi al ogl t em ndex variable-will hold the item index for the button used to dismiss the
aert.

Di al ogl t e ndex outltenHt;

RunSt andardAl ert ( alert, NULL, &outltenHit );
Adding the Alert Code

Cdling Cr eat eSt andar dAl ert createsan alert. Calling RunSt andar dAl ert poststhat alert and retains
application control until the user dismissesthe alert. After RunSt andar dAl er t completes its execution, your
application should either handle the situation that brought about the alert, or it should quit (if thereis no way to
recover from the problem). Before looking at the new error-handling code, let's take another look at how the
previous example project, HelloWorldDebug, took care of awindowrelated error:

Cant Cr eat eW ndow:
return err;

HelloWorldDebug took the easy way out: ther equi re_noerr label Cant Cr eat eW ndowis placed at the end
of mai n sothat al the code after the call to Cr eat e\W ndowrr orNi b gets skipped, and execution resumes at the
ret ur n statement (thus ending the program). Such a simplistic solution might not always be possible.

One problem with the preceding code isthat the call to Di sposeNi bRef er ence gets skipped.

Di sposeN bRef er ence closesthe nib file that was previously opened by the call to

Creat eN bRef er ence. A safer exit would include another call to Di sposeNi bRef er ence, whichisacall
that doesn't get skipped. In addition, while we're on the subject of safety, it's best to exit the application by way of a
call to the Carbon API function Exi t ToShel | . Althoughther et ur n call doesthe job of bringing about a clean
exit, it's best to get used to the idea that error-handling code might not always end up being placed immediately
preceding ther et ur n statement in ei n.

Here's what the error-handling code looks like:

Cant Cr eat eW ndow.

Creat eSt andar dAl ert ( kAl ert St opAl ert,
CFSTR("W ndow Coul dn't Be Opened"),
CFSTR(" The program can no longer run. Click the OK button to quit."),
NULL, &alert );

RunSt andardAl ert( alert, NULL, &outltenHit );

Di sposeN bRef er ence( ni bRef) ;

Exi t ToShel | ();

return err;

The code that follows the Cant Cr eat eW ndow label gets executed if the application jump to the label. However,
it also gets executed when the application flow of control reaches the label naturally. That is, even if thereisno
window-related error, the code following the label eventually is reached. When the only code following the label
wasar et ur n statement, thisfact wasn't an issue. Now that the error-handling code has been expanded upon, this
becomes an issue. | don't want an alert posted (or calls madeto Di sposeNi bRef erence and Exi t ToShel |)
if thereisno error. To specify that the error-handling code execute only in the event of an error, | can test theer r
variable (which obtained its value from the call to Cr eat e\W ndowfr ormriNi b) against the constant noEr r and
execute the error-handling code only if an error did in fact occur:



Cant Cr eat eW ndow:
if ( err !'= noErr )

{
Creat eSt andardAl ert ( kAl ert St opAl ert,

CFSTR("W ndow Coul dn't Be Opened"),
CFSTR(" The program can no longer run. Cick the OK button to quit."),
NULL, &alert );

RunSt andardAl ert ( alert, NULL, &outltenmHt );

Di sposeN bRef erence( ni bRef) ;

Exi t ToShel | ();

}

return err;

Take alook at Example 2.4 to see how the error-handling code fits in with the rest of the application code. It shows
all thecodeinthe mai n. c filefrom the HellowWorldErrorAlert project.

Example 2.4 HelloWorldErrorAlert Error-Handling Source Code

#i ncl ude <Car bon/ Car bon. h>

int main(int argc, char* argv[])

{
| BNi bRef ni bRef ;
W ndowRef wi ndow;
OSSt at us err;
D al ogRef alert;
Di al ogl t em ndex outltenH t;
err = CreateN bReference( CFSTR("nmain"), &nibRef );
err = Set MenuBar FromNi b( ni bRef, CFSTR(" Mai nMenu") );
err = CreateW ndowFromNi b( ni bRef, CFSTR("Mai nW ndow'), &w ndow );
require_noerr( err, CantCreateWndow );
Di sposeN bRef erence( ni bRef );
ShowwW ndow( wi ndow) ;
RunAppl i cati onEvent Loop() ;
Cant Cr eat eW ndow:
if ( err !'= nokErr )
{
Creat eSt andar dAl ert ( kAl ert St opAl ert,
CFSTR("W ndow Coul dn't Be Opened"),
CFSTR("The program can no longer run. Cick the OK button to
quit."),

NULL, &alert );
RunSt andardAl ert( alert, NULL, &outltenHit );
Di sposeN bRef erence( ni bRef );
Exi t ToShel | ();
}

return err;



}
Running the HelloworldError Alert Program

If you created the HelloWorldErrorAlert project from the HelloWorldDebug project, building and running the
executable should result in the display of the alert pictured in Figure 2.27. That's because the HelloWorldDebug
project included amain.nib file that didn't have awindow resource. If, at some point, you edit the main.nib file and
add a window resource named MainWindow, you won't see the alert.

If the project's main.nib file is without a window resource, you can go ahead and add that object now. Again, build
and run the application to verify that the error-handling code now gets skipped. If you'd like to perform another
very simple test, change the second argument to Cr eat eW ndowrr onNi b. That function call looks like this:

err = Creat eW ndowrr omNi b( ni bRef, CFSTR("Mai nW ndow'), &w ndow );

If you change the string that's used to create the CFSt r i ng object, the call to Cr eat eW ndowr onNi b will fail.
It will fail because this string represents the name of awindow resource in the main.nib file. If the string doesn't
match the name of an existing window resource, awindow can't be created. To see the error-handling code execute
even when main.nib file includes a window resource, change the Cr eat eW ndowr onNi b call to look
something like this:

err = Creat eW ndowrromNi b( ni bRef, CFSTR("Testingl123"), &w ndow );



Adding a Pictureto the Helloworld Program

The HelloWorld project is about as simple a project as can be created, yet it's avaluable
learning tool. From examining and editing the code and resources in this project, you've
seen how to work with nib menu resources and window resources, add error-handling
capabilities to source code, work with the debugger, create string objects, and create and
control an aert without the use of resources.

HelloWorld has brought us pretty far, so we might as well make use of it one more time
before the end of the chapter. In this part of the chapter, you'll see how to add an imageto a
project's nib file and have that image displayed in awindow resource in the same nib file.
When you build and run an executable from the project, that program will open a window
and display the picture. Adding the picture to the window resource tells the program to
treat the picture as it would any other resource item in awindow: the program draws and
properly updates the picture without your adding any supporting source code.

Creating the Project

Y ou can start with any one of this chapter's projects, but you might want to select the
original HelloWorld project as your starting point. The other projectsin this chapter had
you remove the window resource, so if you start with one of those projects, you'll need to
re-add the window resource. If you want your name to match the ones used here, call this
latest effort HelloWorldPict.

By now you know the drill: copy an existing project folder, rename the folder and project
file, and then, from within the project, change the target name and executable name. Look
back at either of the previous two projects (HelloworldDebug or HelloWorldErrorAlert) if
you need help with these steps.

Creating a Picture Resource

Y ou can use any type of image as the source of a picture that gets displayed in awindow.
The image can start out as a scanned image, a piece of clipart, a downloaded graphicsfile,
or something you've drawn in a graphics program. Whatever type of image you start with is
unimportant, but you'll need to convert that image to a resource to make use of it.

Regardless of the source of your image, you'll want to select and copy theimage in
preparation for saving it as aresource. To find anice little image of the world (to match
this chapter's Hello,World! theme), | had to look no further than my Mac's desktop.
Opening a new Finder window resultsin the display of asmall globe (see Figure 2.28).To

get the image, | captured the screen using the Grab utility (located in the Utilities folder of



the Applications folder). The resulting .tif document was saved, closed, and then opened in
a graphics program where everything except the image of the world was cropped.

Figure 2.28. The Finder window displays an image of the world.
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After you have the desired image, you need to save it as aresource. Several Macintosh
graphics programs are capable of saving a document as a resource. One such Macintosh
program is GraphicConverter-the same one | used to open the screen dump .tif file and
crop the world image. GraphicConverter isavery popular shareware program available for
downloading from Lemke Software (http://www.lemkesoft.com). GraphicConverter itself
isalso an excellent example of aMac OS X program written using Carbon. Regardless of
the graphics program you use, you'll open a new document and paste the image to that
document. Minimize the document's size to eliminate surrounding white space (if you use
GraphicConverter make use of the Smart Trim item from the Edit menu).

Y our next step isto save that document as afile of type resource. Figure 2.29 shows the

Resource(* .RSRC) format being selected in GraphicConverter. Y our graphics program
might call this type resource or rsrc. Y ou can give the file any name, but make sure to end
the name with an extension of .rsrc. If you'd like your file's name to match the name used
in this example, call the file world.rsrc. Save thisfile to the HelloWorldPict folder. If you
inadvertently save it to adifferent location, make sure to return to the Finder and move the
file to the project folder.

Figure 2.29. Saving a GraphicConverter graphic document as a resour ce.
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If your graphics editor of choice doesn't support saving a document as aresource file, don't
despair. If you're familiar with Apple's ResEdit program, you can use that programming
tool in conjunction with your graphics editor of choice. Use your graphics program to first
select and copy the image you want saved as a resource. Then launch ResEdit and create a
new resource file, saving that file in your project's folder. Now, with the graphic image
copied to the Clipboard, choose Paste from the Edit menu of ResEdit. That pastes the
image to the new resource file and storesit there asa PICT resource. Save the resourcefile,
giving it aname of your choosing with a.rsrc extension. Now close thefile.

Adding the Picture Resourceto the Project

Now that you have aresource file that holds a picture, you need to include that file in the
project that will useit. If the HelloworldPict project isn't open, open it now. Choose Add
Files from the Project menu and select the image file. If faced with awindow that asks you
to tell Project Builder to which targets to add the file, click the Add button. The file's name
will appear in the Groups & Fileslist, as shown in Figure 2.30. In that figure, you see that
the world.rsrc file appears under the Resources folder. If your newly added file appears
elsewherein thelist, smply drag and drop it in the Resources folder.

Figure 2.30. The HelloWorldPict project with theworld.rsrc file added.

8806 i) HelloWorldPict pbproj —
[ = . - A
o] CrFm uapPFdd
& Graupd & Files M= o Oe
L L T B T PURRUn v Debud
B[ Sourced i ] 4 F || maing IJ h
¥ [ Redduries E £1include i
a B[] InfoPlist. strings <L arbansCarbaon. s D
a - maincnib
a [ woeld.rsrc 2 vk mainfint
¥ [0 External Frameworics and Libraries = arge, chae®
# [ Products £ argv[])
-
2 1 L
| IEHLbRat v
- " "
Build succeeded

The picture resource file is now a part of the project. Interestingly enough, the main.nib file
now knows about the contents of thisfile. To see that, double-click the main.nib namein



the project window to open the nib file in Interface Builder. In Interface Builder, click the
Images tab in the main.nib window.

Asshown in Figure 2.31, the world image that's stored in the world.rsrc file appears along
with afew other images. Three of the images (caut, note, and stop) are a part of every main.
nib file-they're images that are sometimes used in alerts. The other three images all come
from the world.rsrc file. When a graphics program saves a picture as aresource, it might
save theimage in afew different formats. Y ou'll want to use one of the PICT images.

Figure 2.31. Theimage of theworld appearsin the main.nib file.
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The image now isready to use in any window resource. Y ou can easily add it to the one
window resource currently in the main.nib file. Begin by clicking the window. If it's not
aready open, click the Instances tab in the main.nib window and then double-click the
MainWindow. Now click the middle of the five buttons that run across the top of the
palette. As shown in Figure 2.32, you will see a number of controls. Click the blue PICT
control and drag and drop it on the window. Y ou can resize the PICT by clicking its edge
and dragging. In Figure 2.32, you see that I've placed the PICT to the left of the Hello,
World! text and resized the PICT to become a small square.

Figure 2.32. Adding a pictureitem to awindow in the Helloworld nib file.
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The PICT item needs to be told what image it'sto display. There are a couple of ways you
can do this. One way isto click the PICT item that you've just created (the PICT you've
just placed in the window) and choose Show Info from the Tools menu. Make sure the
Attributes pane is displayed, and then enter the resource ID of theimage. In Figure 2.33,
I've entered an ID of 128, which matchesthe ID Interface Builder assigned to the world
image (refer back to Figure 2.31). A second, easier way to specify theimage to useisto
click the Instances tab in the main.nib window, click the image to use, and then drag and
drop it on the PICT item in the window.

Figure 2.33. Specifying the I D of theimage that'sto be displayed in the pictureitem.
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After entering aresource ID in the PICT item's Info window (or after directly dragging the
image to the PICT item), the PICT item takes on the look of the selected image, as shown
in Figure 2.34. If you'd like to change the size or location of the picture in the window, just
click it and drag it.

Figure 2.34. The picture displayed in the window in the nib file.



Window

Hello, World!

Running the HelloWor|dPict Program

To see theresults of your efforts, build and run an executable from within the
HelloWorldPict project. As mentioned, you don't need to alter any of the project's source
code. Aslong as the code includes a call to CreateWindowFromNib, the program will
know how to display all the resource itemsin the window it creates.



For More Information

For more information about Apple's Project Builder and Interface Builder tools, or to find
references to other major topics from this chapter, visit the following web sites:

Project Builder: http://devel oper.apple.com/tool s/projectbuilder/

Interface Builder: http://devel oper.apple.com/tool g/interfacebuilder/

Metrowerks CodeWarrior: http://www.metrowerks.com/desktop/

Resour ces. http://www.MacKiDo.com/Software/NewResources.html
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Chapter 3. Eventsand the Carbon Event M anager

MACINTOSH PROGRAMS ALWAYSHAVE BEEN EVENT-BASED. An eventisan
action of some kind, such as aclick of the mouse button or the press of a key.When it
occurs, the program responds. The Event Manager always has been the part of the
application program interface (API) that defined event-handling routines and the
component of the system software that worked with events. Now, with the new Carbon
API and the new Mac OS X system software, you have the new Carbon Event Manager.

If you've programmed the Mac before, you'll appreciate how the Carbon Event Manager
takes over and handles many of the event-related tasks for which your own code was
normally responsible. If you're new to Mac programming, you'll be pleased to know that
your mastery of thisimportant part of writing a Macintosh program will take alot lesstime
than it would have if you started programming the Mac just a little while ago!

In this chapter, you'll read about the important routines that make up the Carbon Event
Manager. You'll see how an event is defined, how you specify the eventsin which your
program isinterested, and how the Carbon Event Manager plays middle-man in passing
events to your application and in helping your application handle events. Thisisan
important chapter for any Mac OS X programmer. After you know the basics of event
handling, you're well on your way to creating powerful programs with functional menus
and operational controls.



Eventsand Event Handlers

The number of different types of events that can occur is vast. A mouse button click on a control, a mouse
button click on a menu, a window collapsing, expanding, zooming, or closing, a disc inserted into the
computer, and many, many other actions cause the generation of an event.

Y our program won't need to watch for, or respond to, every type of event. Instead, you'll define the event
types for which your program should watch. Y ou'll relay this information, along with information about an
application-defined routine that handles the event, to the Carbon Event Manager. The routine is one that you
write for the purpose of handling a particular event. It specifies what your program should do in response to
the occurrence of an event of interest. Such aroutine is called an event handler. After these steps are
completed, you don't have to write any additional event-handling code because now the responsibility of
watching for and handling particular events falls on the Carbon Event Manager.

Event Types

To distinguish one event from another, each Carbon event has an event class and an event kind associated
with it. The event class specifies the broad category, such as a mouse event, to which the event belongs. The
event kind further honesin on the particular nature of the event by specifying the kind of event, such asa
mouse-down event, within the class. Together, the event class and event kind are referred to as an event type.

A commonly occurring event is the mouse-down event. Such an event is generated in response to a user
clicking the mouse button. A click of the mouse button resultsin an event that has an event class of mouse
event and an event kind of mouse-down. That wording might be understandable to you, but of course, the
operating system needs that information in amore "code-like" manner. Apple defines awealth of event class
and event kind constants for this purpose. For a mouse click, the pertinent constants are as follows:

KEvent C assMouse = FOUR_CHAR _CODE(' nous');
KEvent MouseDown = 1;

Both the event class constant and the event kind constant are integers, although the event class constant is
specified by afour-character value that gets trandlated to a 32-bit integer (by way of the FOUR CHAR CODE
macro).

In all cases, you'll be pleased to know that you aren't responsible for knowing any of the actual four-character
or integer values. Y ou need only become familiar with some of the constants with which you'll be working.
The CarbonEvents.h header file lists them all, but you might want to read through this chapter before tackling
the hundreds of constants found there. In this chapter, you'll find explanations and examples that use the most
common event constants. Tables 3.1 and 3.2 introduce you to two important event classes: the mouse event
class (kEvent Cl assMbuse) and the window event class (kEvent Cl assW ndow). Thesetableslist a
few (but not all) of the event kinds in those two classes.

Table 3.1. The Mouse Event Class (kEventClassMouse) and Some of I1ts Event Kinds

Event Kind Cause of Event Kind



kEvent MouseDown Mouse Mouse button clicked

kEvent MouseUp Mouse button released
kEvent MouseMoved Mouse position changed
kEvent MouseDr agged Mouse dragged

Table 3.2. The Window Event Class (kEventClassWindow) and Some of Its Event Kinds

Event Kind Cause of Event Kind
kEvent W ndowAct i vat ed Window brought to front
kEvent W ndowDeact i vat ed Window sent behind
kEvent W ndowDr awCont ent Draw (update) window's contents
kEvent W ndowShown Window became visible
kEvent W ndowHi dden Window became invisible
kEvent W ndowCol | apsed Window collapsed (minimized to Dock)
kEvent W ndowExpanded Window expanded (enlarged from Dock)
kEvent W ndowZooned Window zoomed

When an event class and an event type are paired, the result specifies one and only one type of event. Such a
pairing is called an event type specifier. The Event TypeSpec isastructure that represents an event type
specifier:

struct Event TypeSpec
{

U nt 32 event C ass;
U nt 32 event Ki nd;

Each event type has an event class and an event kind. Some event types also have event parameters (also
called event attributes). The number, and purpose, of an event's parameters depends on the event typein
guestion. For instance, the already-discussed mouse-down event type, which has an event class of
kEvent Cl assMbuse and an event kind of kEvent MouseDown, has four parameters that hold further
information about the mouse-down event. Table 3.3 lists these event parameters and their purposes.

Table 3.3. The Mouse-Down Event Parameters

Parameter Represents
kEvent Par anmiVbuselocat i on Location of cursor at time of mouse click

kEvent Par anKeyModi fi ers Modifier keys pressed at time of mouse click



kEvent Par amivbuseBut t on Mouse button clicked (for the instance of a multiple-button mouse)

kEvent Par anCl i ckCount Number of mouse clicks (such as a double-click)

TheEvent TypeSpec keepstrack of just two pieces of information-the event class and event kind-to define
an event type. A different datatype, the Event Ref , keepstrack of this same information and event
parameter information. Asshown inthest r uct definition, the composition of an Event TypeSpec
structure is documented. The sameisn't true of the Event Ref datatype.

The Event Ref isan opaque type. Apple would prefer that a programmer not know its exact makeup. As
described in the source code walkthrough of the HelloWorld program in Chapter 2, "Overview of Mac OS X
Programming," making a data type opaque assures Apple that they can alter the internals of the datatype a a
future date without being concerned that programmers have written code that directly accesses fields of the
datatype.

When working with events, you'll declare avariable of type Event TypeSpec and then fill in the two fields
of that structure. You'll also make use of an Event Ref variable, but you'll often enable the system to fill in
that structure's fields. Examples of both of these situations appear in the description of event handlerslater in
this chapter.

Your first step in handling an event is defining the event type in which your program isinterested. To do this,
declare an event type specifier for the event type of interest. For the upcoming discussion of installing an
event handler, consider a program that's waiting for a click a button in awindow. The class of such an event is
considered a command, and the event kind is the processing of that command. For this situation, the event
type specifier might look like this:

Event TypeSpec event Type;

event Type. event Cl ass = kEvent C assConmand,
event Type. event Kind = kEvent ProcessComand,;

An alternate way of declaring the event specifier and assigning values to its fields would be to do the work at
the time of the declaration:

Event TypeSpec event Type = { kEvent C assCommand,
kEvent ProcessConmand };

Command events, as well as several other classes of events, are covered throughout this chapter. Asyou read
this chapter, and as you study its numerous example programs, you'll come to understand how to set up event
specifiers for the circumstances your program will encounter.

Installing an Event Handler

One of the primary jobs of the Carbon Event Manager system software is to watch for events. When this
system software encounters an event about which your program is to be notified, it passes that event on to
your program. In particular, it sends the event to aroutine that you've written specifically to handle this type
of event. Such aroutineis an event handler. You'll need to write this routine (that task is covered next), and
you'll need to install thisroutine.

To install the event handler means to provide the Carbon Event Manager system software with an association



between the event type specifier (the type of event to be handled) and the event handler (the application-
defined routine that should be executed at the occurrence of an event of the specified type). Pairing an event
type with an event handler routine and making the Carbon Event Manager aware of this pairing requires a call
to the Carbon APl routine | nst al | Event Handl er . Here's the prototype for that function:

CSSt atus I nstal | Event Handl er ( Event Tar get Ref tar get,
Event Handl er UPP handl er Pr oc,
Ul nt 32 numlypes,
const Event TypeSpec* typeli st,
voi d* user Dat a,
Event Handl er Ref * handl er Ref );

Thel nst al | Event Handl er parameter list might look alittle daunting, so I'll cover this routine in detail
here. After looking over this chapter's example programs, and after you've used this routine afew times
yourself, you'll see that the arguments you pass to the function are easy to discern.

A program specifies an event type to watch for, and it defines an event handler routine to handle an
occurrence of such an event. When the Carbon Event Manager encounters an event of the specified type and
invokes the appropriate event handler routine, it needs to know upon what object the handler should act. In
other words, you need to specify the target of the event. A target is awindow, menu, control, or even the
application itself. The target you specify should be the object "closest” to the event. For instance, if a program
iswatching for events that occur in awindow, the window can be considered the target. Simply telling the
Carbon Event Manager that a window is to be the target is not enough, though. Y ou need to tell the Carbon
Event Manager which window is the target. In addition, you need to supply thisinformation as an

Event Tar get Ref variable rather than as the window reference itself.

Thistarget information is sent to the Carbon Event Manager by way of thefirst | nst al | Event Handl er
parameter, which isthe target. Y ou can create an Event Tar get Ref value by passing the intended target to
the proper target routines: Get W ndowkEvent Tar get , Get MenuEvent Tar get ,

Get Control Event Tar get, or Get Appl | cat i onEvent Tar get . Each routine takes the one
argument passed to it and generatesan Event Tar get Ref from that argument. In the following code
snippet, the target of an event handler routine isto be awindow that's referenced by the \W ndowRef variable
window, and it's assumed that this window has already been created by acall to Cr eat eW ndowkr ormriNi b.
The following code would generate an Event Tar get Ref that then could be used as the first argument to

I nst al | Event Handl er:

W ndowRef wi ndow,
Event Tar get Ref target;

target = Get WndowEvent Target ( w ndow );

Thesecond | nst al | Event Hand| er parameter ishand! er Proc, an Event Hand! er UPP. The UPPin
Event Handl er UPP stands for universal procedure pointer. In short, any time you see UPP in avariable or
type name, you can expect that a pointer to aroutineisinvolved. If the Carbon Event Manager isto invoke
the event handler function, it needs to know where that function's code isin memory. The handl er Pr oc
variable holds a pointer to the event handler routine. Y ou can generate such a pointer by calling the
NewEvent Handl er UPP function. Simply pass the name of the event handler routine to

NewEvent Handl er UPP and the function returns a pointer to that function. Assuming that the as-yet
unwritten event handler routine will be called MyEvent Handl er, the call to NewEvent Handl er UPP
appears as shown in the following code. The resulting Event Handl er UPP then could be passed as the
second argument to | nst al | Event Handl er .



Event Handl er UPP handl er UPP;

handl er UPP = NewEvent Handl er UPP( MyEvent Handl er );

Thethird | nst al | Event Handl er parameter, whichisnunilypes, isthe number of event typesto which
this one event handler can respond. Although so far the focus has been on one event type and one event
handler routine, it is possible to have a single event handler that's capable of handling more than one type of
event. In Chapter 4,"Windows," you'll see a program that provides an example of such a situation.

The next parameter ist ypeli st -apointer to the event type or event types that this event handler routine
handles. As mentioned, an event handler can serve more than one event type. Here's where the Carbon Event
Manager getsthe Event TypeSpec for each event type. Thet ypeli st variableisapointer that points to
either one Event TypeSpec ortoanarray of Event TypeSpecs.

Theuser Dat a parameter is used to pass a pointer to any information that might be of use to the event
handler. The pointer is passed to the Carbon Event Manager, which in turn passes the pointer to the event
handler routine each timeit's called. One common use for this pointer isto use it to pass a pointer to the
window in which the event took place. For the handling of some event types, it might not make sense to pass
supplemental information, and in such a case, you can use avalue of NULL here.

Thelast | nst al | Event Hand! er parameter isa pointer to an event handler reference. Thisis avalue that
the Carbon Event Manager fillsin for use by your program. Y our program will need to use this value only if
your program will be dynamically changing the event types that make use of the event handler routine. Thisis
asituation you won't encounter often, so expect to simply pass avalue of NULL here.

Now let's gather things together and take alook at a snippet that defines one type of event and installs an
event handler that's to handle events of that type. The event type is used to watch for acommand (such asa
mouse click on abutton in awindow), and the event handler routine that will handle such an event is named
MyEvent Handl er . We develop and discuss this routine later in the chapter.

W ndowRef W ndow;

Event TypeSpec event Type;

Event Tar get Ref t arget;

Event Handl er UPP handl er UPP;

event Type. event C ass = kEvent O assComrand,;
event Type. event Ki nd kEvent ProcessConmand,;

target = Get WndowkEvent Target ( w ndow );
handl er UPP = NewEvent Handl er UPP( MyEvent Handl er );

I nstal | Event Handl er ( target,
handl er UPP ),
1,
&event Type,
(void *)w ndow,
NULL );

Writing an Event Handler



When the Carbon Event Manager encounters an event, it checks whether your program has installed an event
handler for that particular type of event. If it has, the Carbon Event Manager calls that routine. This callback
system (in which you install an event handler in the Carbon Event Manager, and the Carbon Event Manager
calls back that routine when appropriate) is a powerful feature of the new Carbon Event Manager. Y ou tell the
Carbon Event Manager which routine to call under what circumstances, and the Carbon Event Manager takes
over.

Event Handler Routine For mat

To make this system work, you need to write your program's event handler routine in away that makes it easy
for the Carbon Event Manager to invoke. That simply means that your event handler routine always has the
following prototype:

pascal OSStatus routineName( Event Handl er Cal | Ref next Handl er,
Event Ref t heEvent,
voi d* userData );

In the preceding prototype, r out | neNane isa placeholder of sorts. Your event handler can have any name
(I've been using My Event Hand| er in previous snippets).

The event handler has areturn type of OSSt at us . When the event handler function is finished executing, it
should return one of two values. noEr r if it has successfully handled the event or event Not Hand! edEr r
if for some reason the event couldn't be properly dealt with. This returned value makes it back to the Carbon
Event Manager and, if thevalueisevent Not aHandl edEr r, the Carbon Event Manager passes the event
to another event handler routine. This other routine might be one that your program defined, or it could be a
standard default event handler routine that the Carbon Event Manager has defined. Default handlers are
discussed later in this chapter.

It's possible to have your event handler routine pass an event by calling Cal | Next Event Handl er . It
would pass this routine the value submitted by the Carbon Event Manager inthe next Handl er parameter.
Keep in mind that while you will be writing the code for the event handler routine, it is the Carbon Event
Manager that always will be calling it.

TheEvent Ref parameter t heEvent isan event reference that describes the event that's to be handled.
Recall that an Event Ref includes the same event class and kind information asan Event TypeSpec, but
that it also includes extra parameter information about an event. The user Dat a parameter is a pointer to the
supplemental information that you included when installing the event handler.

The code in Example 3.1 shows the format of atypical event handler routine. I've emphasized the word
"format” because this example doesn't provide a complete source code listing for an event handler. Instead,
it'sintended to show the setup of such aroutine. Notice that there are three parameters to this

MyEvent Handl er function and that the data type of each parameter matches the type defined in the
prototype of the event handler routine. Regardless of the name you give your event handler, and regardless of
the type of event it'sto handle, you'll aways have these same three parameters. Carbon Event Manager will
be looking for them when it invokes this routine.

Example 3.1 Partial Listing of an Event Handler Routine

pascal OSStatus MyEvent Handl er ( Event Handl er Cal | Ref  handl er Ref,
Event Ref event,
void * user Dat a )



OSSt at us result = event Not Handl edErr ;

if [ based on the event paraneter this is an event to be handled.... ]
{

[ handl e the event |

result = noErr;

}

return result;

MyEvent Handl er startsby settingr esul t to a constant that obviously implies that the event handler
hasn't taken care of the passed-in event. A test then is made to verify whether the event can be handled. If the
event isthe one My Event Handl er was created to handle, the code in the body of thei f statement is
executed. Ther esul t variablethenissetto noEr r totell the Carbon Event Manager that the handler did
indeed handle the event. If the event isn't the one for which My Event Handl er isresponsible, thei f
statement is skipped and the event handler routine ends by returning the event Not Hand|l edEr r constant
back to the Carbon Event Manager so that the manager can attempt to handle the event.

When the Carbon Event Manager invokes iy Event Hand! er , it passes the routine three values. The event
handler routine should look at the event valueto determine if the event isone that it should handle. Recall
that the Carbon Event Manager invokes the event handler routine based on a match; the event type of the
event that it encountered must match the event type specified when the event handler was installed. Thus, if
the Carbon Event Manager invokes an event handler, how could the event handler not need to handle the
event? Theevent Cl ass and event Ki nd fieldsof the Event Ref variableevent will both match the
event class and event kind values of the event type specified during the installation of the event handler.
However, the Carbon Event Manager passesan Event Ref to the event handler routine, and an Event Ref
contains event parameter information in addition to the event class and event kind information that make up
the Event TypeSpec used in the event handler installation. Thisisimplied in the code for the
MyEventHandler. In addition, it isillustrated in Figure 3.1.

Figure 3.1. Installing and executing an event handler.
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Figure 3.1 shows an application installing an event handler in the Carbon Event Manager. When the Carbon
Event Manager becomes aware of an event, it compares that event type to the event type of the installed
handler. If there's amatch, an event reference is sent to the event handler routine in the application. There the
handler routine looks at the event parameter information to verify whether this event istruly onethat it is set
up to handle.

Getting an Event Parameter in the Event Handler Routine

Example 3.1 provides an overview of how an event handler routine iswritten, but it doesn't go into much
detail. In particular, it doesn't explain how the routine makes the final determination as to whether it can
handle the event that's been passed to it, and it doesn't provide an example of how the event handler routine
might actually handle an event. It'stimeto clear up the cryptic nature of Example 3.1.

When the Carbon Event Manager sends an event to an application’'s event handler routine, it includes the
event's parameter information. Recall that an event can have information other than its class and kind
associated with it. This extrainformation is held in the event's parameters, and thisinformation varies
depending on the type of the event.

A parameter always has an event parameter name and an event parameter type. In this chapter, I've
mentioned the mouse-down event, which is an event that has an event class of kEvent Cl assMbuse and an
event kind of kEvent MbuseDown. This particular event type has four event parameters. Table 3.4 shows

the name and type of each.

Table 3.4. The M ouse-Down Event Parameters

Name Type Information



kEvent Par amVbuselLocati on typeQDPoi nt Screen coordinates of mouse button click

kEvent Par amVbuseBut t on typeMouseButt on  Pressed mouse button
kEvent Par anKeyMbdi fi ers t ypeUl nt 32 Pressed modifier keys at time of click
kEvent Par anCl i ckCount t ypeUl nt 32 Number of clicks

To extract the parameter information from an event, make use of the Cet Event Par anet er routine. Here's
alook at the function's prototype:

OSSt at us Get Event Par anet er ( Event Ref i nEvent,
Event Par amNane I nName,
Event Par anType i nDesi redType,
Event Par anifype * out Act ual Type,
Ul nt 32 i nBuf ferSi ze,
U nt32 * out Actual Si ze,
void * out Dat a) ;

Wow! Y et another daunting function prototype! Fortunately, alook at the arguments, along with an example
call to the function, revealsthat using Get Event Par anet er isn't asdifficult as might be expected.

Thefirst argument, | nEvent , isthe event from which the parameter datais to be extracted. When
CGet Event Par anmet er iscaled from within an event handler, the Event Ref argument event that the
Carbon Event Manager passes can be used. Here's another look at the event handler declaration:

pascal OSStatus MyEvent Handl er ( Event Handl er Cal | Ref handl er Ref,
Event Ref event,
void * user Dat a )

From within My Event Handl er, acal to Get Event Par anet er would start out like this:
CGet Event Par aneter ( event,

The second and third arguments, | nNane and i nDesi r edType, are the name and type of the parameter
for which you're looking. If your event handler iscalling Get Event Par anet er , it'sdoing so to verify
whether the Carbon Event Manager passed in an event that has a particular parameter. Thisis done so that
you'll know the parameter name and type for which you're checking. Y ou can find the parameter constantsin
the CarbonEvents.h header file.

Consider this example: Y ou want your event handler to know the screen coordinates at the time the mouse
button was pressed. Y ou've previously set up your program so that it looks for a mouse-down event. You did
this by defining an Event TypeSpec variable that had an event type of kEvent Cl assMouse and an
event kind of kEvent MouseDown. You determined that those were the correct values either by reading this
chapter or by perusing the CarbonEvents.h header file. Next, you used thisEvent TypeSpec inacall to

I nstall Event Handl er . You now know that an event that comes into your event handler routine will be
amouse-down event. If an event wasn't of that type, your event handler wouldn't have been invoked by the
Carbon Event Manager. Now you want to further examine the event to find out the point that defines the
screen coordinates at which the mouse button was pressed. Browsing the CarbonEvents.h header file shows
you that the parameter of interest iskEvent Par aniVbuselocat | on:



Paraneters for nopuse events:
kEvent MouseDown

--> kEvent Par amVbuselLocat i on t ypeQDPoi nt
--> kEvent Par anKeyModi fi ers typeUl nt 32
--> kEvent Par amvbuseBut t on t ypeMouseButt on
--> kEvent Par anCl i ckCount typeUl nt 32

ThevalueskEvent Par aniVbuselLocat i onandt ypeQDPoi nt become the second and third arguments
to Get Event Par anet er.

Thefourth Get Event Par anet er argument, out Act ual Type, isfilled in by the Carbon Event Manager.
This type should match the type you specify in the third argument. It's unlikely that thisinformation will be of
value to your event handler, so you can pass avalue of NULL here.

The next argument isi nBuf f er Si ze, which isthe size of the buffer that is to hold the parameter value that
Cet Event Par amet er returns. Usesi zeof with the data type of the expected return value. The

out Act ual Si ze argument will befilled in with the actual size of the returned data. Pass a value of NUL L
hereif thisinformation isn't needed.

Thelast Get Event Par anet er isout Dat a. Thisisapointer to the memory that will receive the
parameter data.

An Event Handler to Handle a Command Event

The most common event you'll want any of your Macintosh programs to handle is probably the command
event. A command event is generated when a menu item is selected or when a control is chosen. Every
program has a menu bar, and almost any program includes at |east one button in awindow. Thus, if you
understand how a command event is handled, you're on your way to adding agreat deal of functionality to
your Macintosh application.

Asistypically the case when working with an interface element, you need to coordinate the work that goes
into your project's nib resource file and source code file. For instance, in creating a window, you define a
window nib resource, take note of its name (such as Vai n\W nd), and then make acall to

Creat eW ndowr onNi b using that resource's name. To handle acommand, you'll do similar work.

Associating a Command With a Resour ce

A control, such as a button, can have a command associated with it. A command consists of four characters,
and it should be unique for your resources. That is, if you have ten buttons in various window resourcesin
your main.nib resource file, you'll want to think of ten different commands so that you can give each a unique
four-character command. The characters you choose to use to compose a command aren't critical, aslong as
each command is unique. In Figure 3.2, | clicked the Do This button, selected Show Info from the Tools

menu, selected the Control pane in the Info window, and typed the characters this in the Command field.

Figure 3.2. Setting a button's command in I nterface Builder.
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To associate a command with the other button in the window, | follow the same steps, making sure, however,
to enter a different command. For instance, the command for the Do That button could be the four characters
of that. Note that I've intentionally used the vague-sounding button names Do This and Do That because the
emphasis here isn't on what particular actions | want the buttons to perform. That doesn't matter when
assigning a command to a control. What occurs when a button is clicked will be established in the source
code. Here, the point is simply to assign avalue to a control so that the program knows which control has

been selected.

When choosing a four-character command, avoid the several commands that Apple already has defined. If
you do use one of those commands, and then try to give the command some type of action in your code, your
program might not behave as expected. The commands to avoid (unless you're trying to implement the
command's behavior), are listed in CarbonEvents.h, and are repeated in the following code:

kHI ConmandOK

kH ConmandCancel

kHI CommandQui t

kHI CommandUndo

kHI CommandRedo

kH ConmandCut

kH CommandCopy

kH CommandPast e

kHI Commandd ear

kH ConmandSel ect Al |

kH CommandH de

kHI ConmmandPr ef er ences
kH CommandZoomA ndow

kH ConmandM ni m zeW ndow
kH CommandAr r angel nFr ont
kHI ConmandAbout

= FOUR_CHAR CODE("
FOUR_CHAR CODE("
FOUR_CHAR CODE("
FOUR_CHAR CODE("
FOUR_CHAR CODE("
FOUR_CHAR CODE("
FOUR_CHAR CODE("
FOUR_CHAR CODE("
FOUR_CHAR CODE("
FOUR_CHAR CODE("
FOUR_CHAR CODE("
FOUR_CHAR CODE("
FOUR_CHAR CODE("
FOUR_CHAR CODE("
FOUR_CHAR CODE("
FOUR_CHAR CODE("

ok '),
not!'),
quit'),
undo' ),
redo'),
cut '),
copy’ ),
past'),
clea'),
sall'),
hi de'),
pref'),
zoom ),
mni'),
frnt'),
abou' )

A menu resource al so enables a command to be associated with it. In fact, as you'll see when writing the event
handling code, your program will not need to distinguish between a control command and a menu command.
Y our program will view each as simply a command to be carried out, and it won't care about the source of the
command. To demonstrate that, Figure 3.3 illustrates that a menu item can be given the same command as a
button by selecting the menu item, choosing Show Info from the Tools menu, and typing the command in the
Command field. Note that in Figure 3.3, the This menu item now has the same command (t hi s) associated

with it as the This button in the window pictured in Figure 3.2.



Figure 3.3. Setting a menu's command in I nterface Builder.
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| said that each command should be unique, but here I've given two resources the same command. That means
that both resources will be bound to the same action. Whether the user clicks the Do This button or chooses
the This menu item, the event handler that handles the command event will respond in the same manner. Let's
move on to the source code now to see just how the event handler does in fact handle a command event.

Handling a Command Event

Back near the end of the "Event Types' section in this chapter, you saw the code for creating an
Event TypeSpec for acommand event:

Event TypeSpec event Type;
event Type. event Cl ass = kEvent O assConmand,
event Type. event Kind = kEvent ProcessComand,;

The "Installing an Event Handler" section illustrated how an event handler isinstalled:

W ndowRef wi ndow;
Event Tar get Ref target;
Event Handl er UPP handl er UPP;

target = Get WndowEvent Tar get ( Wi ndow ) ;
handl er UPP = Newkvent Handl er UPP( MyEvent Handl er );

I nstal | Event Handl er ( target,
handl er UPP ),
1,
&event Type,



(void *)w ndow,
NULL )

Now let's write the event handler routine. The My Event Handl er routinein Example 3.2 is an event
handler routine that handles a command event. It aso fillsin some of the missing code from Example 3.1.

Example 3.2 An Event Handler Routine

#define KkThisCommand 'this'
#define kThat Conrmand 'that'

pascal OSStatus MyEvent Handl er ( Event Handl er Cal | Ref  handl er Ref,

Event Ref event,
void * user Dat a )
{
OSSt at us result = event Not Handl edErr;
H Conmand conmmand;
Get Event Par anet er ( event,
kEvent Par anDi r ect Qbj ect,
t ypeH Conmand, NULL,
si zeof (H Command), NULL,
&conmand ) ;
swi tch ( command. commandl D )
{
case kThi sConmand:
My Thi sCommandHandl er ( (W ndowRef ) userData ) ;
result = noErr;
br eak;
case kThat Conmand:
MyThat CommandHand! er ( (W ndowRef ) userData ) ;
result = noErr;
br eak;
}
return result;
}

Example 3.2 starts with the definitions of two constants, each matching one of the two unique commands in

the resources. Y ou need to make your source code aware of each unique command that's associated with a
resource, and using a#def | ne for each is one way to do that.

In Example 3.2, you see how Get Event Par anet er isused to get the parameter held in the argument

event and storeit inthevariable conmand. MyEvent Handl er callsGet Event Par anet er to get
parameter data from an event with aclassof kEvent Cl assConmand and akind of

kEvent ProcessConmand. From the CarbonEvents.h header file, you see that an event with akind of
kEvent ProcessConmand hastwo parameters:

Par ameters for comrand events:

kEvent ConrmandPr ocess



kEvent Par anDi r ect Obj ect t ypeH Conmand
kEvent Par anKeyModi fi ers typeUl nt 32 (optional)

kEvent CommandUpdat eSt at us
kEvent Par anDi r ect Qbj ect t ypeH Conmand

ThekEvent Par anDi rect Obj ect parameter has atype of HI Conmrand. Looking again at the
CarbonEvents.h header file reveals the definition of this data type:

struct H Command {

Ul nt 32 attri butes;
Ul nt 32 conmmand| D;
struct {

MenuRef menuRef ;

Menul t em ndex nmenul t em ndex;
} nenu;

b

t ypedef struct H Command HI Conmand;

By now, you should be repeating this mantra often: " The CarbonEvents.h header fileis my friend. The
CarbonEvents.h header fileis my friend." It is this header file that holds a wealth of information about event
types; you should be searching and browsing through it early and often.

If Get Event Par anet er iscalled and the call specifies that the parameter of interest isthe

kEvent ParanDi rect Obj ect parameter, an H Conmand structure ends up being placed in the last
Get Event Par amet er argument. This happens because the parameter typeis HI Conmand. Take another
look at the call to Get Event Par anet er to verify that the second and third arguments specify the
parameter's name and type and that the last argument is of the data type that enables it to hold the parameter
that Cet Event Par anet er will place here:

CGet Event Par aneter ( event,
kEvent Par anDi r ect Cbj ect
t ypeH Conmand, NULL,
si zeof (H Command), NULL,
&conmand ) ;

Now the conmand variable holds an HI Conmrand structure. An event handler routine that's handling a
command needs this parameter data. In particular, the event handler will want to look at the conmand!| D
field of the HI Conmmand structure:

switch ( command. conmandl D )
{
case kThi sConmand:
My Thi sCommandHandl er () ;
result = noErr;
br eak;
case kThat Conmand:
My That ComnmandHandl er () ;
result = noErr;
br eak;



When the user clicks the Do This button or chooses the This menu item, an event occurs. Y our program
doesn't create this event; it's a system action. In creating the event, the system assigns it a class

(kEvent C assCommand) and akind (kEvent Pr ocess Comrand). It also supplies the valuesto the
parameters that are part of thisevent'skind (kEvent Par anDi r ect Cbj ect and

kEvent Par anKeyModi fi er s). The system places the command (in this example, the characters this) in
the command! Dfield of the H Conmand structure that isthe kEvent Par anDi rect Cbj ect parameter.
The system then sends the event to the Carbon Event Manager (see the bottom of Figure 3.1). The Carbon
Event Manager compares this event to any event handlers your program has installed. If there's a class and
kind match, the Carbon Event Manager invokes the corresponding event handler in your program, passing
along the event as it does so (see theright side of Figure 3.1).

This event handler's main task is to get the command from the event. The call to Get Event Par anet er
extracts the Hl Conmand structure, enabling the cormmand| D field of that structure to be examined in a

swi t ch statement. Herein lies the power of the event handler. A single event handler can handle any number
of commands. This example handles two commands (k Thi s Conmrand and k That Commrand), so there are
two case labelsin the body of the swi t ch statement. If | modify the nib resource file to give commandsto
other controls and other menu items, | don't need to write any new event handler routines. Instead, | define
more constants and add more case labelstotheswi t ch statement inthe My Event Handl er routine.

Under each case label isacall to an application-defined routine that includes the code to handle one
command. Y ou could place the command-handling code right here under the case label, but moving that
code to its own routine and placing a call to that routine in the case section makes things easy on the eye. We
certainly do want tidy code, right?

There's no naming or calling convention that a command-handling routine needs to follow. In Example 3.2, |

call theroutines My Thi sConmandHand| er and My That ConmandHand! er , and neither gets passed any
values. Here'salook at My Thi s CommandHandl er :

pascal void MyThi sCommandHandl er ( void )
{

}

/'l perform'this' action here

Not too interesting, | agree, but in this discussion, the action that the command performsisn't important.
Instead, how program execution gets to the point where the command is handled is what matters. What a
command-handling routine does is application-specific. The body of the routine looks different for every
command and every program. If, for the sake of thoroughness, you must see a complete, fully operational
command-handling routine, check out this new version of My Thi s ConmandHandl er :

pascal void MyThi sCommandHandl er ( void )
{

}

SysBeep( 1 );

SysBeep isaCarbon API routine that simply plays the aert sound on the Mac. Y ou'll have a chance to see
SysBeep inaction in this chapter's first complete example program: BeepWorld.

My oh-so-simple command-handling routine doesn't have any reason to work with the window that holds the



Do This button, but if it did, it would be an easy task to get that information to the routine. Recall that the
second-to-last | nst al | Event Hand| er argument isapointer to user Dat a. Thisuser Dat a variable
can hold any supplemental data that you want your event handler routine to receive each time the Carbon
Event Manager invokesit. Earlier in this section, the event handler was installed and when that installation
took place, the window that serves as the target also was used asthe user Dat a variable. The following
snippet illustrates this. The fifth argument to | nst al | Event Handl er isthe pointer to theuser Dat a
parameter, and here you see that a pointer to the W ndowRef variable wi ndowis used:

W ndowRef w ndow;

target = CGet WndowEvent Tar get ( w ndow ) ;
handl er UPP = NewEvent Handl er UPP( MyEvent Handl er );

I nstal | Event Handl er ( target,
handl er UPP ),
1,
&event Type,
(void *)w ndow,
NULL );

Now take alook at the My Event Hand! er routing's parameters. The third parameter holds the pointer to the
window:

pascal OSStatus MyEvent Handl er ( Event Handl er Cal | Ref  handl er Ref,
Event Ref event,
void * user Data )

MyEvent Handl er now almost has access to the target window. | say "almost" because user Dat a is
simply a generic pointer. By theway | invoked | nst al | Event Handl er, | know that this pointer points to
memory that holds a window reference, so casting the pointer to that type provides the sought-after window
reference:

W ndowRef w ndow;

wi ndow = ( W ndowRef )userDat a;
After that, the window could be passed to a command handler, if necessary:

case kThi sConmand:
My Thi sCommandHand! er ( wi ndow ) ;
result = noErr;
br eak;

On the receiving end, Vy Thi s ConmandHand!| er would accept the passed window in the following
manner:

pascal void MyThi sCommandHandl er ( W ndowRef w ndow )

{
/1l use the w ndow reference variabl e wi ndow here as you
/'l woul d anywhere el se in your program as in:
/1 ShowW ndow( wi ndow )






Example Programs

Collectively, events, event handlers, and the Carbon Event Manager provide you with the means to accomplish
an amazing number of programming tasks. When you know how to work with events, you're well on your way
to knowing how to program the Mac. Thefirst part of this chapter gave you a sound understanding of how to use
events. The best way to continue to learn about eventsisto start writing programs that use them. In this section,
you'll find a number of short, simple example programs. Each offers a different event-handling technique.

By now, you're well versed in the steps to creating a project, so none of this chapter's examples will go into the
details of creating a new project or copying an existing one. Instead, if an example is based on a previously
created project, I'll just mention that fact so that you can use the already-created project as your starting point. If
you do need tips on projects, refer back to the example programs in Chapter 2.

BeepWorld: mplementing a Button
The purpose of BeepWorld is to demonstrate command event handling for a single button in a window.

This chapter's"An Event Handler to Handle a Command Event" section spelled out the details of how a program
can handle an event that arises from the click of a button or the choosing of a menu item. The BeepWorld
program displays awindow with one button. Clicking the button initiates a command event, and the program
handles it by beeping the speakers of the user's computer.

The BeepWorld program modifies the last chapter's HellowWorld program to provide an example of command
handling. Y ou can make a copy of the Chapter 2 HelloWorld project to serve as the starting point of the

BeepWorld project.
Creating the Button and Command in the Nib File

Supplying the program's window with a button is taken care of by editing the window resource. Start by opening
the main.nib resource file. If you created the BeepWorld project from the HelloWorld project, the window
resource will already include a static text item displaying Hello,World! asits text. Add a button to the existing
window, change its name to Beep, and give it acommand of beep. Y ou can use these steps to accomplish the
tasks:

1. Add the button by clicking the Button item in the palette window, and then dragging and dropping the
item onto the window.

2. Change the button's title from Button to Beep by double-clicking the button and typing the new title.

3. Click the button item in the window to make it active, and then choose Show Info from the Tools menu
to display the Button Info window.

4. Make the button the default button by selecting the Attributes pane in the Button Info window's pop-up
menu, and then clicking the Default option button under the Button Type heading.

5. Give the button the command of beep by selecting the Control pane in the Button Info window's pop-up
menu, and then typing beep in the Command field.



Figure 3.4 shows the results of following the preceding list of steps. It isn't critical to make the Beep button the

default button, but because this is the book's first example program that uses a button, it's as good a time as any
to see how thisis done! Making the button the default button gives it an undulating appearance and enables a
press of the Return key to be the same as clicking the button.

Figure 3.4. Giving the Beep button a command.
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Now save the main.nib file and return to the Project Builder project window.
Writing the Source Code

The code for the BeepWorld program doesn't need much explanation. This chapter's "Handling a Command
Event" section includes detailed descriptions of al the programming concepts presented here. BeepWorld sums
all the command event information from earlier in this chapter; Example 3.3 provides the complete listing for

this program.
Example 3.3 Sour ce Code for the BeepWorld Program

#i ncl ude <Car bon/ Car bon. h>

#def i ne kBeepComrand ' beep'

pascal OSSt atus CommandEvent Handl er ( Event Handl er Cal | Ref handl er Ref ,
Event Ref event, void *userData );
pascal void BeepConmmandHandl er ( void );

int main( int argc, char* argv[] )
{

| BNi bRef ni bRef ;

W ndowRef w ndow;

OSSt at us err;



Event Tar get Ref target;
Event Handl er UPP  handl| er UPP;
Event TypeSpec cndEvent;

kEvent Cl assConmmand;
kEvent Pr ocessConmand;

cmdEvent . event C ass
cnmdEvent . event Ki nd

err = CreateN bReference( CFSTR("main"), &nibRef );
err = Set MenuBar FromNi b( ni bRef, CFSTR(" Mai nMenu™) );
err = CreateW ndowrFromNi b( ni bRef, CFSTR("Mai nW ndow'), &w ndow );

Di sposeN bRef erence( ni bRef );

target = Get WndowEvent Target ( w ndow );
handl er UPP = NewEvent Handl er UPP( ConmandEvent Handl er );

I nstal | Event Handl er ( target, handl erUPP, 1, &cndEvent,
(void *)w ndow, NULL );

ShowwW ndow( wi ndow );
RunAppl i cati onEvent Loop();

return( 0 );

pascal OSStatus CommandEvent Handl er ( Event Handl er Cal | Ref handl er Ref,
Event Ref event, void *userDat a)

{
OSSt at us result = event Not Handl edErr;

HI Command comand;

Cet Event Par aneter ( event, kEvent ParanDirect Qbj ect, typeH Comrmand,
NULL, sizeof (H Command), NULL, &command);

swi tch ( conmand. commandl D )
{
case kBeepCommand:
BeepConmandHandl er () ;
result = noErr;
br eak;

}

return result;

pascal voi d BeepCommandHandl er ( void )

{
SysBeep( 1 );



}

Running the Program

Build and run BeepWorld and you'll see awindow that displays the Hello,World! string and the Beep button.
Click the button to hear the beep sound. If you made the Beep button the default button, you can press the Return
key in place of clicking the mouse on the button.

BeepWorld 2.0: Implementing a Menu Item

The purpose of BeegpWorld 2.0 isto demonstrate command event handling for a single button and for a menu
item, with both providing the same action.

We're running alittle low in liquid assets, so it'stime to do what any good software firm would do in such
circumstances-put out an upgrade of BeepWorld and get some much-needed revenue from our installed base of
users! Clicking the Beep button to generate a simple noise works great, but customers are demanding an
alternate means of hearing that sound. Our revision of BeepWorld provides that feature by implementing the
Beep menu item in the Sound menu.

The work involved in changing the original BeepWorld program to BeepWor | d 2. 0 isso minimal that you
might not want to bother creating a new project. Instead, use the original BeepWorld project and make just one
small change to its main.nib resource file. Y ou won't have to edit or add to the main.c source codefile.

If you created the BeepWorld project from the Chapter 2 HelloWorld project, the main.nib file already has a
Sound menu in its menu bar, and that menu has a Beep menu item in it. If your project is lacking that menu, refer
back to Figures 2.15 through 2.18 in Chapter 2 to see the stepsinvolved in adding a new menu to a menu bar
resource.

To get the Begp menu item to do something, you need to assign a command to it, just as you assigned a
command to the Beep button in the original BeepWorld program. If you assign the menu item the command
beep, choosing thisitem has the exact same effect as clicking the Beep button. An event will be generated, and
the beep command will end up in the conmand! Dfield of the HI Conmand structure of the

kEvent ParanDi rect Cbj ect parameter of that event. Go ahead and give the Beep menu item a command
of beep. For help in doing that, refer back to Figure 3.3.

Because the BeepWorld source code already is set up to handle abeep command (the event handler
ConmmandEvent Handl er handles that command regardless of what action createsit), you don't have to make
any changes to the BeepWorld source code to get the Beep menu item to work. Thisisthe power of the Carbon
Event Manager way of doing things. After your code iswritten to handle one command, it's simple to add the
handling of other commands.

Build and run the program. Click the Beep button to verify that it still works. Then choose the Begp menu item
from the Sound menu to witness that it acts in the same manner as clicking the Beep button.

BeepWorld 3.0: Implementing Buttonsand Menu Items

The purpose of BeepWor | d 3. 0 isto demonstrate command event handling for a single button and for a
menu item, with each providing a different result.

InBeepWor | d 2. 0, clicking the Beep button and choosing the Beep menu item had the same effect-asingle
playing of the system alert sound. That demonstrated that to the system,"a command is acommand." That is, the



system doesn't care about the source of the command; it ssmply viewsit as asignal that some action needsto
take place. Although your own program might have a menu item and a button that perform the same action, it's
more likely that you'll have buttons and menu items that al perform individual, unique acts. In BeepWbr | d

3. 0, that's the case.

For demonstration purposes, the action that takes place in response to a click of a button or a selection from a
menu is unimportant, as long as the actions are different. Because you're now familiar with the SysBeep
function, I'll again use acall to that routine here. If the user clicks the Beep button, the system sound plays once.
If the user instead chooses the Beegp menu item, the system sound will be heard twice.

Start with either the original BeepWorld or the BeepWor | d 2. 0 project and open the main.nib resourcefile.
To get the Beep menu item to do something other than the Beep button, you need to assign a unique command to
it. This command must differ from the command assigned to the button. The button has a command of beep.
Give the Beegp menu item a command of bep2. If you're working from the BeepWor d 2. 0 project, that menu
item already has acommand of beep. Simply edit the command in the menu item's Info window. Figure 3.3

illustrated how to give a menu item a command.

To give the menu item functionality, you need to edit the source code. As it stands now, the source code knows
how to handleabeep command, but the bep2 command holds no meaning to it. Open the main.c file and add a
new constant beneath the existing kBeepCommand constant:

#def i ne kBeepComrand ' beep'
#def i ne kBeep2Conmand ' bep2'

The event handler calls the application-defined routine BeepConmandHand! er to perform the action
associated with the beep command. Y ou'll write another routine to perform the action associated with the new
bep2 command. Add a prototype for the function to help the compiler know the format of this routine. Again, the
name of this routine can be any name of your choosing.

pascal void BeepCommandHandl er ( void );
pascal void Beep2CommandHandl er ( void );

Theoriginal CormandEvent Handl er routine uses Get Event Par anet er to determine what command
occurred. It then usesaswi t ch statement to call the correct routine to handle that command. The origina
BeepWorld program watched for one command only, so there'sonly one case label intheswi t ch statement:

pascal OSStatus ComrandEvent Handl er ( Event Handl er Cal | Ref handl er Ref,
Event Ref event, void *userDat a)

{

OSSt at us result = event Not Handl edErr;
HI Conmand conmmand;

Get Event Paraneter ( event, kEvent ParanDirect Obj ect, typeH Conmand, NULL,
si zeof (H Conmmand), NULL, &conmand);
switch ( command. commandl D )

{
case kBeepConmand:
BeepCommandHandl er () ;
result = noErr;
br eak:
}

return result;



}

For each new command your program is to watch for, you need anew case label in the event handler routine.
Add a section that handlesabep2 command. This section responds to that command (using the
kBeep2Conmmand constant) by calling the new routine Beep2ConmandHand! er . Here'show theswi t ch
statement |ooks now:

switch ( command. comrand| D )
{
case kBeepCommand:
BeepComrandHandl er () ;
result = noErr;
br eak;

case kBeep2Command:
Beep2ComandHandl er () ;
result = noErr;
br eak:

}

Now you need to write the new command handler routine. Recall that the command handler routine for the beep
command looks like this:

pascal voi d BeepComrandHandl er ( void )

{
}

SysBeep( 1 );

To keep things simple, write the new command handler by copying the origina routine and then adding a second
cal to SysBeep:

pascal void Beep2ConmmandHandl er ( void )
{

SysBeep( 1 );

SysBeep( 1 );
}

That'sit. The project now is set up to create a program that responds depending on whether the Beep button or
the Begp menu item is selected. Build and run the program. Click the button to hear a single beep, and then
choose the menu item to hear two beeps.

Now that the project is set up to handle both a button click and a menu selection, it's easy to change the
functionality of either interface element. To change what happens when the button is clicked, edit the
BeepConmandHand! er function. To change the effect of choosing the menu item, edit the
Beep2ConmandHand| er function. If you don't have a Mac programming background, easily achieving some
noticeable action might not be possible. Sy s Beep might be the only routine you know about! If that's the case,
move on to BeepWor | d 4. 0 to see how to give a program the capability to draw to awindow in response to a
menu item selection.

BeepWorld 4.0: Drawing to a Window

The purpose of BeepWor | d 4. 0 isto demonstrate how to draw some text to awindow in response to a menu



item selection. A command event can be interpreted by a program in whatever way a programmer wants. If a
selection of amenu item isto initiate the drawing of words or graphics to awindow, the programmer sets up the
program to do so. BeepWr | d 4. 0 demonstrates how to do this.

When a user of BeepWor | d 4. 0 chooses the Beep menu item, the system sound plays twice, and Beep! is
drawn twice to the window as well. Figure 3.5 shows what the BeepWor | d 4. 0 window looks like. Here the

command isissued from a menu selection, but it just as easily could have come from a click on a button.

Figure 3.5. The BeepWorld 4.0 window with text drawn in it.
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Start with the BeepWor | d 3. 0 project. The main.nib resource file remains the same, so you need not open
that file. Instead, open main.c to edit the source code. To enable the Beep2ConmandHand! er to draw to the
program's window, you need to make the routine aware of that window. If you don't, the drawing could (and
very likely would) take place directly on the screen. Passing areference to the program's window is how you'll
let Beep2ConmmandHand!| er know where to draw. Start the code changes by modifying the
Beep2ConmandHand! er prototype. It looked like this before:

pascal void Beep2CommandHandl er ( void );

Now let the compiler know that this routine will be receiving an argument. In particular, it will receive an
argument of the type W ndowRef :

pascal void Beep2ComandHandl er ( W ndowRef w ndow ) ;

The ConmandEvent Handl er routine invokes Beep2ConmandHand| er . ConmandEvent Handl er gets
the reference to the affected window directly from the Carbon Event Manager. Recall that when the event
handler routine was installed, some user data accompanied thecall to | nst al | Event Handl er . Thiscould be
any data, but | chose to pass a pointer to the program's window. It's the second-from-last argument in the call to

I nstal | Event Handl er:

I nstal | Event Handl er ( target, handlerUPP, 1, &cndEvent,
(void *)w ndow, NULL );

When the Carbon Event Manager invokes CommandEvent Handl er inresponse to acommand event, it
passes the routine three arguments. The last argument is the pointer to the data that was installed:

pascal OSStatus CommandEvent Handl er ( Event Handl er Cal | Ref handl er Ref,
Event Ref event, void *userData)

Hereuser Dat a isageneric pointer, so it hasto be typecast to the more specific reference to a window:

W ndowRef wi ndow,

wi ndow = ( W ndowRef )user Dat a;



Now the variable w ndowcan beused asa\W ndowRef argument in the call to Beep2ConmandHandl| er :
Beep2ComuandHandl er ( wi ndow ) ;
Here's the new version of ConmendEvent Handl er with the new window-referencing code added to it:

pascal OSStatus ComrandEvent Handl er ( Event Handl er Cal | Ref handl er Ref,
Event Ref event, void *userDat a)

{
OSSt at us result = event Not Handl edErr;
H Conmand command;
W ndowRef wi ndow;
w ndow = ( W ndowRef )userDat a;
Get Event Par anet er ( event, kEvent ParanDirect Obj ect, typeH Command, NULL,
si zeof (H Command), NULL, &command);
switch ( comrand. commandl D )
{
case kBeepConmand:
BeepConmandHandl er () ;
result = noFErr;
br eak;
case kBeep2Command:
Beep2ComandHand| er ( wi ndow ) ;
result = noErr;
br eak;
}
return result;
}

Y ou now need to edit Beep2ConmandHander so that it draws to the window. The following version of
Beep2CommandHandl er includes cals to three routines with which you might not be familiar.

Set Port W ndowPor t ensures that subsequent drawing takes place in the specified window. Thisroutineis
described in Chapter 4 and Chapter 7

The VbveTo routine specifies a pixel coordinate at which subsequent drawing actions should take place. The
first call to VoveTo marks 40 pixelsfrom the left edge of the window and 50 pixels down from the top of the
window as the place to position the start of the drawing. The Dr awSt r i ng routine does just what it says; it
draws astring. The\ p that precedes the text of the string is necessary for Dr awSt r 1 ng to accept the string in
Pascal format. Both the VoveTo and Dr awSt r i ng routines are covered in Chapter 7, "QuickDraw Graphics.”

pascal voi d Beep2CommandHandl er ( W ndowRef w ndow )
{

SysBeep( 1 );

SysBeep( 1 );

Set Port W ndowPort ( wi ndow ) ;
MoveTo( 40, 50) ;

DrawsString("\ pBeep!");
MoveTo( 40, 80);



DrawString("\ pBeep!");
}

Now you're ready to build and run the application. Running BeepWor | d 4. 0 resultsin the window shown
back in Figure 3.5, less the two lines of text that say Beep!. To draw that text to the window, choose the Beep

item from the Sound menu.

Experienced Mac Programmer

Y ou probably are familiar with Set Por t, which is the port-setting routine that's part of the original
Macintosh Toolbox. That function acceptsa\W ndowrt r asits argument. In Carbon, the

W ndowPt r isout and the W ndowRef isin. The new Set Por t W ndowPor t existsto take the
place of Set Por t . After the port is set, drawing proceeds as it has for Mac OS 8/9, for the most
part. Use QuickDraw routines such as VbveTo and Dr awst r i ng to achieve the graphics results
you want. As shown in the preceding code snippet, those two routines-and most other original
QuickDraw routines-remain a part of the API.

MyCloseWindow: Handling a Window-Related Event

The purpose of MyCloseWindow is to demonstrate how to handle awindow-related event in a manner different
from that governed by the window's standard behavior. In particular, the program responds to a click on the
Close button of the program’s only window. Instead of just closing the window, the program sounds a beep and
then closes the window.

Normally, the Carbon Event Manager's default window event handler handles most window-related events
(dragging, resizing, closing, and so forth). It's possible, though, to override the standard behavior the system
takes to implement a new behavior. Using this example's technique, you can intervene on any window-related
event and then either completely handle the event or handle the event as your program seesfit and then enable
the standard behavior to occur.

Y ou can base the MyCloseéWindow project on any of the example projects from this chapter. | started with the
last version of BeepWorld and made a couple of changesto its resource file and then edited the source code file.

Editing the Nib File

The MyCloseWindow program requires only the standard window and menu bar that are part of any main.nib
file created by Project Builder. The window doesn't need to have any buttons; in fact, it doesn't need any itemsin
itatal. InFigure 3.6, you seethat | did include one static text item in the window, but that's optional .

Figure 3.6. The MyCloseWindow window and the menu bar nib resour ces.
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If you're working with a copy of amain.nib file that was used with one of the BeepWorld projects, that file's
menu bar will include a Sound menu. That menu isn't needed in this MyCloseWindow project. Y ou can leave it
in the menu bar, or you can click the Sound menu and press the Delete key to removeit. That'swhat | did in
Figure 3.6. | also edited the name of the application menu so that it now is named MyCloseWindow. Again, that
step isn't critical either because this menu won't be used in this example.

Writing the Sour ce Code

Before proceeding, make sure you have a handle on this business of event types. An event type consists of an
event class. Direct from our favorite header file, CarbonEvents.h, here are the event class choices from which
you can pick:

enum {
kEvent Cl assMbuse = ' nous’
kEvent Cl assKeyboar d "keyb',
kEvent Cl assText | nput = "text',
kEvent Cl assApplication = "appl',
kEvent Cl assAppl eEvent = 'eppc',
kEvent Cl assMenu = 'menu',
kEvent Cl assW ndow = 'w nd,
kEvent Cl assContr ol ='¢cntl"',
kEvent Cl assConmand = 'cmds',
kEvent Cl assTabl et = "tbhlt',
kEvent Cl assVol une = 'vol '

}s

All this chapter's previous examples watched for command events, so each example was interested in an event
that had aclassof kEvent C assCommrand. If you want your program to watch for a particular event that
occurs in awindow (such as a mouse button click on awindow's Close button), the event class you're interested
iniskEvent C assW ndow. Now you need to narrow it down to the particular window-related action for
which your program is set to watch. For command events, the command kind was kEvent Process Comrand.
| just mentioned a click on the window's Close button, so let's ook through the CarbonEvents.h header file to see
which window-related kind constant would apply to that type of event:

enum {
kEvent W ndowCol | apse = 66,
kEvent W ndowCol | apsed = 67,
kEvent W ndowCol | apseAl | = 68,
kEvent W ndowExpand = 69,
kEvent W ndowExpanded = 70,
kEvent W ndowExpandAl | = 71,
kEvent W ndowCl ose = 72,



At the bottom of the list isthe event kind of interest- kEvent W ndowCl ose. If you think that it's odd that this
group of constants starts with the value 66, and if you think that it's even more odd that the list holds just seven
window-related event kinds (all having to do with awindow's size), you're right on with your observations.
There are actually dozens of window-related event kind constants. They cover just about every conceivable
window action. To find out if awindow needs updating (that is, if it needsto be redrawn or refreshed), there's
kEvent W ndowlpdat e. Want to do something special if one of your program's windows is activated (clicked
when another window isin front of it)? Make use of the kEvent W ndowAct | vat ed event kind constant.

Thelist goes on and on. For brevity, I've elected to show just afew of the window-related event kind constants.
Plenty more are shown, and covered, in Chapter 4. If you want to see all the sixty-or-so window-related events
covered in adetailed, tutorial fashion, you'll need to make a request to my publisher to put out Volume 11-X of
this book!

The event type to watch for hasaclassof kEvent Cl assW ndowand atype of kEvent W ndowCl ose. I've
changed the name of the Event TypeSpec variablefrom cndEvent towi ndowEvt just to makeit clear that
this event is window-related rather than command-rel ated:

Event TypeSpec wi ndowEvent ;

wi ndowkEvent . event Cl ass = kEvent Cl assW ndow,
w ndowEvent . event Ki nd kEvent W ndowCl ose;

Most of the mai n function looks the same as other versions of this routine. The few changes are cosmetic rather
than functional. In addition to the Event TypeSpec name change, |'ve changed the name of the event handler
routine from ConmandEvent Handl er to W ndowEvent Hand! er to reflect the fact that the program now
iswatching for window-related events rather than command-related events. Here's the affected code:

handl er UPP = NewEvent Handl er UPP( W ndowEvent Handl er );

I nstal | Event Handl er ( target, handl erUPP, 1, &w ndowEvent,
(void *)w ndow, NULL );

The event handler routine has the same prototype as before. Recall that it must have the same three parameters so
that the Carbon Event Manager knows how to invoke it. The body of the routine, however, has changed
significantly:

pascal OSStatus W ndowEvent Handl er ( Event Handl er Cal | Ref handl er Ref,
Event Ref event, void *userDat a)

{

OSStatus result = event Not Handl edErr;

Ul nt 32 event Ki nd;

event Kind = CGet Event Ki nd( event );

if ( eventKind == kEvent W ndowCl ose )

{

SysBeep( 1 );

/1 result = noBrr; * coment out to force default handler to cl ose
wi ndow

}

return result;



For command events, | was interested in more than just the event class and kind. | wanted to know the value of
the event parameter. Calling Get Event Par anet er tested the parameter to verify whether it was the desired
one (kEventParamDirectObject) and, if it was, to return the HI Cornmrand structure so that the command 1D
could be extracted. That approach isn't needed in this new event handler. Here, the program isn't interested in the
occurrence of acommand. It'sinterested in a click on the window's Close button. That information is held in the
event's kind, so the event's parameter value is unimportant now. Just asthe Get Event Par anet er returnsthe
value held in one of the parameters of an event, so too doesthe GCet Event Ki nd return the value held in the
event kind of an event. Pass Cet Event Ki nd an event and the routine returns the event's kind. An event kind is
aways of type UInt32 (an unsigned 32-bit integer), so that's the data type of the value that Cet Event Ki nd
returns.

Ul nt 32 event Ki nd;

event Ki nd = Get Event Ki nd( event );

Now test the event kind to seeif it corresponds with the event being watched for, which is a close window event.
If it is, handle the event. Again, for ssmplicity, a beeping of the speakers provides the feedback that demonstrates
that the code is working.

One very interesting change to the event handler is the removal of the assignment of noEr r tother esul t
variable. I've commented out this line of code so that | could leaveit in place as areminder of how this chapter's
previous examples worked. The other examplesset r esul t tonoEr r to signal that the event had been handled
by the event handler. It was done also to let the Carbon Event Manager know that no further processing of the
event was needed. Here in MyCloseWindow, | don't make the assignment, so the event handler ends and returns
theinitial value of r esul t, whichisevent Not Handl edEr r, to the Carbon Event Manager.

Y ou might wonder what thisevent Not Handl edEr r tellsthe Carbon Event Manager. It implies that the
event wasn't handled and that the Carbon Event Manager needs to perform its standard, default action for an
event of thistype. Of course, the event handler did handle the event as planned, but in using this technique, you
also forced the Carbon Event Manager to carry out its normal handling of the event. That normal handling of a
window close event would be...yes, to close the window. | want the clicking of the window's Close button to
close the window as the user expects. However, | aso want another action to take place. That action isthe
playing of the system sound. Now I've achieved both tasks.

Y ou've seen bits and pieces of the MyCloseéWindow code. Take alook at Example 3.4 to see the complete

source code listing. Note that because the program doesn't watch for command events, there are no command
constants (such asthe#def i ne of kBeepConmand) and thereis no command-handling routine (such as
BeepCommandHandl er).

Example 3.4 Source Code for the MyCloseWindow Program

#i ncl ude <Car bon/ Car bon. h>

pascal OSStatus W ndowkEvent Handl er ( Event Handl er Cal | Ref handl er Ref,
Event Ref event, void *userData );

int min( int argc, char* argv[] )
{

| BNi bRef ni bRef ;

W ndowRef w ndow;

OSSt at us err;



Event Tar get Ref target;
Event Handl er UPP  handl| er UPP;
Event TypeSpec wi ndowEvent ;

w ndowEvent . event O ass = kEvent Cl assW ndow,
wi ndowEvent . event Kind = kEvent W ndowCl ose;
err = CreateN bReference( CFSTR("main"), &nibRef );

err Set MenuBar FromNi b( ni bRef, CFSTR("Mai nMenu") );

err Cr eat eW ndowFr onNi b( ni bRef, CFSTR(" Mai nW ndow'), &w ndow );
Di sposeN bRef erence( ni bRef );

target = Get WndowEvent Target ( wi ndow );

handl er UPP = NewEvent Handl er UPP( W ndowEvent Handl er );

I nstal |l Event Handl er ( target, handl erUPP, 1, &w ndowEvent,
(void *)wi ndow, NULL );

ShowwW ndow( wi ndow ) ;
RunAppl i cati onEvent Loop() ;

return( 0);

}

pascal OSStatus W ndowEvent Handl er ( Event Handl er Cal | Ref handl er Ref,
Event Ref event, void *userDat a)

{
OSSt at us result = event Not Handl edErr;
Ul nt 32 event Ki nd;
event Kind = Get Event Ki nd( event );
if ( eventKind == kEvent WndowCl ose )
{
SysBeep( 1 );
/1 result = noBrr; * coment out to force default handler to cl ose
wi ndow
}
return result;
}

Do you want your program to sound a beep whenever a user closes awindow? Probably not. However, you now
know the technique for intercepting a window-related event and adding you own actions to the normal handling
of that event. In Chapter 4, you'll see more practical reasons for doing this.



For More Information

For more information about events and the Carbon Event Manager, visit the following web
site:

Carbon Event Manager API: http://devel oper.apple.com/techpubs/macosx/
Carbon/oss/CarbonEventM anager/Carbon_Event_Manager/index.html


http://developer.apple.com/techpubs/macosx/Carbon/oss/CarbonEventManager/Carbon_Event_Manager/index.html
http://developer.apple.com/techpubs/macosx/Carbon/oss/CarbonEventManager/Carbon_Event_Manager/index.html

Chapter 4. Windows

TODISPLAY INFORMATION, A PROGRAM NEEDS to open at least one window.
Most programs, however, enable more than one window to be open at any given time. In
this chapter, you'll see how to implement the New item in the File menu so that selecting
that menu item opens a new window. Y ou'll also see how to add a second New item to give
auser the ability to open a second type of window.

When there are two or more windows on the screen, the task of tracking the windows
becomes important. When it comes time to redraw the contents of its windows, you'll want
to make sure your program draws the proper content to each window. Thus, window-
updating techniques make up an important part of this chapter as well.

To allow each window to have its own unique data associated with it (such asits own user-
entered text or graphics), you'll want to know how to store a set of information with each
window. In addition, you'll also want to know how to later retrieve that information. These
topics are all covered in this chapter.



Opening and Closing Windows

Y ou aready know how to open awindow in aMac OS X nib-based program-Chapter 2, "Overview of
Mac OS X Programming," demonstrated that technique. First, create awindow resource in your project's
nib file. Then, in your project's source code file, call Cr eat eNi bRef er ence to open the nib fileand
Creat eW ndowkr o\l b to get areference to the window resource. Show the newly opened window
by calling ShowW ndow:

| BNi bRef ni bRef ;
OSSt at us err:
W ndowRef w ndow;

err Creat eNl bRef erence( CFSTR("nmain"), &nibRef );

err Creat eW ndowFr omNi b( ni bRef, CFSTR(" Mai nW ndow'), &w ndow );

ShowW ndow( w ndow ) ;

Y ou aso know how your program implements window closing. To close awindow, your program does
nothing-the Carbon Event Manager handles a click of the window's Close button for you. So, knowing
these facts, what's | eft to learn about opening and closing windows? Actually, there's plenty, as you'll see
in this section.

Opening Multiple Windows of the Same Type

Y our program might enable more than one window to be open at any given time. Those windows might be
of the same type, asin the case of aword processor enabling any number of new, empty document
windows to be opened. Typically, such a program enables new windows of the same type to be opened by
choosing New from the File menu.

Implementing the New Menu Item in a Nib File

To have your program respond to a user's choosing the New menu item, you'll need to assign that menu
item a command. Y ou do that by assigning a command to the New menu item in the menu bar resource of
your project's nib resource file. That involves opening the nib file, clicking the New menu item, choosing
Show Info from the Tools menu, and then typing a four-character command in the Command field of the
Info window. The BeepWorld 2.0 example program from Chapter 3, "Events and the Carbon Event

Manager," introduced this technique; several other example programsin that chapter further demonstrated
how thisisdone. To build on this, Figure 4.1 shows what you'll seein Interface Builder if you wereto

assign nwi n (for new window) as the command for the New menu item.

Figure4.1. Assigning a command to the New menu item.
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Implementing the New Menu Item in Source Code

To allow any number of identical windows to be opened, you'll package the window-opening codein an
application-defined routine and then call that routine in response to the user's choosing the New menu
item. The following is such aroutine. Note that all its code has been lifted from the nai n routine shared
by al Chapter 3 examples:

voi d Creat eMyNewwW ndow( void )
{

| BNi bRef ni bRef ;

OSSt at us err;

W ndowRef Wi ndow;

err Creat eNi bRef erence( CFSTR("nmain"), &nibRef );
err = Creat eWndowFr omNi b( ni bRef, CFSTR("Mai nW ndow'), &w ndow );
Di sposeNi bRef erence( ni bRef );

ShowW ndow( w ndow ) ;

Every time a program needs to open a new window, it should call the Cr eat e My NewW ndow routine to
do so. To call thisroutine in response to a New menu item selection, you'll need to have the call appear in
the event handler that's invoked in response to a selection of the New menu item. Here's how that event
handler might look:

#defi ne k NewW ndowConmmand "nwi n'

pascal OSStatus MyAppEvent Handl er ( Event Handl er Cal | Ref handl er Ref ,
Event Ref event, void *userDat a)

{
OSSt at us result = event Not Handl edErr;

H Conmmand conmand;

Get Event Paraneter ( event, kEventParanDi rect Cbj ect, typeH Comrmand,



NULL, sizeof (H Command), NULL, &command);

switch ( command. commandl D )

{
case kNewwW ndowConmand:
Cr eat eMyNewW ndow( ) ;
result = noErr;
br eak;
}

return result;

This routine responds to just one command-the k NewW ndowConmand command that matches the
command assigned to the New menu item in the nib resource file (see Figure 4.1). This event handler gets
invoked by the system in response to the user choosing New from the File menu. For the system to invoke
thisroutine in that manner, it first needs to be installed in the Carbon Event Manager. Here's the code that
takes care of that task:

Event Target Ref target;

Event Handl er UPP handl er UPP;

Event TypeSpec appEvent = { kEvent d assCommand,
kEvent ProcessComrand };

target = Get ApplicationEvent Target( );
handl er UPP = NewEvent Handl er UPP( MyAppEvent Handl er );
I nstal | Event Handl er ( target, handlerUPP, 1, &appEvent, 0, NULL );

Asdiscussed in Chapter 3, the event that defines a command has an event class of

kEvent Cl assConmand and an event kind of kEvent ProcessConmmand. Usethat class and kind in
the declaration of an event specification, and then usethat Event TypeSpec intheinstallation of the
event handler routine. The preceding code snippet does that for an application-defined event handler
routine named My Appl i cat i onEvent AHandl er .

One line in the code might have caught your eye-the line that makes use of the call to
Cet Appl i cat i onEvent Tar get . That routine was mentioned in Chapter 3, but most of that chapter's

target discussions-and all of that chapter's target examples- relied on the related routine-
Cet W ndowEvent Tar get . Here, however, I'm specifying that the application itself, rather than a
window, be the target associated with the event handler routine.

Thetarget istypically the object affected by the event, but choosing the target of an event handler is not a
process that's set in stone. Being the analytical, methodical people that we programmers are, don't we just
hate ambiguous situations like that? As an example of this "looseness" in choosing atarget, consider that if
you specify that a window should be the target, and you then alter your code so that the application is
instead the target, the results might be the same.

Here's why the preceding scenario is possible: If you're writing a handler for acommand generated by a
button, your first inclination might be to select the button itself to be the target. After al, the button seems
to be the target of the user's click of the mouse button. The button, though, is generally not the target of
such an action. In short, your goal in choosing atarget is to select the object that will be affected by an
event's action. In this example, it's unlikely that the button itself will be affected by a click of the button.



Instead, the affected object will probably be (but not always) the window that holds the button. For
instance, clicking awindow's Draw button might draw something in that window. The button initiates the
action, but the window is the target of the action.

An event is processed in a containment hierarchy that starts at a specific object and works its way up to the
application itself. A program should attempt to handle an event at the lowest level first and then, failing
that, pass the event up alevel. The Carbon Event Manager holds standard event handlers that take care of a
number of different event types at a number of different levelsin this event hierarchy.

It's best to define an event to be targeted to its lowest level, and then have your program attempt to handle
the event at that level. If your program can't handle the event at that level, the event should then be passed
to the system where the Carbon Event Manager will attempt to handle it. Looking back at the genera
format of an event handler reminds you of this event-handling technique:

pascal OSStatus MyEvent Handl er ( Event Handl er Cal | Ref handl| er Ref ,
Event Ref event, void *userDat a)

{
OSSt atus result = event Not Handl edErr;
/1l attenpt to handle the event here and if we can, then tell the
/| Carbon Event Manager that by setting result to noErr:
result = noErr;
/1 if the event *can't* be handled, then we notify the Carbon Event
/1 Manager of this fact by sending it the val ue event Not Handl edErr :
return result;
}

| want my program to handle the New menu item. Choosing this item doesn't act on any existing window.
It creates a new window, so it makes sense to name the application itself as the target of the event. The
Cet W ndowEvent Tar get routine requires awindow as its argument, and atarget is returned. The

Cet Appl i cati onEvent Tar get needsno argument. That makes sense. A program might have any
number of windows that possibly could be awindow target, but a program has only one application (itself)
that can be the application target.

When installing an event handler for an event that has a window as the target, it often makes senseto use a
reference to the window as the user data, like this:

I nstal | Event Handl er ( target, handl erUPP, 1, &w ndowEvent,
(void *)w ndow, NULL );

When installing the event handler for an event that has the application asitstarget, you might not want to
pass along any user data. In such a case, simply use avalue of 0 as the second-to-last argument:

I nstal | Event Handl er ( target, handlerUPP, 1, &appEvent, 0, NULL );
MultipleSameTypeWindow Program

The purpose of the MultipleSameTypeWindow program is to demonstrate how a program implements the



New menu item to cause any number of windows of the same type to be opened.

The MultipleSameTypeWindow program gathers the code from this section’s discussion and presentsit as
an application that has a functioning New menu item. Each time a user chooses New from the File menu, a
new window opens. As per the program name, each new window isidentical to the previously opened
window. Figure 4.2 shows that each window holds a couple of paragraphs of text (determining the author
of said text is|eft as an exercise for the reader). This figure aso shows that each new window will open
offset from the previously opened window.

Figure 4.2. The windows displayed by the M ultipleSameTypeWindow program.
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Editing the Nib File

The project's nib file requires awindow resource named MainWindow. Although I've opted to include a
static text item in the window, the contents of the window are insignificant. Of more importanceis the
assignment of a command to the New menu item. Back in Figure 4.1, you saw how to do this. Y ou can use

any four-character code you want, but regardless of your choice, you need to take note of it so that you can
define a matching constant in the project's source code.

Writing the Sour ce Code

Example 4.1 holds the entire listing for the MultipleSameTypeWindow program. Most of this example's

code has been discussed on earlier in this chapter. The exception is the code that offsets a new window
from the previously opened window:

Example 4.1 MultipleSameTypeWindow Sour ce Code

#i ncl ude <Car bon/ Car bon. h>
#defi ne kNewwW ndowConmand "nw n'
pascal OSStatus MyAppEvent Handl er ( Event Handl er Cal | Ref handl er Ref ,

Event Ref event, void *userData );
voi d Creat eMyNewW ndow( void );

SInt 16 gW ndowSt art Top 40;
SInt16 gW ndowSt art Left = 15;



int min(int argc, char* argv[])

{

| BNi bRef ni bRef ;

CSSt at us err;

Event Tar get Ref target;

Event Handl er UPP handl er UPP;

Event TypeSpec appEvent = { kEvent C assConmand,

kEvent ProcessCommand };
err = CreateN bReference( CFSTR("nain"), &ni bRef );
err = Set MenuBar FromNi b( ni bRef, CFSTR(" Mai nMenu") );
Di sposeNi bRef erence( ni bRef );
Cr eat eMyNewW ndow( ) ;
target = Get ApplicationEventTarget( );
handl er UPP = NewEvent Handl er UPP( MyAppEvent Handl er );
| nstal | Event Handl er ( target, handl erUPP, 1, &appEvent, 0, NULL );
RunAppl i cati onEvent Loop() ;

return( 0 );

pascal OSStatus MyAppEvent Handl er ( Event Handl er Cal | Ref handl er Ref ,

{

Event Ref event, void *userData)

0SSt at us result = event Not Handl edErr ;
H Command conmand;

Get Event Paraneter ( event, kEvent ParanDirect Obj ect, typeH Comrand,
NULL, sizeof (H Conmmand), NULL, &conmand);

switch ( command. conmandl D )

{
case kNewwW ndowCommand:

Cr eat eMyNewW ndow( ) ;

result = noErr;

br eak;

}

return result;

voi d Creat eMyNewwW ndow( void )

{

| BNi bRef ni bRef ;
OSSt at us err:
W ndowRef wi ndow;



err = CreateN bReference( CFSTR("main"), &nibRef );
err = CreateW ndowFr omNi b( ni bRef, CFSTR("Mai nW ndow'), &w ndow );
Di sposeNi bRef erence( ni bRef );

MoveW ndow ( wi ndow, gW ndowStartlLeft, gWndowStartTop, TRUE );
ShowW ndow( wi ndow );

if ( gWndowStart Top < 200 )

{
gW ndowSt art Left += 20;
gW ndowSt art Top += 20;
}
el se
{
gW ndowSt art Left = 15;
gW ndowSt art Top = 40;
}

}

A window's initial screen placement is defined by the nib window resource used as the window's templ ate.
Opening more than one window based on the same nib resource means that new windows appear directly
on top of one another. The result of this stacking is that the user might not even be aware that a new
window has indeed appeared on screen. The MultipleSameTypeWindow program handles this potential
dilemma by opening a new window and then offsetting that window.

The Carbon API routine Vove\W ndow moves awindow to the specified location. The coordinates listed
as the second and third arguments to this routine serve to define the new upper-left corner for the window
named in the first argument. The final argument to Vove\W ndowis a Boolean value that specifies that
position of the window in the layer of open application windows. A value of TRUE means the window will
become the active window. A value of FAL SE means the window should retain its current position (which
might or might not mean that the window is the active [frontmost] window).

The global variable pair g\W ndowsSt ar t Lef t and g\W ndowSt ar t Top are used to provide the screen
coordinates for the upper-left corner of the first new window. After awindow is opened, these global
values are incremented so that the next new window appears slightly below and to the right of the
previously opened window. So that the windows don't cascade completely offscreen, the global variable
values are reset to their initial values after several windows have been opened.

Opening and Closing a Window by Showing and Hiding It

The previous discussion centered on programs that enable multiple windows of the same type to be
opened. An application that uses such atechnique is usually document-based. A typical document-based
program is aword processor or a graphics application.

Other types of applications, however, might enable only one or two windows to appear on screen. A
program of thistype usually isn't document-based. An example of this type of program is a utility
application that displays awindow in which the user carries out some calculation. Figure 4.3 provides an
example of an application that displays only one window and that doesn't enable multiple copies of this
one window to be opened.



Figure 4.3. An example of awindow that isn't document-based.
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In aprogram such as the one pictured in Figure 4.3, there's no need to open multiple copies of the same

window. If you're devel oping such an application, and you want the user to be able to open and close your
program's window, it might make sense to open the window at program startup, and then simply hide and
reshow this same window rather than actually closing and re-creating a new window.

In such a program, there's no need to open multiple copies of the same window. If you're developing such
an application, and you want the user to be able to open and close your program’'s window, it might make
sense to open the window at program startup, and then simply hide and reshow this same window rather
than actually closing and re-creating a new window. Doing this means that each time the user chooses the
New menu item, your program doesn't have to open the nib file and receive arefererence to the file, copy
the window resource to memory and get a reference to that memory, and then close the nib file. Instead,
create the window once and let it sit around, perhaps hidden some or even much of the time, for the
duration of the program'’s execution.

This technique of opening awindow and then closing it by hiding it rather than actually destroying it also
isagood way to preserve awindow's state. That might be helpful for a particular application. For instance,
if the window has a number of interface items such as radio buttons, checkboxes, or text boxes, and the
user enters values in these items, hiding the window won't work because the window |oses those values.
These values might represent information the user would prefer not to re-enter- something the user that
would need to do if the window was "really" closed and then later opened as a new window.

A program that displays awindow like the one pictured in Figure 4.3 might enable its File menu items

New and Close, but use the items simply to show and hide the program's one window. That way, the
window can be created at program start up and need not be created each time the user closes and then
opens the window.

The previous example program, MultipleSameTypeWindow, assigned a command to the New menu item
so that choosing that menu item results in a new window opening. To have the New menu item show a
hidden window rather than open a new window, you'll do the same. In the MultipleSameTypeWindow
program, | gave the New menu item a command of ninai . You can give that menu item the same
command here as well.

By now, you should be accustomed to adding a command to a menu item. If you need alittle help,
however, refer back to Figure 4.1 to see how thisisdone. You'll also want to give the Close menu item a
command aswell. If you use nirai for "new main window," you might want to use cai for "close main
window." Keep in mind that the functionality of a menu item is determined in your code, not in the nib



resource file or by the name of the menu item. Thus, the four-character command you assign to a menu
item, aswell asthe action that results from a selection of amenu item, is entirely up to you.

Y our code now has two command constants: one for the New menu item and one for the Close menu item:

#defi ne kNewivai nW ndowConmand "nmai '
#defi ne kC oseMai nW ndowCommand "cmal '

A single command-handling event handler routine will handle both commands. As you read in the section
describing the MultipleSameTypeWindow program, sometimes it makes sense to have an event handler
installed at the application level rather than at alower level (such as for a particular window level).

The following code is another example of an event handler being installed with the application as the
target. Having the event handler act at the application level is especially important here because after a
window is hidden, an event handler can't show it again (the Carbon Event Manager won't respond properly
to act on the window that isn't present on the screen). Here's how the installation of the event handler
might look:

Event Target Ref target;

Event Handl er UPP handl er UPP;

Event TypeSpec appEvent = { kEvent Cl assCommand,
kEvent ProcessComrand };

target = Get ApplicationEvent Target( );

handl er UPP = NewEvent Handl er UPP( MyAppEvent Handl er );

Instal | Event Handl er ( target, handl erUPP, 1, &appEvent,
(void *)w ndow, NULL );

In this chapter's MultipleSameTypeWindow program, the action of the New menu item was implemented
in the event handler by calling an application-defined routine that actually opened a new window:

switch ( command. commandl D )

{
case kNewwW ndowConmand:
Cr eat eMyNewW ndow( ) ;
result = noErr;
br eak;
}

Now we'll replace the call to the application-defined CreateMyNewWindow routine with acall to the
Carbon routine ShowW ndow:

switch ( command. commandl D )
{
case kNewiai nW ndowConmand:
ShowW ndow( wi ndow ) ;
result = noErr;
br eak;
case kC osemMai nW ndowCommand:
H deW ndow( w ndow );



result = noErr;
br eak;

}

Y ou've already worked with the Carbon routine ShowWW ndow. Look at any source code listing in this
book and you'll seethat a call to this routine aways appears after awindow is created from acall to
Creat eW ndowkFromNi b, ShowW ndowis used to show, or display, a previously hidden window (a
window created from a nib resource starts out asinvisible).

MenuCloseOneWindow Program

The purpose of the MenuCloseOneWindow program is to demonstrate how a program can simply show
and hide an existing window in response to the user opening and closing the window.

The MenuCloseOneWindow displays a single window like the one shown in Figure 4.2. Once again, the
content of the window is unimportant to the example at hand, so I've opted to simply reuse the nib resource
from the MultipleSameTypeWindow program. This window will be displayed and hidden in response to
selections of the New and Close menu items, giving theillusion that the window is actually being opened
and closed.

Note that clicking the window's Close button generates an event that isn't handled by the program's own
event handler. Instead, a Carbon Event Manager standard event handler takes care of that task, asit hasin
all previous examplesin this book. What that meansis that closing the window by clicking its Close button
really does close the window; it doesn't just hide it. If you use the window's Close button to close the
window, choosing New from the File menu won't reopen the window (the attempt to show the now-
disposed-of window fails). Later in this chapter, the MenuButtonCloseWindows program solves this
problem.

Editing the Nib File

The same nib resource file used for the MultipleSameTypeWindow project can be used here. The

Vel n\W ndowwindow resource can have any (or no) content. The New menu item should have a
command (nai isused here), and the Close menu item should have acommand (c el isused in this
example).

Writing the Sour ce Code

The MenuCloseOneWindow source code is similar to the MultipleSameTypeWindow source code. The
important changes are the addition of asecond #def i ne to match the command given to the Close menu
item, the addition of asecond case label totheswi t ch statement in the event handler, and the use of the
Carbon routine Hi de\W ndowto carry out the action associated with the New and Close menu items.
Example 4.2 holds the complete listing for the MenuCloseOneWindow program.

Example 4.2 M enuCloseOneWindow Sour ce Code

#i ncl ude <Car bon/ Car bon. h>

#defi ne kNewvai nW ndowConmand "nmai '
#defi ne kd oseMai nW ndowConmand "cmai '



pascal OSStatus MyAppEvent Handl er ( Event Handl er Cal | Ref handl er Ref ,
Event Ref event, void *userData );

int main(int argc, char* argv[])

{
| BNi bRef ni bRef ;
OSSt at us err;
W ndowRef wi ndow;

Event Target Ref target;

Event Handl er UPP handl| er UPP;

Event TypeSpec appEvent = {kEvent d assConmand,
kEvent ProcessComrand} ;

err = CreateN bReference( CFSTR("nmain"), &nibRef );
err = Set MenuBar FromNi b( ni bRef, CFSTR(" Mai nMenu") );
err = Creat eW ndowFr omNi b( ni bRef, CFSTR("Mai nW ndow'), &w ndow );

Di sposeNi bRef erence( ni bRef );

target = CetApplicationEventTarget( );

handl er UPP = NewEvent Handl er UPP( MyAppEvent Handl er );

I nstal | Event Handl er ( target, handl erUPP, 1, &appEvent,
(void *)w ndow, NULL );

ShowwW ndow( wi ndow ) ;
RunAppl i cati onEvent Loop();

return( 0 );

pascal OSStatus MyAppEvent Handl er ( Event Handl er Cal | Ref handl er Ref ,
Event Ref event, void *userData )
{
OSSt at us result = event Not Handl edErr;
H Conmmand command,
W ndowRef w ndow;

w ndow = ( W ndowRef )userDat a;

CGet Event Paranet er ( event, kEvent ParanDirect Obj ect, typeH Comrand,
NULL, sizeof (H Conmmand), NULL, &conmand);

switch ( command. commandl D )
{
case kNewivai nW ndowConmand:
ShowwW ndow( wi ndow ) ;
result = noErr;
br eak;
case kC oseMai nW ndowComrand:



H deW ndow( w ndow );
result = noErr;
br eak;

}

return result;

}

Using Global Variablesto Reference Windows

With the exception of the MultipleSameTypeWindow program, this book's discussions and examples have
revolved around applications that display a single window. That simplicity isideal for demonstrating how
to implement specific programming tasks, but it doesn't represent the real world. The majority of
applications are capable of displaying more than one window.

Multiple windows can be displayed in two ways. First, a program might allow the opening of more than
one window of the same type. For instance, aword processor application lets a user repeatedly choose
New from the File menu to open a new, empty document window that's identical to the window opened
before it. Y ou've seen how to do that in this chapter's MultipleSameTypeWindow example.

The second way to display multiple windows is to display two or more different types of windows. An
example would be a graphics program that displays a window to which you can draw and a different
window that holds a palette of drawing tools from which you can choose. Figure 4.3 illustrates this
concept. Of course, a program can make use of both multiple window techniques-a graphics program
might display one tool palette window and then enable any number of new, empty, identical drawing
windows to be opened.

If a program enables numerous windows of the same type to appear at the same time, it doesn't make sense
to attempt to track each window by way of its own window reference variable. Y ou wouldn't know in
advance how many such variables to alocate. However, when a program opens one or more windows and
each is adifferent type, it becomes a practical matter to define a global window reference variable for each
type. I'll cover thistopic in this section because this technique simplifies the opening and closing of
windows.

Note

The updating of window contents is another topic that lends itself well to global window
reference variables, so you can expect to see examples later in this chapter in the "Updating
Window Content" section.

To make use of global window references, declare aglobal \W ndowRef variable for each type of window
your program uses. To make the reference global, declare it outside mai n or any other routine. Y ou can
give such avariable any name, but the commonly used convention in Macintosh programming isto start
such a variable name with alowercase g (for global).

Consider a program that displays two windows: one window is the main window and another window is
the information window. The two \W ndowRef declarations might look like this:



#i ncl ude <Car bon/ Car bon. h>

W ndowRef gMai nW ndow;
W ndowRef gl nf oW ndow;
int main( int argc, char* argv[] )
{
| BNi bRef ni bRef ;
CSSt at us err;

Near the start of main, you'll want to create one instance of each window. Depending on your program,
you also might want to show each window at startup as well:

err
err

Cr eat eW ndowFr omNi b( ni bRef, CFSTR(" Mai nW ndow'), &gMai nW ndow ) ;
Cr eat eW ndowFr omNi b( ni bRef, CFSTR("I nf oW ndow'), &gl nf oW ndow );

ShowW ndow( gMai nW ndow ) ;
ShowwW ndow( gl nf oW ndow ) ;

At this point, either window can be referenced at any time, from any routine. Thisis handy when updating
(asyou'll seelater in this chapter) and closing a window:

H deW ndow( gl nf oW ndow ) ;
GlobalWindows Program

The purpose of the GlobalWindows program isto provide a simple example of how global variables can
be used to reference windows. This program also illustrates the use of a utility, or floating, window.

Figure 4.4 shows the two windows displayed by the Global Windows program. Two global variables are
used here-one to keep track of each window.

Figure 4.4. Thewindows displayed by the GlobalWindows program.

A6 Main Window

Type = Document

&) L& Info Window

Type = Utility

The GlobalWindows program includes a utility window titled Info Window. A program typically uses a
utility window when the window's information needs to be easily accessible at any time. For instance, a
graphics program might use a utility window to display itstool palette.



Notice that in comparison to the window titled Main Window, this utility window has a smaller title bar,
smaller buttonsin the title bar, and smaller text in itstitle. Additionaly, this window cannot be minimized.
Running the program also reveals that this window always remains the frontmost window. If you click the
other window-the one titled Main Window-that Main Window will become active (its title bar will become
high-lighted). The Info Window, however, remainsin front of the Main Window.

Editing the Nib File

The GlobalWindows program displays two types of windows, so the project requires two window
resourcesin itsnib file. To add a second window to a nib file, click the right-most button at the top of the
Interface Builder palette window (that button displays a small window, as shown in Figure 4.5), click the
window that includes three buttonsin itstitle bar, and drag and drop that window onto the main.nib
window. Name the new window by double-clicking its name in the main.nib window and typing the new
name. In Figure 4.5, I've given the new window the name InfoWindow.

Figure4.5. A nib filewith two window resourcesin it.
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By default, Interface Builder gives a new "three button™ window a window type of Document. To change
the window type, click the window in the main.nib window, and then choose Show Info from the Tools
menu. Now click the Window Class popup menu and choose the preferred type.

In Figure 4.5, I'm changing the InfoWindow from a document window to a utility window. A floating
window looks identical to a utility window, and it too remains in front of document windows. The primary
difference between a utility window and a floating window is that the utility window is displayed in front
of document windows and in front of floating windows.

Writing the Sour ce Code
Example 4.3 shows the complete listing for the Global Windows program. Notice that no special handling
of the utility window is necessary from the source code. After awindow is defined as a utility window in

the nib resource, the system knows how to handle its look and screen placement.

Example 4.3 GlobalWindows Sour ce Code



#i ncl ude <Car bon/ Car bon. h>

W ndowRef gMWai nW ndow;
W ndowRef gl nf oW ndow,

int main( int argc, char* argv[] )
{
| BNi bRef ni bRef ;
CSSt at us err;
err CreateN bReference( CFSTR("main"), &nibRef );
err Set MenuBar FromNi b( ni bRef, CFSTR(" Mai nMenu") );
err Cr eat eW ndowFr omNi b( ni bRef, CFSTR(" Mai nW ndow") ,
&gMai NW ndow) ;
err = Creat eW ndowFr omNi b( ni bRef, CFSTR("I nf oW ndow'), &gl nf oW ndow)
Di sposeNi bRef erence( ni bRef );

ShowwW ndow( gMai nW ndow ) ;
ShowwW ndow( gl nf oW ndow ) ;

RunAppl i cati onEvent Loop() ;

return( 0 );

}

Showing and Hiding Multiple Windows

Using global window reference variables along with the ShowW ndowand H deW ndowroutinesisa
good technique to handle window opening and closing for a program that has a couple or afew different
types of windows.

This chapter's MenuCloseOneWindow program displayed just one window, so it made sense to pass that
window as the user data during the installation of the event handler:

target = Get ApplicationEvent Target( );

handl er UPP = NewEvent Handl er UPP( MyAppEvent Handl er );

I nstal | Event Handl er ( target, handl erUPP, 1, &appEvent,
(void *)wi ndow, NULL );

Within that program's event handler, the window was extracted from the user dataand used in callsto
ShowW ndowand Hi deW ndowto show and hide the one window:

wi ndow = ( W ndowRef )user Dat a;

Get Event Paranet er ( event, kEvent ParanDi rect Obj ect, typeH Conmand,
NULL, sizeof (H Command), NULL, &conmand);

switch ( command. commandl D )

{
case kNewMvai nW ndowConmand:



ShowwW ndow( w ndow ) ;
result = noErr;
break;

case kd osemai nW ndowCommand:
H deW ndow( wi ndow );
result = noErr;
br eak;

}

A program that displays two windows, each of a different type, could declare aglobal variable for each,
usetwo callsto Cr eat eW ndowkr onNi b to create an instance of each type of window, and then install
the event handler without passing a reference to either window:

W ndowRef gTypeAW ndow,
W ndowRef gTypeBW ndow;

err = CreateW ndowrFromNi b( ni bRef, CFSTR("W ndowA"), &gTypeAW ndow ) ;
err Creat eW ndowFr omNi b( ni bRef, CFSTR("W ndowB"), &gTypeBW ndow );

Di sposeN bRef erence( ni bRef );

target = Get ApplicationEvent Target( );
handl er UPP = NewEvent Handl er UPP( MyAppEvent Handl er );
I nstal | Event Handl er ( target, handl erUPP, 1, &appEvent, 0, NULL );

In the preceding snippet, note that the second-from-last | nst al | Event Hand! er argument isO,
whereas in all other examples, it's been ageneric pointer to awindow, asin( voi d *)w ndow. This
new code is meant to handle menu items that work with more than one particular window, so passing one
particular window to the event handler wouldn't serve much of a purpose.

With the event handler receiving no reference to a window, how does it go about determining which
window or windows to open or close? Two methods are used for the determination. For opening a
window, a separate New menu item can exist for each type of window. That's a technique you find in alot
of programs, including Apple's Project Builder IDE. That program has a File menu that includes a New
Project menu item for opening a new project window and a New File menu item for opening a new source
codefile.

Here'show theswi t ch statement in an event handler could take care of the opening of two types of
windows (which really is the showing of one of two previously created windows):

#define kNewlypeAW ndowConmmand " newA
#defi ne kNewTypeBW ndowConmand "newB'

switch ( command. comandl D )

{
case kNewTypeAW ndowComrand:



ShowwW ndow( gTypeAW ndow ) ;
result = noErr;
br eak;

case kNewTypeBW ndowComrand:
ShowW ndow( gTypeBW ndow ) ;
result = noErr;
br eak;

Closing awindow involves a different technique. In this case, the globa window reference variables aren't
needed. In a Macintosh program, it's common practice for the File menu to have a single Close menu item,
regardless of the number of types of windows the program displays. In addition, it's common practice for
that Close menu item to close the frontmost window, regardless of the type of window that the frontmost
window might be. Thus, to implement the Close menu item, you'll determine which window is frontmost
and then hide that window. Fortunately, the Carbon Fr ont W ndow routine makes that task easy:

#def i ne kC oseFr ont W ndowConmmand ' cfnt'

W ndowRef w ndow;

case kCl oseFr ont W ndowCommand:
wi ndow = Front W ndow() ;
H deW ndow( w ndow );
result = noErr;
br eak;

Combining this case section with the two case sectionsin the previous snippet (the case sections for
the k NewType AW ndowConmand label and the k NewTypeBW ndowConmand label) resultsin an
event handler that opens and closes (shows and hides) two types of windows. The next example program
provides a complete example of how that's done.

MenuCloseTwoWindows Program

The purpose of the MenuCloseTwoWindows program is to demonstrate how to use the ShowW ndow/
Hi deW ndow technique to open and close more than one type of window from the File menu. This
chapter's MenuCloseOneWindow program used the ShowWW ndowand Hi de\W ndow routines to show
and hide asingle window. Here I'll use that same routine to show and hide two windows.

The MenuCloseTwoWindows program displays two New menu items-one for each of the program's two
types of windows. To make it easy to distinguish between the windows, the program draws text in one and
numbers in the other. Figure 4.6 shows the program'’s File menu and its two windows.

Figure 4.6. The windows and File menu from the MenuNewClose program.
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To close awindow, click it to make it active and then choose the Close menu item. To reopen a closed
window, choose the appropriate New menu item. As in the MenuCloseOneWindow program, closing a
window by clicking its Close button closes the window for good; choosing the corresponding New menu
item can't reopen it. This chapter's MenuButtonCloseWindows program demonstrates how to integrate the
Close button into the ShowW ndow/ Hi deW ndow approach of opening and closing windows.

Editing the Nib File
The nib file requires a menu bar that includes a File menu with the items shown in Figure 4.6. In Interface
Builder, edit the existing New item to say New Word Window, and then add a menu item beneath the New

Word Window item. To add the new menu item to the existing File menu, follow these stepsin Interface
Builder:

1. Click the File menu in the menu bar window to expose the itemsin that menu.
2. Click the leftmost button running along the top of the palette window.

3. Click the blue box titled Item in the pal ette window and drag and drop this box under the New
Word Window item in the File menu in the menu bar window.

4. Double-click the newly added item and type the name New Number Window for the menu item.

Now click the New Word Window item and choose Show Info from the Tools menu. Type nwr d (for new
word window) in the Command field of the Info window, as shown in Figure 4.7. In asimilar manner, give

the New Number Window item a command of nnum(for new number window) and the Close item a
command of cf nt (for close frontmost window).

Figure4.7. Assigning a command to a program's New menu item.
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The nib file requires two window resources. Change the name of the existing window resource from

Vel nW nd to Wor dW ndow by double-clicking its name in the main.nib window and typing the new
name. Add a second window by clicking the right-most button in the pal ette window and then dragging
and dropping awindow onto the main.nib window. As shown in Figure 4.7, this new window should have

the name Nunber W ndow.
Writing the Sour ce Code

Example 4.4 provides the entire listing for the MenuCloseTwoWindows program.The three #def | nes

have values that match the three commands assigned to the menu itemsin the nib file. Also note that the
two callsto Cr eat eW ndowrr ormiNi b need to have window names that match the window resource
names (V\or dW ndowand Nurrber W ndow). The two function calls also include the proper global
window reference variables (g\V\or d\W ndowand gNunber W ndow) as arguments.

Example 4.4 M enuCloseTwoWindows Sour ce Code

#i ncl ude <Car bon/ Car bon. h>

#def i ne kNewwdr dW ndowConmmand "nwrd'
#defi ne kNewNunber W ndowCommand ' nnumi
#defi ne kCl oseFr ont W ndowConmand ' cf nt'

pascal OSStatus MyAppEvent Handl er ( Event Handl er Cal | Ref handl er Ref ,
Event Ref event, void *userData );

W ndowRef gWor dW ndow,
W ndowRef gNunber W ndow,
int main( int argc, char* argv[] )
{
| BNi bRef ni bRef ;
OSSt at us err;

Event Target Ref target;

Event Handl er UPP handl er UPP;

Event TypeSpec appEvent = { kEvent Cl assConmand,
kEvent ProcessComrand};



err = CreateN bReference( CFSTR("nain"), &ni bRef );
err = Set MenuBar FronNi b( ni bRef, CFSTR("Mai nMenu™) );
err = Creat eW ndowrFr omNi b( ni bRef, CFSTR("Wr dW ndow"),

&Wor dW ndow) ;
err = Creat eW ndowrFr omNi b( ni bRef, CFSTR(" Nurmber W ndow") ,
&gNunber W ndow) ;
Di sposeNi bRef erence( ni bRef );

target = Get ApplicationEvent Target( );
handl er UPP = NewEvent Handl er UPP( MyAppEvent Handl er );
| nstal | Event Handl er ( target, handl erUPP, 1, &appEvent, 0, NULL );

ShowwW ndow( gWbr dW ndow ) ;
ShowW ndow( gNunber W ndow ) ;

RunAppl i cati onEvent Loop() ;

return( 0 );

pascal OSStatus MyAppEvent Handl er ( Event Handl er Cal | Ref handl er Ref ,
Event Ref event, void *userDat a)

{
OSSt at us result = event Not Handl edErr;

H Command conmand;
W ndowRef wi ndow;

Get Event Paranet er ( event, kEvent ParanDirect Obj ect, typeH Comrand,
NULL, sizeof (H Command), NULL, &conmand );

switch ( command. commandl D )

{
case kNewwbr dW ndowConmand:
ShowwW ndow( gWbr dW ndow ) ;
result = noErr;
br eak;
case kNewNumber W ndowComrand:
ShowwW ndow( gNunber W ndow ) ;
result = noErr;
br eak;
case kd oseFront W ndowCommand:
wi ndow = Front W ndow() ;
H deW ndow( wi ndow );
result = noErr;
br eak;
}
return result;

}

Hiding a Window Using the Window's Close Button



Closing awindow by clicking the window's Close button is a task normally handled by the Carbon Event
Manager. To round out the show/hide technique, you'll want to have your program take control of thistype
of event so that the affected window can be hidden ssimply with acall to H de\W ndow, instead of
deallocating its memory, as would be the case if the window were actually being closed.

The Chapter 3 program MyCloseWindow supplies you with the information you need to change the

behavior of awindow's Close button. You'll declare an event specification for awindow close event, and
then pass that specificationto | nst al | Event Handl er:

Event TypeSpec w ndowkEvent = { kEvent d assW ndow, kEvent W ndowCl ose };

err = CreateW ndowrFr omNi b( ni bRef, CFSTR("Wor dW ndow'), &w ndow );

target = Get Wndowkvent Target ( w ndow );

handl er UPP = Newkvent Handl er UPP( MyW ndowEvent Handl er );

I nstal | Event Handl er ( target, handl erUPP, 1, &w ndowEvent,
(void *)wi ndow, NULL );

In the MyCloseWindow program, the event handler routine MyWindowEventHandler made acall to
SysBeep inresponse to awindow close event. In Chapter 3, | promised that this technique of intercepting
awindow-related event would be put to better use. Here's where that's done. In the following version of
MyWindowEventHandler, acall to Hi de\W ndow hides the affected window. The variabler esul t then
isassigned avalue of noEr r so that the Carbon Event Manager is notified that the program's event
handler took care of the event. If the code didn't return this value, the window would be hidden and the
Carbon Event Manager would go ahead and really close the window.

pascal OSStatus MyW ndowkvent Handl er ( Event Handl er Cal | Ref handl er Ref ,
Event Ref event, void *userData )

{
OSSt at us result = event Not Handl edErr ;
Ul nt 32 event Ki nd;
W ndowRef w ndow;
wi ndow = ( W ndowRef )user Dat a;
event Kind = Get Event Ki nd( event );
if ( eventKind == kEvent W ndowCl ose )
{
H deW ndow( w ndow );
result = noErr;
}
return result;
}

MenuButtonCloseWindows Program



The purpose of the MenuButtonCloseWindows program is to provide a complete example of using the
ShowW ndow Hi deW ndow technique to enable more than one type of window to be opened and

closed from the File menu and to be closed with a click on awindow's Close button. This program expands
upon the previous example, MenuCloseTwoWindows, so afew comparisons can be made between the two
examples.

This program displays the same File menu and two windows that are displayed by
MenuCloseTwoWindows (refer to Figure 4.6).To create these interface elements, this example uses the

same nib file as the MenuCloseTwoWindows example. No changes are needed.

Example 4.5 shows the compl ete source code listing for the MenuButtonCloseWindows program. In the
source code, #def | nes, the My AppEvent Handl er routine, and the global window reference variables
al remain unchanged from the source code of the MenuCloseTwoWindows program. This new program
adds a second event handler routine (My W ndowEvent Handl er) to the one event handler routine
present in the MenuCloseTwoWindows program (My AppEvent Handl er).

Note that Example 4.5 introduces the concept of using the same event handler routine for more than one

target. To force awindow's Close button to hide the window, each window installs the same event handler,
MyW ndowEvent Handl er, withitself asthe target. A second example of using the same event handler
for different windows can be found near the end of this chapter in the SameTypeWindowWithData
example program.

Example 4.5 M enuButtonCloseWindows Sour ce Code

#i ncl ude <Car bon/ Car bon. h>

#def i ne kNewwbr dW ndowConmand "nwrd'
#def i ne kNewNunber W ndowCommand ' nnumni
#def i ne kCl oseFr ont W ndowConmand ' cfnt'

pascal OSStatus MyAppEvent Handl er ( Event Handl er Cal | Ref handl er Ref ,
Event Ref event, void *userData );

pascal OSStatus MyW ndowkEvent Handl er ( Event Handl er Cal | Ref handl er Ref,
Event Ref event, void *userData );

W ndowRef gWor dW ndow,
W ndowRef gNunber W ndow,
int main( int argc, char* argv[] )
{
| BNi bRef ni bRef ;
CSSt at us err;

Event Target Ref target;

Event Handl er UPP handl er UPP;

Event TypeSpec appEvent = { kEvent Cl assConmand,
kEvent ProcessComrand};

Event TypeSpec wi ndowEvent = {kEvent C assW ndow,
kEvent W ndowCl ose};



err = CreateN bReference( CFSTR("nain"), &ni bRef );
err = Set MenuBar FronNi b( ni bRef, CFSTR("Mai nMenu™) );
err = Creat eW ndowrFr omNi b( ni bRef, CFSTR("Wr dW ndow"),

&Wor dW ndow) ;

target = Get WndowkEvent Target ( gWr dW ndow ) ;

handl er UPP = NewEvent Handl er UPP( MyW ndowEvent Handl er );

I nstal | Event Handl er ( target, handlerUPP, 1, &M ndowEvent,
(void *)gWordwW ndow, NULL );

err = Creat eW ndowFr omNi b( ni bRef, CFSTR(" Number W ndow") ,
&gNunmber W ndow ) ;

target = Get Wndowkvent Target ( gNunber W ndow ) ;

handl er UPP = NewEvent Handl er UPP( MyW ndowEvent Handl er );

I nstal | Event Handl er ( target, handlerUPP, 1, &M ndowEvent,
(voi d *)gNunmber Wndow, NULL );

Di sposeNi bRef erence( ni bRef );

target = Get ApplicationEvent Target( );
handl er UPP = NewEvent Handl er UPP( MyAppEvent Handl er );
| nstal | Event Handl er ( target, handl erUPP, 1, &appEvent, 0, NULL );

ShowwW ndow( gWor dW ndow ) ;
ShowwW ndow( gNunber W ndow ) ;

RunAppl i cat i onEvent Loop() ;

return( 0 );

pascal OSStatus MyW ndowkvent Handl er ( Event Handl er Cal | Ref handl er Ref,
Event Ref event, void *userDat a)
{

0SSt at us result = event Not Handl edErr ;
Ul nt 32 event Ki nd;
W ndowRef wi ndow;

w ndow = ( W ndowRef )userDat a;

event Ki nd = Get Event Ki nd( event );

if ( eventKind == kEvent WndowCl ose )

{
H deW ndow( w ndow );
result = noErr;

}

return result;



pascal OSStatus MyAppEvent Handl er ( Event Handl er Cal | Ref handl er Ref ,
Event Ref event, void *userDat a)
{

0SSt at us result = event Not Handl edErr ;
HI Conmand command;
W ndowRef w ndow;

Get Event Paraneter ( event, kEvent ParanDirect Obj ect, typeH Conmrand,
NULL, sizeof (H Conmmand), NULL, &conmmand );
switch ( command. commandl D )
{
case kNewwbr dW ndowConmand:
ShowwW ndow( gWbr dW ndow ) ;
result = noErr;
br eak;
case kNewNumber W ndowComrand:
ShowwW ndow( gNunber W ndow ) ;
result = noErr;
br eak;
case kd oseFront W ndowConmand:
wi ndow = Front Wndow() ;
H deW ndow( wi ndow );
result = noErr;
br eak;

}

return result;

}



Updating Window Content

A window's content can come from resourcesin anib file. Up to this point in the book, that's always been the
case. If awindow included a button, it was from a button item added to the window resource. If a window
included text, it was from a static text item added to the window resource.

The Carbon Event Manager, by way of its standard event handlers, knows how to update a window to properly
draw all its resource-related content. The code so far in this book verifies this. None of the example programs
includes any code to update a window; yet, when an example program is run and its window is obscured and then
returned to full view, the window's contents are correctly redrawn.

Y our program likely will include one or more windows that include content generated from resource items.
However, your program also might include one or more windows that include dynamic content-text, graphics, and
pictures. The system will handle resource-related window content updates for you, but the updating of
codegenerated window content is up to you.

Introduction to Window Updating

Here's how your program will handle window updating: you write a routine that draws the window's content, and
then you make sure that the routine gets called when awindow update event occurs. That's a bit of an
oversimplification, but it sums up nicely how window updating works, and it hints that this task won't be difficult
to handle.

A window's content can be any combination of many entities: text, numbers, simple graphics, complex graphics,
digitized images, movies, and on and on. The particulars of updating each type of content varies. The general
approach to updating doesn't.

In this section of the chapter, I'll select one type of content-text-and examine how that content is updated. After
you understand the updating technique for text, you'll be able to apply it to other types of content, such as

graphics.
Drawing Text to a Window

The easiest way to display a small amount of text in awindow isto use the Carbon Dr awsSt r i ng routine. The
Dr awSt r i ng routine was briefly mentioned in Chapter 3. Dr awSt r i ng accepts a Pascal-formatted string (a
string prefaced by \ p) asits one argument, and it then proceeds to draw that string to a specified window. Where
that text is drawn depends on the current position of the graphics pen.

Graphics pen is the term given to a set of values that collectively specify how subsequent drawing should take
place. For instance, the graphics pen specifies the thickness of linesthat are drawn and the pixel location for the
start of adrawing. In the case of drawing text, the starting location (the positioning of the graphics pen) is
important. Y ou set this starting position by calling the Carbon VoveTo routine.

Asitsnameimplies, VbveTo moves the graphics pen to a specified location. Vbve To accepts two arguments: the
horizontal placement of the pen and the vertical placement of the pen. The upper-left corner of awindow's content
areais considered to have an x, or horizontal, value of 0, and ay, or vertical, value of 0. Thus, the following call

to MbveTo would establish the starting point for drawing at 10 pixelsin from the left edge of awindow and 30
pixels down from the top of that window:



MoveTo( 10, 30 );

The WindowUpdate example program that follows this discussion includes acall to VbveTo. That call setsthe
graphics pen 30 pixelsin from the left of the window and 60 pixels down from the top of that window. Y ou can
peek ahead at Figure 4.8 to see that example program's window and take note of where the T of the word This

from the string Thisis drawn from code! starts. That string is the result of the following code:

Figure 4.8. The window displayed by the WindowUpdate program.
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MoveTo( 30,60 );
DrawString( "\pThis is drawn from code!" );

Updating Text

Now you know how to draw text in awindow. However, drawing text once doesn't have anything to do with
updating that text. If you include acall to Dr awSt r i ng inyour program's main routine, the text might very well
be drawn to your program's window. Obscure that window by dragging most of it offscreen and then reveal it
again by dragging it back onscreen, and the result will be awindow void of the text! This happens because the call
to Dr awSt r i ng needsto be made each time the window needs to be updated (or redrawn or refreshed). Y our
program can become aware of when awindow needs updating by watching for awindow update event. Such an
event hasaclassof kEvent Cl assW ndowand akind of kEvent W ndowDr awCont ent :

Event TypeSpec w ndowEvent ;

W ndowEvent . event Cl ass =

kEvent Cl assW ndow;,

w ndowEvent . event Kind = kEvent W ndowDr awCont ent ;

Now is as good atime as any to point out that the previous method of defining an event-declaring the event
specification variable and then assigning values to each of its two members-isn't the only way of defining that
event. An alternate means of accomplishing the same task is to perform the assignment at the time of the
declaration:

Event TypeSpec wi ndoweEvent = { kEvent Cl assW ndow,
kEvent W ndowDr awCont ent };

Regardless of how the event is defined, the next step is to use the event in the install ation of awindow event
handler. In the following code, it's done to install an event handler routine named \W ndowEvent Handl er for a
window that's already been created with acall to Cr eat eW ndowr oniNi b:

Event Tar get Ref target;

Event Handl er UPP handl er UPP;

Event TypeSpec wi ndowkEvent = { kEvent Cl assW ndow,
kEvent W ndowDr awCont ent };

target = Get WndowEvent Target ( w ndow );



handl er UPP = NewEvent Handl er UPP( W ndowkvent Handl er ) ;
I nstal | Event Handl er ( target, handl erUPP, 1, &wm ndowEvent,
(void *)w ndow, NULL );

Now let's take alook at the event handler. This routine should extract the affected window from the user Dat a
argument so that the proper window can be updated. Call Get Event Ki nd to verify that the event is awindow
update event, and then call an application-defined Updat e\W ndow routine to carry out the actual updating.

pascal OSStatus W ndowkEvent Handl er ( Event Handl er Cal | Ref handl er Ref,
Event Ref event, void *userData)

{
OSSt at us result = event Not Handl edErr;
Ul nt 32 event Ki nd;
W ndowRef w ndow;
wi ndow = ( W ndowRef )userDat a;
event Kind = Get Event Ki nd( event );
I f ( eventKind == kEvent W ndowDr awCont ent )
{
Updat eW ndow( wi ndow ) ;
}
return result;
}

Before moving on to the code that makes up the Updat e\W ndow routine, take another look at the f statement
in the preceding W ndowEvent Handl er function. Recall from previous event handlers that after an event is
handled, r esul t issetto noEr r to let the Carbon Event Manager know that it does not have to handle the
event. The preceding routine doesn't do that. The effect of thisisthat r esul t keepsitsinitia value of

event Not Handl edEr r , which gets returned to the Carbon Event Manager. That means that the Carbon Event
Manager won't be aware of the handling of the event, and it too will handle the event using its standard event
handler for thistype of event.

Building on this concept, your Updat e\W ndow routine will update the content of the window for which your
program's code is responsible. This content might be created by callsto Dr awSt r i ng. Your Updat eW ndow
routine won't update resource-related content. As you've done in the past, you'll leave that up to the system. By
telling the Carbon Event Manager that the update event wasn't handled, you're letting the Carbon Event Manager
know that it should go forth with its normal updating of resource-related window content.

Now comesthe Updat e\W ndow routine. Thereis no one way to write to aroutine; it's truly application-specific.
A program that draws one line of text in awindow will have an Updat e\W ndow routine that might include just a
single call to MoveTo and asingle call to DrawString. A program that draws text, graphics, and picturesin a
window will have an Updat e\W ndow routine that could include dozens of callsto avariety of QuickDraw
graphics routines. (QuickDraw isthe topic of Chapter 7, "QuickDraw Graphics.") Two points will generaly hold

true, though: the function needs to know which window to update and that window's port needs to be set:

voi d Updat eW ndow( W ndowRef w ndow )

{
Set Port W ndowPort ( wi ndow ) ;

/'l code to draw the contents of the wi ndow goes here



Before a program starts calling drawing routines, it should specify where that drawing isto take place. On a
Macintosh, drawing takes place in aport. In Macintosh programming parlance, a port is a data structure that
defines a drawing environment.

The computer screen itself is considered a port. That makes it possible for the system to direct drawing of the
desktop to the monitor. Each window has a port, which makes it possible for your program to specify to which
window drawing should take place. If you don't specify the port in which drawing isto take place, the results will
be unpredictable. Y our drawing might work as you intended, or it might not. The Carbon

Set Port W ndowPor t routine lets you specify the port to which to draw. Pass this routine areferenceto a
window and all subsequent drawing routines will operate in the port of that window.

WindowUpdate Program

The purpose of the WindowU pdate program is to demonstrate a technique for updating the application-defined
content of awindow.

Figure 4.8 shows the results from running the WindowUpdate program. As you can surmise from the content of

the window, this program demonstrates the updating of content derived from resources (a static text itemin a
window resource) and from code (a string of text drawn from acall to Dr awsSt r i ng in an update routine).

The nib file holds awindow with one static text item, as shown in Figure 4.9. It isn't important what text appears

in the static text item. In fact, it isn't even important what kind of resource item appears in the window. What is
important, however, isthat you can verify that the program updates resource-related content and code-created
content.

Figure 4.9. The window resour ce from the UpdateWindow nib file.
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As shown in the program source listing in Example 4.6, the program uses the technique of responding to an event

of classkEvent Cl assW ndowand kind kEvent W ndowDr awCont ent . When such an event occurs, the
event handler calls this application-defined routine:

voi d Updat eW ndow( W ndowRef wi ndow )

{
FMFont Fam |y font Fam | y;

Set Port W ndowPort ( wi ndow ) ;

fontFam |y = FMGzet Font Fami | yFronNane( "\ pTi nes" );
Text Font ( fontFamly );

Text Face( bold + italic );

Text Si ze( 24 ),

MoveTo( 30, 60 );

DrawString( "\pThis is drawn from code!" );



Updat eW ndow could simply draw aline of text in the system font, but I've opted to take this opportunity to
demonstrate the use of afew Carbon routines that alter the characteristics of the drawn text. Back in Figure 4.8,
you saw the line of text that results from the call to Updat e\W ndow. The font used in the drawing is set with a
cal to Text Font . Beforecalling Text Font , cal FMzet Font Fam | yFr onName to get aFVFont Fami |y
reference to the desired font. Pass FVet Font Fam | yFr onNae the name of the font of interest. Even though
you're programming in C, this routine is expecting the font name in the form of a Pascal string, so preface the
name with\ p.

To change the face, or style, of drawn text, call Text Face. Use Apple-defined constants alone or in conjunction
with one another as the argument to Text Face. Thevaluesbol d, i t al i ¢c,and nor mal arethree of the
constants. Chapter 7 lists the others. To change the size of text that's drawn by callsto Dr awst r i ng, you'll use
the Text Si ze routine. Pass Text Si ze the sizein points.

After callsto characteristic-changing routines such as Text Font , Text Face, and Text Si ze, all subsequent
drawing of text takes place with the newly specified look. To draw text with a different look, call any one of the
same routines, asillustrated in the following code:

Text Face( bold );

MoveTo( 10, 30 );

Drawstring( "\pThis text is bold." );

Text Face( italic );

MoveTo( 10, 50 );

DrawString( "\pThis text appears is italic." );

Example 4.6 UpdateWindow Sour ce Code

#i ncl ude <Car bon/ Car bon. h>

pascal OSStatus W ndowEvent Handl er ( Event Handl er Cal | Ref handl er Ref,
Event Ref event, void *userData );

voi d Updat eW ndow( W ndowRef wi ndow );

int main(int argc, char* argv[])

{
| BNi bRef ni bRef ;
0SSt at us err;
W ndowRef w ndow;

Event Tar get Ref target;
Event Handl er UPP handl er UPP;
Event TypeSpec wi ndowkEvent = { kEvent C assW ndow,
kEvent W ndowDr awCont ent };

err = CreateN bReference( CFSTR("nain"), &nibRef );
err = Set MenuBar FronmNi b( ni bRef, CFSTR("Mai nMenu") );
err = Creat eW ndowFr omNi b( ni bRef, CFSTR(" Mai nW ndow'), &wi ndow );

Di sposeNi bRef erence( ni bRef );

target = Get Wndowkvent Target ( w ndow );

handl er UPP = NewEkvent Handl er UPP( W ndowEvent Handl er );

I nstal | Event Handl er ( target, handl erUPP, 1, &w ndowEvent,
(void *)w ndow, NULL );



ShowwW ndow( wi ndow ) ;
RunAppl i cati onEvent Loop() ;

return( 0 );

pascal OSStatus W ndowkvent Handl er ( Event Handl er Cal | Ref handl er Ref,
Event Ref event, void *userData)

{
OSSt at us result = event Not Handl edErr;
Ul nt 32 event Ki nd;
W ndowRef w ndow;
wi ndow = ( W ndowRef )user Dat a;
event Ki nd = Get Event Ki nd( event );
I f ( eventKind == kEvent W ndowDr awCont ent )
{
Updat eW ndow( wi ndow ) ;
}
return result;
}

voi d Updat eW ndow( W ndowRef wi ndow )
FMFont Fam |y font Fam | y;
Set Port W ndowPort ( wi ndow ) ;

fontFam |y = FMGzet Font Fami | yFronNane( "\ pTi nes" );
TextFont( fontFamly );

Text Face( bold + italic );

Text Si ze( 24 );

MoveTo( 30,60 );

DrawString( "\pThis is drawn from code!" );

}

Updating Multiple Windows

This chapter's MenuButtonCloseWindows exampl e created two windows, each tracked by a global window
reference variable. The program defined one window event handler and then installed that same handler for each
window. In that example, the event handler responded to a window close event so that a click of awindow's Close
button would result in the hiding of the window instead of the actual disposing of the window. If a program that
used global window references instead wanted to watch for update events, a similar technique could be used.
Instead of awindow close event, you would define a window update event:

Event TypeSpec wi ndowkEvent = { kEvent C assW ndow,
kEvent W ndowDr awCont ent };

Y ou would then create one window and install the event handler for that window:



W ndowRef gW ndowTypel;
err = CreateWndowFromNi b( ni bRef, CFSTR("Mi nW ndow'), &JW ndowTypel );

target = Get WndowEvent Tar get ( gW ndowTypel );

handl er UPP = NewEvent Handl er UPP( MyW ndowEvent Handl er ) ;

I nstal | Event Handl er ( target, handl erUPP, 1, &wm ndowEvent,
(void *)gW ndowTypel, NULL );

Y ou would do this for each type of window, making sure that the establishment of the target and the installation of
the event handler routine used the same window reference. This was done in the preceding code;
gW ndowTypel appearsin callsto both Get W ndowtEvent Tar get and | nst al | Event Handl er.

The window event handler should determine if the window-related event is of the

kEvent W ndowbDr awCont ent kind and, if itis, call the appropriate application-defined update routine. In the

user Dat a argument, the window event handler will have received areference to the affected window. That's the
window that should be passed to the update routine. Here's the pertinent part of the window event handler routine:

wi ndow = ( W ndowRef )user Dat a;
event Ki nd = Get Event Ki nd( event );

if ( eventKind == kEvent W ndowDr awCont ent )

{
if ( window == gW ndowTypel )
Updat eW ndowTypel() ;
else if ( window == gW ndowType2 )
Updat eW ndowType2() ;
}

Each update routine should hold the code necessary to redraw one type of window.
The next program, MultipleWindowUpdate, provides an example.
MultipleWindowUpdate Program

The purpose of the MultipleWindowUpdate program is to expand on the single-window updating technique
described in the previous example program, WindowUpdate.

Asshown in Figure 4.10, MultiplewWindowUpdate displays two windows, each with a different line of text in it.

The program uses the technique of keeping track of each window by means of global window reference variables,
as described in this chapter's "Using Global Variables to Reference Windows" section. An example of updating

multiple windows of the same type so that each can hold different information (such as document windows
created by choosing New from the File menu) can be found in this chapter's "Window Data and Multiple

Windows" section.

Figure 4.10. The windows displayed by the MultipleWwindowUpdate program.
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The nib file for this project requires two window resources. This example uses a document window and a utility
window, but you're free to change the window types. In the nib file, the windows should be named Vai n\W ndow
and | nf oW ndow. If you use different names, you'll need to change the argumentsto callsto

Creat eW ndowkr oniNi b to match your names. Both windows are empty. Their content will be created in
window update routines in the source code. The program doesn't make use of any of the menu items, so you can
leave the menu bar resource unchanged.

Example 4.7 contains the entire listing for the example program. Here you see an exampl e of the multiple window
updating technique described in the previous section: aglobal variable is declared for each of two window types,
and asingle event handler is used to invoke the proper update routine for the window that needs to be redrawn.
The code that comprises each update routine is similar to the code discussed in the previous example,
WindowUpdate.

Example 4.7 M ultipleWindowUpdate Sour ce Code

#i ncl ude <Car bon/ Car bon. h>

pascal OSStatus MyW ndowkvent Handl er ( Event Handl er Cal | Ref handl er Ref,
Event Ref event, void *userData );

voi d Updat eMai nW ndow( void );

voi d Updat el nf oW ndow( void );

W ndowRef gMai nW ndow,
W ndowRef gl nf oW ndow,
int main(int argc, char* argv[])
{
| BNi bRef ni bRef ;
OSSt at us err;

Event Tar get Ref target;
Event Handl er UPP  handl er UPP;
Event TypeSpec wi ndowkEvent = { kEvent C assW ndow,
kEvent W ndowDr awCont ent };

err = CreateN bReference( CFSTR("main"), &nibRef );
err = Set MenuBar FromNi b( ni bRef, CFSTR(" Mai nMenu") );
err = CreateW ndowFromNi b( ni bRef, CFSTR("Mai nW ndow"), &gMai nW ndow) ;

target = Get WndowEvent Target ( gMai nW ndow ) ;

handl er UPP = NewEvent Handl er UPP( MyW ndowEvent Handl er );

I nstal | Event Handl er ( target, handlerUPP, 1, & ndowEvent,
(void *)gMai nW ndow, NULL );

err = Creat eW ndowFr omNi b( ni bRef, CFSTR("I nfoW ndow'), &gl nfoW ndow);



target = Get Wndowkvent Target ( gl nf oW ndow ) ;

handl er UPP = NewEvent Handl er UPP( MyW ndowEvent Handl er ) ;

I nstal | Event Handl er ( target, handl er UPP, 1, &w ndowkEvent,
(void *)glnfoWwndow, NULL );

Di sposeNi bRef erence( ni bRef );

Showw ndow( gMai nW ndow ) ;
ShowwW ndow( gl nf oW ndow ) ;

RunAppl i cati onEvent Loop() ;

return( 0 );

pascal OSStatus MyW ndowkvent Handl er ( Event Handl er Cal | Ref handl er Ref,

{

vVoi

voi

Event Ref event, void *userDat a)
OSSt at us result = event Not Handl edErr ;
Ul nt 32 event Ki nd;
W ndowRef w ndow;
wi ndow = ( W ndowRef )userDat a;

event Kind = CGet EventKi nd( event );

if ( eventKind == kEvent W ndowDr awCont ent )

{
if ( window == gMVai nW ndow )
Updat eMai nW ndow( ) ;
else if ( window == gl nf oW ndow )
Updat el nf oW ndow() ;
}

return result;

d Updat eMai nW ndow( void )
FMFont Fami |y font Fam | y;
Set Por t W ndowPort (  gMai nW ndow ) ;

font Fam |y = FMGet Font Fami | yFromName( "\ pTi nes" );
TextFont ( fontFamly );

Text Face( bold + italic );

Text Si ze( 36 );

MoveTo( 30,60 );

DrawString( "\pMain Wndow' );

d Updat el nf oW ndow( void )



FMFont Fami |y font Fam | y;
Set Por t W ndowPor t (gl nf oW ndow ) ;

font Fam |y = FMGet Font Fami | yFromName( "\ pArial" );
Text Font ( fontFamly );

Text Face( bold );

Text Si ze( 18 );

MoveTo( 60, 35 );

Drawstring( "\plnfo Wndow' );



Associating I nformation with Windows

Y ou've seen that it's easy to use Interface Builder to define windows that display information such as text
or pictures. Using awindow resource to define the content of awindow is a great technique for creating a
window for datainput, such as awindow used as a spreadsheet, or for creating awindow that displays
information for the user to view, such as an About window that reveals copyright information about a
program.

On the other hand, a window resource isn't always useful for defining awindow that will have dynamic
content. For example, you might use a window resource to define the content of a window that displays a
picture of the program's creator (that would be you). However, if your program opens a window that
enables the user to add one or more pictures of hisor her own choosing, defining that window's content in
advance isimpossible. For situations in which the user creates window content during program execution,
anonresource solution isin order.

Experienced Mac Programmer

Of coursg, it is possible to set up dynamic content display in awindow resource. In the past,
you might have used a user item in aWIND resource (or auser pane in awindow nib resource)
to provide a means of adding window content during runtime. That's sidestepping the issue a
bit, though. In this section, I'm leading up to a means of creating multiple, complex windows,
such as those that would be found in a program that enables the user to add text, numbers, and
pictures in various combinations at various locations within each window.

A window can display any kind of information. Text, numbers, or pictures are common entities making up
the content of awindow. A window also can display a QuickTime movie, or it can "hold" a sound. In
addition, depending on what features a programmer wants to provide, a program can hold any combination
of these entities.

A program that supports the display of just one type of content can enable each of its windows to display
different forms of that same content. For instance, a text editor that enables only the entry of text will
enable each open window to hold different passages of text. Thus, when it comes to associating
information with windows, there are a few techniques to master.

Y ou'll want to know the simplest technique first: how to associate one piece of information, such asa
number, with asingle window. Beyond that you'll want to know how to associate different types of
information, such as several numbers, a picture, and a string of text, with asingle window. Finally, you'll
want to know how to make sure that the information associated with different windows is tracked. For
instance, when two windows in the text editor program you're developing need updating, you'll want to
make sure that the correct text gets displayed in the proper window. In this section, you'll see how your
program's windows can include all these features.

Associating a Single Variable With a Window



To associate data with awindow, you'll rely on the Carbon Set W ndowPr oper t vy routine.
To retrieve awindow's data, you'll use the corresponding Cet W ndowPr oper ty routine.
Setting a Window's Data

The Set W ndowPr oper t y routine accepts a pointer to the data to associate with the window; thus, that
datacan be astrivia asasingle variable (suchasan i nt variable that holds a number) or as complex as a
large structure (that might have numerous fields to hold text, pictures, movies, and so forth).

I'll start out simple by demonstrating how to use Set W ndowPr oper t v to associate one piece of
information with awindow. Here's the prototype for Set W ndowPr operty:

OSSt at us Set W ndowPr operty( W ndowRef w ndow,
PropertyCreator propertyCreator,
PropertyTag propertyTag,
Ul nt 32 propertySi ze,
void * propertyBuffer );

Thewi ndow parameter is areference to the window with which to associate the data.
This parameter is the variable returned by Cr eat e\W ndowr onNi b when the window was created.

ThepropertyCreat or isacreator code, which istypically the application's signature. When you build
an application, you have the option of providing it with a fourcharacter code. This code is used by the
desktop to relate document files created by your application to your application. For instance, if you
double-click a Microsoft Word file on the desktop, the system knows to open that file in Microsoft Word.
If you don't provide your application with a signature, you can pass 0 asthe pr oper t yCr eat or vaue.

Thepr oper t yTag isafour-character identifier that you provide for this one piece of data. Later, when it
comestime to retrieve this data (with acall to the Get W ndowPr oper t y routine), you'll use the same
propertyTag. You can useany four characters you want for this value.

ThepropertySi ze tels Set W ndowPr oper t v the size of the data. Thissizeisin bytes, so you can
usesi zeof to getthisvaue. For instance, if the data consists of just one integer, you could passsi zeof
(int ) here If thedataisastructure, you'll usesi zeof with the structure type, asinsi zeof

(- MyW ndDat aSt ruct ) . The MoreWindowlnfo example program that follows the WindowInfo
example program provides an example of using a structure to hold window data.

Finally, it'stime to consider the data. The pr oper t yBuf f er isageneric pointer that points to the
memory that holds the data to associate with the window. For a single piece of data, such as an integer,
you'll pass the address of the integer variable, asin & heNurber . For astructure, you'll first create a
handle to the structure and then pass a pointer to that handle. Don't worry; that processisn't as complicated
asit sounds! This chapter's"Associating a Window with a Structure” section provides an example of how
to do this.

Thisfollowing snippet of code provides alook at how Set W ndowPr oper t v can be used to associate a
single value-an integer-to awindow:



Ul nt 32 wi ndowNunber = 99;
W ndowRef w ndow;

err = CreateW ndowrFr omNi b( ni bRef, CFSTR("Mai nW ndow'), &w ndow );

Set W ndowPr operty( w ndow, 0O, "test", sizeof( Unt32 ),
&wm ndowNunber );

This example associates the number 99 with the window created from the previous call to

Creat eW ndowkr onNi b. The program isn't using an application signature, so avalue of 0 is passed as
the second argument. | somewhat arbitrarily chose test as the fourcharacter property tag. The characters
that make up the tag aren't important, as long as the exact same characters are used in the

Cet W ndowPr oper ty cal that will follow.

The Ul nt 32 datatype isacommonly used Carbon data type for a variable that's to hold an unsigned
integer. Using si zeof with this data type provides the size in bytes of thistype. Prefacing the data-
holding variable name with & sends the address of the w ndowNunber variableto

Set W ndowPr operty.

Retrieving a Window's Data

After associating data with awindow, you'll eventually want to retrieve that data. If the data consists of
information about the content of the window (such as text or graphics that are displayed in the window),
thisis when you'll want to update the window.

On the other hand, if the data consists of other information, such as user-entered numbers, the time to
retrieve the window data might be when the user specifies that some calculation involving the datais to
take place. In any case, you'll use the Carbon routine Get W ndowPr oper t vy to retrieve previously
stored window information:

OSSt at us Get W ndowPr operty( W ndowRef w ndow,
PropertyCreator propertyCreator,
PropertyTag propertyTag,
Ul nt 32 bufferSi ze,
U nt32 * actual Si ze,
void * propertyBuffer );

If you take alook back at the prototype for the Set W ndowPr oper t y routinein the "Setting a
Window's Data" section, you'll see that most of the parameters for that routine match those of

Cet W ndowPr oper t y. Thefirst parameter, wi ndow, isthe window to examine for associated data.
ThepropertyCreat or andpropertyTag are each fourcharacter strings that should match the
corresponding arguments previously passed to Set W ndowPr oper ty for this same window. The
buf fer Si ze isthe size, in bytes, of the data to retrieve. This argument should match the
propertySi ze argument passed to Set W ndowPr oper ty for thiswindow. act ual Si ze isa
pointer to avariable.



Cet W ndowPr oper t y usesthisvariable to hold the actual size of the datato retrieve. This size should
of course matchthebuf f er Si ze, soif you aren't interested inthisact ual Si ze, you can pass avaue
of NULL here. Findlly, thepr opert yBuf f er isageneric pointer to the memory that will, upon
completion of Get W ndowPr oper t vy, hold the window's data.

The following snippet shows how to retrieve the data associated with a window. I've included the call to
Set W ndowPr oper t y to emphasize that acall to Set W ndowPr oper t y must precede acall to

Cet W ndowPr oper ty (or else there will be no datato retrieve) and to demonstrate how similar the
arguments to the two routines are. After you've figured out how to call Set W ndowPr oper ty for your
particular situation, you then know how to call Get W ndowPr operty.

Ul nt 32 wi ndowNunber = 99;
W ndowRef w ndow;
Ul nt 32 t heNunber ;

err = CreateW ndowrFr omNi b( ni bRef, CFSTR("Mai nW ndow'), &w ndow );

/| associate the data (99) in variable wi ndowNunber with a w ndow.
Set W ndowPr operty( wi ndow, 0, 'test', sizeof( Unt32 ),
&M ndowNunber );

/Il retrieve the data (99) fromthe wi ndow and store it in theNunber:
Get W ndowPr operty( wi ndow, 0O, '"test', sizeof( Unt32 ),
NULL, &t heNunber );

Windowl nfo Program

The purpose of the Windowlnfo program is to demonstrate the use of Set \W ndowPr oper ty and

Cet W ndowPr oper t vy to associate data with a window, and then to retrieve that data from a window.
This program associates a single integer value with awindow. The next example in this chapter,
MoreWindowInfo, demonstrates associating a structure with a window.

WindowInfo displays one window with the number 2 written to it. It isn't important what number is used.
I'm simply showing how data can be assigned to awindow, and then later retrieved during the updating of
the window. This program doesn't make use of any menu items, and the window that displays the number
isinitially empty, so providing details about the project's nib file are unimportant. Simply make sure
there's awindow named MainWind in the nib file and you're all set to go.

Example 4.8 provides the entire source code listing for the Windowlnfo program. After creating a new
window, the program calls Set \W ndowPr oper t vy to associate the number 2 with the window. The one
event the program looks for is an update event, as discussed in this chapter's "Updating Window Content"
section. When an update event occurs, My W ndowEvent Handl er isinvoked. That routine calls the
application-defined routine UpdateWindow to redraw the window's contents. To do this, the window's data
(the number 2) isretrieved and that data is drawn to the window.



In previous examples, you've seen that Dr awSt r 1 ng isused to draw astring of text to awindow.
Because this program's window has a number associated with it, and because | want to draw that number
to the window, a conversion needs to take place. The Carbon routine NumroSt r i ng accepts an integer as
its first argument and returns the string version of that number in the second argument. Here's how variable
wi ndowNunber getsitsvaue:

Ul nt 32 wi ndowNunber ;

Get W ndowPr operty( wi ndow, 0O, '"test', sizeof( Unt32 ),
NULL, &w ndowNunber );

In the following code, NuniroSt r i ng is called to convert the integer value in the variable
wi ndowNunber toastring held in variable nunber St r:

Str 255 nunmber Str ;

NumroSt ri ng( w ndowNunber, nunber Str );

Now Dr awsSt r i ng can be called to draw the string, with the result being the number 2 being written to
the window:

DrawString( nunberStr );
Example 4.8 Windowlnfo Sour ce Code

#i ncl ude <Car bon/ Car bon. h>

pascal OSStatus MyW ndowkEvent Handl er ( Event Handl er Cal | Ref handl er Ref,
Event Ref event, void *userData );

voi d Updat eW ndow( W ndowRef w ndow );

int main( int argc, char* argv[] )

{
| BNi bRef ni bRef ;
OSSt at us err:
W ndowRef wi ndow;

Event Tar get Ref target;
Event Handl er UPP  handl| er UPP;
Event TypeSpec wi ndowkEvent = { kEvent Cl assW ndow,
kEvent W ndowDr awCont ent };
Ul nt 32 wi ndowNunber = 2;

Creat eNi bRef erence( CFSTR("nmai n"), &nibRef );
Set MenuBar Fr onNi b( ni bRef, CFSTR(" Mai nMenu") );
Creat eW ndowFr omNi b( ni bRef, CFSTR(" Mai nW ndow'), &w ndow );

err
err
err

target = Get Wndowkvent Target ( w ndow );
handl er UPP = NewEvent Handl er UPP( MyW ndowEvent Handl er );



&

I nstal | Event Handl er ( target, handlerUPP, 1, &M ndowEvent,
(void *)wi ndow, NULL );

Set W ndowPr operty( wi ndow, 0O, 'test', sizeof (U nt32),
ndowNunber) ;

Di sposeNi bRef erence( ni bRef );
ShowwW ndow( wi ndow ) ;
RunAppl i cati onEvent Loop() ;

return( 0 );

pascal OSStatus MyW ndowkEvent Handl er ( Event Handl er Cal | Ref handl er Ref,

{

VoI

Event Ref event, void *userDat a)

0SSt at us result = event Not Handl edErr ;
Ul nt 32 event Ki nd;
W ndowRef w ndow;

wi ndow = ( W ndowRef )userDat a;
event Kind = Get Event Ki nd( event );

if ( eventKind == kEvent W ndowDr awCont ent )
{

Updat eW ndow( wi ndow );
}

return result;

d Updat eW ndow( W ndowRef w ndow )

FMFont Fam |y font Fam | y;
Ul nt 32 wi ndowNunber ;
Str 255 nunmber Str;

Set Port W ndowPort ( wi ndow ) ;

Get W ndowPr operty( wi ndow, 0, 'test', sizeof( Unt32 ),
NULL, &w ndowNumnber );

NunmiroSt ri ng( wi ndowNunber, nunber Str );

fontFam |y = FM&et Font Fam | yFr omNane( "\ pTi mes" );
Text Font( fontFamly );

Text Face( bold + italic );

Text Si ze( 36 );

MoveTo( 150, 60 );



DrawStri ng( nunberStr );

Associating a Structure with a Window

Using asingle piece of information, such as a number, as the data to associate with awindow provides a
good look at how Set W ndowPr oper ty and Get W ndowPr oper t y are used. However, if your
program associates data with a window, it's going to associate more than one value with that window.
Set W ndowPr operty and Get W ndowPr oper t v each work with only one piece of information.
Bundling al your window's data into a single structure is how you get around this apparent limitation.

The first thing you need to do is to define a structure that includes the fields appropriate to storing
whatever datais to be associated with your program’'s window. The following snippet defines a structure
that holds one integer and one string. The structure your program needs will differ, but the techniques that
I'll be describing still apply.

t ypedef struct
{
Ul nt 32 nunber ;
Str 255 string;
} WndowbDat a, **W ndowDat aHandl e;

The preceding structure is given the data type name of \W ndowbDat a .The code aso defines the data type
W ndowbDat aHand! e, which serves as a handle to the W ndowbDat a structure. A handle, whichisa
pointer to a pointer, is a data type commonly used in Macintosh programming.

Before associating a structure with awindow, you'll want to declare a structure of type \W ndowDat a and
then reserve the memory space necessary to hold such a structure. Y ou can do that by using the Carbon
routine NewHand! e, which specifies the number of bytesto reserve. Y ou can typecast the result so that
instead of a generic handle, you have a handle that references a\W ndowbDat a structure:

W ndowDat aHandl e wi ndDat aHndl ;

wi ndDat aHndl = ( W ndowDat aHandl e ) NewHandl e( si zeof ( WndowData ) );

With memory reserved for the W ndowbDat a structure and a means to reference that memory, it'stimeto
fill the structure's fields with values. For a numerical field likethe nunber field, you dereference the
handle twice. Dereferencing a handle once resultsin a pointer to the structure; dereferencing ahandle a
second time results in the structure itself. Y ou then access the field of interest. Herethe nunber field of
the W ndowbDat a structure referenced by thewi ndDat aHndl variable is being assigned the value 5:

Ul nt 32 t heNunber = 5;

(**w ndDat aHndl ) . nunber = t heNunber;

Next, you assign avalue to the string field of the structure. Assigning a string variable avalue at the time
of declaration is easy:

Str255 theString = "\ pCopyright (c) 2001"



A Str 255 variableisn't asingle value. It's actually an array of characters, so assigning a string variable
after the string is declared is alittle trickier. One way to do thisisto use the Carbon Bl ockMbveDat a
routine to transfer a block of memory (the block that holds an existing string) to another block of memory
(the block pointed to by a different string variable). Here's an example of that technique:

Si ze nunByt es;

nunBytes = theString[0] + 1;
Bl ockMoveDat a( theString, (**w ndDataHndl).string, nunBytes );

Thefirst argument to Bl ockVbveDat a isthe source string, which isthe string that holds avalue that is
to be copied to another string. The second argument is the destination string, which is the string that will
hold the copied value when Bl ockVbveDat a has executed. The final argument is the number of bytesto
copy, which are the bytes in the source string.

Asmentioned, an St r 255 isan array. It'san array that can hold up to 255 characters, but it also can hold
any number of characters lessthan that. The first element in the array holds the actual number of
charactersin the array. Thus, the byte size of an St r 255 variable is the number of charactersin the array
(as specified in element [0]) and one extra byte to account for the first count-holding element (element [O]
itself). The variable nunByt es holds the total byte length of the string.

After assigning valuesto the nunber and st ri ng fields of the structure, the structure can be used as the
data to be associated with awindow. A call to Set W ndowPr oper t y does that:

Set W ndowPr operty(w ndow, O, 'test', sizeof(WndowData),
&w ndDat aHndl ) ;

The size of the datais simply the size of the structure; si zeof providesthat value. The pointer to the data
Isapointer to the structure's handle variable.

You've seen how acall to Get W ndowPr oper t y ismade to retrieve a single value from awindow.

Using that routine with a structure works in a similar fashion. Before making the call, you will need to
allocate storage space for the structure to retrieve. Y ou can do this by setting up a structure to be used

before the call to Set W ndowPr operty:

W ndowDat aHandl e wi ndDat aHndl ;

wi ndDat aHndl = ( W ndowDat aHandl e ) NewHandl e( si zeof ( WndowData ) );

Alternately, you could declare aglobal \W ndowbDat aHand! e variable, allocate memory for it (perhaps
inmai n ), and then use that variable for both setting and getting window data.

Recall that the first four Get W ndowPr oper t y arguments will be similar to the first four

Set W ndowPr oper t y arguments. The fifth argument can be NUL L if you don't need to verify that the
actual data size matches the expected size. The sixth argument matches the last argument to

Set W ndowPr oper ty. It'sapointer to a block of memory of the appropriate size to hold the retrieved
data:



Get W ndowPr operty( wi ndow, O, 'test', sizeof( WndowData ),
NULL, &w ndDataHndl );

After retrieving a handle to a structure, you need to dereference the handle to access the various members
of the structure. Here's how that's done for the integer held in the nunber member of this example's
structure:

Ul nt 32 t heNunber ;

t heNunber = (**w ndDat aHndl ). nunber;

For the string member in this example, you get the number of bytesin the string. With the following code,
you can move that many bytesinto alocal string variable:

Si ze nunByt es;

Str 255 theString;

nunBytes = **w ndDat aHndl ).string[0] + 1;

Bl ockMoveDat a( (**w ndDataHndl ) .string, theString, nunBytes );

Now that the structure members are stored in local variables, your program can use the window data. For
example, the content of the window (such as text or pictures) could be associated with the window and
then used in updating the window's contents. Such an example is discussed next.

MoreWindowl nfo Program

The purpose of the MoreWindowInfo program isto expand on the technique demonstrated in the previous
example,WindowlInfo. In this program, a structure, rather than asingle value, is associated with a window.

The MoreWindowlInfo program displays the window shown in Figure 4.11. The text And the number is...
comes from a string stored in the string member of a structure associated with the window. The number 5
comes from an integer stored in the same structure. When the window requires updating, the structure
associated with the window is retrieved, the structure's string is drawn to the window, and the structure's
integer is converted to a string and drawn to the window.

Figure 4.11. Thewindow displayed by the M oreWindowl nfo program.
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Just like the previous example, Windowlnfo, the MoreWindowInfo program doesn't use any menu items
and the program's window starts out empty. That means that you don't need to put any work into the nib
file. If the nib file has a window named MainWind, you're all set.

The source code listing for MoreWindowlInfo appearsin Example 4.9. Thest r uct used to hold window
dataisthe same structure we just described. It consists of anunber member and ast r i ng member. In



Example 4.9, asingle global variableis used in al instances in which a structure of this type needsto be

used. This means that memory for the structureis allocated just once (in nai n in this example). The
structure is used as a temporary holding place of sorts to store data to assign to a window and to hold data
just retrieved from a window.

Example 4.9 M oreWindowl nfo Sour ce Code

#i ncl ude <Car bon/ Car bon. h>

pascal OSStatus MyW ndowkvent Handl er ( Event Handl er Cal | Ref handl er Ref,
Event Ref event, void *userData );

voi d Updat eW ndow( W ndowRef w ndow );

t ypedef struct

{
Ul nt 32 nunber ;

Str 255 string;
} W ndowDat a, **W ndowDat aHandl e;
W ndowDat aHandl e gW ndDat aHndl ;

int main( int argc, char* argv[] ))

{
| BNi bRef ni bRef ;
OSSt at us err;
W ndowRef W ndow;,
Event Tar get Ref target;

Event Handl er UPP handl er UPP;
Event TypeSpec wi ndowkEvent = { kEvent Cl assW ndow,
kEvent W ndowDr awCont ent  };

Ul nt 32 t heNunber = 5;

Str 255 theString = "\ pAnd the nunber is ...";

Si ze nunByt es;

err = CreateN bReference( CFSTR("main"), &nibRef );

err = Set MenuBar FromNi b( ni bRef, CFSTR(" Mai nMenu") );

err = CreateW ndowFromNi b( ni bRef, CFSTR("Mai nW ndow'), &w ndow );

target = Get WndowEvent Target ( w ndow );

handl er UPP = NewEvent Handl er UPP( MyW ndowEvent Handl er ) ;

I nstal | Event Handl er ( target, handl erUPP, 1, &w ndowEvent,
(void *)w ndow, NULL );

gW ndDat aHndl = (W ndowDat aHandl e) NewHand| e( si zeof ( WndowData ) );
(**gW ndDat aHndl ) . nunber = t heNunber;

nunBytes = theString[0] + 1;

Bl ockMoveDat a( theString, (**gWndDataHndl).string, nunBytes );

Set W ndowPr operty( wi ndow, O, 'test', sizeof( WndowData ),



&JW ndDat aHndl ) ;

Di sposeNi bRef erence( ni bRef );

ShowW ndow( wi ndow );

RunAppl i cati onEvent Loop();

return( 0 );

pascal OSStatus MyW ndowkvent Handl er ( Event Handl er Cal | Ref handl er Ref,

{

VOI

Event Ref event, void *userDat a)
CSSt at us result = event Not Handl edErr;
Ul nt 32 event Ki nd;
W ndowRef Wi ndow,
wi ndow = ( W ndowRef )user Dat a;
event Kind = Get Event Ki nd( event );

if ( eventKind == kEvent W ndowDr awCont ent )
{

}

return result;

Updat eW ndow( wi ndow ) ;

d Updat eW ndow( W ndowRef w ndow )

FMFont Fami |y font Fam | y;

Ul nt 32 t heNunber ;
Str 255 number St r;
Si ze nunByt es;

Str 255 theString;

Set Port W ndowPort ( wi ndow ) ;

Get W ndowPr operty( wi ndow, 0O, "test', sizeof( WndowData ),
NULL, &gW ndDat aHndl );

t heNunber = (**gW ndDat aHndl ) . nunber;
nunBytes = (**gW ndDataHndl ).string[0] + 1;
Bl ockMoveDat a( (**gW ndDat aHndl ) . string, theString, nunBytes );

NunmiroSt ri ng( t heNunmber, nunberStr );

fontFam |y = FMGet Font Fam | yFromNane( "\ pTi nes" );
Text Font( fontFamly );

Text Face( bold + italic );



Text Si ze( 24 );

MoveTo( 35,60 );
DrawsString( theString );
MoveTo( 250,60 );
DrawStri ng( nunberStr );

Window Data and Multiple Windows

A common situation is for a program to enable the user to open multiple windows of the same type, and
for each of these open windows to hold different data. A word processor, for instance, enables any number
of documents to open, and each can hold different text. To create a program of this type, you can use the
New menu item to open a new window and then use Set W ndowPr operty and

Cet W ndowPr oper t y to assign and retrieve data unique to that window.

This chapter's "Opening Multiple Windows of the Same Type" section describes how to use the New menu
item to enable any number of windows of the same type to be opened. In short, you can assign the New
menu item a command in the menu bar of the nib file, and then install an application-level event handler
that responds to that command. In the event handler, you'll call an application-defined routine that opens a
new window. This chapter's MultipleSameTypeWindow program introduces this technique.

If each new window isto have someinitial information assigned to it, you can do that in the routine that
creates the window. A cal to Set W ndowPr oper t y doesthetrick. In addition, to ensure that each
window is properly updated, you can install an event handler in that same window-creating routine.

The following code snippet provides an abbreviated version of a Cr eat e My NewW ndow routine that
performs these tasks. This routine creates awindow, assigns the number 10 toit, and installs an event
handler that responds to an update event. For alook at acomplete Cr eat e My New\W ndow routine that
creates a window, assigns unigque data to it, and then installs an event handler, refer to the
"SameTypeWindowWithData Program" section of this chapter.

voi d Creat eMyNewW ndow( void )

{
| BNi bRef ni bRef ;
OSSt at us err;
W ndowRef wi ndow;
Event Tar get Ref t ar get;
Event Handl er UPP handl| er UPP;
Event TypeSpec wi ndowkEvent = { kEvent C assW ndow,
kEvent W ndowDr awCont ent  };
SInt16 nunber = 10;

err
err

CreateN bReference( CFSTR("main"), &nibRef );
Cr eat eW ndowFr omNi b( ni bRef, CFSTR("Mai nW ndow'), &w ndow ) ;

target = Get WndowEvent Target ( w ndow );

handl er UPP = NewEvent Handl er UPP( MyW ndowEvent Handl er );

I nstal | Event Handl er ( target, handl erUPP, 1, &M ndowEvent,
(void *)wi ndow, NULL );



Di sposeNi bRef erence( ni bRef );
Set W ndowPr operty( w ndow, 0O, 'test', sizeof( SIntl6 ), &iunber );

/] offset and show wi ndow here

}

SameTypeWindowWithData Program

Sure, it'sa somewhat unwieldy name, but atitle of SameTypeWindowWithData certainly lets you know the
purpose of this example program. This program demonstrates how to create multiple windows of the same
type, each with its own associated data.

The SameTypeWindowWithData program has a New menu item that creates a new window. By way of a
call to Set W ndowPr oper t y, each new window gets a randomly generated number associated with it.
By way of acall to Get W ndowPr oper t v, each window is properly updated (that is, each window has
the correct number drawn to it any time the window becomes obscured and then revealed). Figure 4.12

shows the program after the New menu item has been selected afew times.

Figure 4.12. Thewindows displayed by the SameTypeWindowWithData program.

The nib file for this project requires a single empty window named Vai n\W nd . You'll give the New
menu item a command by assigning it acommand of nwi n so that the command corresponds to the
#def i ne that will be used in the source code. This chapter's "Opening Multiple Windows of the Same
Type" section provides an example of assigning this same command to the New menu item.

Example 4.10 provides the complete listing for the SameTypeWindowWithData program. From other
examplesin this chapter, you're familiar with most of this code.

The application event handler watches for the command generated by a selection of the New menu item.
The two global variables are used in the staggering of each new window. Refer back to this chapter's
MultipleSameTypeWindow example to review either of these two techniques.

The Cr eat ey NewW ndowroutine is invoked by the application event handler in response to choosing
the New menu item. To provide each new window with data, Set W ndowPr oper t v iscalled. Rather
than simply assigning the same value to each window, Cr eat ey NewW ndow calls the Carbon routine
Randomto generate arandom number to assign to the new window. That way, each window will (most
likely) have a different number assigned to it.

When you run the program, you should choose New several times to create a number of windows. Move
the windows about because changing the ordering forces updates. As you do this, you'll see that the



program properly updates each window by redrawing the correct number to that window. The Random
function requires no arguments. Just call it and the routine returns an integer value in the range of -32767
to +32767.

Example 4.10 SameTypeWindowWithData Sour ce Code

#i ncl ude <Car bon/ Car bon. h>

#def i ne kNeww ndowConmmand "nw n'
pascal OSStatus MyAppEvent Handl er ( Event Handl er Cal | Ref handl er Ref ,
Event Ref event, void *userData );

pascal OSStatus MyW ndowkEvent Handl er ( Event Handl er Cal | Ref handl er Ref,
Event Ref event, void *userData );

void CreateM/NewW ndow void );
voi d Updat eW ndow( W ndowRef w ndow );

SInt16 gW ndowSt art Top
SInt16 gW ndowSt art Lef t

40;
15;

int main( int argc, char* argv[] )

{
| BNi bRef ni bRef ;
OSSt at us err;
Event Tar get Ref target;
Event Handl er UPP handl er UPP;
Event TypeSpec appEvent = { kEvent d assConmand,
kEvent ProcessCommand };
err = CreateN bReference( CFSTR("nmain"), &ni bRef );
err = Set MenuBar FromNi b( ni bRef, CFSTR(" Mai nMenu") );
Di sposeNi bRef erence( ni bRef );
Cr eat eMyNewW ndow( ) ;
target = Get ApplicationEvent Target( );
handl er UPP = NewEvent Handl er UPP( MyAppEvent Handl er );
| nstal | Event Handl er ( target, handl erUPP, 1, &appEvent, 0, NULL );
RunAppl i cati onEvent Loop() ;
return( 0 );
}

pascal OSStatus MyAppEvent Handl er ( Event Handl er Cal | Ref handl er Ref ,
Event Ref event, void *userDat a)

{



OSSt at us result = event Not Handl edErr ;
HI Conmand conmand;

Get Event Paraneter ( event, kEvent ParanDi rect Cbj ect, typeH Comrand,
NULL, sizeof (H Conmmand), NULL, &conmand);

switch ( command. conmandl D )

{
case kNewwW ndowConmmand:
Cr eat eMyNewW ndow( ) ;
result = noErr;
br eak;
}
return result;
}
voi d Creat eMyNewwW ndow( void )
{
| BNi bRef ni bRef ;
OSSt at us err;
W ndowRef wi ndow;
Event Tar get Ref target;
Event Handl er UPP handl er UPP;
Event TypeSpec w ndowkEvent = { kEvent d assW ndow,
kEvent W ndowDr awCont ent };
SInt16 randonNum
err Creat eNi bRef erence( CFSTR("mai n"), &ni bRef );

err Cr eat eW ndowFr onNi b( ni bRef, CFSTR(" Mai nW ndow'), &w ndow );

target = Get WndowEvent Target ( w ndow ) ;

handl er UPP = NewEvent Handl er UPP( MyW ndowEvent Handl er );

I nstal | Event Handl er ( target, handl erUPP, 1, &M ndowEvent,
(void *)wi ndow, NULL );

Di sposeNi bRef erence( ni bRef );
randonNum = Randon();

Set W ndowPr operty( wi ndow, 0O, 'test', sizeof( SIntl6 ),
& andonNum ) ;

MoveW ndow ( wi ndow, gW ndowStartLeft, gWndowStartTop, TRUE );
ShowW ndow( wi ndow );

if ( gWndowStart Top < 200 )
{
gW ndowSt art Left += 20;
gW ndowSt art Top += 20;
}

el se



}

gW ndowSt art Left
gW ndowSt art Top

15;
40:;

}

pascal OSStatus MyW ndowkvent Handl er ( Event Handl er Cal | Ref handl er Ref,

{

VOi

Event Ref event, void *userDat a)
OSSt at us result = event Not Handl edErr;
Ul nt 32 event Ki nd;
W ndowRef w ndow,
wi ndow = ( W ndowRef )userDat a;
event Kind = Get Event Ki nd( event );

if ( eventKind == kEvent W ndowDr awCont ent )
{

}

return result;

Updat eW ndowm w ndow ) ;

d Updat eW ndow( W ndowRef w ndow )

FMFont Fam |y font Fam | y;
SInt 16 wi ndowNunber ;
Str 255 nunmber Str ;

Set Port W ndowPort ( wi ndow ) ;

Get W ndowPr operty( wi ndow, O, 'test', sizeof( SIntl6 ),
NULL, &w ndowNunber );

NuniroSt ri ng( wi ndowNunber, nunber Str );

fontFam |y = FMGet Font Fam | yFromNane( "\ pTi nes" );
Text Font( fontFamly );

Text Face( bold + italic );

Text Si ze( 36 );

MoveTo( 110,60 );

DrawsStri ng( nunberStr ) ;



For More Information

The following web site offers more information on some of the topics presented in this
chapter:

Random number generation: http://devel oper.apple.com/techpubs/macosx/
Carbon/graphics/QuickDraw/QuickDraw_Manager/Functions/Random.html


http://developer.apple.com/techpubs/macosx/Carbon/graphics/QuickDraw/QuickDraw_Manager/Functions/Random.html
http://developer.apple.com/techpubs/macosx/Carbon/graphics/QuickDraw/QuickDraw_Manager/Functions/Random.html

Chapter 5. Controls

A CONTROL ISAN ITEM WITH WHICH a program's user can interact. By clicking a
control such as a push button, a user can initiate some immediate action, asyou've seenin
severa of the example programs in previous chapters. Other types of controls also can be
acted on by the user, but these controls generally modify a setting instead of causing an
immediate action to take place. Examples of such controls are radio buttons, text input
fields, and checkboxes. In this chapter you'll see how to create and manage controls of
these types. In learning about these control types, you'll see how a control can be assigned
either acommand signature (as you've done in previous chapters) or a control 1D.



Command Signatures and Control IDs

Some controls, such as radio buttons and checkboxes, usually don't initiate any action
when clicked. The control's state might change-for instance, a checkbox will become
checked if it was unchecked-but the act of clicking the control won't generally cause a
change in the program. Instead, the program examines the state of such a control at alater
time (such as when a Done button is clicked) and then an action might be initiated. It isthis
clicking of a button that more often causes an immediate action. These two different types
of behavior that a control can exhibit explain why one control is assigned a command
signature and another control is assigned a control ID.

Consider the window resource shown in Figure 5.1. It includes a static text item (the Select
a beep option, then click the Beep button string), a push button control (the button titled

Beep), and aradio button group control (all three radio buttons comprise a single control).

Figure5.1. A window that includes a push button and a radio button group.
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The push button is the type of control usually assigned a command signature (also referred
to asacommand). Y ou've worked with commands before, so you know that acommand is
afour-character constant assigned to a control. Assigning a command signature to an item
in aresource file enables a program's code to respond to the user's selection of that item.
It's important to note that assigning a command signature to a control doesn't give the
program any indication of which control has been selected by the user. For instance, if you
assign each of two buttons a command of beep, the program responds the same way to a
click on either button, and the program won't know or care which button initiated the
action.

Y ou've also seen that you can assign a menu item the same command as a button, and
again, the program properly responds in the same manner to either a click on the button or
a selection of the menu item. Again, the program won't know, or care, which action
generated the command. Figure 5.2 shows the push button being assigned a command

signature of beep.

Figure 5.2. Assigning a command signature to a push button control.
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The radio button group control pictured in Figure 5.1 isthe type of control that is usually

assigned a control 1D rather than a command. A control ID consists of two components: a
signature and an ID. The signature is afour-character constant, and the ID is an integer
value. Be aware that there's the potential for confusion here. The control ID is composed of
two parts: asignature and an integer. The integer isreferred to asthe ID. Thus, acontrol ID
isthe combination of two identifiers, while the ID is one of those identifiers. Tricky
wording, to be sure. Figure 5.3 shows a control ID with a signature of SPRE and an ID of 1

being assigned to the radio button group.

Figure5.3. Assigning a control 1D to a radio button group control.
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The four-character constant used for the signature is typically the same as the program's
creator code, which isthe application signature. As discussed further in Chapter

10,"Bundles and Icons," each program that's released to the public should have its own

creator code, and that creator code should be registered with Apple. In such a case, any
four characters can be used as the signature. This chapter's RadioButtonGroup example
program provides more information about creator codes, and the specific process of
registering such a code with Appleis described in Chapter 10.

Note

This book's examples haven't been assigned creator codes-it's a bit unlikely



that any of them will ship as commercial products!

The commonly used convention for assigning control |Ds to a program's controlsisto use
the same four-character constant as the signature for every control 1D and to use a unique
integer value asthe ID of every control ID. For instance, if | were to add two more controls
that each required a control 1D to the window pictured in Figure 5.1, their control IDs

might each have a signature of SPRB, while their IDs would have values of 2 and 3. By
giving each control that requires a control 1D a unique value, your program can identify
that particular control. Thisisn't possible if your program assigns only a command to a
control.

When should you assign a control 1D rather than a command to a control ? The answer is
this: when your program needs to access a particular control. When will your program need
to access a control ? Typically when the program needs to get, or set, the control's value.

Consider the window pictured in Figure 5.1. The value of aradio button group is a number

that identifies which radio button is currently on (only one radio button in a group can be
on at any given time). In this case, the program will need to get the value of the radio
button group control when the user clicks the Begp button. When the user clicks the Beep
button, the program accesses the radio button group control, determines which radio button
ison, and then uses that information to sound the appropriate number of beeps. For the
radio button group, a command won't do. The program needs a unique identifier for this
control so that it can access the control. A control ID is unique; acommand might not be.

In this chapter, you'll read about push buttons, bevel buttons, and even pictures used as
buttons. A button is usually assigned acommand. This chapter also covers radio button
groups, text input fields, and checkboxes. Each type of control usually has a control 1D
assigned to it.



Buttons

Some types of controls have more than one state. For such a control, the program needs to
examine the control to determine its state. This need to know about the particular control
means that the program has to access the particular control. Thisis the reason for
associating a unique identifier (a control D) to some controls.

Note, however, that a button isn't such a control. A program doesn't have to examine a
button to determine its state. The program knows that a button alwaysis waiting to be
clicked. Thus, there's no need to assign a unique identifier to it. Instead, a command
signature usually is assigned to a button. This command doesn't have to be unique to the
button. If it makes sense for the program to have more than one means of issuing the
command, other controls and menu items can be assigned the same command.

Y ou've been working with buttons and commands for awhile now. BeepWorld, the very
first example program in Chapter 3, "Events and the Carbon Event Manager," included a
push button that had a command assigned to it. Thus, you know that from a resource
standpoint, acommand signature is assigned to a button by adding a fourcharacter
command to a button item on awindow in anib resource. In addition, you know that from
a code standpoint, acommand is dealt with by installing an event handler that specifically
responds to a command event.

Button Types

To this point, the buttons that have been included in the example programs have all been
push buttons. A push button is the most common type of button, but you should know that
Interface Builder makesit easy to include other varieties of buttonsin your programs as
well. Figure 5.4 shows awindow resource that includes afew different types of buttons.

Figure 5.4. Several types of buttonsin a window resour ce.
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Along the top of the window in Figure 5.4 are four bevel buttons. From the left side of the

window, the first three bevel buttons are all the same type. They each were created by
dragging and dropping the smaller square button from the pal ette to the window.

The right-most, larger button in the row of four buttons in the window also is a bevel
button. It was created by dragging and dropping the larger square button from the pal ette to
the window. Theicon that appears in any one of these buttonsis set in the item's Info
window. Enter avalue of 0, 1, or 2 inthe ID field of the Info window (as shown on the
right side of Figure 5.4) to have the button display one of the three small color icons that

are apart of any main.nib file. In Interface Builder, you can see those icons by clicking the
Images tab in the file's main.nib window.

The last new button in the window resource is called an imagewell. It appears at the lower-
left corner of the window in Figure 5.4. Drag and drop the small square button from the

bottom of the palette to the window to add this item to the window. The icon displayed by
this button is selected in the same way as it is for the other types of icon buttons. Y ou enter
anID of 0, 1, or 2 in the button's Info window. Note that any of these buttons can be
assigned a command in the same way that a push button is assigned one-click theitem to
select it, bring up the Info window, and enter afourcharacter command in the Command
field of the Control pane of that window.

Another way to create a button is to add a picture to a window resource and give that
picture acommand. How to add a picture to a window resource was described in the
"Adding a Picture to the Helloworld Program” section of Chapter 2, "Overview of Mac OS

X Programming.” In short, you first add a picture file to the project, add a PICT item to the
window, and then drag the picture from its place under the Images tab of the main.nib
window to the window resource.

To turn apicture item into a button, select the picture item and choose Show Info from the
Tools menu. With Attributes selected from the Info window's pop-up menu, uncheck the
Don't Track checkbox. This step isimportant. If you leave this checkbox checked, the
program won't track the user's mouse actions as related to the picture item, and aclick on



the picture item won't get registered. Y our last step isto choose Control from the Info
window's pop-up menu and enter afour-character command in the Command field. Voil &
Y ou've got a picture that behaves like a button!

| conButtons Program

The purpose of the IconButtons program is to demonstrate how different types of buttons
can be added to a window. The IconButtons program displays the window shown in Figure

5.5. Clicking any of the six buttonsin the window produces the same result-a single beep.

Figure5.5. The window displayed by the IconButtons program.
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Use the Chapter 3 BeepWorld project as the basis for this project. Open the main.nib file

and enlarge the window resource to accommodate the extra buttons. Now click the bevel
button on the palette and drag and drop it on the window resource. Use the Attribute pane
in the button's Info window to enter an ID of 0. The result is the display of the stop sign
icon on the button.

Y our next step isto select the Control pane in the Info window and assign a command of
beep to the bevel button. Create any or all the other buttons in a similar manner.
Experiment by dragging different types of buttons to the window resource and trying
different ID values. The source code supportsthe beep command, so aslong asyou give
any button that command, it will behave in the same way as the original button, whichis
the Beep push button.

The source code for the IconButtons program is identical to the source code devel oped for
the Chapter 3 BegpWorld program. Rather than repeat the source code here, I'll summarize

how the code works. To see the entire listing, refer to Example 3.3 back in Chapter 3.

The BeepWorld (and now the |conButtons) source code defines the constant
kBeepConmmand to be the same four characters (beep) asthe command assigned to the
Beep button. The program defines an event specification for acommand event (an event
with aclassof kEvent Cl assComrand and akind of kEvent ProcessConmand) and
installs an event handler with the program’'s window as the target, the applicationdefined
routine CormandEvent Handl er asthe event handler, and the command event as the
event to which to respond. The ConmandEvent Hand! er routine responds only to an



event with the command of beep, and it does so by invoking the application-defined
BeepConmandHandl er routineto call SysBeep .



Radio Buttons

Radio buttons are small, round buttons that come in groups. Unlike a checkbox, which is used to turn on or off an
option, aradio button never appears without at least one other such button. Thisis because radio buttons are used to
choose one (and only one) option from a set of two or more options. Thus radio buttons are used in mutually exclusive
situations. When one button is on, all othersin the set should be off.

A radio button group is acontrol consisting of two or more radio buttons. This type of control typically has a control
ID, rather than a command, associated with it. When the user has finished making a selection from a set of radio
buttons, your program will want to know something about this set of controls. Mainly, your program needs to know
which button is now on so that some corresponding parameter can be set in the program. Thus your program needs to
know about a particular control.

The control 1D is how your program interacts with a control. Thisis unlike a user's selection of a push button, which
initiates some prescribed action. Y our program usually doesn't need to know anything about the contral. It doesn't even
need to know that it was a control that triggered an event. It could be a menu-item selection. That's why acommand is
associated with a control such as a push button, and a control ID is associated with a control such as aradio button

group.
Radio Button Groups and the Nib Resource

Radio buttons are added to awindow in anib file. Radio buttons can be added individually. Back in Figure 5.4, you
saw an individual radio button control labeled RadioButton near the lower-left of the palette window. Radio buttons
also can be added collectively and treated as a single control using the radio button group item. Figure 5.4 shows this
control appearing in the lower-left of the palette window as two radio buttons labeled Radiol and Radio?2.

In most situations, the radio group is the route to take. This control takes on all the responsibility of tracking the user's
actions with the control. Asthe user clicks one radio button in a group, the control turns off the previously on button
and then turns on the newly selected button. Y our source code does not need to include any button-handling code.
Instead, your source code is responsible only for getting (reading) the control to see which button the user selected as
the final choice.

To add aradio button group to a window resource, drag and drop the radio button group item from the pal ette to the
window. A radio button group starts with two radio buttons, as shown in Figure 5.6. To add more buttons to the group,

select the group, choose Show Info from the Tools menu, and change one or both values in the Size section of the
Attributes pane.

Figure5.6. Setting the number of radio buttonsin aradio button group control.
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Figure 5.7 shows a radio button group with three radio buttons. Thetitle of abutton is changed by double-clicking the
original title (such as on Radiol) and typing a new title (such as Beep 1 time).

Figureb5.7. Setting the control I D of aradio button group control.
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To associate acontrol ID with aradio button group, select the group in the window and display the Info window. From
the Control pane, enter afour-character signature in the Signature field and an integer in the ID field. The Command
field isleft blank. Figure 5.7 provides an example.

Radio Button Groups and Sour ce Code

In response to the user clicking on aradio button, your program's code does nothing. The tracking of the user's
interaction with aradio button control is the system's responsibility. Besides being extremely helpful to us
programmers (thanks, Apple), thisway of handling a control makes sense. Y our program doesn't need to respond to, or
even know about, the user's clicks on radio buttons. The user can click and click on these buttons and these actions
don't matter to your program. Y our program cares only about the user's final choice, which is the radio button that's on
at the time the user specifies that his choice has been made.

Thefinal choice specification usually comes in the form of aclick on a push button, such as an OK or Done button. In
Figure 5.7, the user would click the Beep button when satisfied with his or her "number of beeps" choice. In that

example, only when the user clicks the Beep button would the program need to examine the state of the radio button
group control to determine which radio button is on.

You'l start your source code handling of aradio button group by defining a constant that matches the control signature
and a constant that matches the control ID. These values match the values assigned to the control in the nib file. Using
the radio button control pictured in Figure 5.7, those constants might look like this:

#def i ne kContr ol Si gnat ure ' SPRB'
#def i ne kRadi oGroupControl I D 1

Next, define a constant for each radio button in the radio button group. Each radio button in aradio button group has a
value. Starting from the top (from the top-left if there is more than one column of radio buttonsin the group) and going
down, the values of the radio buttons start with the number 1 and increase consecutively. Referring to the examplein
Figure 5.7, here's how those constants could look:

#def i ne kBeeplTi ne 1



#def i ne kBeep2Ti ne 2
#def i ne kBeep3Ti ne 3

Note that the button numbering has nothing to do with the purpose of abutton. For instance, if your program had a
radio button group for selecting one color of three possible choices, your button constants would still have the values
1,2,and 3.

Now install an event handler. Even though the radio button control doesn't have a command associated with it, the
event handler will be one that responds to commands. Again, thisis because it's usually a command (such as the one
generated by the Beep button in the current example) that triggers the examining of the radio button group control. The
following snippet holds the setup of such an event handler. Note that there's no new code in this snippet to discuss. The
code has been used in many of the previous example programs that handled button or menu commands.

W ndowRef wi ndow,

OSSt at us err:

Event Tar get Ref tar get;

Event Handl er UPP handl er UPP;

Event TypeSpec cndEvent = { kEvent Cl assCommand, kEvent ProcessCommand };

target = Get WndowEvent Target ( wi ndow ) ;

handl er UPP = NewEvent Handl er UPP( CommandEvent Handl er );

I nstal | Event Handl er ( target, handl erUPP, 1, &cndEvent,
(void *)w ndow, NULL );

The event handler routine will bein the style of other handlers that respond to commands. Here, however, your
program is watching for a click on the Begp button, not for any action associated with the radio button group. With that
in mind, the event handler could look like this:

pascal OSStatus CommandEvent Handl er ( Event Handl er Cal | Ref handl er Ref ,
Event Ref event, void *userDat a)

{
0SSt at us result = event Not Handl edErr;
H Conmmand conmand;
W ndowRef wi ndow,
wi ndow = ( W ndowRef )userDat a;
CGet Event Par anet er ( event, kEvent ParanDi rect Cbj ect, typeH Conmand,
NULL, sizeof (H Conmand), NULL, &conmand);
switch ( command. conmandl D )
{
case kBeepConmand:
BeepCommandHandl er ( wi ndow ) ;
result = noErr;
br eak;
}
return result;
}

Now we need to go to the heart of the matter. When the Beep button is clicked, the event handler invokes the
application-defined routine BeepConmandHand! er . Regardless of the purpose of your program'’s radio button
group, the setup is similar. Y ou need to watch for the action that signals that the user has finished with the radio button
group, determine which radio button is on, and respond in a manner appropriate for the selected radio button.

Determining which radio button in agroup is on is done by first accessing the radio button group control. A couple of



new data types and a couple of new Carbon routines help you do that. Y ou begin by declaring a Cont r ol Handl e
variable that's to be used to reference the control and a Cont r ol | D variable that holds the control's signature and 1D:

Cont rol Handl e nunBeepsRadi oButt onG oup;
Control I D nunBeepsControl I D = { kControl Si gnat ure,
kRadi oG oupControl I D };

Herethe Cont r ol | Dvariable uses the previously defined constants k Cont r ol Si gnat ur e ('SPRB') and
kRadi oG oupControl | D(1). To obtain a handle to the radio button group control, call the Get Cont r ol Byl D
routine:

Get Cont rol Byl D{ wi ndow, &nunBeepsControl | D,
&nunBeepsRadi oBut t onGroup ) ;

You'll need totell Get Cont r ol Byl Dthewindow that holds the control (your program may have more than one
window that displays acontral). You'll also pass Get Cont r ol Byl Dthe control 1D of the control. The combination
of the signature and ID are unique to your program, so this information always specifies one and only one of your
program's controls. Using that information, Get Cont r ol By | D returns a handle to the specified control. After

CGet Cont r ol Byl Dexecutes, your program can use thishandle (nunBeepsRadi oBut t onG oup in this example)
to access the control. Here accessing the control means determining its value. Calling Get Cont r ol 32Bi t Val ue
returns the value of a control:

Sl nt 32 nunBeepsVal ue;

nunBeepsVal ue = Get Control 32Bit Val ue( nunBeepsRadi oButtonG oup );

What the value of a control represents varies by the type of control. For aradio button group, the value corresponds to
the radio button that's on. In the preceding code snippet, if Get Cont r ol 32Bi t Val ue returnsthe number 1, the first
radio button (the top button, or the top-left button in a multicolumn arrangement of controls) is the one that was on at
the time the Beep button was clicked. If the number returned is 2, the second button-the middle of the three buttons-is
the one that was on. Y ou see the pattern. Now, all that's eft to do is to use this control value in a switch statement,
taking the appropriate action for the radio button that was on:

switch ( nunBeepsVal ue )
{
case kBeeplTi ne:
/'l beep once
br eak;
case kBeep2Ti ne:
/'l beep twi ce
br eak;
case kBeep3Ti ne:
/'l beep thrice
br eak;

Obviously, the handling of the radio button choiceis very application-specific. Other sets of radio buttons have other
purposes. For instance, if your program's set of buttons was used to set a color from among four choices, the code
would have four case labels and each |abel would set the same color-specifying variable to an appropriate value.

RadioButtonGroup Program

The purpose of the RadioButtonGroup program is to demonstrate how to include a set of radio buttonsin awindow.
Figure 5.8 shows what the program's window looks like.



Figure5.8. Thewindow displayed by the RadioButtonGroup program.
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In keeping with my pattern of picking a program name that hints at the purpose of the example program, I've named
this program RadioButtonGroup. However, when it's complete (surely still more beeps can be added), I'll name the
shipping version of this program SuperBeep. In preparation for that day, |'ve registered with Apple a creator code, or
application signature, for this program. Thisis the book's first example that uses a control 1D with a control, soit'sas
good atime as any to enhance the example by demonstrating what you'd do if you were developing a program that
might actually be unleashed on the public!

The control 1D consists of afour-character signature and an ID. Although not mandatory, Apple does suggest that the
four-character signature match the program's four-character creator code. | visited Appl€e's site, determined that the
creator code of SPRB was available, and registered that creator code for the SuperBeep program. Chapter 10 provides
more information about creator codes and registering them. Now, for any one of the program's controls that requires a
control ID, I'll use SPRB as the signature part of the control ID. Figure 5.7 illustrates this for the program's one control.

Note

| didn't have to register a creator code for this application to add a control to it. In addition, if you're
creating numerous example and test programs (as in this book), you aren't going to want to go to Apple
and register a creator code for each. By default, Project Builder assigns a creator code of ???? (four
question marks) to an application built from a project. If you want to, go ahead and use that creator code
for the signature part of the control 1D for the controlsin your test programs. Only if your program will
become public do you need to register a creator code to ensure that the user's Mac OS X desktop properly
associates related documents to your program. In case you haven't already guessed, none of this book's
example programs result in shipping products, so there's no point in using up several available creator
codes. That's right-even the super-charged SuperBeep application will never go public. Apparently my
marketing research was poorly done, and I've overestimated the demand for aMac OS X application that
does little more than beep!

Editing the Nib File

Thisis another project based on the BeepWorld project from Chapter 3. Make a copy of that project, open the main.nib
file, and add a radio button group control item to the window. Y ou also can add a stetic text item as |'ve done in Figure
5.7. Set the control's signature to SPRB and give its ID avalue of 1. You'll soon create corresponding constants in the

source code. This control doesn't need a command, but make sure the Beep button has the command of beep
associated withit.

Writing the Sour ce Code

Example 5.1 provides the entire listing for the RadioButtonGroup program. Most of the source code was discussed in
the overview of radio button groups. After looking over the BeepConmandHand! er routine, you might notice that
the routine could have been written in a much more succinct way. Right now, the routine calls Get Cont r ol Byl Dto
get ahandle to the radio button group contral. It then calls Get Cont r ol 32Bi t Val ue to determine which radio
buttonison. Lagt, it entersaswi t ch statement that |ooks like this:

switch ( nunBeepsVal ue )



case kBeeplTi ne:
SysBeep( 1 );
br eak;

case kBeep2Ti ne:
SysBeep( 1 );
SysBeep( 1 );
br eak;

case kBeep3Ti ne:
SysBeep( 1 );
SysBeep( 1 );
SysBeep( 1 );
br eak;

}

Because the number of beeps sounded happens to match the value of the radio button (radio button number 1 specifies
one beep should be played, and so forth), the entire swi t ch statement could be replaced by these few lines of code:

Sl nt 16 X;

for ( x = 1; x <= nunBeepsVal ue; x++ )
SysBeep( 1 );

Although that approach isthe oneto takein a"rea" program, the intent here isto show the basic approach used to
handle aradio button selection. In most cases, the button number will have nothing to do with the action that's to take
place. For instance, if a set of radio buttons existed to enable the user to choose a United States currency, af or loop
wouldn't cut it. Instead, the swi t ch statement would be appropriate:

#def i ne kDol | ar 1
#def i ne kDol | ar5
#def i ne kDol | ar 10
#def i ne kDol | ar 20
#defi ne kDol | ar 50

/1l 1st radio button
/1 2nd radi o button
/1 3rd radio button
/1 4th radi o button
/1 5th radio button

abh wNPEF

I nt 32 dol | ar Val ue;

switch ( dollarVal ue )

{
case kDol | ar1:
dol | ar Denom nation = 1;
br eak;
case kDol | ar5:
dol | ar Denom nati on = 5;
br eak;
case kDol | ar 10:
dol | ar Denom nati on = 10;
br eak;
case kDol | ar 20:
dol | ar Denomni nati on = 20:;
br eak;
case kDol | ar50:
dol | ar Denomni nati on = 50;
br eak;
}

Example 5.1 RadioButtonGroup Source Code



#i ncl ude <Car bon/ Car bon. h>

#define kBeepComand " beep’
#def i ne kControl Si gnature ' SPRB'
#def i ne kRadi oG oupControl | D 1
#def i ne kBeeplTi ne 1
#def i ne kBeep2Ti ne 2
#def i ne kBeep3Ti ne 3

pascal OSStatus CommandEvent Handl er ( Event Handl er Cal | Ref handl er Ref,
Event Ref event, void *userData );

pascal void BeepConmandHandl er ( W ndowRef w ndow );

int main( int argc, char* argv[] )

{
| BNi bRef ni bRef ;
W ndowRef wi ndow,
OSSt at us err;
Event Tar get Ref target;
Event Handl er UPP handl er UPP;
Event TypeSpec cndEvent ;
cnmdEvent . event d ass = kEvent C assConmand;
cnmdEvent . event Kind = kEvent ProcessCommand;
err = Creat eN bReference( CFSTR("nmin"), &nibRef );
err = Set MenuBar FromNi b( ni bRef, CFSTR("Mai nMenu") );
err = Creat eW ndowFromNi b( ni bRef, CFSTR("Mai nW ndow'), &wi ndow );
Di sposeN bRef erence( ni bRef );
target = Get WndowEvent Target ( wi ndow ) ;
handl er UPP = NewEvent Handl er UPP( ConmandEvent Handl er );
I nstal | Event Handl er ( target, handlerUPP, 1, &cndEvent,
(void *)wi ndow, NULL );
ShowwW ndow( wi ndow ) ;
RunAppl i cati onEvent Loop();
return( 0 );
}

pascal OSStatus CommandEvent Handl er ( Event Handl er Cal | Ref handl er Ref,
Event Ref event, void *userData)

{
OSSt at us result = event Not Handl edErr ;
H Command command;
W ndowRef W ndow,

wi ndow = ( W ndowRef ) user Dat a;
Cet Event Par anet er ( event, kEvent ParanDi rect Gbj ect, typeH Comand,



NULL, sizeof (H Comrand), NULL, &comrand);

switch ( conmand. comrandl D )

{
case kBeepConmand:
BeepConmandHandl er ( wi ndow ) ;
result = noErr;
br eak;
}

return result;

pascal voi d BeepCommandHandl er ( W ndowRef wi ndow )

{

Contr ol Handl e nunBeepsRadi oBut t onGr oup;

Control I D nunBeepsControl I D = { kControl Si gnature,
kRadi oG oupControl I D
b

Sl nt 32 nunBeepsVal ue;

CGet Control Byl D( wi ndow, &nunBeepsControl | D, &unBeepsRadi oButtonG oup );
nunBeepsVal ue = Get Control 32Bi t Val ue( nunBeepsRadi oButt onG oup );

switch ( nunBeepsVal ue )

{

case kBeeplTi ne:
SysBeep( 1 );
br eak;

case kBeep2Ti ne:
SysBeep( 1 );
SysBeep( 1 );
br eak;

case kBeep3Ti ne:
SysBeep( 1 );
SysBeep( 1 );
SysBeep( 1 );
br eak;



Checkboxes

A checkbox is a contral that enables a user to turn something on or off. If a checkbox is checked, the control is
considered to be "on"-if the checkbox is unchecked, the control is considered to be "off." Figure 5.9 shows a

window that includes a single checkbox.

Figure 5.9. A window that includes a checkbox control.
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Like aradio button group, a checkbox needs some unique identifier associated with it so that your program can
determine its state. So, like aradio button group, a control will normally have acontrol ID, rather than a command,
associated with it. When the user has signaled that he or she is satisfied with the state of a checkbox (usually by
clicking abutton, such as a Done button), your program determines whether the checkbox is on or off. The control
ID you assign to the checkbox provides your program with access to this control.

Implementing a checkbox in awindow is similar to implementing a radio button group in awindow. If you've read
the previous section of this chapter, you know the basics of working with a checkbox control. If you're planning on
adding a set of radio buttons to awindow in your program, you might consider reading the "Radio Buttons' section
first to get more background information on controls that use control 1Ds.

Checkboxes and the Nib Resour ce

A checkbox is added to awindow resource by clicking the checkbox control located at the left edge of the palette
(see Figure 5.4) and dragging and dropping that item onto the window. To assign a control 1D to the checkbox,

select it and then choose Show Info from the Tools menu. Enter asignature and an ID in the Info window. In Figure
5.10, the checkbox titled Mute speakers has a control 1D consisting of asignature of LxZ7 and an ID of 3.

Figure5.10. Setting the control 1D of a checkbox control.

&} &) Windaw |
i

Check the following bax to turn off the volume.

+] Mure speakers

. DE -
4 i ] i) e chiBain By
Coerol wd

‘Corarol 1D

Sgnawre; | Lxzz I3

Command

zno command > ;| |

Dpriang

¥ Enabiled [T] Hidden (2] Srall




Different programmers use different schemes for choosing control IDs, but one common practiceisfor a
programmer to assign each program control that require a control 1D the same signature. Per Appl€'s convention,
this signature matches the program's creator code (its application signature). Thus, you can guess that the resources
pictured in Figure 5.10 belong to a program with a creator code of LxZ7.

Y ou should further note that the control's signature identifies the program to which the control belongs, and the
control's ID identifies that one control from possibly many controls that the program uses. Thus, each control that
requires a control I1D should have aunique ID.

The window in Figure 5.10 has just one control that requires a control |D-the checkbox. Y et, the ID portion of the
checkbox control ID has avalue of 3. This provides a hint that the program that uses this window has other controls
in other windows. Perhaps another window resource includes two controls: one with an ID of 1 and the other with
an D of 2.

Checkboxes and Source Code

Like aradio button group control, a checkbox control frees your program from the pains of tracking the user's
involvement with the control. When the user clicks a checkbox, the system is responsible for toggling the checkbox
to its opposite state. Only when the user has signaled that his or her choiceisfinal do you need to be concerned with
accessing the checkbox control.

To access a checkbox control, you use the same two routines described in this chapter's "Radio Buttons' section. A
call to Get Cont r ol Byl Disused to obtain a handle to the checkbox control, and that handle is subsequently
passed to Cet Cont r ol 32Bi t Val ue to obtain the value (the state) of the checkbox. For the checkbox pictured in
Figure 5.10, that code would look like this:

#defi ne kContr ol Si gnhat ure ' LxzZ'

#def i ne kMut eCheckboxControl I D 3

Cont r ol Handl e nmut eCheckbox;

Control I D nmut eControl I D = { kControl Si ghat ure,
kMut eCheckboxControl I D };

Ul nt 32 nut eVal ue;

Get Control Byl D( wi ndow, &muteControllD, &ruteCheckbox );
nmut eVal ue = Get Cont rol 32Bi t Val ue( nut eCheckbox );

If the value returned by Get Cont r ol 32Bi t Val ue isal, consider the checkbox to be checked, or on. If the
returned value is 0, that checkbox is unchecked, or off. With the current state of the checkbox known, your program
can respond accordingly. In the example shown here, that would mean turning off the speaker volume of the user's
computer if nut eVal ue is1 (the mute checkbox is checked) or turning on the speaker volumeif mut eVal ue is0
(the mute checkbox is unchecked).

CheckboxDemo Program

The purpose of the CheckboxDemo program isto provide an example of how a program makes use of a checkbox
control.

Figure 5.9 shows the window displayed by the CheckboxDemo program. If the one checkbox is checked at the time
that the OK button is clicked, the program turns the speakers of the user's computer off. If the checkbox is
unchecked at the time the button is clicked, the program restores the speaker volume to the level it was at when the
CheckboxDemo program was launched.



CheckboxDemo introduces a couple of new routines unrelated to the handling of controls. The Carbon routine
CGet Def aul t Qut put Vol une queriesthe system to determine the current volume level of the user's computer.
The corresponding Set Def aul t Cut put Vol unre function changes the volume of the user's computer to a
specified level. Both functions are called from within the nai n routine:

Sl nt 32 gUser Vol unelLevel ;

int main( int argc, char* argv[] )

{
CGet Def aul t Qut put Vol une( &gUser Vol uneLevel );
RunAppl i cati onEvent Loop();
Set Def aul t Qut put Vol une( gUser Vol uneLevel );
return( 0 );

}

Shortly after application startup, Get Def aul t Qut put Vol une iscalled to get the current volume level of the
user's computer. That level isretained in the global variable gUser Vol unelLevel . When the program is about to
exit (when RunAppl i cat i onEvenlLoop returns), the speaker volume isrestored to itsinitial setting.

The CheckboxDemo program is capable of muting the speakers of the user's computer, so what would happen if the
program didn't include this speaker volume code in mai n ? If the user checked the mute checkbox, clicked the OK
button, and then quit the program, the speaker volume would remain off.

Note that a Macintosh user typically makes a systemwide change, which is a change that affects the system, not just
one program. These changes include changing speaker volume or monitor resolution by choosing System
Preferences from the Apple menu. Unless a program exists specifically to serve as a utility that alters systemwide
settings, that program shouldn't make lasting changes to the user's computer. When the user quits a program, he or
she typically expects the computer to be in the same state as it was before the program was launched. In the spirit of
that expectation, CheckboxDemo is capable of muting the user's speakers. CheckboxDemo is a simple application
that exists to demonstrate a programming technigue. It is not a full-fledged application that a user expectsto be a
speaker-volume-adjusting utility! Being agood citizen of Mac OS X, CheckboxDemo is courteous enough to
restore the speaker volume to the level it was at before the program launched.

Get Def aul t CQut put Vol une accepts a single argument-a pointer to a Sl nt 32 (signed 32-bit integer) variable.
When Get Def aul t Qut put Vol une returnsthisvariable, it will hold a value between 0 and 256. A value of 0
signifies that the volume is off, and a value of 256 means the volume is set to its highest setting. Integral values
within this range denote a volume level set proportional to the value. Thus, avalue of, say, 128, would mean the
volume level isat half its maximum setting.

Inmai n, Get Def aul t Qut put Vol ume isused to capture the volume level of the user's Mac before the program
has a chance to alter thislevel. After the event loop exits and the program is about to terminate, mai n calls

Set Def aul t Qut put Vol une to restore the volumeto thisinitial level. Set Def aul t Qut put Vol une accepts
one argument-a value between 0 and 256. Again, avalue of 0 mutes the speakers, and a value of 256 sets the
speaker volume to its highest volume.

After the user clicks the OK button, the program responds to the command generated by the button by invoking the
CommandEvent Handl er event handler, which in turn invokes the Done ConmrandHandl er routine to handle
this one specific command. Here the program accesses the checkbox to determine its state:



Cont r ol Handl e nmut eCheckbox;
Control I D mut eControl I D = { kControl Si gnature,

kMut eCheckboxControl I D };
S| nt 32 mut eVal ue;

Get Control Byl D{ wi ndow, &muteControl |l D, &mruteCheckbox );
nmut eVal ue = Get Control 32Bi t Val ue( nut eCheckbox );

A nut eVal ue of 1 (the program defines the constant k Checkbox On to this value) means the checkbox is
checked, or on. In that case, the program calls Set Def aul t Cut put Vol une to turn off the speakers on the user's
computer:

if ( muteVal ue == kCheckboxOn )
Set Def aul t Qut put Vol une( kVol uneO f Level );

Asmentioned, Set Def aul t Qut put Vol une setsthe speaker volume level of the user's Mac. Herethe level is
set to O, or off. For clarity, the program defines a constant for the speaker-off level. The constant
kVol uneO f Level hasavalueof 0.

If Cet Control 32Bi t Val ue instead returns a value of 0 (for thoroughness the program defines
kCheckbox O f tothisvalue, though that constant isn't used here), the checkbox is unchecked, or off. In that case,
the speaker volume is set to the leve at program startup:

el se
Set Def aul t Qut put Vol une( gUser Vol uneLevel );

After the volume level isset, acall to SysBeep is made to provide the user with some feedback. If the mute
checkbox is checked at the time the OK button is clicked, no sound will be heard. If the checkbox is unchecked, a
single beep at the volume noted at startup will be heard. Example 5.2 provides the complete listing for the

CheckboxDemo program.

Example 5.2 CheckboxDemo Sour ce Code

#i ncl ude <Car bon/ Car bon. h>

#def i ne kDoneCommand ' Done'
#def i ne kCont rol Si gnature ' LxzZ'
#defi ne kMut eCheckboxControl I D 3
#def i ne kCheckboxOr f 0
#defi ne kCheckboxOn 1
#def i ne kVol uner f Level 0

pascal OSStatus ConmandEvent Handl er (  Event Handl er Cal | Ref handl er Ref ,
Event Ref event, void *userData );

pascal void DoneCommandHandl er ( W ndowRef w ndow ) ;

SInt 32 gUser Vol uneLevel ;

int main( int argc, char* argv[] )

{
| BNi bRef ni bRef ;



W ndowRef w ndow;

OSSt at us err;

Event Tar get Ref target;

Event Handl er UPP handl er UPP;

Event TypeSpec cmdEvent = { kEvent O assConmmand,

kEvent ProcessComand };
err = Creat eN bReference( CFSTR("main"), &nibRef );

err Set MenuBar FromNi b( ni bRef, CFSTR(" Mai nMenu") );

err Creat eW ndowFr omNi b( ni bRef, CFSTR(" Mai nW ndow"'), &w ndow ) ;
Di sposeN bRef erence( ni bRef );
target = Get WndowEvent Target ( wi ndow ) ;
handl er UPP = NewEvent Handl er UPP( ConmandEvent Handl er );
I nstal | Event Handl er ( target, handl er UPP, 1, &cndEvent,
(void *)w ndow, NULL );
ShowW ndow( wi ndow ) ;
Get Def aul t Qut put Vol une( &gUser Vol uneLevel );
RunAppl i cati onEvent Loop() ;
Set Def aul t Qut put Vol une( gUser Vol uneLevel );

return( 0 );

pascal OSStatus CommandEvent Handl er ( Event Handl er Cal | Ref handl er Ref ,
Event Ref event, void *userData)
{

OSSt at us result = event Not Handl edErr;

H Command command;
W ndowRef w ndow;

wi ndow = ( W ndowRef )user Dat a;

Get Event Par anet er ( event, kEvent ParanDi rect Qbj ect,
t ypeH Command, NULL,

si zeof (H Command), NULL, &comrand);

switch ( conmand. commandl D )

{

case kDoneCommand:



DoneConmmandHandl er ( wi ndow ) ;
result = noErr;
br eak;

}

return result;

pascal void DoneConmandHandl er ( W ndowRef wi ndow )
{
Cont r ol Handl e nut eCheckbox;
Control I D nmut eControl I D = { kControl Si gnature,
kMut eCheckboxControl I D };
Sl nt 32 nmut eVal ue;

Get Control Byl D( wi ndow, &muteControl D, &nmruteCheckbox );
nmut eVal ue = CGet Control 32Bi t Val ue( nut eCheckbox );

if ( nmuteVal ue == kCheckboxOn )

Set Def aul t Qut put Vol unme( kVol uneOr f Level );
el se

Set Def aul t Qut put Vol une( gUser Vol uneLevel );

SysBeep( 1 );



Text Input Fields

To accept user input, your program's window could use text input fields. This type of control enables the user to
typetext in an outlined box. Although accepting usersupplied text isthe primary use of atext input field, such a
control also can be used to display text. If your window isto display a small amount of static text, a static text field
is the resource item to use. However, if your program instead will display a small amount of dynamically created
text, atext input field should be used.

If you peek ahead abit at the description of the Textlnputltems program, you'll see that Figure 5.12 shows a

window that includes atext input field to accept text (a usersupplied string) and atext input field to display text (the
user-supplied string converted to uppercase characters).

Figure5.12. The window displayed by the Textl nputltems program.
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To work with atext input field, your program will add a text input field item to a window resource, assign that field
acontrol ID, and then access the control from source code.

Text Input Fields and the Nib Resour ce

In anib resource, dragging atext input field item from the palette to awindow creates atext input field. The text
input field is the framed white box located at the |eft edge of the palette, as shown back in Figure 5.4. A text input

field isacontrol, so you'll assign acontrol ID to it so that your program can communicate with it. Figure 5.11

shows awindow with three text input fields. In this figure, the top field is being given a control ID that consists of a
signature of LxZZ and an | D of 1. This chapter's "Radio Buttons" section provides more details about control IDs.

Figure5.11. A window resour cethat holdsthreetext input controls.
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For aesthetic purposes, you can surround one or more text input fields with a border that displays a
title. In Figure 5.11, the lower two text input fields are within a group box. One way to add a group
box to awindow is to drag the box from the palette to the window and then move and resize it to
surround the text input item or items. Y ou can click the middle of the three buttons along the top of
the palette to see the pane that displays the group box.

When boxing items, you need to be careful about the planesin which itemslie. If you create atext
input item and then add a group box that surround the text edit item, the result might be awindow that
doesn't enable the user to enter text in the text edit item. Instead, to ensure user input is possible, you
can box items by selecting the items to group and then choosing Box from the Group In submenu of
the Layout menu.

Text Input Fields and Source Code

From your source code, you'll access atext input field by obtaining a handle to the control and then using that
handle in acall to the Carbon routine Get Cont r ol Dat a.

This chapter's discussion of radio buttons introduced the Get Cont r ol Byl D routine that's used to obtain a handle
toacontrol. Get Cont r ol Byl Dworkswith any type of control. Pass the routine the reference to the window in
which the text input field resides, a pointer to the combination of the control's signature and ID (in the form of a
Cont r ol | Dvariable), and a pointer to avariable where Get Cont r ol Byl D can place the control handle (in the
form of aCont r ol Handl e variable). For the text input field shown at the top of the window in Figure 5.12, the

code to obtain a control handle could look like this:

#def i ne kContr ol Si ghat ure ' LxZZ'
#def i ne kStringlnControl |l D 1

Cont r ol Handl e stringlnText Edit;
Control I D stringlnControlID = { kControl Si gnat ure,
kStringlnControlID };

Get Control Byl D( wi ndow, &stringlnControllD, &stringlnTextEdit );

Now it'stime to learn some new stuff. A control can have an integer asitsvalue. Y ou saw that in the discussion of
radio button groups. For such a control, the Get Cont r ol 32Bi t Val ue isused to obtain the control value.
Another type of control might have something other than an integer for its value. A text input field is such a control.
Its value is a string. For such controls, obtain the control's data using the Get Cont r ol Dat a routine rather than
the Get Cont r ol 32Bi t Val ue function. Here's the prototype for Get Cont r ol Dat a:

OSErr Get Control Dat a( Cont rol Ref i nControl,
Control Part Code i nPart,
ResType i nTagNane,
Si ze i nBuf ferSi ze,
void * i nBuf f er,
Si ze * out Actual Si ze );

Thei nCont r ol parameter is ahandle to the control to be accessed. Passthe Cont r ol Handl e variable that was
filled in by aprevious call to Get Cont r ol Byl D. A Cont r ol Handl e istype Cont r ol Ref .

Thei nPart specifiesthe part of the control to be accessed. Some controls have different parts. Consider the time



indicator control. It isasmall digital clock that displays the current time (click the middle button in the row of
buttons at the top of the palette in Interface Builder to see the timeindicator control at the bottom of the palette). If
your program uses such acontrol, it might have cause to access just a part of this control, such as the hour part, the
minute part, and so forth. Apple defines several constants to be used in specifying what part of a control isto be
accessed. For atime indicator, those would be the constants k Cont r ol Cl ockHour DayPart ,

kCont r ol Cl ockM nut eMont hPart , kCont r ol Cl ockSecondYear Part , and

kControl C ockAVPMPar t . For atext input field, there really isonly one part to the control, so the data that's to
be accessed isn't specific to that part of the control. Here you use the Apple-defined constant

kControl EntireControl.

Thei nTagName isone of several constants defined in the Control Definitions.h header file. This constant supplies
Get Cont r ol Dat a with some specifics about the type of data that's to be accessed from the control. For a text
input field, use the constant k Cont r ol Edi t Text CFStri ngTag.

Thei nBuf f er Si ze isthe sizein bytes of the information to be obtained. Use si zeof with the datatype
corresponding to the value in the control. For atext input field control, the value can be accessed asa CFSt r i ng
(the CFSt ri ng type was discussed in Chapter 2).

Thei nBuf f er isapointer to avariable that isto hold the value returned by CGet Cont r ol Val ue. If you're
obtaining the dataasa CFSt r 1 ng, declare avariable of type CFSt r i ngRef and pass a pointer to that variable
here.

Inthei nBuf f er Si ze parameter, you supply Get Cont r ol Val ue with the size of the datato obtain. Herein
theout Act ual Si ze parameter, Get Cont r ol Val ue replies with the actual size of the data. This should match
thei nBuf f er Si ze , and if your program has no use for thisinformation, you can pass NULL in place of a pointer
toavariable of type Si ze.

Now it's time to move on to an example of an actual call to Get Cont r ol Dat a. Assuming a control handle has
been stored in variable st r i ngl nText Edi t by acall to Get Cont r ol Byl D (as shown in the previous snippet),
the following code can be used to fill the variablet he St ri ng with the text currently in the text input field
referenced by thest ri ngl nText Edi t control handle:

CFStri ngRef theString;

CGet Control Data( stringlnTextEdit,
kControl Enti reControl,
kCont r ol Edi t Text CFSt ri ngTag,
si zeof ( CFStringRef ),
& heStri ng,
NULL );

Now, what should be done with the obtained data? That's up to you and what you want your program to
accomplish. Y our program most likely will examine the user's information and base some decision on that
information. As an alternate, your program might need to manipulate the user's input and then redisplay that altered
value. In many cases, your program will want to supply some feedback, or some value, to the user in response to
obtaining information from atext input field. Y ou can do that by accessing atext input field and then drawing a
string to it. To write to, rather than read from, atext input field, use the Set Cont r ol Dat a routine:

OSErr Set Cont rol Dat a( Cont r ol Ref i nControl,
Control Part Code inPart,
ResType i n TagNane,
Si ze i nSi ze,
[

const void * inData );



When you know how to use Get Cont r ol Dat a, you know how to use Set Cont r ol Dat a. Thefirst three

Set Cont r ol Dat a parameters areidentical to the first three Get Cont r ol Dat a parameters. Y ou pass a handle
to the control to access, a constant representing the control part to access (again, kCont r ol Ent i reCont r ol for
atext input field), and a constant specifying the type of datainvolved (again, the constant

kCont r ol Edi t Text CFSt ri ngTag).

The Set Cont rol Dat a 1 nSi ze parameter isthe same asthe Get Cont r ol Dat a i nBuf f er Si ze parameter.
Usesi zeof ( CFString ) again. Thelast parameter, i nDat a , isapointer to the data to assign to the control.
Again, use apointer toaCFSt r i ngRef variable. In Set Cont r ol Dat a, where you're setting a control value
rather than retrieving a control value, this string needs to have been assigned a val ue before the function call.

Thefollowing isacall to Set Cont r ol Dat a. Assume a handle to the control has been obtained by acall to
CGet Cont r ol Byl D. Further assume that this handle is stored in the Cont r ol Handl e variable
stringQut Text Edi t:

CFSt ri ngRef theString = CFSTR( "Excellent idea!" );

Set Control Dat a( stringQut Text Edit,
kControl EntireControl,
kContr ol Edi t Text CFSt ri ngTag,
si zeof ( CFStringRef ),
& heString );

TextInputltems Program

The purpose of the Textlnputltems program is to demonstrate how to get a value from atext input field and how to
set avaluein atext input field.

Figure 5.12 shows the window displayed by the TextInputltems program. Type any string in the top text input field,

click the Convert to Uppercase button, and the program converts the input string to uppercase and displaysit in the
bottom text input field.

Editing the Nib File
The project's nib file requires awindow resource that holds two text input fields. As shown in Figure 5.13, the
window resource also holds a number of other items, including two group boxes, two static text items, and one push

button. Asfar as program functionality is concenred, all the other items, with the exception of the push button, are
optional.

Figure 5.13. Associating a control ID with atext input control.
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Asshown in Figure 5.13, the upper of the two text input fields has a control ID that consists of a signature of UPPR

and an ID of 1. The lower text input field has the same signature and an ID of 2. The Convert to Upper push button
has a command of Cupr .

Like the signature of a control 1D, acommand can consist of amix of uppercase and lowercase characters. Because
Apple uses all lowercase charactersin its predefined command constants (such as qui t ), you might consider
including at least one upper-case character in your program's commands. I've done that here and will carry on with
this system for the remainder of this book's examples.

Thetext input field that's used to receive the user'sinput is surrounded by a box that's created by clicking the text
input field control and the static text item to the left of the control and then choosing Box from the Group In
submenu in the Layout menu. The box surrounding the lower text input field, though, is created by dragging a
group box from the palette to the window.

In this chapter's discussion of text input fields and the nib file, I've included a caveat regarding grouping text input
field items. Using the group box item from the pal ette can result in enclosed text input fields that are "buried"
within the group box. Such fields don't enable user input. That's why | opted to instead use the menu Box menu
item for the upper group box. For aborder around the output text edit item, though, you can go ahead and use the
group box from the palette. It's actually best if the user can't enter text in thisitem. If the user does, it won't affect
the program. When it comes time to place a string in the output text edit item, the program will replace the user's
text. However, if the user is allowed to enter text in this box, it may be a source of confusion.

Writing the Sour ce Code

The complete source code listing for the Textlnputltems program appears in Example 5.3. Much of this code should
look familiar to you. The Textlnputltems program installs an event handler that responds to acommand. This
ConmmandEvent Handl er routine operatesin amanner similar to other command-handling routines you've seen,
including the one appearing in this chapter's radio button group example. Of interest isthe routine called by
ConmmandEvent Handl er inresponseto akUpper caseConmmand (the command issued by aclick on the
Convert to Uppercase button).

My CommandHandl er callsGet Cont r ol Byl Dtwiceto obtain a handle to each of the two text input controls. A
call to Get Cont r ol Dat a ismade to retrieve the user-entered string from the upper text input field. A call to

Set Cont r ol Dat a ismadeto display astring in the lower of the two text input fields. Rather than simply
redisplaying the user's string, I've opted to include a quick, simple example of string manipulation using a Core
Foundation String Services routine. These Carbon string-handling functions were introduced in Chapter 2.



Here you see that the CFSt r i ngUpper case isaroutine that makesit easy to convert a string reference by a
CFStri ngRef to al uppercase characters:

CFStringUppercase( theString, NULL );

Thefirst CESt ri ngUpper case parameter isthe string to convert. Passa CFSt r i ngRef variable that already
has been assigned some value. The second parameter is a pointer to a supplementary data. As of thiswriting, this
second parameter is unimplemented, and you should passin avalue of NULL, as shown in the preceding snippet.

After a control's ook has been altered, your program should call Dr awOneCont r ol to update the display of the
control. In this program, the look of the text input field used to hold the user's string doesn't get altered. The display
of the typed charactersis handled by the system, so that doesn't count. The look of the text input field used to
provide feedback to the user, though, does get dtered. The call to Set Cont r ol Dat a draws astring to the control.
To update that one control, call Dr awOneCont r ol with the control's handle as the only argument:

DrawOneControl ( stringQutTextEdit );
Example 5.3 Textl nputltems Sour ce Code

#i ncl ude <Car bon/ Car bon. h>

#defi ne kUpper caseComrand " Cupr'
#defi ne kControl Si gnat ure " UPPR
#def i ne kStringlnControl I D 1
#def i ne kStringQutControl I D 2

pascal OSStatus ConmandEvent Handl er (  Event Handl er Cal | Ref handl er Ref ,
Event Ref event, void *userData );

pascal void MyCommandHandl er ( W ndowRef w ndow );

int main( int argc, char* argv[] )

{
| BNi bRef ni bRef ;
W ndowRef wi ndow;
OSSt at us err;
Event Tar get Ref target;
Event Handl er UPP handl er UPP;
Event TypeSpec cmdEvent = { kEvent O assConmmand,

kEvent ProcessCommand ) ;

D
=
—

1

Creat eNi bRef erence( CFSTR("nmain"), &nibRef );

D
=
—

I

Set MenuBar FromNi b( ni bRef, CFSTR(" Mai nMenu") );

err = CreateW ndowFronmNi b( ni bRef, CFSTR("Mai nW ndow"'), &w ndow );
Di sposeN bRef erence( ni bRef );

target = Get Wndowkvent Target ( wi ndow ) ;

handl er UPP = NewEvent Handl er UPP( CommandEvent Handl er ) ;

I nstal | Event Handl er ( target, handl erUPP, 1, &cndEvent,

(void *)w ndow, NULL );

ShowwW ndow( wi ndow ) ;



RunAppl i cati onEvent Loop() ;

return( 0 );

pascal OSStatus ConmandEvent Handl er ( Event Handl er Cal | Ref handl er Ref,
Event Ref event, void *userData)
{
OSSt at us result = event Not Handl edErr;
H Conmand conmand;
W ndowRef wi ndow;

wi ndow = ( W ndowRef )user Dat a;

CGet Event Par anet er ( event, kEvent ParanDi rect Obj ect, typeH Conmand, NULL,
si zeof (H Command), NULL, &comrand);

switch ( command. commandl D )
{
case kUpper caseCommand:
My CommandHandl er ( wi ndow ) ;
result = nobErr;
br eak;

}

return result;

pascal void MyConmandHandl er ( W ndowRef w ndow )
{

Cont r ol Handl e stringlnText Edit;

Cont r ol Handl e stringQut Text Edit;

Control I D stringlnControlI D = { kControl Signature,
kStringlnControl ID };
Control I D stringQutControl I D = { kControl Si gnature,
kStringQutControl I D };
CFStri ngRef theString;

Get Control Byl D( wi ndow, &stringlnControllD, &stringlnTextEdit );
Get Control Byl D( wi ndow, &stringQutControllD, &stringQutTextEdit );

Get Control Data( stringlnTextEdit,
kControl EntireControl,
kCont r ol Edi t Text CFStri ngTag,
si zeof ( CFStringRef ),
& heString,
NULL );

CFStringUppercase( theString, NULL );
Set Cont rol Dat a( stringQut Text Edi t,

kControl EntireControl,
kCont r ol Edi t Text CFStri ngTag,



si zeof ( CFStringRef ),
& heString );

DrawOneControl ( stringQut TextEdit );



For More Information

The following web sites provide extra information about some of this chapter's topics:

Control manager routines. http://devel oper.apple.com/techpubs/macosx/Carbon/
Humanl nterfaceT ool box/ControlManager/Control_Manager/index.html

Control GUI guidelines: http://devel oper.apple.com/techpubs/macosx/Carbon/
Humanl nterfaceT ool box/Aqua/aqua.html


http://developer.apple.com/techpubs/macosx/Carbon/HumanInterfaceToolbox/ControlManager/Control_Manager/index.html
http://developer.apple.com/techpubs/macosx/Carbon/HumanInterfaceToolbox/ControlManager/Control_Manager/index.html
http://developer.apple.com/techpubs/macosx/Carbon/HumanInterfaceToolbox/Aqua/aqua.html
http://developer.apple.com/techpubs/macosx/Carbon/HumanInterfaceToolbox/Aqua/aqua.html

Chapter 6. Menus

MENUS ENABLE A USER TO INTERACT with your program. Y ou've seen that creating
anew Project Builder project automatically provides your program with afew standard
menus. However, you'll want to add other application-specific menus to the menu bar that
your program displays. In this chapter, you'll read about creating and editing menus,
including hierarchical menus. Y ou'll also see how your program can access, disable,
enable, or change the characteristics of any menu or menu item.



Menu Basics

Y our program defines its menus (and items in those menus) in a menu bar resource in the project's main.
nib file. Interface Builder makes it easy to add items to menus and to edit existing menu and submenu
items. After your program’'s menu items are set up and assigned commands, your event-handling source
code defines the response your program should have to a selection by the end user.

Adding New Menusand New Menu Items

To add amenu to a program, you'll use Interface Builder to add the menu and its items to the menu bar.
Y ou'll then add command-handling code to the project's source code file.

Menu and Menu Item Nib Resour ces

Adding a new menu and adding items to that menu are tasks easily accomplished in Interface Builder.
Chapter 2, "Overview of Mac OS X Programming,” discusses adding a new menu to a menu bar in the
nib resource file. Specifically, | walk you through adding a Sound menu with a Begp menu item.
Chapter 3, "Events and the Carbon Event Manager," discusses adding a command signature to a menu
item.

Now we're on to the next step: adding a new menu to a menu bar resource. To do so, click the blue
Submenu box in the palette and drag that item to the menu bar. Determine between which two existing
menus the new menu should go, position it between those menus, and drop it there. Then, double-click
the menu name and type in a new name.

The new menu comes with one item. Y ou can click the menu to expose its item, and then double-click
that item and type a new name for it. To add a second item to the menu, click the blue Item box and
drag and drop it under the first item in the menu. In Figure 6.1, a second item is being added beneath

the Beep Once item in the Sound menu.

Figure 6.1. Adding a menu item to a menu.
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When amenu item is selected by the user, that selection won't result in any action taking place unless
the selected item has a command associated with it and the command is handled in the program's source
code. In Figure 6.2, the Begp Once menu item is being assigned a command of Bep 1. The program that

uses this resource responds to a selection of the second item in the Sound menu. The second item needs

a command too.

Figure 6.2. Assigning a command to a menu item.

= B miain = Mainkienu

[=]

EeeporldMenu  File Edit  ‘Window BAIGL H:Ip}
Beep Once
R

Caribes

Tile: Beep Once

Wenu Sharcut .
[ |
Ky O« :
(.S
DOptions
¥ Enakied
I:Chl:'lrd

[} submenu Parent Choouable
[ Dvnamic

[ Mo Previous ARernase

[ siddes

[ sgnare Mata

_ Commasd

([Bens ' ™ |

The command can be any four characters, but acommand of Bep2 makes sense here.

Menu-Handling Sour ce Code

To handle menu item selection, you'll write an event handler routine that calls Get Event Par anet er



to extract the four-character command from the command-related event. The event handler has the
following format:

pascal OSSt at us ConmandEvent Handl er ( Event Handl er Cal | Ref handl er Ref,
Event Ref event, void *userData)
{

OSSt at us result = event Not Handl edErr;

HI Command command;

Cet Event Paraneter ( event, kEvent ParanDirect Object, typeH Comand,
NULL, sizeof (H Command), NULL, &command );

swtch ( command. commandl D )

{
}

return result;

/! case section for each command to handl e

Theswi t ch includesacase section for each command to be handled. For the two menu items shown
in the Sound menu in Figure 6.2, those command will have constants like these:

#define kBeeplConmand ' Bepl'
#define kBeep2Command ' Bep2'

Install the event handler using an Event TypeSpec that hasaclassof kEvent Cl assConmand and
akind of kEvent ProcessConmand. The user data associated with the command istypically a
window:

Event Tar get Ref t ar get;
Event Handl er UPP handl er UPP;
Event TypeSpec cndEvent = { kEvent O assConmand,

kEvent ProcessCommand };

target = Get WndowEvent Target ( w ndow );

handl er UPP = NewEvent Handl er UPP( CommandEvent Handl er );

| nst al | Event Handl er ( target, handl erUPP, 1, &cndEvent,
(void *)wi ndow, NULL );

When a command-related event occurs, the Carbon Event Manager invokes your program's event
handler to handle the event.

NewM enuAndltems Program

The purpose of the NewMenuAnditems program is to provide an example that makes use of a new
menu that includes more than one menu item. Its source codeis listed in Example 6.1.

The menu that's handled by the program is the one pictured in Figure 6.2. Choosing the Beep Once
menu item generates a Bepl command, while choosing the Beep Twice item produces a Bep?2



command. Both commands are handled within the program's ConmandEvent Hand! er routine. That
routine calls the application-defined function BeepComrandHandl er . Thisroutine ssmply loops the
appropriate number of times, playing the system sound once for each pass through the loop. Although
this routine could have been eliminated in favor of simply calling Sy s Beep from the
ConmmandEvent Handl er, theintent here is to provide the format for a more complicated program
that that handles more commands and that does more than play the system sound.

Example 6.1 NewM enuAndItems Sour ce Code

#i ncl ude <Carbon/ Carbon. h>

#def i ne kBeeplConmand ' Bepl'

#def i ne kBeep2Conmand ' Bep?2'

pascal OSStatus ComrandEvent Handl er ( Event Handl er Cal | Ref handl er Ref,
Event Ref event, void

*userData );

pascal void BeepCommandHandl er ( Ul nt 32 nunBeeps );

int main( int argc, char* argv[] )

{
| BNi bRef ni bRef ;
W ndowRef W ndow;
OSSt at us err;
Event Tar get Ref t ar get;
Event Handl er UPP handl er UPP;
Event TypeSpec cndEvent = { kEvent A assConmand,

kEvent ProcessConmand };

err = CreateN bReference( CFSTR("main"), &nibRef );
err = Set MenuBar FromNi b( ni bRef, CFSTR("Mai nMenu") );
err = CreateW ndowFromNi b( ni bRef, CFSTR("Mai nW ndow'), &wm ndow ) ;

Di sposeN bRef erence( ni bRef );

target = Get Wndowkvent Target ( w ndow );

handl er UPP = NewEvent Handl er UPP( ConmmandEvent Handl er );

I nstal | Event Handl er ( target, handl erUPP, 1, &cndEvent,
(void *)w ndow, NULL );

ShowwW ndow( wi ndow ) ;

RunAppl i cati onEvent Loop() ;

return( 0 );



pascal OSSt atus ConmandEvent Handl er ( Event Handl er Cal | Ref handl er Ref,
Event Ref event, void *userDat a)

{

OSSt at us result = event Not Handl edErr;

H Command command;

Ul nt 32 nunBeeps;

Cet Event Paraneter ( event, kEvent ParanDirect Object, typeH Comand,

NULL, sizeof (H Comrand), NULL, &conmand);
swtch ( command. commandl D )
{
case kBeeplCommuand:
nunBeeps = 1,
BeepCommandHandl er ( nunBeeps );
result = noErr;
br eak;
case kBeep2Command:

nunBeeps = 2;
BeepCommandHandl er ( nunBeeps );
result = noErr;
br eak;

}

return result;

}

pascal void BeepConmandHandl er ( Ul nt32 nunBeeps )

{
U nt 32 x;
for ( x = 1; X <= nunBeeps; Xx++ )
SysBeep( 1 );
}

Adding a Submenu toaMenu

A submenu, or hierarchical menu, is a menu-within-a-menu. When the cursor moves over the submenu
name, a menu drops down and the user chooses an item from the submenu by moving the cursor over
the item of interest and then releasing the mouse button.

A submenu is created in Interface Builder using the Submenu item from the palette. First bring the
menu bar to the forefront and click the menu that's to receive the submenu. With the menu items
displayed, drag the Submenu item from the palette and drop it on the menu. If you've missed your mark
and the submenu ends up with an incorrect placement in the menu, just click it and drag and drop it at
its proper position between the existing menu items. In Figure 6.3, a submenu it being added after the

Beep Twice item in the Sound menu in the menu bar resource of anib file.



Figure 6.3. Adding a submenu to a menu
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Supply the submenu with a name by double-clicking the submenu and typing the new name. The new
submenu comes with one item. Y ou can rename it by doubleclicking it and typing a name. To add
another menu item, display the submenu contents by clicking the submenu name, clicking Item in the
palette, and then dragging and dropping the item to the displayed submenu. In Figure 6.4, an itemis
being added beneath the Soft menu item in the Volume submenu.

Figure 6.4. Adding a menu item to a submenu.
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A menu item in asubmenu is given acommand in exactly the same way any other menu item isgiven a
command: you make the item active and then enter the command in the item's Info window. In Figure

6.5, the Loud menu item in the VVolume submenu is given the command v i+l (for volume high).

Figure 6.5. Assigning a command to an item in a submenu.
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The handling of a submenu item is the same as the handling of any other menu item. Y ou just include
event-handling code for the item's command. The next example program provides a demonstration of
this. We discuss it next.

Hier ar chicalM enuDemo Program

The purpose of the HierarchicalMenuDemo program is to demonstrate the workings of a program that
includes a submenu.

The HierarchicalMenuDemo program includes the VV olume submenu in the Sound menu pictured in
Figure 6.5. In creating the submenu, the Soft item was given acommand of vl Oand the Loud item

was given acommand of v .

The code for HierarchicalMenuDemo is very similar to that of the previous program,
NewMenuAnditems, so including the entire source code listing for the program is unnecessary. Instead,
I'll point out the new code that's added to the NewMenuAndltems code.

NewMenuAnditems defined two constants. One is for the Begp Once menu item command and one is
for the Beep Twice menu item command.

HierarchicalMenuDemo uses those same two constants and adds two more command constants. Now
that the Sound menu has a VVolume hierarchica menu that holds two menu items, there are atotal of
four menu items that have commands, as shown in the following code:

#def i ne kBeeplConmand ' Bepl'
#defi ne kBeep2Comrand ' Bep?2'



#def i ne kVol unmeLowCommand 'vmLO
#def i ne kVol umeH ghCommand "virH

Choosing either item from the V olume submenu results in a change in the volume level of the user's
computer. Set Def aul t Cut put Vol une, which isaroutine discussed in the CheckboxDemo
program in Chapter 5, "Controls," accepts avalue in the range of 0 (volume off ) to 256 (maximum
volume level). I'll use 64 (somewhat arbitrarily) for the low volume setting, and I'll use the maximum
volume value of 256 for the high volume setting:

#def i ne kVol unmeLowLevel 64
#def i ne kVol uneH ghLevel 256

The global variable gUser Vol unelLevel keepstrack of the volume level of the user's machine at
program startup:

Sl nt 32 gUser Vol unelLevel ;

Inmai n,gUser Vol unelLevel isusedto get the volume level before any alterationismadetoit. Itis
used again to restore the volume level before quitting. This code is similar to that which was used in the
Chapter 5 CheckboxDemo program:

int main( int argc, char* argv[] )

{
Get Def aul t Qut put Vol une( &gUser Vol uneLevel );
RunAppl i cati onEvent Loop() ;
Set Def aul t Qut put Vol unme( gUser Vol uneLevel );
return( 0 );

}

The event handler ConmmendEvent Handl er responds to selections of the Begp Once and Beep
Twice menu items as it did in the NewMenuAnditems program. Here, however, theswi t ch statement
gainstwo new case sections, one for each submenu item. Note that the code doesn't distinguish
between commands received from a hierarchical menu or a normal menu; a command is a command.

switch ( conmand. conmandl D )
{
case kBeeplCommand:
nunBeeps = 1;
BeepCommandHandl er ( nunBeeps );
result = noErr;
br eak;
case kBeep2Command:
nunBeeps = 2;



BeepCommandHandl er ( nunBeeps );
result = noErr;
br eak;

case kVol uneLowConmand:
Set Vol uneLevel ( kVol uneLowLevel );
result = noErr;
br eak;

case kVol unmeH ghCommand:
Set Vol uneLevel ( kVol uneH ghLevel );
result = noErr;
br eak;

}

The application-defined Set Vol unelevel routine accepts an integer in the range of 0 to 256 and
uses that value to change the volume level:

voi d Set Vol uneLevel ( SInt32 vol une )

{
Set Def aul t Qut put Vol une( vol une );

SysBeep( 1 );



Altering Menus Characteristics

A menutitle, and the title of any or all theitemsin that menu, can be altered. The most common
change to a menu or menu item is the disabling or enabling of it. If the function of amenu item, or an
entire menu, doesn't make sense at a particular point in the running of your program, that menu item
or menu should be disabled. For instance, if the user closes all your program's windows, you'll want
some or al theitemsin the Window menu to be disabled.

Although the act of disabling and enabling are the main reasons your program will alter the look of a
menu or menu item, there are other ways in which your program might want to alter amenu or menu
item characteristic. Fortunately, the Carbon APl makesit easy to change the font, size, or style of any
menu item.

Accessing Menusand Menu Items

Before you change the look of a menu or menu item, you need to obtain access to it. That access
comes in the way of a menu handle or menu reference. A menu handle has the data type

VenuHandl e, and amenu reference has the datatype VenuRef . MenuHandl e and VenuRef are
the same type, so Carbon routines that list one type as the data type of a parameter will in fact accept
an argument of either type.

To gain access to a menu, you need to give that menu an ID. That's something that hasn't been donein
any of the previous examplesin this book, so listen closely. To give amenu an ID, click the menu in
Interface Builder, choose Show Info from the Tools menu, and then type an ID inthe Menu ID field in
the window's Attributes pane.

Figure 6.6 shows a Color menu being given an ID of 6. In this example, the Color menu is the sixth

application menu from the left side of the menu bar (the program will automatically get the Apple
menu added to the far left of its menu bar), so the menu isgiven an ID of 6. You are, however, freeto
choose your own numbering scheme for menus.

Figure 6.6. Assigning amenu ID to a menu.
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After assigning amenu an 1D, make a call to the Carbon routine Get MenuHand! e to obtain ahandle
to the menu. Because you'll most likely access a menu from avariety of placesin your program's
code, it often makes sense to declare the menu handle as a global variable, obtain the handle early in
the running of your program, and then use it whenever the menu, or an item in the menu, needs to be
altered.

#def i ne kCol or Menul D 6
MenuHandl e gCol or Menu;

gCol or Menu = Get MenuHandl e( kCol or Menul D ) ;

After your program has a handle to a menu, it can access that menu and all the menu'sitems. Y ou'll
define constants that establish the item number of each item in a menu that might be altered. Doing
thismeans that if you decide to rearrange a menu'sitems in Interface Builder, you need to make
changes to menu-accessing code in just one place-the section of your program that defines the
program's constants. For the Color menu shown in Figure 6.6, those constants might look like this:

#defi ne kCol or MenuGr ayscal el t enNum 1
#def i ne kCol or MenuDi t her I t emNum
#def i ne kCol or MenuBi t Dept hl t emNum 3

N

In the next sections, you'll see how access to a menu makes it possible to enable and disable menu
items (and an entire menu) and to change the characteristics of amenu item'stitle (such asits font,
size, or style). All these techniques require that your program first obtain a handle to the menu that
holds the item or items to alter.

Enabling and Disabling Menusand Menu Items

A program can disable any itemsin amenu, or even the entire menu. When amenu item is disabled, it
appears lighter, or dimmer, than an enabled item. In addition, choosing the item produces no effect.

When one or more itemsin a menu are disabled, the title of the menu remains enabled so that the end
user can access the remaining enabled itemsin that menu. However, an entire menu-including the



menu title in the menu bar-can be disabled. To do that, your program can define the menu to be auto
disabling in the project's nib file (Figure 6.6 shows the AutoDisable option), or it can explicitly disable

the menu within the project's source code. If the menu is set to auto disable, any time all theitemsin
that menu are disabled, the menu title itself will become disabled. If the menu isn't set to auto disable,
al the items in the menu can be disabled and the menu title itself will remain enabled. In that case, the
program's code could disable the menu title if desired.

Figure 6.7 shows a Sound menu that's been disabled. The top of the figure emphasizes that the menu
title can be disabled, while the bottom of that same figure shows the dimmed appearance of disabled

items within the menu.

Figure6.7. A disabled menu and itsdisabled items.
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Enabling and Disabling Menu Itemsin a Nib Resource

When you add a new menu item to a menu in your project's nib file, that menu item is enabled by
default. Within the nib file, you can toggle that item's state from enabled to disabled easily. To do that,
click the menu item, choose Show Info from the Tools menu, and then uncheck the Enabled checkbox
in the Options section of the Attributes pane of the Info window. Y ou can look back at Figure 6.2 or

Figure 6.5 to see this checkbox.

Setting the state of a menu item in the nib file is good for initially enabling or disabling an entire menu
or amenu item. For instance, if you add a menu item to the Window menu, you'll most likely have
that item disabled initially if your program doesn't open any windows at launch. Regardless of which
itemsyou initially disable, there's a good chance that your application will need to disable one or more
items as the program runs. As expected, that's done from within source code.

Enabling and Disabling Menu Itemsin Source Code

Disabling a menu item in the nib resource is fine for setting that item'sinitial state, but the bulk of
menu item enabling and disabling work will be done in your program's code. Before attempting to
alter amenu item, you need to get a handle to that item's menu. Consider the Color menu shown back
in Figure 6.6, and the following constant definitions:

#def i ne kCol or Menul D 6
#def i ne kCol or MenuGr ayscal el t emNum 1



#defi ne kCol or MenuDi t her | t enNum
#def i ne kCol or MenuBi t Dept hl t emNum 3

N

Y ou now should declare amenu handle and call Get MenuHand! e to get ahandle to the desired
menu:

MenuHandl e gCol or Menu;

gCol or Menu = Get MenuHandl e( kCol or Menul D ) ;

Todisableamenuitem, cal Di sabl elenul t em Pass this Carbon routine a handle to the menu
that holds the item to alter and the number of the item to alter. For instance, to disable the last menu
item (the third item from the top of the menu), use this code:

D sabl eMenul t en{ gCol or Menu, kCol or MenuBi t Dept hl t emNum ) ;

To enable amenu item, use the Carbon routine Enabl eVenul t em It accepts the same arguments as
D sabl eMenul t em Thiscall to Enabl eVenul t emenables the Dither menu item:

Enabl eMenul t em{ gCol or Menu, kCol or MenuDi t herltemNum);

Interestingly, asingle cal to Di sabl elVenul t emcan disable an entire menu. When amenu is
disabled, itstitle is disabled, as are al the items in the menu. To disable an entire menu, pass avalue
of 0 asthe number of the item to disable:

D sabl eMenul ten{ gCol or Menu, 0 );

To enable amenu and its contents, perform asimilar trick using acall to Enabl elVenul t em like
this:

Enabl eMenul tenm( gCol or Menu, 0 );
DisableEnableMenu Program

The purpose of the DisableEnableMenu program is to demonstrate how to disable and enable
individual menu items and an entire menu. Y es, you finally get to silence those annoying beeps that
have appeared in so many previous examples!

DisableEnableMenu displays the menu bar and window shown in Figure 6.7. The six radio buttons are
all part of one radio button group. To make a change to the state of a menu item in the Sound menu, or
to change the state of the entire menu, click one of the buttons and then click the Do It button. Click
the Sound menu to verify that the change in state took place. Note that disabling the entire menu
renders ineffective enabling changes to individual itemsin that menu. For instance, if the Sound menu
isdisabled, an attempt to enable one of the itemsin that menu will fail.

The Sound menu is the same one found in this chapter's NewM enuAndltem program. Here, though,



the menu has been assigned an ID. Figure 6.8 shows that the Sound menu has an ID of 4.

Figure 6.8. Assigning amenu ID to a program's Sound menu.
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The program's window includes two controls. a radio button group and a push button. As shownin
Figure 6.9, the radio button group has a control 1D consisting of a signature of abCD (you can assume

thisisthe program's creator code) and an ID of 1. The push button has a command of Snivh (for
Sound menu). If you aren't familiar with controls and control 1Ds, refer to Chapter 5 in general and

that chapter's "Radio Buttons" section in particular.

Figure 6.9. The control ID and command for two controls.
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DisableEnableMenu is another program based on this chapter's NewM enuAndltems program, which
means it's also another program that doesn't require a complete source code listing. Instead, we'll only
take alook at the pertinent additions to NewMenuAndltems.

NewMenuAnditems defined two constants-one for the command associated with each of the two
items in the Sound menu. Those contents appear here, but there's al'so a third command to watch for. It



is the one associated with the Do It button:

#def i ne kBeeplComrand ' Bepl'
#defi ne kBeep2Comand ' Bep2'
#def i ne kAdj ust SoundMenuComrand " Snvh'

The radio button group has acontrol 1D with asignature of abCDand | D of 1:

#def i ne kControl Si gnature ' abCD
#def i ne kRadi oG oupControl I D 1

A cdl to Get Cont rol 32Bi t Val ue returns the number of the radio button that was on at the time
the Do It button was clicked. The program defines a constant to match the six values
Cet Control 32Bi t Val ue can return:

#defi ne kDi sabl eSoundMenu
#defi ne kEnabl eSoundMenu

#def i ne kDi sabl eBeepOncel tem
#def i ne kEnabl eBeepOncel t em
#defi ne kDi sabl eBeepTwi celtem
#def i ne kEnabl eBeepTw cel t em

OO WNPRP

Accessing the Sound menu is dependent on using the menu's ID to obtain a menu handle for the menu.
Changing the state of either item in that menu is dependent on knowing the item number of the item to
change:

#defi ne kSoundMenul D 4
#def i ne kSoundMenuBeepOncel t emNum 1
#defi ne kSoundMenuBeepTw cel t emNum 2

A global variable is used to hold the handle to the Sound menu. In ai n, thisvariableis given its
value by way of acall to Get MenuHandl e:

MenuHandl e gSoundMenu;

gSoundMenu = Get MenuHandl e( kSoundMenul D ) ;

Inthe ConmandEvent Handl er routine, theswi t ch statement keepsits origina two case
sections to handle Sound menu item selections, and it gains one new case section to handle a click
on the Do It button:

switch ( command. conmandl D )

{

case kBeeplCommand:
nunBeeps = 1;



BeepCommandHandl er ( nunBeeps ) ;
result = noErr;
br eak;

case kBeep2Conmmand:
nunBeeps = 2;
BeepCommandHandl er ( nunBeeps );
result = noErr;
br eak;

case kAdj ust SoundMenuConmmand:
Adj ust SoundMenu( w ndow ) ;
result = noErr;
br eak;

}

The handling of the Do It button necessitates a new routine- Adj ust SoundMenu. The format of
Ad] ust SoundMenu matches the format of BeepConmandHandl er , which was in the Chapter 5

example program RadioButtonGroup.

As shown in the following code, acall to Get Cont r ol Byl D provides areference to the radio button
group control, and acall to Get Cont r ol 32Bi t Val ue usesthat reference to find which of the
group's radio buttonswas on. A swi t ch statement provides the code to handle each button in the
group. Each case sectioninthisswi t ch calseither Enabl eMVenul t emor Di sabl elVenul t em
to enable or disable the item or menu included in the radio button title.

voi d Adj ust SoundMenu( W ndowRef w ndow )
{
Cont r ol Handl e adj ust SndMenuRadi oBut t onG oup;
Control I D adj ust SndMenuControl I D = { kControl Si gnat ure,
kRadi oG oupControl ID };
Sl nt 32 adj ust SndMenuVal ue;

Get Control Byl D( wi ndow, &adj ust SndMenuControl I D,
&adj ust SndMenuRadi oBut t onG oup ) ;
adj ust SndMenuVal ue = Get Control 32Bi t Val ue(
adj ust SndMenuRadi oBut t onG oup );

switch ( adjust SndMenuVal ue )
{
case kDi sabl eSoundMenu:
Di sabl eMenul ten{ gSoundMenu, 0 );
br eak;
case kEnabl eSoundMenu:
Enabl eMenul ten{ gSoundMenu, 0 );
br eak;
case kDi sabl eBeepOnceltem
Di sabl eMenul t en{ gSoundMenu, kSoundMenuBeepOnceltenmNum ) ;
br eak;
case kEnabl eBeepOnceltem
Enabl eMenul t em( gSoundMenu, kSoundMenuBeepOnceltenmNum ) ;



br eak;

case kDi sabl eBeepTwi celtem
Di sabl eMenul t em{ gSoundMenu, kSoundMenuBeepTw celtenmNum ) ;
br eak;

case kEnabl eBeepTwi celtem
Enabl eMenul t em( gSoundMenu, kSoundMenuBeepTw celtenmNum ) ;
br eak;

Changing the Characteristics of a Menu Item

Disabling or enabling a menu item involves obtaining a handle to the menu that holds the item and
then using that handle as an argument to a menu-altering Carbon routine. Disabling or enabling a
menu item also involves changing the characteristic of that menu item. To change some other
characteristic of amenu item, first get a handle to that menu. To change an item in the File menu, for
instance, begin like this:

#def i ne kFi | eMenul D 1
MenuHandl e gFi | eMenu;

gFi | eMenu = Get MenuHandl e( kFi | eMenul D ) ;

Now choose the appropriate Carbon routine that makes the required change. For instance, to change
the font used to display the name of the New menu item, call Set Venul t enFont | D. Inthe
following code, the F\Vet Font Fam | yFr omNane routineis called to get aF\VFont Fami |y
reference to the font of interest. Y ou then pass FMGet Font Fam | yFr onName the name of this
font, with the name prefaced with \p to specify that the name isin Pascal format. In this code, the font
family is Times.

FMFont Fam | y font Fam | y;

fontFam |y = FMGet Font Fam | yFronmName( "\ pTi nes" );

Now call Set Menul t enfont | D. Inthe call, you pass the handle to the menu, the item number of
the menu item to change (the New item appearsfirst in the File menu), and the font family:

Set Menul tenfont | D( gFil eMenu, 1, fontFamly );

Y ou can repeat the previous steps (get a menu handle and use that handle in a call to the appropriate
menu-altering routine) for any change to a menu item's appearance.

To change the font of one menu item, call Set Menul t enfont | D. To change the font of all itemsin
amenu, call Set MenuFont . Inthe Set MenuFont routine, you pass a menu handle, afont family,
and a constant specifying the point size of the font. For example, to change the font of all theitemsin
the File menu to 24 point Times, use this code:



fontFam |y = FMGet Font Fam | yFronmNanme( "\ pTi nes" );
Set MenuFont ( gFi |l eMenu, fontFamly, 24 );

Y ou can change the style of amenu item'stitle by calling Set | t enfst vyl e . Passthisroutine a
handle to the menu that holds the item of interest, the number of the item of interest, and a constant
that specifiesthe style to use. The following is aline that changes the Open menu item (the second
menu item down from the top of the File menu) to italic:

SetltentStyle( gFileMenu, 2, italic );

There are eight constants for specifying menu item style: nor nel , bol d, it al i c,under | i ne,
out |1 ne,shadow, condense, and ext end. These constants can be used individualy, or two or
more constants can be combined, as shown in the following code:

Setltenttyl e( gFil eMenu, kFileMenud oseltemNum italic + bold );
MenultemCharacteristics Program

The purpose of the MenultemCharacteristics program is to provide an example of how to change the
look of menu items.

MenultemCharacteristics is a simple program that doesn't include any menus other than the ones
supplied in the standard main.nib file that's part of any new nib-based project. The program doesn't
include any event-handling code other than the call to RunApp! i cat i onEvent Loop. You can see
that the entire source code listing for this program (Example 6.2) consists of just alittle more than two
dozen lines of code. MenultemCharacteristics exists ssmply to display some nonstandard menu items
in the File menu. On the left of Figure 6.10, you see the program'’s File menu. On the right of that

figure, you see the same File menu as it appearsin a program that doesn't alter that menu.

Figure 6.10. The File menu before and after being altered by a program.
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The program makes acall to Set VenuFont to change the font of all the itemsin the File menu.
Each item is set to be displayed in 24 point Courier. Then, acall to Set Menul t enfont | Dismade
to change just the New menu item to Times. The Open menu item is set to appear in italics by way of
acal to Set | t entst vl e. Finaly, the Close menu item is set to appear in both italics and bold by



combining theitalic and bold constantsin acall to Set | t enfst yl e.

Note

Menu item numbering includes blank items. For instance, Figure 6.10 shows that a blank

space exists between the Open and Close menu items in the File menu. This blank space
is considered an item-item number 3. That's why the constant for the Close menu item,

kFileM enuCloseltemNum, has avaue of 4.

Example 6.2 MenultemChar acteristics Sour ce Code

#i ncl ude <Car bon/ Car bon. h>

#def i ne kFi | eMenul D 1
#defi ne kFi | eMenuNew t enfNum 1
#def i ne kFi | eMenuQpenl t enNum 2
/1 blank (enpty) item 3
#defi ne kFi | eMenuC osel t emNum 4
#defi ne kBi gFont Si zePt s 24

MenuHandl e gFi | eMenu;

int main( int argc, char* argv[] )

{
| BNi bRef ni bRef ;
W ndowRef w ndow;
CSSt at us err;

FMFont Fam | y font Fam | y;

err Creat eNi bReference( CFSTR("main"), &nibRef );

err Set MenuBar FromNi b( ni bRef, CFSTR(" Mai nMenu" )

err = CreateWndowFronmNi b( ni bRef, CFSTR("Mai nW ndow"),

Di sposeNi bRef erence( ni bRef );

gFi l eMenu = Get MenuHandl e( kFi |l eMenul D );

fontFam |y = FMGet Font Fam | yFronNane( "\ pCourier" );

),

Set MenuFont ( gFi |l eMenu, fontFam |y, kBigFontSizePts );

fontFam |y = FMGet Font Fam | yFronNane( "\ pTi nes" );

&w ndow ) ;



Set Menul t enfont I D( gFi | eMenu, kFi |l eMenuNewl temNum fontFamly );

SetltentStyl e( gFil eMenu, kFileMenuOpenltemNum italic );
SetltentStyl e( gFil eMenu, kFileMenud oseltemNum italic + bold );

ShowwW ndow( wi ndow ) ;
RunAppl i cati onEvent Loop() ;

return( 0 );



Pop-Up Menus

A pop-up menu is amenu that existsin awindow rather than in the menu bar. Figure 6.11 shows a pop-

up menu. At the top of this figure, you see the pop-up menu before it's clicked. The bottom of the figure
shows that this pop-up menu consists of four items, with the first item (Choose a shirt size) serving as
the title of the menu itself.

Figure6.11. A pop-up menu in a window.
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Like aradio button group, a pop-up menu provides the user with a number of options from which the
user picks one. Whether you should use aradio button group or a pop-up menu isup to you. There are
no strict rules here. However, Apple does offer the following guideline: If a situation requires five or
more options, you should use a pop-up menu rather than aradio button group.

Figure 6.11 shows a pop-up menu that uses the first menu item as a means of telling the user the
purpose of the menu. Another way to do thisisto place a static text item to the left of the pop-up menu,

as shown in Figure 6.12.

Figure 6.12. A pop-up menu with a static text caption.
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Now it's time to announce this chapter's Mystery Menu question: When is a menu not a menu? To spare



you the unbearable suspense you'd be subjected to should | hold off on the answer, I'll revedl it right
here: a menu isn't amenu when it is a pop-up menu because a pop-up menu is actually a control. Thus,
to use Interface Builder to add a pop-up menu to awindow, you use the Controls pane of the palette.
There you drag a pop-up menu control (it looks like a pop-up menu with Item 1 asits displayed menu
item) from the palette to awindow. Figure 6.13 shows a pop-up menu control being added to a window.

Figure 6.13. Adding a pop-up menu to a window.
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A pop-up menu comes with oneitem; it has atitle of Item 1. To edit this title, double-click it and type
the new title. Now comes the interesting part. To add additional items to this control, you don't use the
Controls pane of the palette. Instead, you use the Menus pane of the palette to drag and drop an item
from the palette to the pop-up menu. This chapter's "Menu and Menu Item Nib Resources’ section
illustrates how this is done for a normal menu.

Each item in the pop-up menu should have a command associated with it. The possible exception is the
first item. If you use that item as a menu title (as shown in Figure 6.11), it needs no command. In Figure

6.14, the Small item in the pop-up menu is given acommand of pop1 (for thefirst selectable item in

the pop-up menu). Aswith any item capable of having a command associated with it, the four-character
naming schemeis up to you.

Figure 6.14. Assigning a command to a pop-up menu item.
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Pop-Up Menu Source Code

When the user chooses an item from a pop-up menu, that selection generates acommand event, just as
if theitem resided in a standard menu in the menu bar. Y our program responds to the command event
asit would any other type of event generated by a command. The PopUpMenuDemo program provides
an example of this.

PopUpM enuDemo Program

The purpose of the PopUpMenuDemo program is to demonstrate the handling of a pop-up menuin a
window.

Running the program displays the window shown in Figure 6.11. You can click the pop-up menu to

reveal the itemsin that menu. Choosing the Small, Medium, or Large item resultsin a short string being
drawn in the window. The string acknowledges which item was just selected. For instance, choosing
Small resultsin the string You chose the size Small shirt. being drawn.

Thefirst item, Choose a shirt size, serves as the menu'stitle and is disabled. Any menu item can be
disabled by unchecking the Enabled checkbox in the Info window for that item. Figure 6.14 shows the

Enabled checkbox checked for the Small menu item.

The three enabled menu items in the pop-up menu have commands of popl, pop2,and pop3. The
source code, shown in its entirety in Example 6.3, includes three constants corresponding to these

commands.

The program's event handler calls Get Event Par anet er to extract the command from the event. If
the command is either pop 1, pop2, or pop3, the event handler responds by calling the application-
defined PopUpConmandHand! er routine. Thisis shown in the following code for the pop 1 event:



case kPopUpSi zeSnal | Command:
PopUpCommandHand! er ( wi ndow, kPopUpSi zeSnal | Command ) ;
result = noErr;
br eak;

The PopUpComrandHandl er routine includes some code that's new to you. It's code that will be
described in more depth in the next chapter of this book. Based on the menu item selected, the routine
draws one of three strings to the window. Before drawing a string, PopUpConmandHand! er clears
the drawing area of text from a previous string by drawing a white rectangle. To work with arectangle,
you declare avariable of type Rect and then assign values to the rectangle's four coordinates. If the
assignment is made at the time of declaration, the order of the coordinates is top, left, bottom, and right
(T, L, B,and R):

I { T, L, B, R}
Rect whiteRect = { 60, 10, 90, 270 };

The preceding code creates a rectangle that has atop coordinate 60 pixels down from the top of the
window to which the rectangle will eventually be drawn. The bottom coordinate is 90 pixels down. This
establishes arectangle 30 pixelsin height. The left side of the rectangle is 10 pixelsin from the left side
of the window, while the right side of the rectangle is 270 pixelsin from the left side (resulting in a
rectangle 260 pixels across).

DeclaringaRect variable doesn't draw arectangle. To do that, you must call Fr aneRect toframea
rectangleor Fi | | Rect tofill the rectangle. In the following code, Fi | | Rect iscalled tofill the

whi t eRect rectangle with a solid white pattern (which just happens to be the background pattern of a
window):

Pattern white;

Get QDA obal sWite( &white );
Fill Rect( &whiteRect, &white );

The system predefines several patterns for your use. Aswill be discussed in detail in Chapter 7,
"QuickDraw Graphics," these patterns reside in a QuickDraw global structure. To get areference to one
of these patterns, call the appropriate Carbon routine: Cet QDG obal s\Wi t e to obtain awhite
pattern, Get QDG obal sBl ack to get ablack pattern, and so forth. Y ou then use that pattern in acall
toFi | | Rect.Fi || Rect acceptsapointer to the rectangle to fill and a pointer to the pattern to use in
thefilling of said rectangle.

After filling the rectangle to effectively erase any previously drawn text, the program entersaswi t ch
statement where the appropriate string is drawn to the now-empty area in the bottom portion of the
window.

Example 6.3 PopUpM enuDemo Sour ce Code

#i ncl ude <Car bon/ Car bon. h>



#def i ne kPopUpSi zeSmal | Command " popl’
#def i ne kPopUpSi zeMedi unConmand ' pop?2'
#def i ne kPopUpSi zeLar geCommand " pop3'

pascal OSStatus ConmandEvent Handl er ( Event Handl er Cal | Ref handl er Ref,
Event Ref event, void
*userData );

voi d PopUpConmandHandl er ( W ndowRef w ndow, Ul nt32 command );

int main( int argc, char* argv[] )

{
| BNi bRef ni bRef ;
W ndowRef wi ndow;
OSSt at us err,;
Event Tar get Ref target;
Event Handl er UPP handl er UPP;
Event TypeSpec cndEvent = { kEvent d assConmand,
kEvent ProcessConmand };
err = CreateN bReference( CFSTR("main"), &nibRef );
err = Set MenuBar FronmNi b( ni bRef, CFSTR("Mi nMenu") );
err = Creat eW ndowFronNi b( ni bRef, CFSTR("Mai nW ndow'), &w ndow );
Di sposeN bRef erence( ni bRef );
target = Get WndowEvent Target ( w ndow );
handl er UPP = NewEvent Handl er UPP( ConmmandEvent Handl er );
I nstal | Event Handl er ( target, handl erUPP, 1, &cndEvent,
(void *)wi ndow, NULL );
ShowwW ndow( wi ndow ) ;
RunAppl i cati onEvent Loop() ;
return( 0 );
}

pascal OSSt atus ConmandEvent Handl er ( Event Handl er Cal | Ref handl er Ref,
Event Ref event, void *userData)
{
OSSt at us result = event Not Handl edErr;
HI Command command;
W ndowRef W ndow,
wi ndow = ( W ndowRef )userDat a;



CGet Event Par anet er ( event, kEvent ParanDi rect Obj ect, typeH Conmand,
NULL, sizeof (H Command), NULL, &conmand);

switch ( command. conmandl D )
{
case kPopUpSi zeSmal | Command:
PopUpCommandHandl er ( wi ndow, kPopUpSi zeSnal | Conmand ) ;
result = noErr;
br eak;
case kPopUpSi zeMedi unComrand:
PopUpConmmandHandl er ( wi ndow, kPopUpSi zeMedi unCommand ) ;
result = noErr;
br eak;
case kPopUpSi zeLar geCommand:
PopUpCommandHandl er ( wi ndow, kPopUpSi zeLar geConmand ) ;
result = noErr;
br eak;

}

return result;

voi d PopUpComuandHandl er ( W ndowRef w ndow, Ul nt32 comand )
{
/1 { T, L B R}

Rect whiteRect = { 60, 10, 90, 270 };

Pattern white;

Set Por t W ndowPort ( wi ndow ) ;
Get QDA obal sWite( &hite );
Fill Rect( &whiteRect, &white );
MoveTo( 30, 80 );

switch ( conmand )

{
case kPopUpSi zeSmal | Command:
DrawString( "\pYou chose the size Small shirt." );
br eak;
case kPopUpSi zeMedi unComrand:
DrawString( "\pThe size Mediumshirt was selected.” );
br eak;
case kPopUpSi zeLar geComrand:
DrawString( "\pThat was the size Large shirt." );
br eak;
}



For More Information

The following web sites provide extra information about some of this chapter's topics:

Menu GUI guidelines: http://devel oper.apple.com/techpubs/macosx/Carbon/
Humanl nterfaceT ool box/Aqua/aqua.html

Menu manager routines: http://devel oper.appl e.com/techpubs/macosx/Carbon/
Humanl nterfaceT ool box/M enuM anager/Menu_Manager/index.html


http://developer.apple.com/techpubs/macosx/Carbon/HumanInterfaceToolbox/Aqua/aqua.html
http://developer.apple.com/techpubs/macosx/Carbon/HumanInterfaceToolbox/Aqua/aqua.html
http://developer.apple.com/techpubs/macosx/Carbon/HumanInterfaceToolbox/MenuManager/Menu_Manager/index.html
http://developer.apple.com/techpubs/macosx/Carbon/HumanInterfaceToolbox/MenuManager/Menu_Manager/index.html

Chapter 7. QuickDraw Graphics

WHAT IS QUICKDRAW? Y ou're asking that question just alittle late. QuickDraw isa
large set of Carbon API routines that enables programmers to draw simple shapes such as
lines, rectangles, and ovals. All the programs in this book, as well as the programs you
created, relied on QuickDraw. That's because QuickDraw is all about drawing, including
the drawing of interface items such as windows and menus.

The routines in the Carbon API are conceptually categorized into separate areas. Each area
consists of routines that, for the most part, work with a single programming topic. Each
Carbon area can have a name that includes "Manager," such as Window Manager, Menu
Manager, and Carbon Event Manager. On the other hand, some Carbon API areas don't
include "Manager" in their names. QuickDraw is one such area.

In this chapter, you'll see how to draw shapes, as well as how to enhance the look of such
shapes by filling them with monochrome or colored patterns.



QuickDraw Basics

S0, you're ready to jump right into drawing afancy shape such as an oval filled with a checkerboard
pattern, right? No you aren't! Before drawing shapes, make sure that you know about the graphics grid
that's used to define the size and window location of a shape. Y ou aso need to know how to go about
setting drawing parameters, such as the thickness of the lines used to draw shapes. Topics such as
these are covered in this section.

Coordinate System

When your program draws, it needs to specify where to draw. There are two components to this
specification. Y our program should specify the window to which to draw, and it should specify where
in that window the drawing is to take place.

Drawing always takes place in a port, which is a graphics entity used to hold information about a
drawing. Every window has its own port, and the screen (monitor) itself includes a port. The screen's
port makes it possible for the desktop to be displayed. Note that the desktop isn't awindow, yet it gets
drawn to. A window's port makes it possible to specify to which window to draw, in the event a
program enables more than one window at atime to be open.

Y ou tell your program which port to draw to by passing to the Set Por t W ndowPor t routine the
window in which the drawing will occur. Typically, thisis done within awindow update routine,
before any drawing takes place:

voi d Updat eW ndow( W ndowRef w ndow )

{
Set Port W ndowPort ( wi ndow ) ;

/'l now start draw ng

}

Specifying where within awindow a drawing should take place is done by specifying the coordinates
at which to draw. Macintosh windows make use of a coordinate grid system. In this system, every
pixel in the content area of awindow is defined by a coordinate pair. The content areaisthe area
drawn to. This area excludes the window title bar and scroll bars, if present.

The grid is a coordinate system that has a horizontal component and a vertical component. The upper-
left pixel in awindow's content area has a horizontal component of O (zero pixels from the left side of
the window) and a vertical component of O (zero pixels from the top of the window). The horizontal
component of the pair is specified first, followed by the vertical component. Thus, the upper-left pixel
of awindow isreferred to as (0, 0).

To specify the pixel located 20 pixelsin from the left side of the window, but still in the uppermost
row of pixels, you'd refer to the pixel as (20, 0). Figure 7.1 illustrates this. In thisfigure, the circled



pixel is 60 pixelsin from the left side of the window and 20 pixels down from the top of the window,
so to reference this one pixel, you'd use the coordinate pair of (60, 20).

Figure 7.1. The coordinate system of a window.
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In Chapter 4, "Windows," the example program WindowU pdate used a graphics grid. There, before a

string of text was drawn, the VoveTo routine was called to specify the starting point for drawing.
That code specified that the drawing should start 30 pixels from the |eft side of the window and 60
pixels down from the top of the window:

MoveTo( 30, 60 );

Drawstring( "\pThis is drawn from code!" );

The VbveTo routine specifies the starting location for drawing based on a coordinate pair global to
the window. Another routine, Vov e, specifies the starting location based on the current drawing
location. Here are the prototypes for those two routines:

void MoveTo( SIntl1l6 h, SIntl6 v );
void Move( SIntl6 h, SIntl6 v );

To see these routines used in conjunction with one another, consider this snippet:

MoveTo( 40, 80 );
Move( 70, 10 );

The call to VbveTo moves the starting location to the pixel 40 pixelsin from the left side of the
window and 80 pixels down from the top of the window. The call to Vove moves the starting point 70
pixelsto the left of its current position of 40 pixelsin, and 10 pixels down from its current position of
80 pixels down. After both routines execute, the result is that the new starting position for drawing is
at pixel (110, 90).

To use Vbv e to move the starting position to the left or up, use negative values. For instance, to move
the starting position left 10 pixels and up 20 pixels, call Move likethis:

Move( -10, -20 );



Line and Shape Drawing and the Graphics Environment

Each port has its own graphics environment. That is, a port has a set of properties that a program
makes use of when drawing to that port. Consider this snippet:

Set Port W ndowPort ( wi ndow ) ;

MoveTo( 20, 60 );
Li neTo( 120, 60 );

The preceding call to VoveTo specifiesthat the drawing should start 20 pixels from the left side of
the window and 60 pixels down from the top of that window. Li neTo isadrawing routine that draws
aline from the current starting location to the specified ending location. Thecall to Li neTo specifies
that aline should be drawn from that starting point and extend to the point 120 pixels from the left
side of the window and 60 pixels down from the top of the window. The result is a horizontal line 100
pixelsin length. That line will be black, and it will have athickness of one pixel. The line has these
attributes because a graphics port has a graphics environment, and that environment assigns its various
fields default values. One of those fieldsis line thickness, which isinitially set to one pixel.
Collectively, these fields that affect line and shape drawing make up a conceptual drawing device
referred to as the graphics pen.

There are afew access routines that enable you to change the attributes of the graphics pen. You've
aready seen that Vove and VbveTo move the graphics pen (though you might not have known that
what was being affected by these routines was, in fact, the graphics pen). To change the pixel size of
linesdrawn in aport, cal Set Port PenSi ze:

voi d Set Port PenSi ze( CGafPtr port,
Poi nt penSi ze ) ;

A CGr af Pt r isapointer to acolor graphics port, which is the type of port associated with a window.
Rather than simply passing the \W ndowRef , you need to pass a pointer to the window's port. That's
easy enough to do with the Get W ndowfor t routine. Assuming the window isa\W ndowRef
variable, here's how you can change the size of the graphics pen so that it draws lines that have a
height of 8 pixelsand awidth of 5 pixels.

Poi nt t hePenSize = { 8, 5 };

Set Port PenSi ze( Get WndowPort( w ndow ), thePenSize );

Usethe PenNor mal routine to return the current port's graphics pen to itsinitial, or default, state:
PenNor mal () ;

Text Drawing and the Graphics Environment

The characteristics of text drawn to awindow also are under the control of the port's graphics



environment, though the graphics pen won't affect the look of the text. For instance, if you call

Set Port PenSi ze to change the thickness of the graphics pen, the thickness of lines will be
affected, but the thickness of the text won't be. To change the look of the text, use any of the following
routines:

void TextFont( SInt16 font);
voi d Text Face( Styl eParaneter face );
void TextSi ze( SIntl1l6 size );

Text Font establishesthe font used in drawing text to the current graphics port. Thef ont parameter
specifiesthe font family I1D. Each font is considered a family, and each family hasan ID. A font
family 1D of O isused to represent the system font. This system font ID istheinitia value that a
graphics port uses for the display of text. Rather than trying to determine what ID is associated with
any one font family, smply use the FMGet Font Fam | yFr onfName routine to let the system supply
your program with thisinformation. Pass F\VCet Font Fam | yFr oniNane the exact name of afont,
prefaced with \ p, and the routine returns the ID for that font. Use that valueinacall to Text Font :

FMFont Fam | y font Fam | y;

fontFam |y = FMGet Font Fam | yFronmNanme( "\ pTi mes" );
Text Font( fontFamly );

Text Face setsthe style of the font in which text isdrawn. Thef ace parameter can be any one, or
any combination, of the following constants. nor el , bol d,i tal i c,underline,out!ine,
shadow, condense, and ext end. To set the face to one particular style, use the appropriate style
constant. After the following call, all text drawn with Dr awSt r i ng will bein bold:

Text Face( bold );
To set the face to a combination of styles, use aplus () sign between each style:
Text Face( italic + underline + shadow );

To change the size of text drawn to awindow, usethe Text Si ze routine. Passasize in points. A 12-
point sizeis common and is considered a de facto standard for text. Theinitial setting for the text size
is 0, which represents the size of the system font. This line of code sets the text size to twice the
normal size:

Text Si ze( 24 );
GraphicsPortAndPen Program

The purpose of the GraphicsPortAndPen program is to provide an example of the effects of making
changes to a window's graphics environment.

The GraphicsPortAndPen program draws three horizontal lines, making changes to the graphics pen
between the drawing of each line. The program also draws three lines of text, making changes to the



graphics environment before drawing each line of text.
Figure 7.2 shows the window that this program displays.

Figure7.2. Altering a window's graphics environment affectsline and text drawing.
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Example 7.1 provides the source code for the GraphicsPortAndPen program. Most of the code that
makes up this program was introduced in the WindowUpdate program found in Chapter 4. Of interest
hereisonly the application-defined Updat e\W ndowroutine. All the Carbon callsin

Updat eW ndow have been discussed on the preceding pages. One point worth discussing is the
length of the three horizontal linesthat Updat e\W ndowdraws. Each line is drawn by calling Line.
The Li ne routine draws aline of the specified length, regardless of where the current starting point is.

Noticein Figure 7.2 that the middie line is dightly longer than the other two lines, despite the fact that
each line is drawn with the same arguments passed to Li ne. The reason the middle lineislonger is
that beforeit is drawn, the size of the graphics pen is set to a height and width of 10 pixels. It isthe
change in pixel width of the pen that affects the overall length of the line that's subsequently drawn.
Thecall to Li ne doesindeed draw aline 100 pixelsin length, but because the pen's width is 10 pixels
rather than 1, that extra width shows up after the line is drawn.

The bulk of the source code in all the examplesin this chapter is similar. In fact, only the

Updat eW ndowroutine in each program varies. All the rest of the code in each exampleisidentical.
For that reason, only this first example shows the entire source code listing. After this example, each
following example shows only the routine that holds new code-the Updat e\W ndow routine.

Example 7.1 GraphicsPortAndPen UpdateWindow Source Code

#i ncl ude <Car bon/ Car bon. h>

pascal OSStatus W ndowEvent Handl er ( Event Handl er Cal | Ref handl er Ref
Event Ref event, void
*userData );

voi d Updat eW ndow( W ndowRef w ndow ) ;

int main(int argc, char* argv[])



| BNi bRef ni bRef ;
OSSt at us err:
W ndowRef w ndow;

Event Tar get Ref target;
Event Handl er UPP handl er UPP;
Event TypeSpec wi ndowEvent = { kEvent Cl assW ndow,
kEvent W ndowDr awCont ent };

err = CreateN bReference( CFSTR("main"), &nibRef );

err = Set MenuBar FromNi b( ni bRef, CFSTR(" Mai nMenu") );

err = Creat eW ndowFr omNi b( ni bRef, CFSTR(" Mai nW ndow") ,
&w ndow ) ;

Di sposeNi bRef erence( ni bRef );

target = Get WndowEvent Target ( w ndow ) ;

handl er UPP = NewEvent Handl er UPP( W ndowEvent Handl er ) ;

| nst al | Event Handl er ( target, handl erUPP, 1, &w ndowkEvent,
(void *)w ndow, NULL );

ShowwW ndow( wi ndow ) ;
RunAppl i cati onEvent Loop() ;

return( 0 );

}

pascal OSStatus W ndowkvent Handl er ( Event Handl er Cal | Ref handl er Ref,
Event Ref event, void *userDat a)

{
OSSt at us result = event Not Handl edErr;
Ul nt 32 event Ki nd;
W ndowRef Wi ndow;
w ndow = ( W ndowRef )user Dat a;
event Kind = Get Event Ki nd( event );
if ( eventKind == kEvent W ndowDr awCont ent )
{
Updat eW ndow( w ndow ) ;
}
return result;
}

voi d Updat eW ndow( W ndowRef w ndow )
{



Poi nt t hePenSi ze = { 10, 10 };
FMFont Fanily  fontFamily;

Set Port W ndowPort ( wi ndow ) ;

MoveTo( 20, 30 );
Li ne( 100, 0 );

Set Port PenSi ze( Get WndowPort( wi ndow ), thePenSize );
MoveTo( 20, 50 );
Li ne( 100, 0 );

PenNor mal () ;
MoveTo( 20, 70 );
Li ne( 100, 0 );

fontFam |y = FMGet Font Fam | yFronNane( "\ pTi nes" );
Text Font( fontFamly );

Text Face( normal );

MoveTo( 20, 100 );

DrawString( "\pThis is 12 point, normal, Tinmes" );

fontFam |y = FMGet Font Fam | yFr omNane( "\ pVerdana" );
Text Font( fontFamly );

Text Face( bold + italic );

MoveTo( 20, 130 );

Drawstring( "\pThis is 12 point bold and italic Verdana" );

Text Face( normal );

Text Si ze( 24 );

MoveTo( 20, 160 );

DrawsString( "\pThis is 24 point normal Verdana" );



Defining and Drawing Shapes

Lines, rectangles, round rectangles, and ovals are the basic shapes used in drawing. Earlier
in this chapter, you were introduced to line drawing. This section will expand on those
previous line-related discussions. Here you'll also read about drawing rectangles and
squares (a square is arectangle with four sides of identical length), ovals and circles (a
circleisan oval with identical horizontal and vertical diameters), and round rectangles (a
round rectangle is a rectangle with rounded corners).

Drawing Lines

Line drawing is accomplished using the Li ne and Li neTo routines. Thanks to this
chapter's "Line and Shape Drawing and the Graphics Environment™ section and the
GraphicsPortAndPen example program, which introduced both of these routines, this
"Drawing Lines" section can be brief.

To draw aline, you can move to a starting pixel coordinate and thencall Li neTo to
specify the ending pixel for the line. Here a horizonta lineis drawn from a point 30 pixels
in from the left side of awindow and 50 pixels down from the top of the window, to a point
100 pixelsin from the left side of the window:

MoveTo( 30, 50 );
Li neTo( 100, 50 );

Because the line runs from a horizontal point of 30 to a horizontal point of 100, the
horizontal length of the lineis 70 pixels. To specify aline of a specific length, use the

LI ne routine rather than the Li neTo function. Here the same line as previously described
iIsdrawnusing Li ne:

MoveTo( 30, 50 );
Line( 70, 0 );

Defining and Drawing Rectangles

The rectangle is an important shape in its own right. You'll often use rectangles to frame
graphics or text. The rectangle isimportant also because it is used to define some other
shapes, including the square, the round rectangle (such as an interface push button), and,
perhaps surprisingly, the oval and circle. (Remember that acircleis a specia type of oval).

Before drawing arectangle, you declare avariable of type Rect and then specify the
coordinates of the four sides of the rectangle. The coordinates are pixel values and are



given in terms of the port of the window to which the rectangle will be drawn. Each
coordinate is in the system described in this chapter's " Coordinate System™ section. For
instance, atop coordinate of 50 means the top side of the rectangle will be drawn 50 pixels
from the top of the window in which the rectangle appears. The following snippet defines
the rectangle that's shown in Figure 7.3.

Figure 7.3. The pixel coordinates of arectangle.
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Rect t heRect = { 50, 80, 110, 180 };

To define the coordinates of arectangle after the rectangle has been declared, use the

Set Rect routine. Pass Set Rect apointer toaRect variable, along with the four
rectangle-defining coordinates. Of importance here is that the order of the assignment of
the coordinates differs for an initialization and acall to Set Rect . For initialization, the
order istop, left, bottom, and right. For Set Rect , the order isleft, top, right, and bottom.

The following snippet defines the same rectangle as the one previously defined:

Rect theRect;
[/ L, T, R, B
Set Rect ( &t heRect, 80, 50, 180, 110 );

Figure 7.3 showstherectanglet heRect after it'sdrawn. Note, however, that the

assignment of coordinates to a rectangle isn't enough to actually draw the rectangle. To do
that, call the Fr aneRect routine, passing the function a pointer to a previously defined
rectangle:

FranmeRect ( & heRect );

Asitsnameimplies, Fr aneRect drawsjust the frame of a previously defined rectangle.
To draw arectangle that's filled with apattern, call Fi | | Rect . Here, apreviously defined



rectangle is being drawn with adark gray pattern:

Pattern t hePatt ern;
Get QDA obal sDarkGray( &t hePattern );

Fill Rect( &t heRect, &t hePattern );

The Get QDG obal sDar kG ay routine is one of five access functions that returns a
pattern to a program. The preceding snippet isincluded here to provide an example of how
a shape can be filled with a pattern, but there are other ways for your program to make use
of patterns as well.

Note

This chapter's "Patterns' section provides you with all the details about using
predefined system patterns and using patterns of your own creation.

Defining and Drawing Round Rectangles

The material in the preceding section is fundamental to the drawing of many types of
shapes, so make sure you have a solid grasp of it. Our next step is to examine rectangles
used with other types of shapes. Part of drawing a rectangle with rounded edges (like the
one shown in Figure 7.4) involvesfirst defining arectangle. In the following code snippet,

I'm defining the same rectangle used in the previous section and pictured in Figure 7.3.

Figure 7.4. The pixel coordinates of around rectangle.
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Rect t heRect ;
[/ L, T, R, B



Set Rect ( &t heRect, 80, 50, 180, 110 );
Now acall to Fr aneRoundRect draws the outline of the round rectangle:

/1 H V
FranmeRoundRect ( &t heRect, 50, 50 );

The rectangle has the same size and window location as the one pictured back in Figure
7.3, but it has rounded corners. The degree of rounding of each corner is determined by the
second and third arguments passed to Fr aneRoundRect . These two arguments define
the horizontal and vertical diameter of acircle that isinvisibly inscribed within the
rectangle specified in thefirst Fr aneRoundRect argument. In Figure 7.4, I've gone

ahead and drawn this circle in one of the four corners of the rectangle to illustrate how the
circle diameters set the degree of roundness to a corner.

Asyou read in the discussion of rectangles, a shape can be filled with a pattern using afill
routine. For around rectangle, that routineisFi | | RoundRect :

Pattern t hePat t er n;
Get QDA obal sDar kG ay( &t hePattern );

Fi | | RoundRect ( & heRect, &thePattern );

The Get QDG obal sDar kG ay pattern accessor routine is described in this chapter's
"Patterns" section, and an example program that draws a round rectangle can be found in
the "BasicShapes Program™ section.

Defining and Drawing Ovals

The drawing of an oval is dependent on the defining of arectangle. This chapter's
"Defining and Drawing Rectangles" section tells you how to do that. To establish the
coordinates of an oval, define arectangle in which the oval will beinscribed. Here, I'm
again defining the same rectangle used in the "Defining and Drawing Rectangles' section
and pictured in Figure 7.3.

Rect t heRect ;
/1 L, T, R, B
Set Rect ( &t heRect, 80, 50, 180, 110 );

Now acall to Fr aneOval drawsthe outline of the oval within the specified rectangle.
The rectangle itself isn't drawn, though for clarity 1've shown the rectangle in Figure 7.5:



Figure 7.5. The outline of the oval.
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FraneOval ( &t heRect );

Like other shapes, an oval can be filled with a pattern by using afill routine. After
obtaining a pattern, call Fi | | Oval :

Pattern t hePatt ern;
Get QDA obal sLi ght Gay( &t hePattern );

Fill Oval ( & heRect, &t hePattern );

Cet QDA obal sLi ght G ay and other pattern accessor routines are described in this
chapter's "Patterns’ section.

BasicShapes Program

The purpose of the BasicShapes program is to provide examples of how to frame and fill
basic shapes such as arectangle, oval, and round rectangle.

Figure 7.6 shows that when you run BasicShapes, you see a window that displays each of
the three shapes discussed in this chapter. Example 7.2 showsthat acall to Fi | | Oval

fillsthe oval with agray pattern. To fill the other two shapes, obtain a pattern and then
follow the Set Rect cal withacaltoFi | | Rect or Fi | | RoundRect .

Figure 7.6. The window displayed by the BasicShapes program.



666 Window

O

Example 7.2 BasicShapes UpdateWindow Sour ce Code

voi d Updat eW ndow( W ndowRef w ndow )

{
Rect t heRect ;

Pattern t hePattern:;
Set Port W ndowPort ( w ndow ) ;

Set Rect ( &t heRect, 40, 20, 180, 100 );
FrameRect ( & heRect );

Get QDA obal sG ay( &t hePattern );

Set Rect ( &t heRect, 120, 70, 220, 130 );
Fill Oval ( & heRect, &t hePattern );
FraneOval ( &t heRect );

Set Rect ( &t heRect, 50, 140, 140, 160 );
FrameRoundRect ( & heRect, 25, 25 );



Patterns

Black lines? Empty rectangles? How boring. How "un-Macintosh"! Although | have
managed to dlip in agray rectangle or two so far in this book, for the most part, things have
been more drab than gray. Fortunately all that monochromeness was for the sake of

brevity. | wanted to present short, concise examples of how to draw lines and shapes. Now
that you know the basics, it's time to see how you can fill shapes with any of the dozens of
predefined monochrome patterns present in the Mac OS X system software. It's also time to
see how you easily can create your own colored patterns and use those patterns to fill lines
and shapes.

QuickDraw Global System Patterns

When drawing a shape, such as a rectangle, you might want to ssmply frame the shape. On
the other hand, you might want to fill that shape with a color or a pattern. Asyou'll see later
in this chapter, you can define your own patterns. If you need a basic, monochrome pattern
such as light gray or black, you can make use of one of the five predefined patterns that are
availableto all Mac programs.

To access one of the patterns, you need to know alittle about a global data structure named
QDA obal s. Heréshow QDG obal s looks, as defined in the QuickDraw.h header file:

struct QDA obal s {

char privates[76];
| ong randSeed:

Bi t Map screenBits;
Cur sor arrow,
Pattern dkG ay;
Pattern |t G ay;
Pattern gray,

Pattern bl ack;
Pattern whi t e;

G afbPtr t hePort

b
t ypedef struct QDA obal s QDG obal s;

The members of this structure, with the exception of thearray pr i vat es, are available to
any program, including the one you're developing. To make use of one of the members of
this structure, you use an accessor function. There's one such function for each member,
except pri vat es. Of most interest (in this chapter, anyway) arethefive Pat t er n
members. Each member defines a different monochrome pattern that your program can use
in drawing lines and shapes. The access function for these five pattern members are as



follows:

Get QDA obal sWhite( Pattern * white );

Get QDA obal sLight Gay( Pattern * |tGay );
Get QDA obal sGray( Pattern * gray );

Get QDA obal sDarkGray( Pattern * dkGay );
Get QDA obal sBl ack( Pattern * bl ack );

To get a pattern for use by your program, call the appropriate accessor function. Here a
program gets a reference to the light gray pattern:

Pattern t hePatt ern;

Get QDA obal sLi ght G ay( &t hePattern );

After you have aglobal pattern saved inaPat t er n variable, you can use that pattern in
the filling of shapes. The next section,"” System Pattern List," describes away to obtain il
more system-defined monochrome patterns.

System Pattern List

Thefive patternsin the QDG obal s data structure come in handy. There will be times
when you want to fill a shape with black, white, or a shade of gray, and these patterns are
easy to access. However, there also will be times when you want the use of a more intricate
pattern. In those cases, the system pattern list may help.

Every Mac system has 38 patterns, each stored in a pattern resource of type PAT. All these
resources are collectively kept in asingle pattern list resource of type PAT#. The

Carbon routine Get | ndPat t er n isused to get areference to a single pattern from a
pattern list resource. Here'show Get | ndPat t er n iscalled to provide a program with the
use of one pattern from the list of 38 system patterns:

Pattern thePattern;
short thePatternListI D = sysPat Li st D,
short patternl ndex = 12;

Getl ndPattern( & hePattern, thePatternListlD,
patternl ndex );

Thefirst Cet | ndPat t er n parameter isapointer to avariable of type Pat t er n . When
Cet | ndPat t er n returnsthisvariable, it will hold the desired pattern. The next
parameter isthe ID of the pattern list resource to access. It's possible to create your own list
of patterns, so Cet | ndPat t er n needs to know which pattern list to access. The fina



CGet | ndPat t er n parameter is an index to the pattern to retrieve.

Pattern numbering in alist starts with the number 1. Figure 7.7 shows the 38 patterns and

their associated index value. In the previous code snippet, the twelfth pattern in the list (the
pattern that looks like bricks in Figure 7.7) is being sought.

Figure 7.7. The patterns, with their index values, from the system pattern list.
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After Cet | ndPat t er n finishes, the pattern variable (t hePat t er n in the previous code
snippet) can be used in the same way that a pattern obtained from the global variable

QDA obal s can be used. An example of using a pattern to fill a shape appearsin the
following section of this chapter.
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GlobalPatter ns Program

The purpose of the Global Patterns program is to demonstrate how a program makes use of
any of the five patterns that are part of the QDG obal system data structure and any of the
38 patterns that are part of the system pattern list resource.

As shown in Figure 7.8, the Global Patterns program draws five rectangles along the top of

the program's window. Each rectangleisfilled in with one of the five system patterns.
Beneath the top row are 38 smaller rectangles, each displaying one of the system patterns
from the system pattern list resource.

Figure 7.8. An example of the use of each of thefive system patterns.
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The Global Patterns program's Updat e\W ndow routine (shown in Example 7.3) usesa

for loopto call each of thefive QDG obal pattern accessor routines, drawing and filling
arectangle in each pass through the loop. The program then uses a second f or loop to call
Cet | ndPat t er n 38 times, one time per pattern in the system pattern list resource. Each
pass through the loop draws and fills one rectangle with one pattern.

Example 7.3 GlobalPatter ns UpdateWindow Sour ce Code

voi d Updat eW ndow( W ndowRef w ndow )

{
Rect patternRect,;
Pattern t hePatt ern;
short thePatternListI D = sysPat Li st D,
short X;

Set Port W ndowPort ( wi ndow ) ;
Set Rect ( &patternRect, 20, 40, 80, 100 );

for ( x = 1; X <= 5; x++)

{
{

switch ( x )

case 1:
Get QDA obal sWiite( & hePattern );
br eak;
case 2:
CGet QDA obal sLi ght G ay( &t hePattern );
br eak;
case 3:
Cet QDA obal sG ay( &t hePattern );
br eak;
case 4.



Get QDA obal sDar kGray( &t hePattern );
br eak;
case 95:

CGet QDA obal sBl ack( &t hePattern );
br eak;

}

Fill Rect( &patternRect, & hePattern );
FrameRect ( &patternRect );
O fset Rect ( &patternRect, 70, 0 );

}
Set Rect ( &patternRect, 30, 120, 50, 140 );

for ( x = 1; x <= 38; x++ )

{
CGetlndPattern( & hePattern, thePatternListID, x );

Fill Rect( &patternRect, & hePattern );

FrameRect ( &patternRect );
If ( x == 13 )

Set Rect ( &patternRect, 30, 150, 50, 170 );

else if ( x == 26 )
Set Rect ( &patternRect, 30, 180, 50, 200 );

el se
O fset Rect( &patternRect, 25, 0 );

Color Pixel Patterns

The five system patterns held in the QDGlobals system variable and the 38 patterns that
make up the system pattern list resource are monochrome patterns. In many cases, those
patterns will suffice, but there certainly will come atime when you need to make use of a
color pattern. To do that, you'll create your own using appat (pixel pattern) resource.

Interface Builder doesn't have atool for creating pattern resources. For that chore, your
best bet isto use Apple's free resource editing tool-ResEdit. If you don't already have
ResEdit, you'll find adownload link in the tools area of Apple's developer site at http://
devel oper.apple.com/tools/.


http://developer.apple.com/tools/
http://developer.apple.com/tools/

ResEdit isn't anative Mac OS X application, so when you run it, you'll be running it in the
Classic (Mac OS 9) environment. As for including ResEdit-created resources in your
Project Builder projects that target Mac OS X, don't let the fact that ResEdit runsin Classic
mode bother you. When you save a ResEdit resource to afile, that file can beincluded in a
Project Builder project and that file's resources then can be accessed by your program's
code.

To create apixel pattern, or ppat , resource in ResEdit, choose Create New Resource from
the Resource menu. Type ppat inthetext box and click the OK button. Doing that creates
ablank (all white) ppat resource with an ID of 128 and putsyou inthe ppat editor.

Asshown in Figure 7.9, you can use avariety of tools and colors to create a colored pattern
that is 8x8 pixelsin size. In Figure 7.9, I've created a pattern that consists of diagonal lines

(they're blue lines, in case you're curious). As you turn pixels on and off in the magnified
view of the pattern in left box of the two boxes at the top of the pixel editor, the right-most
box shows how the pattern will ook when drawn at actual sizein an arealarger than 8x8
pixels.

Figure 7.9. Creating a ppat resour cein ResEdit.
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After creating the ppat resource, choose Save from the File menu to save the file in which
the resource is located. Note that you can store more than one ppat resource in the same
file and that, in fact, you can save different types of resourcesin the same file as well.
When it comes time for your code to access a particular resource from aresourcefile, it
will be able to do so regardless of the file in which the resource resides. Aslong asthefile
is added to the project, the code will find it.

Speaking of adding aresource file to a project, that's what you do next. Before writing the
code that accesses aresource, add the file that holds the resource to the project. Figure 7.10



shows that |'ve given the resource file that holds my ppat resource the name ppats.rsrc
and that | have the file housed in the same folder as the project to which it's been added
(the PixPatResource project). To add the resource file to a project, click the Resources
folder under the Groups & Files heading in the project window and choose Add Files from
the Project menu. As shown in Figure 7.10, the resource file name then appears along with

the other project resource files (InfoPlist.strings and main.nib in Figure 7.10).

Figure 7.10. A resour cefile on disk and added to a project.
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Earlier in this chapter (in the "System Pattern List" section), you saw that you can use the
CGet | ndPat t er n routine to obtain a monochrome pattern (a pattern of type PAT) from a
pattern resource list. To obtain areference to a color pattern saved asappat resource, you
use the Carbon routine Get Pi xPat . Pass Get Pi xPat thelD of appat resource and
CGet Pi xPat returns ahandle to that pattern:

Pi xPat Handl e bl ueDi agonal Pi xPat ;

bl ueDi agonal Pi xPat = Get Pi xPat ( 128 );

After your program has a handle to a color pattern,it can use that handle in calls to other
Carbon routines, including PenPi xPat . The PenPi xPat function sets the color state of
the graphics pen, which means all subsequent drawing will take place using this new
current pattern.

PenPi xPat ( bl ueDi agonal Pi xPat );

You've seenthat theFi | | Rect routine accepts two arguments: arectangleto fill with a
pattern and the pattern to be used in the filling of that rectangle. Another shape-filling
routineis Pal nt Rect . Thisroutine, though, accepts only one argument-a rectangle to fill
with apattern. Unlike Fi | | Rect , which requires that afill pattern be specified,

Pal nt Rect always usesthe current graphics pen pattern, as set in aprevious call to
PenPi xPat , asthefill pattern. Thisfollowing code snippet defines a rectangle and then
fills that rectangle with the diagonal blue line pattern to which the graphics pen was just
Set:

Rect t heRect ;



Set Rect ( &t heRect, 30, 50, 150, 120 );
Pai nt Rect ( &t heRect );

If you prefer to specify the fill pattern each time you fill arectangle with a colored pattern,
youcanuseFi | | CRect.Fi | | Rect (without the Cbetween Fi | | and Rect ) acceptsa
monochrome pattern (type Pat t er n ) asits second argument. Fi | | CRect (withthe C)
accepts ahandle to acolor pixel pattern (type Pi xPat Hand! e ) asits second argument.
Rather than changing the graphic pen's color pattern with acall to PenPi xPat and then
calling Pai nt Rect tofill arectangle with this current pattern, the same patterned
rectangle could be achieved by ssmply makingacall to Fi | | CRect

/! no need to call PenPi xPat here

Fill CRect( &t heRect, bluebD agonal Pi xPat );

After your program is finished using a color pattern, it should dispose of the memory
referenced by that handle. A call to the Carbon routine Di sposePi xPat takes care of
that task:

Di sposePi xPat ( bl ueDi agonal Pi xPat );
PixPatResour ce Program

The purpose of the PixPatResource program is to demonstrate how a program uses a
programmer-defined color pattern resource (ppat ) to draw patterned lines and shapes.

Figure 7.11 shows the window displayed by the PixPatResource program. To draw this
patterned line and patterned rectangle, the program uses the ppat resource pictured back
in Figure 7.9. As shown in the program's Updat e\W ndowroutine (listed in Example 7.4),
the filling of the rectangle is achieved by calling Get Pi xPat to set the graphics pen
pattern to a handle that referencesappat resource and then calling Pai nt Rect . The
drawing of the patterned line is done with acall to the same Li ne routine used much
earlier in this chapter.

Figure 7.11. Drawings made with a pixel pattern.
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After the graphics pen pattern is changed, even line drawing is affected. The program calls
PenSi ze toincrease the height and width of the line so that the ling's pattern is more
readily noticeable.

Example 7.4 PixPatResour ce UpdateWindow Source Code

#def i ne kPi xPat Bl ueDi agonal 128

voi d Updat eW ndow( W ndowRef w ndow )

{
Pi xPat Handl e bl ueDi agonal Pi xPat ;

Rect t heRect ;
Set Port W ndowPort ( wi ndow ) ;

bl ueDi agonal Pi xPat = Get Pi xPat ( kPi xPat Bl ueDi agonal );
PenPi xPat ( bl ueDi agonal Pi xPat );

PenSi ze( 10, 10 );

MoveTo( 20, 20 );

Li ne( 220, 60 );

Set Rect ( &t heRect, 30, 50, 150, 120 );
Pai nt Rect ( &t heRect );

Di sposePi xPat ( bl uebDi agonal Pi xPat );



For More Information

For more information about QuickDraw and Macintosh graphics, stop in at any of the
following web sites:

ResEdit resource editor: http://devel oper.apple.com/tools/

QuickDraw routines: http://devel oper.apple.com/techpubs/macosx/Carbon/
grahics/QuickDraw/quickdraw.html


http://developer.apple.com/tools/
http://developer.apple.com/techpubs/macosx/Carbon/grahics/QuickDraw/quickdraw.html
http://developer.apple.com/techpubs/macosx/Carbon/grahics/QuickDraw/quickdraw.html

Chapter 8. Text and Localization

WHEN YOU DEVELOP A PROGRAM, you develop it using your native language. If
your native language is English, your application has menus, buttons, and windows that
display English text. Thisisall fine and well-if your target market is English-speaking.
However, if your program is one that might find popularity among people that speak a
language other than English, you'll want text displayed in the appropriate language. This
chapter will help you accomplish that task.

If you think that your program will never be translated into a different language, you might
be inclined to skip this chapter. Don't. Although at this moment you might not see the need
to create alternate language versions of your program, that need might certainly arisein the
near future. A corporate buyout, new marketing strategies, and other unforseen
circumstances could result in justification of foreign language versions of your application.
Because preparing your program for internationalization or localization, both of which are
the trandation of a program's text from one language to another, is surprisingly easy to do,
it behooves you to set up your program for the day when localization might be an issue. In
addition, even if you're sure your application will never be translated, the method used for
localizing the text that's displayed in your program's windows is very useful for storing and
displaying large amounts of text even if that text is never to be trand ated.

In the first section, you see how to localize interface text. The second section discusses
localizing text that's displayed in a window.



L ocalized Resource Files

Y ou've seen that aresource file holds the interface element of your programs. When you
localize this resource file, you provide your application with the ability to display
information in the user's native language. That is, if you originally create your project's nib
filein English, and then localize that nib file for the Japanese language, your application
becomes one that can display its menus, window titles, and so forth in both English and
Japanese. It then becomes the user's choice as to which of these languages becomes the
program's display language.

Choosing an Interface L anguage

When you launch an application on a Macintosh running Mac OS X, that application
displays the text of interface elements (menu names and so forth) in English, by default.

Y ou can change this aspect of your Mac's behavior by specifying that you'd prefer that
programs display the text of interface elementsin a different language. To do that, run
System Preferences from the Finder and click the International icon-it's pictured on the far
left side of Figure 8.1. The International pane appears and you can click the Language tab
to see alist of languages from which to choose. In Figure 8.1, I'm dragging Deutsch above

English to change the preferred language of my Mac from English to German.

Figure 8.1. Using the International pane of System Preferencesto specify a different
language.
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S0, I've set my preference for German. Now, whenever a program runs, the text of its



interface elements will be displayed in German, if the developers of the application added a
set of German resources to the English resources that were created for the application. If
they didn't, I'll still see English.

To create a set of German resources, the devel opers need to create alocalized main.nib file.
We discuss that next.

Note

If you set your Mac to use a non-English language and then run one of the
example programs from a previous chapter in this book, you'll still see
interface element text displayed in English. That's because | didn't
internationalize any of the example programs. My very short programs exist
for the benefit of demonstrating one or two isolated topics, and they certainly
aren't exercisesin localization.

Creating a Localized Nib File

To create aversion of your application localized for a different language, first completely
develop the English version. Then make a copy of the main.nib file and edit any text that
accompanies interface elements in the new version of the main.nib file.

In the past, you've opened a project's main.nib file by double-clicking the main.nib icon or
name in the Groups & Fileslist of the project window. In doing so, you might not have
noticed that this main.nib file isn't really afile, but a group of files. This group happensto
initially hold just onefile, but it's organized as a group nonetheless. To open the main.nib
file only, you can click the triangle to the left of the main.nib icon. Doing so in our scenario
revealsthat the nib file has the title "English,” as shown in the top project window of
Figure 8.2.

Figure 8.2. The top project hasone main.nib file (English), and the bottom project has
two main.nib files (English and Ger man).
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The main.nib group lists the variants of the main.nib filesin a project. So far, this group
isn't much of agroup at al. It has just one file, named English. The lower project window
in Figure 8.2 shows that this group can hold other main.nib files. In this example, the
second nib fileis named German. To add a new localized main.nib file to this project, click
main.nib in the Groups & Fileslist of the project window, and then choose Show Info from
the Project menu. Click the Localization & Platforms dropdown list, and then click Add
Localized Variant, asis being donein Figure 8.3.

Figure 8.3. Creating a new localized main.nib file.
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Choosing the Add Localized Variant menu item from the Localization & Platforms pop-up
menu displays a sheet requesting that you enter the name of the new locale (such as
German, Spanish, Japanese, and so forth). Type the locale and click the OK button.
Nothing appears to happen, but if you now look under the main.nib group in the project
window, you will see that German has been added under English, as shown in the bottom
project window of Figure 8.2.

Within the project, the new main.nib file is named German. If you look in the project's
folder on your Desktop, you'll see that there is no nib file named German. Instead, thereis
anew main.nib file in anew folder-afolder named German.lproj- as shown in Figure 8.4.

The nib file names of English and German (as shown back in Figure 8.2) are names that
Project Builder derives from the names of the project's |proj folders.

Figure 8.4. The new main.nib file goesintoitsown lproj folder.
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Editing the New L ocalized Nib File

The project now holds two main.nib files; they are identical and both include English text.
The next step isto open the new main.nib file and edit it such that the end result isafile
that has all itsinterface text in German.

Consider the BeepWorld program from Chapter 3, "Events and the Carbon Event

Manager." For a German version of that program, the program's window should display
static text that says Hallo, Welt! instead of Hello, World!. Its button should have atitle of
Sgnalton instead of Beep. Figure 8.5 shows the window from the English version of

BeepWorld's main.nib file (top) and the same window from the German version of
BeepWorld's main.nib file (bottom).

Figure 8.5. A simple example of localizing part of a program'sinterface.



) 0 Window

Hello, Wearld)

€ Beep )

."'U ) Window

Halla, Welt!

f Slgnalt-un ."l

For BeepWorld, you'd need to trand ate the text of each menu and menu item as well. Other
more sophisticated applications would need far more extensive changes in the new main.
nib file.

Note

Unfortunately, there's no magical Translate All Items To Different Language
menu item in Interface Builder. The trandation efforts fall on the shoulders of
you or the translator you hire.

Despite the work involved, thereis still a beauty to the Mac OS X internationalization
method because, to convert an application from one language to another, you don't need to
touch your source code. Thus, your code won't be littered with all kinds of |

(l'anguage == kEnglishLanguage) stylebranches, and you won't need to use
conditional compilation directivessuch as#i f def ENGL.I SHthroughout your code to
enable the building of different versions of the same application. Instead, you develop your
program in English, create a new copy of the main.nib file (using the Show Info menu item
from the Project menu), and then edit that one resourcefile.

After making necessary changes to the localized main.nib file, save it, return to Project
Builder, build the application as you've always done, and then run it. What happens?
Nothing of interest-the program runsin its English version. To see the German interface,
you need to change your computer's International setting to German in System Preferences
and then run the program.



L ocalizing Window Content Text

An application might be able to display al itstext as static text items in window resources. However, that's likely only
for the most trivial of programs. An application also might be able to display all its text using the QuickDraw routine
Dr awsSt ri ng. That's unlikely too; Dr awSt r i ng isn't used for long passages of text, and the text resulting from its
useisn't editable. Dr awsSt ri ng typicaly is used for short strings that often are hard-coded into the program.

Instead of using static text resource items or callsto Dr awst r i ng for displaying non-trivial amounts of text in a
window, consider defining your program's text in string resources that then are stored in asingle file that's easily
readable from your source code.

The Locdizable.strings file discussed in this section provides a powerful way for you to keep track of all the text your
program displays, and it makes for an easy means for your application to access that text at any time. Thus, it's agood
text-displaying solution even if you don't plan on localizing your application for another language.

Creating a Localizable.strings File

Just as your program can store interface items as resources to be retrieved and displayed by the program, so too can your
program store strings as resources and retrieve and display their text within windows. To do this, you store the stringsin
asingle Localizable.strings file that you add to your project. When you've added all the strings your program needs to
the one Localizable.strings file, you can make a copy of this string-holding file and localize it to the language of your
choosing.

Before jumping into localized files, though, you'll need to create the first, English language version of the Localizable.
strings file. With your project open, choose New File from the File menu. Choose Empty File asthe file type to add to
the project, and then click the Set button to specify where the file should end up. Then, move to the project's English.
Iproj folder, choose it, and name the file Localizable.strings, as shown in Figure 8.6. Click the Finish button and a new,
empty text fileis added to the project. The file should end up in the project's Resources group (see Figure 8.7). If it ends
up elsewhere, just drag and drop it on the Resources folder.C

Figure 8.6. Creating a new L ocalizable.stringsfile.
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Figure8.7. A Localizable.stringsfile with one key-value pair in it.
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Storing Text in the Localizable.strings File

The Localizable.stringsfile is atext file that holds one or more strings. Y our program will be able to retrieve any one of
these strings at any time. To do that, each string needs to have some sort of unique identifier that your program can use
to referenceit. Such an identifier is called akey. Any one key is paired with one string. The string is considered the
value of the key, so the result is dubbed a key-value pair.

The key can be any sequence of case-sensitive characters enclosed in quotation marks. For clarity, you might want to
make each key aword somewhat descriptive of the key's value, but that isn't arequirement. Follow the key with an
eguals sign, and then type or paste in the value, which isthe string itself. Enclose the string in quotation marks and the
key-value pair is complete.

The following is aLocalizable.strings file that holds two strings (two key-value pairs):

{

"Roul ett eWheel " = "The standard American roulette wheel is divided into 38
sl ot s,

nunbered 1 to 36 plus 0 and 00.";

"Roul etteCol ors" = "Even nunbered slots are red and odd nunbered slots are
bl ack.

The 0 and 00 slots are green.”

}

As shown in the preceding code snippet, a semicolon separates key-value pairs, and the entire contents of the file must
begin with an opening brace and end with a closing brace. To add areturn to a string, don't manually use the Return key.
If you do and the string is subsequently retrieved and displayed, the return character symbol, not an actual occurrence of
areturn, will be displayed. To avoid this outcome, use \r within the string of the key-value pair to indicate a return.

Figure 8.7 shows a L ocalizable.strings file that holds one string containing several returns. Look ahead to Figure 8.9 to
see how that one string looks when retrieved and displayed in a window.

Figure 8.9. A program that displaystext retrieved from a L ocalizable.stringsfile.
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Using the Text from a L ocalizable.strings File

When your project holds a Localizable.strings file, your code can make use of any or all the stringsin that file. Y our
program does that by retrieving and then displaying the string.

Retrieving a String

Use the Core Foundation routine CFCopylLocal i zedSt ri ng to obtain areference to astring located in the
Localizable.stringsfile. Thiscall to C-CopyLocal | zedSt ri ng obtains the string associated with the key-value pair
that hasthe key Roul et t eViheel :

CFStringRef theString;

theString = CFCopyLocal i zedString( CFSTR( "Roul ett eWeel " ),
CFSTR( "Short definition of the appearance of the wheel
used in the ganbling gane of chance roulette." );

After the preceding code snippet executes, The standard American roulette whedl is divided into 38 slots, numbered 1 to
36 plus 0 and 00. will be the text referenced by t heSt r i ng. By default, CFCopyLocal i zedSt ri ng examinesthe
file named Localizable.strings, so there's no need to specify where the string of interest islocated. The first argument to
CFCopylLocal i zedSt ri ng isthe key from the key-value pair of interest; you use the C-FSTR macro to pass this key
asaCFSt ri ng. The second argument is a comment that might help the translator should this string need to be
translated to a different language. Y ou would pass NUL L as the second argument if you didn't want to use additional
descriptive information.

For clarity, it's always nice to use constants wherever possible, and the key is no exception. The next snippet skipsthe
comment argument to CFCopylLocal i zedSt ri ng and uses aconstant in place of the actual key:

#defi ne kRoul et t eWheel DescKey "Roul ett eWeel "

theString = CFCopyLocal i zedStri ng( CFSTR(kRoul ett eWheel DescKey), NULL );
Displaying the String

At this point, you have a string from the Localizable.strings file saved asa CFSt i ng object, ready to be displayed in a
window. You've been at this point before. In the "Text Input Fields and Source Code" section of Chapter 5, "Controls,”
the Set Cont r ol Dat a routine was used to place the text of a CFSt r i ng object in atext input control. Y ou can use
that same technique here as well.

To set up an areain awindow to which you can write, you can open your project's main.nib file and add a text input
field to awindow. Y ou can do that by dragging the text input item from the palette to a window (the text input field is
the framed white box located at the |eft edge of the palette). Size the text input field appropriately. In Figure 8.8, I've
made the text input field occupy most of a small window. The text input field is a control that requires a signature and
control 1D to enable it to be accessed. Choose Show Info from the Tools menu, select Control from the pop-up menu,
and enter asignature and ID.

Figure 8.8. A window resour ce with a text input field.
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Y our code heeds access to the text input field to display text in the field. A call to Get Cont r ol Byl Dreturnsahandle
to the control specified by the signature and ID that comprisea Cont r ol | Dvariable:

#defi ne kText Fi el dSi gnat ure "Ltxt'
#defi ne kDyl anThonmasQuot eControl I D 1

Cont r ol Handl e quot eText Edi t ;
Control I D guoteControl ID = { kTextFi el dSi gnature,
kDyl anThomasQuot eControl I D };

Get Control Byl D{ wi ndow, &quoteControl ID, &quoteTextEdit );

Now usethe CFSt ri ng text retrieved by acall to C-CopylLocal i zedSt ri ng asan argument to
Set Cont r ol Dat a:

Set Control Data( quoteTextEdit, kControl EntireControl,
kControl Edi t Text CFStri ngTag, sizeof( CFStringRef ),
& heString );

The Set Cont r ol Dat a arguments consist of the handle to the control to access, a constant representing the control
part to access, a constant specifying the type of datainvolved, the byte size of the incoming text, and a pointer to the
incoming text.

Finish up your code with acall to Dr awOneCont r ol to redraw the text input field with the newly added text in place.
Figure 8.9 shows the results. Note how the use of \ r in the string value in the Localizable.strings file trandates to line

breaks in the displayed text.
DrawOneControl ( quoteTextEdit );
Creating a Localized L ocalizable.strings File

In this chapter's "L ocalized Resource Files' section, you saw that you can create |ocalized versions of a project's main.
nib resource file to create different language interfaces for an application. The sameistrue for the Localizable.strings
file. You can create localized versions of thistext-holding file so that your application displays window content in
different languages.

Clicking the arrow to the left of Localizable.stringsin the Groups & Fileslist of the project window reveas al versions
of the Localizable.strings file. Asit does for the main.nib file, Project Builder automatically names the first version of
Locdizable.strings "English" (again assuming that you're running Mac OS X with English as the selected language). To
create a duplicate Localizable.strings file named for a different language, follow steps similar to those used to create a
localized main.nib file:

1. Click Localizable.stringsin the Groups & Fileslist of the project window to highlight this group.



2. Choose Show Info from the Project menu.

3. Click the Localization & Platforms drop-down list and click Add LocalizedV ariant.
4. Enter the name of the new locale (such as German) in the sheet that appears.

5. Click the OK button to create the new file.

Project Builder creates a new Localizable.strings file with the appropriate name and adds it to the Localizable.strings
group.

The new Localizable.strings file will hold the same key-value pairs found in the original, English version of thefile. It's
up to you (or to the trandlator you've hired) to make the necessary trand ations. When doing so, don't translate the keys.
Recdll that the key isused in your source code, and you don't want to have to alter your source code to handle each
language. The key serves only as a means for your program to locate a particular string in the Localizable.strings file.
The key itself is never displayed by your application, so it doesn't need to be trand ated.

Figure 8.10 shows the trandlation from English to German of the one string from the Localizable.strings file pictured
back in Figure 8.7. Note that both keys have the same value; Quote appears as the key in both cases.

Figure 8.10. Thetrandated string from a project's Localizable.stringsfile.
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Note

The AltaVista search site (http://www.altavista.com) includes alink to their language translation page
(http://world.altavista.com). Here you type or paste aword or words into a text box, choose atrangation

(such as English to German) from amenu, and click the Trandate button. Y our text is quickly trandated
and the resulting trandation is displayed above the original text. I've included this note to let you know
about thisinteresting "quick and dirty" means of translating text. I've also included this note to warn you
that | don't know German, and that | used this AltaVista method to translate the Dylan Thomas quote used
in this chapter from English to German. It's unlikely that AltaVista's web page can compete with areal,
live, professional trandator, so | can't vow for this trandation's accuracy!

The LocalizedWindowText Program

The purpose of the LocalizedWindowText program is to demonstrate how a program retrieves and displays text stored
in aLocalizable.strings resource file.

Running the program results in the window shown back in Figure 8.9. There you see that the window displays the Dylan
Thomas quote that's appeared throughout this chapter.


http://www.altavista.com/
http://world.altavista.com/

To provide the program with a place to display the quote, atext input field is added to the main.nib file's one window
resource. To match the constants that will be defined in the source code, give the text input field asignature of Lt xt
and an ID of 1. Back in Figure 8.8, you see the main.nib file's one window with the text input added to it.

Creating the string to display in the window isfairly simple. In the project, create the first Localizable.stringsfile, as
described in this chapter's "Storing Text in a Localizable.strings File" section. Add a single key-value pair to thisfile.
Givethe key avalue of "Quote" to match the key constant that will be defined in the source code. Y ou can use the same
text pictured back in Figure 8.7, but of course, you don't have to do so.

Your next step isto include the braces at the start and end of the file. Then, you need to make sure to enclose both the
key and the value (the string) in quotation marks. Save the file and then create a second, localized version of it using the
steps listed in this chapter's "Creating a Localized Localizable.strings File" section. This new file has the original string
init. You can take the time to actually make the trandlation of thistext, or you can use this as a simple test program and
simply edit the string so that it differs from the original. With two versions of the Localizable.strings file in your project,
it's time to write the code.

Example 8.1 shows the complete listing for LocalizedWindowText program. The listing is especially short because the
program doesn't define or install any event handlers. When the program runs, awindow opens and a string is displayed
in it; the user doesn't need to make any menu selections or click a button to make anything happen. In this example, al
the window-opening code has been placed in its own application-defined routine. For clarity, you might consider having
such aroutine for each type of window your program opens.

Example 8.1 L ocalizedWindowText Source Code

#i ncl ude <Car bon/ Car bon. h>

#defi ne kKText Fi el dSi gnat ure "Ltxt'
#defi ne kDyl anThomasQuot eControl I D 1
#def i ne kQuot eText Key "Quot e"

voi d OpenNewQuot eW ndow( void );

int main( int argc, char* argv[] )

{
OpenNewQuot eW ndow() ;
RunAppl i cati onEvent Loop() ;
return( 0 );

}

voi d OpenNewQuot eW ndow( void )

{
| BNi bRef ni bRef ;
W ndowRef wi ndow,
OSSt at us err;
Control Handl e quot eText Edi t;
Control I D quot eControl I D = { kText Fi el dSi gnat ure,

kDyl anThomasQuot eControl I D };
CFSt ri ngRef theString;

err = CreateN bReference( CFSTR("main"), &nibRef );

err = Set MenuBar FromNi b( ni bRef, CFSTR("Mai nMenu") );

err = CreateW ndowFromNi b( ni bRef, CFSTR(" Mai nW ndow'), &w ndow );
Di sposeNi bRef erence( ni bRef );



ShowwW ndow( wi ndow ) ;
Get Control Byl D{ wi ndow, &quoteControl D, &quoteTextEdit );
theString = CFCopyLocalizedString( CFSTR( kQuoteTextKey ), NULL );
Set Control Dat a( quoteText Edit, kControl EntireControl,
kControl Edi t Text CFStri ngTag, sizeof( CFStringRef ),
& heString );

DrawOneControl ( quoteTextEdit );



For More Information

The following web sites provide extra information about some of this chapter's topics:

QuickDraw text: http://devel oper.apple.com/techpubs/macosx/Carbon/text/
QuickDrawText/quickdrawtext.html

String-related bundle services. http://devel oper.apple.com/techpubs/macosx/
CoreFoundation/BundleServices/bundleservices_carbon.html
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Chapter 9. QuickTime Movies and File Handling

AT THIS POINT,YOU KNOW ALL about interface e ements such as windows, controls,
and menus, and you have afirm grasp on how your program recognizes and handles a
variety of types of events. So it's on to the fun stuff. In this chapter, you'll see how your
program opens and plays a QuickTime movie. QuickTime is movie-playing software that is
part of the system software of every Macintosh in your target audience.

It's possible for a program to cause a QuickTime movie to spring forth from (seemingly)
nowhere. However, it's more likely that a movie-playing application will enable the user to
select the file that holds the movie to play. Giving the user the power to open a QuickTime
movie file, or any other type of file, involves the Open dialog box. Wel'll look at the Open
dialog box first in this chapter.



Filesand Navigation Services

A fileisasequence of bytes stored on physical media, such as a hard drive, and adirectory is another
name for afolder. A volume can be an entire physical storage device or it can be part of the device (the
result of formatting the device to consist of multiple volumes). For a program to access afile, it needs to
know the file's name, the directory in which the file is located, and the volume on which that directory
resides. In certain circumstances, a program that's to open afile includes these values (the file name and
location) directly within its code, but that's a scenario few programs use. In addition, this hard-coding of
fileinformation prevents the user from choosing what file to open, and it also sets up an application failure
should the user move or delete the sought-after file.

A better way to handle the situation is to call Navigation Services routines to make use of the Open dialog
box. By displaying the Open dialog box, you enable a user to select the file to open. Handling file opening
in thisway also forces the system to do the work of determining afile's name and location, and it leaves it
to the system to convey thisimportant file information to your program.

The Open dialog box provides the user with a standard interface for opening afile. This same Open dialog
box is used by any real-world application. Y ou can seeit by choosing Open from the File menu of
programs such as Apple's TextEdit or by looking at Figure 9.1.

Figure 9.1. A typical Open dialog box (asdisplayed in TextEdit).
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Navigation Servicesis part of the Carbon API that makesis possible for your programs to include standard
dialogs such as the Open dialog box. In addition, it is an important and useful part of the Carbon API. It
routines provide interface consistency for the user and removes the burden of file location determination



from the programmer. In this chapter, you'll see how to make use of Navigation Services, so brace yourself
for abarrage of information about key Navigation Services routines.

Implementing an Open Dialog Box

Y ou'll make use of anumber of Navigation Services routines to display and handle an Open dialog box
that is similar to the one TextEdit and other Mac OS X applications use. To do that, your code will perform
the following:

1. Create and display the standard Open dialog box.
2. Become aware of the user's action in the Open dialog box.

3. Respond to the user's action (for instance, open the appropriate file if the user clicks the Open
button).

4. Clean up by disposing of the Open dialog box when appropriate.

The overal look and behavior of an Open dialog box usually is the same. Such a dialog box includes
Cancel and Open buttons and alist view of the folders and files on the user's machine. The general
behavior of thistype of dialog box is the same from one implementation to another as well; the user
navigates through the file list, clicks the name of afile to open within the list, and then clicks the Open
button to open the selected file. To promote this consistent ook and behavior, Navigation Services defines
theNavDi al ogCreat i onOpt i ons datastructure as the following:

struct NavDi al ogCreati onOptions {

U nt 16 ver si on;

NavDi al ogOpti onFl ags opti onFl ags;

Poi nt | ocati on;

CFSt ri ngRef cl i ent Naneg;

CFSt ri ngRef wi ndowTi t | e;

CFStri ngRef acti onButtonLabel;
CFSt ri ngRef cancel But t onLabel ;
CFSt ri ngRef saveFi | eNane;

CFSt ri ngRef nmessage;

Ul nt 32 pr ef er enceKey;
CFAr r ayRef popupExt ensi on;

W ndowMbdal i ty nodal i ty;

W ndowRef par ent W ndow,

char reserved[ 16];

}
typedef struct NavD al ogCreati onOpti ons NavDi al ogCreati onOpti ons;

TheNavDi al ogCreat i onOpt | ons structure defines the features (such as size and location) of an
Open dialog box. The Navigation Servicesroutine Nav Get Def aul t Di al ogCreati onOptions is
used to fill thefieldsof aNavDi al ogCr eat i onOpt | ons structure with default values. Use this
routine by declaring avariable of type NavDi al ogCr eat i onOpt i ons and then passing that variable's
address as the routine's one argument:



CSSt at us err;
NavDi al ogCreati onOpti ons di al ogAttri but es;

err = NavCet Def aul t Di al ogCreati onOpti ons( &di al ogAttri butes )

After setting the values of the members of a structure to default values, you can customize the structure by
changing the value of any individual member. For instance, to make the Open dialog box take over the
application and disallow other application actions to take its place, the value of the dialog box's

NavDi al ogCreati onOpti ons nodal | t v member can be set to the Apple-defined constant

kW ndowibdal i t yAppModal :

di al ogAttri butes. nodality = kW ndowivbdal i t yAppModal ;

Y ou've seen how a program includes an application-defined event handler routine that's associated with a
window or other object. The Open dialog box also needs an application-defined event handler routine
associated with it. This event handler will be called by the system when the user dismisses the Open dialog
box. Navigation Services creates, displays, and runs the Open dialog box, but it is this event handler that
should perform the actual work of opening a user-selected file. Like other event handlers, this Open dialog
box event handler can have a name of your choosing, but it must include arguments of specific types.
Here's the prototype for such aroutine:

pascal void MyNavEvent Cal | back(
NavEvent Cal | backMessage cal | BackSel ect or,
NavCBRecPt r cal | BackPar s,
voi d* cal | BackUD ) ;

In amoment, you'll pass a pointer to this event handler to the Navigation Services routine that creates the
Open dialog box. The pointer should be of type NavEvent UPP. The UPP in NavEventUPP stands for
universal procedure pointer, which isa pointer that is capable of referencing procedures, or routines, in
different executable formats. In this case, aNav Event UPP can point to aroutine that isin native Mac OS
X executable format or in pre-Mac OS X executable format. You'll also need this pointer elsewhere in your
program, so declaring this pointer globally makes sense:

NavEvent UPP gNavEvent Handl er Pt r;

Use the Navigation Services routine NewiNav Event UPP to set this routine pointer variable to point to the
Open dialog box event handler:

gNavEvent Handl er Pt r = NewNavEvent UPP( MyNavEvent Cal | back );

Now it'stime to make acall to the Navigation Servicesroutine Nav Cr eat eCet Fi | eDi al og to create
the Open dialog box. This routine requires seven arguments, many of which can typically get set to NULL.
Here's the function prototype:

NavCr eat eGet Fi | eDi al og(

const NavDi al ogCreati onOpti ons * i nOpti ons,
NavTypeLi st Handl e i nTypelLi st
NavEvent UPP i nEvent Proc,

Nav Pr evi ewUPP i nPrevi ewPr oc,



NavQbj ect Fi | t er UPP inFilterProc,
void * i nCl i ent Dat a,
NavDi al ogRef * outDi al og );

Using the previously declared di al ogAttri but es and gNavEvent Handl er Pt r variables, here's
how acall to NavCr eat eCGet Fi | eDi al og could look:

NavDi al ogRef openD al og;

err = NavCreateCetFil eDi al og( &di al ogAttri butes, NULL,
gNavEvent Handl er Pt r, NULL, NULL,
NULL, &openDi al og );

Thei nOpt i ons parameter is apointer to the set of Open dialog box features that was returned by a prior
call toNavGet Def aul t Di al ogCr eat 1 onOpt i ons. Inthe preceding code snippet,

di al ogAt tri but es holdsthat set of default values, with the exception of the modality that was altered
after NavGet Def aul t Di al ogCreat i onOpt i ons wascalled.

Thei nTypelLi st isalist of filetypesto display in the Open dialog box's browser; pass NUL L to display
al file types.

Thei nEvent Pr oc parameter isthe procedure pointer that points to the Open dialog box's event handler
routine. In the preceding snippet, the global UPP variable gNavEvent Hand! er Pt r, which was
assigned its value from a call to NewiNavEvent UPP, isused.

The next three arguments each can be set to NULL. Thei nPr evi ewPr oc parameter isa pointer to a
custom file preview routine. The i nFi | t er Pr oc parameter isa pointer to a custom file filter routine.
Thei nCl | ent Dat a parameter is avalue that gets passed to either of the just-mentioned custom routines
(if present). The preceding snippet uses NUL L for each of these three arguments.

The last argument is a pointer to avariable of type NavDi al ogRef . After
NavCreat eCet Fi | eDi al og executes, thisargument will hold areference to the newly created Open
dialog box.

NavCreat eCet Fi | eDi al og creates an Open dialog box, but it doesn't display or control it. To do
those chores, call the Navigation Services routine NavDi al ogRun:

err = NavDi al ogRun( openDi al og );

NavDi al ogRun handles the user's interaction with the Open dialog box, so you don't need to write any
code to follow the user's actions as he or she uses the dialog box to browse for afile to open. When the
user clicks the Cancel or Open button, the application-defined event handler associated with this Open
dialog box is called. In doing this, Navigation Services passes on information about the event that initiated
the event handler call.

Asyou'll see alittle later in this chapter, the event handler takes care of the opening of the selected file and
the dismissing of the Open dialog box. Control then returns to the code that follows the call to
NavDi al ogRun. That code should look something like this:



if ( err !'= noErr )
{
NavDi al ogDi spose( openbDi al og );
D sposeNavEvent UPP( gNavEvent Handl erPtr );

If NavDi al ogRun completes without an error, your work is done. If there was an error, the variable er r
will have anonzero (nonnonkr r) value. Y our code should call the Navigation Services routines

NavDi al ogDi spose to dispose of the Open dialog box reference and Di sposeNavEvent UPP to
dispose of the pointer to the Open dialog box event handler.

Whew. That covers the process of displaying and running the Open dialog box. Now it'stime to take a
look at all the code as it might appear in an applicationdefined routine that is used to enable a user to
choose afile to open:

void D spl ayOpenFi |l eDi al og( void )

{
OSSt at us err:

NavDi al ogRef openDi al og;

NavDi al ogCreati onOpti ons dial ogAttri butes;

err = NavCet Def aul t Di al ogCreati onOpti ons( &di al ogAttri butes );
di al ogAttri butes. nodality = kW ndowivbdal i t yAppModal ;

gNavEvent Handl er Ptr = NewNavEvent UPP( MyNavEvent Cal | back );
err = NavCreateCetFil eDi al og( &dial ogAttributes, NULL,

gNavEvent Handl er Pt r, NULL, NULL,
NULL, &openDi al og );

err NavDi al ogRun( openbDi al og );
if ( err !'= noErr )
{
NavDi al ogDi spose( openDi al og );
Di sposeNavEvent UPP( gNavEvent Handl erPtr );

Open Dialog Box Event Handler

After the user of an Open dialog box makes afinal decision (by clicking the Cancel or Open button), the
Open dialog box event handler is automatically invoked. When the system invokes this handler, the system
passes information about the event initiated by the user's action:

pascal void MyNavEvent Cal | back(
NavEvent Cal | backMessage
cal | BackSel ect or,
Nav CBRecPt r cal | BackPar ns,



voi d* cal | BackUD )

Y our event handler usestheinformation inthecal | BackSel ect or argument to determine the action
with which to deal. The bulk of the event handler consists of aswi t ch statement that determines which
of the primary dialog box-related tasks needs handling:

switch ( call BackSel ector )
{
case kNavCBUser Acti on:
[l further determ ne which action took place (open or save)
/1 handl e the action (open or save selected file)
br eak;

case kNavCBTer m nat e:
/'l clean up after the nowdi sm ssed dial og
br eak;

The main two tasks handled inthe swi t ch consist of auser action (kNavCBUser Act 1 on), such asthe
request to open afile, and the memory clean up (kNav CBUTer m nat e), which isin response to the
dismissal of the dialog box.

To respond to a user action, call the Navigation Services routine NavDi al ogCGet Repl y. Passthis
routine areference to the dialog box that initiated the event and a pointer to areply record.

NavDi al ogCGet Repl v will fill the reply record with information about the user's action (such asthe file
to open). Thecont ext field of the event handler argument cal | BackPar s holds the dialog
reference. Declare avariable of type NavRepl yRecor d to be used as the reply record:

OSSt at us err;
NavRepl yRecord reply;
NavUser Acti on user Action = O;

err = NavDi al ogGet Repl y( cal | BackPar ns- >context, &reply );

Now call NavDi al ogCGet User Act | on, passing this routine a reference to the affected dialog box.
Once again, the context field of thecal | BackPar ans event handler argument is used.

NavDi al ogGet User Act i on tellsyour program the exact action the user took. In the case of an Open
dialog box, you're looking for auser action of kNavUser Act i onOpen. Note that similar code is used to
handle a Save dialog, and in such a case, you'd look for a user action of kNavUser Act i onSave As.
Finishwith acall to NavDi sposeRepl v to dispose of the reply record.

user Acti on = NavDi al ogGet User Acti on( cal | BackPar ns- >cont ext );

switch ( userAction )

{
case kNavUser Acti onOpen:
/1 open file here using reply record information
br eak;

}

err = NavDi sposeReply( &reply );



Note

The preceding code snippet includes one very vague comment. Obviously, some code needs
to actually open the user-selected file, yet I've waved that chore off with a single comment.
That's because the particulars of opening afile are specific to the type of file to open; amove
file, agraphicsfile, and an application-defined file al require different code to be
transformed from data on media to datain memory and finally to information displayed in a
window. Later in this chapter, we'll jump into the general steps, and the detailed code, for
opening one type of file: a QuickTime moviefile.

Y ou can put the just-described Open dialog box event handler code into a routine that looks like the one
shown here:

pascal void MyOpenDi al ogEvent Cal | back(
NavEvent Cal | backMessage cal | BackSel ect or,

Nav CBRecPt r cal | BackPar ns,
voi d* cal | BackUD )

OSSt at us err:;
NavRepl yRecord reply;
NavUser Acti on user Action = O;

switch ( call BackSel ector )
{
case kNavCBUser Acti on:
err = NavDi al ogGet Repl y( cal | BackPar ns- >context, &eply );
user Acti on = NavDi al ogGet User Acti on( cal | BackPar ns- >cont ext );

switch ( userAction )

{
case kNavUser Acti onQpen:
/'l open file here using reply record information
br eak;

}

err = NavDi sposeReply( & eply );

br eak;

case kNavCBTer m nat e:
NavDi al ogDi spose( cal | BackPar ns- >cont ext );
Di sposeNavEvent UPP( gNavEvent Handl erPtr );
br eak;

}
}

The Wy OpenDi al ogEvent Cal | back routine is generic enough that it should work, with very little
alteration, in your own file-opening program. Now all you need to do is replace the routine's one comment
with acall to an application-defined function designed to open afile of the appropriate type. In the next
section, you see how to write such aroutine. The code for the application-defined function



OpenOneQTrMovi eFi | e opens aQuickTime movie file. The OpenPlayMovie example then uses the
My OpenDi al ogEvent Cal | back routinewith acall to OQpenOneQrVovi eFi | e.



QuickTime Movies

A sound knowledge of the fundamentals of developing an interface for your Mac OS X program is of
great importance, but you didn't choose to learn about Mac programming for the sole purpose of creating
windows that include a few buttons. Y ou most certainly also want to know how your own program can
include at least some multimedia capabilities.

Unfortunately, Mac OS X programming for sound playing, sound recording, and smooth animation are
worthy of their own programming book. So, what can | show you in just half a chapter? Well, | can show
you one multimedia topic that best showcases Mac OS X multimediain action: QuickTime. By giving
your program the ability to play QuickTime movies, you can add high-resolution graphics, animation,
and sound playing to your program.

Note

QuickTime is now cross-platform software, but it started out as an extension of Mac-only
system software.

In this section, you see how to use the previously discussed Navigation Services routines to present the
user with an Open dialog box that lets him or her choose a QuickTime movie file to open. After that file
is open, you use Carbon API routines (which are grouped into the Movie Toolbox area of the Carbon
API) to play the movie.

Opening a QuickTime Movie File

This chapter's "Files and Navigation Services" section provides al the details for presenting the user with
a standard Open dialog box. It also shows how to respond to a user's selection of afilethat islisted in
that dialog box.

In this part of the chapter, you'll be using that information to give the user the power to pick a QuickTime
movie fileto display. Specifically, I'll jump into descriptions of the techniques and Movie Toolbox
routines that your program will use to get QuickTime movie file data that exists on the user's disk into a
format that's ready to play asamoviein awindow. The result will be an application-defined routine
named CpenOneQTMVovi eFi | e. Then, after you've devel oped this routine, you can insert it into the
kNavUser Act 1 onOpen case label section of theswi t ch statement in the

My OpenDi al ogEvent Cal | back routine that was developed earlier in this chapter.

Transferring Movie File Data to Memory

Scan back just abit in this chapter and you'll see the heading "Opening a QuickTime Movie File." Look
ahead alittle and you'll see the heading "Playing a QuickTime Movie." In broad terms, these are the two
steps a program performs so that a user can view amovie. However, each step is more involved that it
would first appear. For instance, in the case of opening a movie file, what's actually taking placeisthe



opening of that file (so its data can be accessed), the copying of that file's movie data content into
memory (where it can be referenced by the application), and the closing of the file (because its contents
are no longer needed). The goal of what's loosely described as the opening of afileisactualy the
transferring (or copying) of afile's datainto memory.

To open afile, your program needs to know the file's name and location. If the user selected thefilein
the Open dialog box, that dialog box's event handler gets the required information from the
NavRepl yRecor d variable. Recall from this chapter's

"Open Dialog Box Event Handler" section that the Open dialog box event handler called
NavDi al ogCGet Repl y tofill aNavRepl yRecor d with information about the userselected file to
open:

NavRepl yRecor d reply;

err = NavD al ogGet Repl y( cal | BackPar ns- >context, &eply );

With years of computer programming experience comes an appreciation for a programming task as
simple as adding two numbers; the job's simplicity ensures there's little or no chance of error. Thisisin
contrast to atask such asfile handling, which can be fraught with peril! The task involves selecting afile,
opening it, copying its contents to memory, and then accessing that memory to make use of the data
within. One flipped bit in this process can really play havoc on a program or even the drive itself!

In an attempt to avoid intimacy with the debugger, file-handling code often makes judicious use of error
checking. To increase the explanation-to-code ratio in this book, 1've provided descriptions of some basic
error-handling techniques in Chapter 2, "Overview of Mac OS X Programming,” and then for the most
part, kept errorhandling code to a minimum in the subsequent chapters. Now, however, is no time to be
stingy with error checking, so in upcoming snippets, you'll see alittle extra precautionary code, starting
right here:

CSSt at us err;
AEDesc newDescr i pt or;
FSRef nmovi eRef ;

err AECoer ceDesc( &reply->selection, typeFSRef, &newDescriptor );

err AEGet DescDat a( &newDescriptor, ( void * )( &novieRef ),

si zeof ( FSRef ) );

The Apple Event Manager routine AECoer ceDesc accepts data of one type (the first argument),
manipulates it to another type (specified by the second argument), and saves the resultsin a new variable
(the third argument). The usage of this routine verifiesthat the r epl v variable that holds the user-
selected fileisin the format of an FSRef . After the call to AECoer ceDesc completes, your program is
assured of having an FSRef within the variable newbDescr i pt or . The Apple Event Manager routine
AECet DescDat a theniscaled to retrievethe FSRef fromthenewbDescr i pt or variable.

At this point, the program has an FSRef (the variable novi eRef ) that holds information about the
user-selected file. Thus, we're almost ready to open the QuickTime movie file. However, we need to
make one quick detour. Some of the Carbon API routines are older (they existed as original Macintosh



Toolbox API routines), and some are newer (they were created to handle Mac OS X tasks for which no
original Macintosh Toolbox routine existed). The newer file-handling Carbon API routines that require
information about afile accept that information in the form of an argument of type FSRef . In contrast,
original file-handling Toolbox routines that became part of the Carbon API look for this same
information in the form of an argument of type

FSSpec. In addition, opening a QuickTime movie file requires the use of one of these older FSSpec -
accepting routines. Fortunately, for situations such asthis, the routine FSCGet Cat al ogl nf o function
can be used to convert an FSRef toan FSSpec:

FSSpec user Fi | eFSSpec;

FSGet Cat al ogl nf o( & ovi eRef, kFSCat | nf oNone, NULL, NULL,
&user Fi | eFSSpec, NULL );

FSCet Cat al ogl nf o isaworkhorse of a utility routinein that it can be used to obtain all sorts of
information about a catalog file. (A catalog file is a specia file used to keep information about all the
files and directories on avolume.) You can use FSCet Cat al ogl nf o to obtain information such as the
reference number of the volume on which afile resides or the parent directory ID of afile. You also can
use FSCGet Cat al ogl nf o to simply obtain an FSSpec for afile for which you already have an
FSRef . That'swhat I'm interested in here. Of most importance in this usage of FSCGet Cat al ogl nf o
isthe first argument, which isa pointer to the FSRef to convert, and the fifth argument, which isa
pointer to an FSSpec variablethat FSCGet Cat al ogl nf o isto fill with the file system specification.
The only other nonNUL L value is the second argument. This argument normally is used to specify which
of many pieces of information about afile or directory are to be returned. | don't need any of this
information, so the constant k FSCat | nf oNone isused here.

Now it's time to open the file. The Movie Toolbox routine CpeniVbvi eFi | e doesthat. The first
Openhbvi eFi | e argument isafile system specification. Y ou can use the one returned by the call to
FSCet Cat al ogl nf o. After OpenMovi eFi | e opensthe specified filem it provides your program
with areference number for that file. That reference number is your program's means of (you guessed it)
referring to that file in subsequent callsto Movie Toolbox routines. The next argument is a pointer to a
variable in which Cpenibvi eFi | e placesthisreference value. The last argument is a permission level
for the opened file. A program that opens a movie for playing but that won't enable the atering of the
movie contents should use the constant f s RdPer m

OSEr r err;
FSSpec user Fi | eFSSpec
shor t nmovi eRef Num

err = QpenMovi eFil e( &userFil eFSSpec, &nmovi eRef Num fsRdPerm);
Caution

Besides f s RdPer m other permission constantsinclude f s\W Per m(to enable writing)
and f sRdW Per m(to enable reading and writing). In my simple examples, the permission
level isn't crucial. That is, you can changeit to, say, f s Rd\W Per m, and the user still won't
be able to cut any frames from an opened movie. However, in your full-blown application,
permissions might be of importance. If your program includes a functioning Edit menu that



supports the cutting and pasting of multiple data types, you might not want to give the user
the ability to alter the frames of amovie. In such an instance, you'll want to make sure that
movie files are opened with the f s RdPer mconstant rather than with one of the constants
that enables file writing.

After opening amoviefile, that file's data needs to be loaded into memory. A call to the Movie Toolbox
routine NewiVovi eFr onfi | e doesthis:

Movi e movi e = NULL;
shor t movi eReslI D = O;

err = NewMovi eFrontil e( &movi e, novi eRef Num &novi eResl D,
NULL, newMbvi eActive, NULL );

After Newlbvi eFr onfi | e completes, the first argument holds a reference to the movie (avariable of
type Vovi e ). To create this movie, NewiVbvi eFr onti | e needs the movie file reference number that
was returned by the prior call to OpenVbvi eFi | e. You should pass this as the second argument.
NewVovi eFr onti | e aso needsthe ID of the movie datain the filein question. Although asinglefile
typically holds one movie, it can hold multiple movies. Thus, it's necessary to specify which of afile's
moviesisto be used. A value of 0 asthe third argument tells NewiVbvi eFr onti | e to usethefirst
movieinthefile. Thus, even if thereisonly one movie in thefile, thisvalue of O doesthe job.

When Newivbvi eFr onfi | e exits, it fillsin the fourth argument (nmovi eNane) with the name of the
movie resource that was used to create the movie. Note that thisisn't the name of the file that holds the
movie; it's the name of aresource within the file. That's usually not of importance, so your program can
pass NUL L here. The fifth argument is used to provide supplemental information to

Newlvbvi eFr onfi | e. Using the constant newivbvi eAct | ve specifies that the new movie should be
active; amovie needs to be active for it to be played. The last argument tells whether

Newlbvi eFr onti | e had to make any changesto the data in the file. This shouldn't occur, so again a
value of NUL L typically suffices.

Thecal to Openbvi eFi | e opened thefile in preparation for accessto it. NewiVovi eFronti | eis
the routine that accessed the file. Now, with the movie data safe in memory and alVbvi e variable
referencing that data, the file can be closed:

Cl oseMovi eFi | e( novi eRef Num ) ;

Cl oseMovi eFi | e needsto know which file to close. The reference number returned by
OpenMovi eFi | e provides that information.

Displayinga Moviein a Window

At this point, amovieisin memory and accessible by way of alVbvi e variable. Now the movie needsto
be associated with a window. There's nothing special about a window that holds a movie; you just create
anew window resource in your program's main.nib file. Y ou can make the window any size you want.

Y our code resizes this window to match the size of the movie that eventually gets displayed within the
window. With the window resource defined, include the standard window-creation code in your code:



W ndowRef wi ndow;

OSSt at us err;

| BNi bRef ni bRef ;

err = CreateN bReference( CFSTR("main"), &nibRef );

err = CreateW ndowFr omNi b( ni bRef, CFSTR("Mvi eW ndow'), &w ndow ) ;
Di sposeN bRef erence( ni bRef );

Now, for the link between the movie and the window, call Set Por t W ndowPor t to make the
window's port the active port. Then, call the Movie Toolbox routine Set Vovi eGM\or | d to associate the
movie with the currently active port:

Set Port W ndowPort ( w ndow ) ;

Set Movi eGMNr I d( nmovi e, NULL, NULL );

The Gor | dinSet Movi eGMor | d refersto agraphics world, which is acomplex memory drawing
environment used in the preparation of images before their onscreen display. The first

Set Movi eGAor | d argument is the movie to associate with a port. The second argument is the port;
pass NULL hereto tell Set Vbvi eGA\or | d to associate the movie with the current port, which isthe
window named in the call to Set Por t W ndowPor t . Thelast argument isahandletoaCGdevi ce,
which is a structure describing a graphics device. A value of NULL heretells Set Movi eGA\or | d to use
the current device.

Now determine the size of the open movie and use those coordinates to resize the window to match the
movie size:

Rect novi eBox;

Get Movi eBox( novi e, &novi eBox );

O f set Rect ( &movi eBox, -novieBox.left, -novieBox.top );

Set Movi eBox( novi e, &novi eBox );

Si zeW ndow( wi ndow, novi eBox.right, novieBox.bottom TRUE );
ShowwW ndow( wi ndow ) ;

Pass Cet Vbvi eBox amovie and the routine returns a rectangle that holds the size of the movie. This
might be all you need, or it might not be. Although the returned rectangle does hold the size of the movie,
it's possible that the top and left coordinates of this rectangle each might not be 0. In such a case, looking
at movi eBox. ri ght for the movieswidth and novi eBox. bot t omfor the movie's height would
provide erroneous information. For instance, anovi eBox. | ef t valueof 50and anovi eBox.

ri ght vaue of 200 means that the movie has awidth of 150 pixels. A cal to the QuickDraw routine

O f set Rect simply offsetsthe novi eBox rectangle such that its left and top coordinates each have a
value of 0. A call to Set Movi eBox makes the new, offset values the boundaries for the rectangle that
defines the size of the movie.

Although the movie rectangle has been adjusted, the window that's to display the movie has not. A call to
Si zeW ndowdoesthat. Pass Si ze\W ndowthe window to resize, along with the new width and height
to use in the size change. The last argument is a Boolean value that tells whether an update event should
be generated. The call to ShowWW ndowfinaly reveals the movie-holding window to the user.



To ensure that the window displays a frame of the movie, call Vovi esTask. This Movie Toolbox
routine does just that. Pass the movie to use in the frame display as the first argument and avalue of O as
the second argument. ThisO value tells Vbvi es Task to service (update) each active movie. If your
program can display more than one movie at atime, Vovi es Task will jump to each open movie,
displaying one new frame in each. Precede the call to Vbvi esTask with acall to

CoToBegl nni ngOf Movi e. This Toolbox routine rewinds the movie to its first frame. Although a
newly opened movie will most likely be set to the movie'sfirst frame, acal to this routine ensures that
that will be so:

GoToBegi nni ngOf Movi e( novie );
Movi esTask( nmovie, 0 );

Playing a QuickTime Movie
The movie's now open and displayed in awindow. Let's play it from start to finish:

Start Movie( novie );
do

{
Movi esTask( novie, 0 );
} while ( [IsMvieDone( novie ) == FALSE );

Contrary toitsname, St ar t Movi e doesn't start amovie. Instead, it prepares the specified movie for
playing by making the movie active and setting the movie's playback rate. To actually play amovie, call
Movi esTask withinaloop. Each call to Movi esTask plays aframe of the movie. Because your
program won't know how many frames are in the movie to play, rely on acall to the Movie Toolbox
routine | sVbvi eDone to determine when the frame-playing loop should terminate. Pass

| sMovi eDone amovie and the routine returns avalue of TRUE if the last frame has been reached or
FALSE if there's one or more frames left to play.

Note

Related to the running of amovie isthe movie controller. It is the thin, three-dimensional
control that runs along the bottom of awindow displaying a QuickTime movie. The movie
controller is under the user's control, and it enables the user to run, pause, or step forward or
backwards through the movie displayed in the window. For more information on movie
controllers, see the URL listed at the end of this chapter.

OpenPlayM ovie Program

The purpose of OpenPlayMovie isto demonstrate how the Navigation Services routines are used to
display the standard Open dialog box. It also shows how to respond to a user-selected file when that file
isaQuickTime movie.



OpenPlayMovie starts by opening awindow that includes asingle line of text, as shown in Figure 9.2.
When you follow that window's instructions, you see the standard Open dialog box. Use thefileliststo
move about your drive or drives to find a QuickTime movie. When you click the Open dialog box's Open
button, a new window displaying the first frame of the movie appears. Choose Play Movie from the
Movie menu and the movie plays from start to finish. Y ou can choose Play Movie as often as you wish.

Figure 9.2. Windows displayed by the OpenPlayM ovie program.
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Nib Resources

The main.nib window in the project's main.nib file includes two windows, as shown in Figure 9.3. By
default, Interface Builder sets a new window to be resizable, and it gives the window a small resize
control in the lower-right corner of the window. The OpenPlayMovie program eliminates this resize
control from the movie-playing window. The control would obscure a small part of one corner of the
movieif it were present.

Figure 9.3. The OpenPlayM ovie nib resour ces.
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Y ou can use Interface Builder to set awindow so that it can't be resizable. To do that, click the
MovieWindow window in main.nib (see Figure 9.3), choose Show Info from the Tools menu, display the
Attributes pane, and then uncheck the Resizable checkbox. While you're there, uncheck both the Close
and the Zoom checkboxes so that the window won't be closeable or zoomable.

The Movie menu includes two items: Open Movie and Play Movie. The Open Movie item has a
command of Oprnv. Assign it that command from the Attributes pane of the item's Info window. The
Play Movie item has acommand of PLmv. Play Movieitemisinitialy disabled. Click that item, choose
Show Info from the Tools menu, and, from the Attributes pane, uncheck the Enabled checkbox. Because
the program'’s code will be accessing the Movie menu, this menu needs an ID. Y ou can give the Movie
menu amenu ID of 5 by clicking Movie in the menu window, choosing Show Info from the Tools menu,
and entering 5 in the Menu 1D field.

Sour ce Code

The QuickTime function prototypes aren't included in a project by default, so you'll need to include
QuickTime.h along with Carbon.h:

#i ncl ude <Car bon/ Car bon. h>
#1 ncl ude <Qui ckTi me/ Qui ckTi nme. h>

Define a constant to match the commands assigned to the Open Movie and Play Movie menu itemsin the
nib resource. Also, define constants to match the Movie menu ID and the menu placement of the two
itemsin the Movie menu:

#define kOpenMyvi eConmand " OoPmv!
#define kPl ayMovi eCommand " PLNMV'
#define kMvi eMenul D 5
#define kMyvi eMenuOpenltenmNum 1
#define kMovi eMenuPl ayltenmNum 2

OpenPlayMovie declares three global variables. The procedure pointer gNavEvent Handl er Pt r is
used in setting up the Open dialog box event handler, gVovi e will reference the movie after it's opened,
and gVovi eMenu will hold ahandle to the

Movie menu so that the menu's items can be enabled and disabled:

NavEvent UPP gNavEvent Handl er Pt r;
Movi e ghovi e = NULL;
MenuHandl e ghMovi eMenu;

Almost all the nai n routine is the same asin past examples. Additions of note include acall to
Ent er Movi es (aMovie Toolbox initialization routine that's required before a program makes use of
other Movie Toolbox routines) and acall to Cet VenuHand! e (to obtain a handle to the Movie menu):

int main( int argc, char* argv[] )

{
| BNI bRef ni bRef ;



W ndowRef wi ndow,

CSSt at us err,;

Event Tar get Ref target;

Event Handl er UPP handl er UPP;

Event TypeSpec appEvent = { kEvent d assCommand,

kEvent ProcessConmand };
Ent er Movi es() ;
/'l set up nenu bar, open wi ndow, install event handl er
ghovi eMenu = Get MenuHandl e( kMovi eMenul D ) ;
RunAppl i cati onEvent Loop() ;

return( 0 );

}

OpenPlayM ovie demonstrates some simple menu adjustment techniques that make it possible to force the
program to enable only one movie to be opened. When the program launches, the Open Movieitemis
enabled and the Play Movie item is disabled, as specified in the menu resource in the nib file. If amenu
item doesn't make sense at a particular moment in the running of a program, it should be disabled. When
the program launches, no movie is open, so the Play Movie item isn't applicable. That's why it'sinitially
disabled. The program enables a user to select amovie to open, so the Open Movie item starts out
enabled. The toggling of the state of these two items takes place in the application's event handler.

The following snippet comes from My AppEvent Handl er and shows the code that responds to a
command issued by the user's choosing of the Open Movie menu item:

case kOpenMovi eCommand:
Di spl ayQpenFi | eDi al og() ;
if ( gvovie !'= NULL )

{
Di sabl eMenul tem( gMovi eMenu, kMovi eMenuQpenl t enNum ) ;
Enabl eMenul t en( gMovi eMenu, kMovi eMenuPl aylt enNum ) ;
}
result = noErr;
br eak;

Handling an Open Movie menu item selection begins with a call to the application-defined

Di spl ayOpenFi | eDi al og routine. The global Vovi e variable givbvi e wasinitialized to a value of
NULL to signify that no movieis open. If the user opensamovie, giVovi e references that movie and

will have avalue other than NUL L. In that case, My AppEvent Hand! er disablesthe Open Movie item
and enables the Play Movie item. That makes it impossible for the user to attempt to open a second
movie, and it makes possible the playing of the now-open movie. If the user clicks the Cancel button in
the Open dialog box, giVovi e will retain its NUL L value and the two menu items will retain their initial
state. This enables the user to again choose Open Movie to open amovie.

In your more sophisticated movie-playing programs, you might alow the display and playing of multiple
movies. In that case, you can expand on the technique discussed here by allowing the closing of movie



windows and the toggling of the Play Movie item from enabled to disabled when all such movie
windows are closed. One way to do that is to intercept window-closing events. When awindow closes,
check whether it was the last movie window. (Y ou could keep a global movie window counter that
increments and decrements as movies are opened and closed.) In Chapter 3, "Events and the Carbon
Event Manager," the MyCloseWindow example introduces the topic of window closing events. (The
program sounds a beep when the user clicks a window's Close button.) In Chapter 4, "Windows," the

MenuButtonCloseWindow example elaborates on this technique. Finally, in Chapter 6, "Menus," you
learn how to enable and disable menu items.

If the user chooses Play Movie, the application-defined Pl ay Onelbvi e routineis called. Note that
there's no need for any menu-item disabling or enabling here. If thisitem is enabled, it means amovie
window is open and can be played. If no movie window is open, thisitem will be disabled and the
kPl ayMovi eComrand can't be generated by the program!

case kPl ayMovi eCommand:
Pl ayOneMovi e( gMovie );
result = noErr;
br eak;

In response to the user's choosing Open Movie, the program calls Di spl ayOpenFi | eDi al og. This
application-defined routine was developed in this chapter's "Implementing an Open Dialog Box" section.
The OpenPlayMovie source code listing (Example 9.1) shows this routine. The event handler, or callback
routine, that Di spl ayOpenFi | eDi al og installsisthe application-defined routine

My OpenDi al ogEvent Cal | back. (Thisisanother routine discussed at length in the "Implementing
an Open Dialog Box" section. Refer to those pages for more information on this callback function.) Here
I'll point out that if the system invokes this routine with a user action of kNavUser Act i onCpen, the
callback routine invokes the application-defined function CpenOneQTVbvi eFi | e to open the user-
selected moviefile.

The OpenOneQTMVovi eFi | e routineis basically acompilation of the code discussed in this chapter's
"Transferring Movie File Datato Memory" section. AECoer ceDesc makes sure that the

NavRepl yRecor d filled in by the Open dialog box isvalid, AEGet DescDat a retrieves an FSRef
from that reply record, and FSCGet Cat al ogl nf o convertsthe FSRef to an FSSpec for usein
opening the moviefile:

void OpenOneQTrMovi eFil e( NavRepl yRecord *reply )

{
AEDesc newDescr i pt or;
FSRef novi eRef ;
W ndowRef W ndow;
CSSt at us err;
FSSpec user Fi | eFSSpec;

| BNi bRef ni bRef ;

err AECoer ceDesc( &reply-<selection, typeFSRef, &newDescriptor );

err AEGet DescDat a( &newDescriptor, ( void * )( &mvieRef ),

si zeof ( FSRef ) );



FSGet Cat al ogl nf o( & ovi eRef, kFSCat | nf oNone, NULL, NULL,
&user Fi | eFSSpec, NULL );

gMovi e = Get Movi eFronti |l e( userFil eFSSpec );

The application-defined routine Get Vbvi eFr onti | e (discussed next) opens the movie file and
assigns gVbvi e areference to the movie. A new window then is opened, its port is set to the current
port, and the application-defined routine Ad| ust Movi e W ndow (discussed shortly) resizes the window
and associ ates the movie with the window. CpenOneQrVovi eFi | e endswith acall to

AEDI sposeDesc to dispose of the AEDI sc created earlier in the routine:

err = CreateN bReference( CFSTR("main"), &nibRef );
err = CreateW ndowFr omNi b( ni bRef, CFSTR("Movi eW ndow'), &w ndow ) ;
Di sposeN bRef erence( ni bRef );
Set Port W ndowPort ( wi ndow ) ;
Adj ust Movi eW ndow( gMovi e, w ndow );

AEDi sposeDesc( &newDescriptor );

Get Mbvi eFronti | e isashort routine that makes three Movie Toolbox calls. Openhovi eFi | e
opens the user-selected file. NewiVovi eFr onfti | e loads the movie datato memory and returns a
reference to the movie. Cl oselMbvi eFi | e closesthe moviefile. This chapter's "Transferring Movie
File Datato Memory" section discusses each routine.

Movi e Get Movi eFrontil e( FSSpec userFi | eFSSpec )

{
OSEr r err;
Movi e nmovi e = NULL,;
short novi eRef Num
short novi eResl D = O;
err = QpenMovi eFi |l e( &userFi | eFSSpec, &movi eRef Num fsRdPerm);
err = NewMovi eFronFil e( &movi e, novieRef Num  &novi eResl D,
NULL, newibvi eActive, NULL );
Cl oseMovi eFi |l e( novi eRef Num ) ;
return ( novie );
}

Ad] ust Mbvi eW ndow combines the code discussed in this chapter's "Displaying aMoviein a
Window" section to create aroutine that calls Set Movi e GA\or | d to associate the open movie with the
recently opened window and to resize the window to match the size of the movie.

voi d Adj ust Movi eW ndow Movi e novie, WndowRef w ndow )



}

Rect novi eBox;

Set Movi eGWr | d( novie, NULL, NULL );

Get Movi eBox( novi e, &novi eBox );

O fset Rect ( &nmovi eBox, -novi eBox.left, -novieBox.top );

Set Movi eBox( novi e, &novi eBox );

Si zeW ndow( wi ndow, novi eBox.right, novi eBox.bottom TRUE );
ShowwW ndow( w ndow ) ;

GoToBegi nni ngOf Movi e( ghovie );
Movi esTask( gMovie, 0 );

At this point, amovie file has been opened and the first frame of the movieis displayed in awindow. To
play the movie, the user chooses Play Movie from the Movie menu. Doing that initiates acommand that
the application event handler handles by calling P| ay OneMovi e. This routine bundles the code
discussed in this chapter's "Playing a QuickTime Movi€" section, with the result being the playing of the
movie from start to finish:

voi d Pl ayOneMovi e( Movie novie )

{

}

GoToBegi nni ngOf Movi e( novie );
Start Movie( novie );
do

{
Movi esTask( novie, 0 );
} while ( IsMovieDone( novie ) == FALSE );

Example 9.1 OpenPlayM ovie Sour ce Code

#i ncl ude <Car bon/ Car bon. h>
#i ncl ude <Qui ckTi nme/ Qui ckTi ne. h>

#defi ne kOpenMovi eComand " OPmv'

#def i ne kPl ayMovi eConmmand " PLMV'

#defi ne kMovi eMenul D 5

#def i ne kMovi eMenuQpenl t enNum 1

#defi ne kMovi eMenuPl ayl t emNum 2

Movi e Get Movi eFronFi | e( FSSpec userFil eFSSpec );

voi d Adj ust Movi eW ndow( Movi e novi e, W ndowRef w ndow );
voi d Pl ayOneMovi e( Movie novie );

voi d Di spl ayOpenFi | eDi al og( void );

voi d OpenOneQTMovi eFi | e( NavRepl yRecord *reply );



pascal OSStatus MyAppEvent Handl er ( Event Handl er Cal | Ref handl er Ref
Event Ref event, void *userData );
pascal void MyOQpenDi al ogEvent Cal | back(
NavEvent Cal | backMessage
cal | BackSel ect or,
NavCBRecPt r cal | BackPar ns,
voi d* cal | BackUD ) ;

NavEvent UPP  gNavEvent Handl er Ptr;
Movi e gMovi e = NULL;
MenuHandl e gMovi eMenu;

int main( int argc, char* argv[] )
{
| BNi bRef ni bRef ;
W ndowRef wi ndow;
0SSt at us err;
Event Tar get Ref target;
Event Handl er UPP handl er UPP;
Event TypeSpec appEvent = { kEvent C assConmand,
kEvent ProcessConmand };

Ent er Movi es() ;

Creat eN bRef erence( CFSTR("main"), &nibRef );

err Set MenuBar FronNi b( ni bRef, CFSTR(" Mai nMenu") );

err Cr eat eW ndowFr omNi b( ni bRef, CFSTR(" Mai nW ndow"'), &wm ndow );
Di sposeNi bRef erence( ni bRef );

err

ShowwW ndow( wi ndow ) ;

target = Get Applicati onEvent Target ();
handl er UPP = NewEvent Handl er UPP( MyAppEvent Handl er );
I nstal | Event Handl er ( target, handl erUPP, 1, &appEvent, 0, NULL );

ghovi eMenu = Get MenuHandl e( kMovi eMenul D ) ;
RunAppl i cati onEvent Loop() ;

return( 0 );

pascal OSStatus MyAppEvent Handl er ( Event Handl er Cal | Ref handl er Ref
Event Ref event, void *userData)

{
OSSt at us result = event Not Handl edErr ;

HI Conmmand conmand;

CGet Event Paraneter ( event, kEventParanDirect Object, typeH Conmand,
NULL, sizeof (H Command), NULL, &command);



switch ( command. conmandl D )
{
case kOpenMvi eCommand:
Di spl ayOpenFi | eDi al og() ;
if ( gMovie !'= NULL )
{
Di sabl eMenul ten( gMovi eMenu, kMovi eMenuQpenltenmNum ) ;
Enabl eMenul t en{ gMovi eMenu, kMovi eMenuPl ayltemNum ) ;
}
result = noFErr;
br eak;

case kPl ayMovi eCommand:
Pl ayOneMovi e( ghbvi e );
result = noFErr;
br eak;

}

return result;

voi d Di spl ayOpenFi | eDi al og( void )

CSSt at us err,;
NavDi al ogRef openDi al og;
NavDi al ogCreati onOpti ons di al ogAttri but es;

err = NavGet Def aul t Di al ogCreati onOpti ons( &di al ogAttri butes );
di al ogAttri butes. nodality = kW ndowMbdal i t yAppModal ;

gNavEvent Handl er Ptr = NewNavEvent UPP( MyQpenDi al ogEvent Cal | back );

err = NavCreateCGetFi |l eDi al og( &di al ogAttri butes, NULL,
gNavEvent Handl er Pt r, NULL, NULL,
NULL, &openDi al og );

err = NavDi al ogRun( openbDi al og );
if ( err !'=noErr )
{
NavDi al ogDhi spose( openDi al og );
D sposeNavEvent UPP( gNavEvent Handl erPtr );

pascal void MyOpenDi al ogEvent Cal | back(
NavEvent Cal | backMessage
cal | BackSel ect or,
NavCBRecPt r cal | BackPar ns,



voi d* cal | BackUD )

OSSt at us err;
NavRepl yRecord reply;
NavUser Acti on user Action = 0;

switch ( call BackSel ector )
{
case kNavCBUser Acti on:
err = NavDi al ogGet Repl y( cal | BackPar nms- >context, &reply );
user Acti on = NavDi al ogGet User Acti on( cal | BackPar ns-
>cont ext );
switch ( userAction )
{
case kNavUser Acti onQpen:
OpenOneQTMovi eFil e( &reply );
br eak;
}
err = NavDi sposeReply( & eply );
br eak;

case kNavCBTer m nat e:
NavDi al ogDhi spose( cal | BackPar ns- >cont ext );
D sposeNavEvent UPP( gNavEvent Handl erPtr );
br eak;

void OpenOneQTMovi eFil e( NavRepl yRecord *reply )
{
AEDesc newDescr i ptor;
FSRef novi eRef ;
W ndowRef Wi ndow;
OSSt at us err,
FSSpec user Fi | eFSSpec;
| BNi bRef ni bRef ;
err = AECoerceDesc( &reply->selection, typeFSRef, &newDescriptor );

err = AECet DescDat a( &newDescriptor, ( void * )( &mvieRef ),
si zeof ( FSRef ) );

FSCGet Cat al ogl nf o( &novi eRef, kFSCat | nf oNone, NULL,
NULL, &userFil eFSSpec, NULL );

gMovi e = Get Movi eFrontil e( userFil eFSSpec );
err = CreateN bReference( CFSTR("main"), &nibRef );

err = CreateW ndowFromNi b( ni bRef, CFSTR("Mvi eW ndow'), &w ndow );
Di sposeNi bRef erence( ni bRef );



Set Port W ndowPort ( wi ndow ) ;
Adj ust Movi eW ndow( gMovi e, wi ndow );

AED sposeDesc( &newDescriptor );

Movi e CGet Movi eFrontfi | e( FSSpec userFil eFSSpec )

{
CSEr r err;
Movi e nmovi e = NULL,;
short novi eRef Num
short novi eReslI D = O;
err = OpenMvi eFil e( &userFil eFSSpec, &novi eRef Num fsRdPerm);
err = NewMovi eFronFil e( &mvie, novieRef Num &novi eResl D,
NULL, newMbvi eActive, NULL );
Cl oseMovi eFi |l e( nmovi eRef Num ) ;
return ( novie );
}

void Adjust MovieWndow Movie novie, WndowRef w ndow )
Rect novi eBox;
Set Movi eGWr | d( nmovi e, NULL, NULL );
Get Movi eBox( novi e, &nmovi eBox );
O fset Rect ( & ovi eBox, -novi eBox.left, -novieBox.top );
Set Mbvi eBox( novi e, &nmovi eBox );
Si zeW ndow( wi ndow, novi eBox.right, novieBox.bottom TRUE );
Showw ndow( wi ndow ) ;

GoToBegi nni ngOf Movi e( gMovie );
Movi esTask( gMovie, 0 );

void PlayOneMovie( Myvie novie )
GoToBegi nni ngOf Movi e( novie );
Start Movi e( novie );

do
{



Movi esTask( novie, 0 );
} while ( IsMovieDone( novie ) == FALSE );



For More Information

The following web sites provide extra information about some of this chapter's topics:

Navigation Services: http://devel oper.apple.com/techpubs/macosx/Carbon/Files/
NavigationServices/navigationservices.html

QuickTime technologies. http://devel oper.apple.com/techpubs/quicktime/
quicktime.html

QuickTime API: http://devel oper.apple.com/techpubs/quicktime/qtdevdocs/RM/
frameset.htm

Movie controllers: http://devel oper.apple.com/techpubs/quicktime/gtdevdocs/RM/
frameset.htm
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http://developer.apple.com/techpubs/quicktime/qtdevdocs/RM/frameset.htm
http://developer.apple.com/techpubs/quicktime/qtdevdocs/RM/frameset.htm
http://developer.apple.com/techpubs/quicktime/qtdevdocs/RM/frameset.htm
http://developer.apple.com/techpubs/quicktime/qtdevdocs/RM/frameset.htm

Chapter 10. Bundlesand I cons

ON THE DESKTOP, YOUR APPLICATION'S ICON SUGGESTS that your program is
just that-an application file. It's not, however. What appears to the user to be an application
isrealy abundle consisting of severa files and folders. In this chapter, you see how to
examine the contents of an application bundle and discover the purpose of the various files
and folders that comprise that bundle. Y ou'll also learn how to register a contributor code.

Y our application can open multiple windows of a variety of types, with each window
displaying text, graphics, and controls. Y our program can check for errors, post alerts, and
even play QuickTime moviefiles. In short, your program can do quite a bit whenit's
running.

However, although your application might perform amazing tricks while executing, it's just
another plain, generic icon from the desktop. In this chapter, you'll change that. You'll see
how to create an icon and associate it with your application.

With Aqua, Apple introduces an entirely new scheme for displaying icons and the result is
that you can design large, high-resolution icons. If you're artistic, or know someone who is,
now isthe best time to create atruly unique, photo-quality icon that really reflects the
nature or purpose of your application.



Applications, Bundles, and Packages

An application that you see as an icon on your Mac's desktop is not an application. Itisan
application bundle, which is afile package that holds folders and files. One of thefilesin
this package is the application itself. The other folders and files support the application file,
and they can include image and sound files, multiple versions of nib files (each localized
for adifferent language), files that hold strings localized for different languages, and other
files.

The Application Bundle

The application bundle is afile package that holds a self-sufficient binary file that's
launchable from the desktop. An application bundle is what a developer usually creates.

Note

There are other types of bundles as well. Frameworks and plug-ins are
bundles that can be dynamically loaded and used by applications. The
purpose for creating such bundlesis reusability. Such a bundle usually has
some general purpose and thus can be included with more than one
application.

Placing an application and all the filesit usesinto a single package and then giving that
package a single icon on the desktop is a new, important, and clever scheme. It hides the
plethora of files so that the end user doesn't get confused or inadvertently delete support
files. It also makes the transfer of an application from one computer to another easy in that
the program's files are assured to arrive together when the user copies what he or she thinks
isasingle application file.

The desktop hides the true nature of an application, but it also makes it relatively easy to
view the contents of an application package. To do that, press and hold the Control key,
and then click an application icon. Choose Show Package Contents from the contextual
menu. In Figure 10.1, I'm doing it with the CheckboxDemo program from Chapter 5,

"Controls," but you can do thisfor any application.

Figure 10.1. Displaying the contents of an application bundle.
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Choosing Show Package Contents opens a new Finder window that displays a single folder
named Contents. Y es, this folder holds the entire contents of the application bundle you've
selected. Figure 10.2 shows the contents of the Contents fol der.

Figure 10.2. Thefoldersand filesthat make up atypical application bundle.
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In Figure 10.2, you see that the Contents folder holds three files and two folders. Project

Builder placed al theseitemsin this folder when the application was built. The following
subsections discuss these in detail.



Info.plist

Thisis an information property list that holds application bundle information that's of use
to the Finder. For instance, among the information in Info.plist file is the specification that
this bundle is an application (a bundle doesn't have to be a standal one application) and that
the name of the executable in this bundle is CheckboxDemo. The information in the Info.
plist file isin extensible markup language (XML) format. It can be hand-edited, but it'sa
much better idea not to. Instead, leave it to Project Builder to put together thisfile's
information from various settings within the project from which the application gets built.

pbdevelopment.plist

Thisisan information property list that's of use only to Project Builder. It exists only when
adevelopment version of an application is built. When you're at the point where your
development is complete, and you're satisfied with the resulting application, you build your
deployment version. The building is accomplished by checking the Deployment option
under the Targets tab in the project (see Figure 10.8). When a deployment version of an

application is built, that application bundle won't include a pbdevelopment.plist file.

Figure 10.8. Associating a creator code with an application in a project.
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Thisfile holds the bundle type and creator code for the application. An application has a
bundle type of APPL and a unique creator code of the developer's choosing. See this
chapter's "Registering a Creator Code" section for more information.

MacOS

Thisisafolder that holds the executable itself. This book's examples each include asingle
executable, but it's possible to create an application bundle that holds more than one
executable. The primary example of such a situation isfor a project that's building two
versions of the same program. One version would run on Mac OS X and one would run on
Mac OS 9. Such a project would actually create two separate executables, with each being



launchable on its respective operating system version.

Resour ces

Thisfolder holds all the resources used by the application. These resources are themselves
within another folder in the Resources folder. In Figure 10.2, that folder is named English.

Iproj.

If you create localized versions of your application (different versions for different human
languages), the Resources folder will hold other folders as well (such as Japanese.lproj).
Minimally, the two items in one folder within the Resources folder are the main.nib file
and the InfoPlist.strings file. Both are part of every nib-based Project Builder project. The
main.nib file has been discussed throughout this book. The InfoPlist.stringsfileis
described in the following section.

InfoPlist.strings Resour ce File

One of thefiles that ends up in an application bundle is the InfoPlist.strings resource file.
Thisfileis noteworthy because it holds a string that appears in the interface of the program
that gets built from the project. If you click the Resources folder under the Groups & Files
heading in aproject, you'll seethe file listed along with the main.nib resourcefile. To view
the contents of the InfoPlist.stringsfile, click its name. Figure 10.3 showsthisfile for this

chapter's SuperBeepl con example program.

Figure 10.3. TheInfoPlist.stringsresourcefile.
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The InfoPlist.strings file holds a collection of key-value pairs. In XML, such a collection of
pairingsisreferred to as adictionary. In each new project, Project Builder includes an
InfoPlist.strings file that holds three key-value pairs. Each key (, CFBund| eNane,
CFBundl eShor t Ver si onSt ri ng,and CFBundl eGet | nf oSt ri ng) hasastring

assigned to it.

In Figure 10.3, you see that |'ve edited the Project Builder supplied strings to include



references to the name of the project's application and to include proper copyright
information. Of most importance hereisthe C-Bund| eName key. The value you assign
to this key is used in the Application menu of your program. In Figure 10.3, you see that
the InfoPlist.strings file for the SuperBeepl con project includes a CFBund| eNane of
SuperBeepl con. At the top of Figure 10.4, you see the nib menu resource from this same
project. In this case, the name of the Application menu is TestProgram, but when the
program is built and executed, the A pplication menu takes on the name Super Beepl con (as
shown in the lower part of Figure 10.4).

Figure 10.4. A nib menu resour ce (top) and theresulting application menu (bottom).
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The occurrences of SuperBeeplcon in the Application menu name, in the Hide
SuperBeeplcon item, and in the Quit SuperBeepl con item name come from the

CFBundl eNane valuein the project's InfoPlist.strings file. It's important to note that the
one menu item name that doesn't automatically get assigned the C-Bund| eNanme vaueis
the About item. Y ou're responsible for supplying this item with the proper name in the nib
menu resource.

One other item of interest in the InfoPlist.stringsfile isthe CFBundl eCGet | nf oSt ri ng
key. The value of this key appears as the version information in the Info window that's
displayed when the user clicks the application on the desktop and then chooses Show Info
from the File menu. As shown in Figure 10.5, the value of this key can be set from under
the Application Settings tab when the Targets tab is selected in the project window. As of
thiswriting, in fact, the Get-Info string field under the Application Settings tab is the place
to define the version information for your program. It isthis string that appears in the Info
window.

Figure 10.5. The Get-Info stringin a project isused asthe version stringin the
Finder's Show Info window.
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Registering a Creator Code

Every file has afour-character type. The value, unsurprisingly, specifies the type of the
file. An application aways has atype of APPL. (Other common file types are TEXT for a
text fileand P! CT for apicturefile.) Every file can aso have afour-character creator code,
which is a unique value belonging to one and only one application. In the case of an
application file, the creator codeis an identifier of the application itself. In the case of afile
created by an application, the creator code identifies the file as belonging to (or created by)
the application with the same creator code.

As an example of acreator code, consider Apple's SimpleText text editor application. The
resource editor ResEdit can be used to ascertain the type and creator code of any file. At
the top of Figure 10.6, you see that ResEdit reports that for SimpleText, thefiletypeis
APPL (it's an application) and the creator code is ttxt (a unique four-character value
registered to this one application).

Figure 10.6. Thefiletype and creator of the SimpleText application (top) and of afile
created by the SimpleText application (bottom).
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Now consider afile created by SimpleText. | launched SimpleText and created a new file,
which | named ReadMe.txt. After closing that file, | viewed it in ResEdit. The results are
shown at the bottom of Figure 10.6. In that figure, you see that afile created by SimpleText
has atype of TEXT (it's atext file) and a creator code of ttxt (it was created by the
application with this same creator code- SimpleText).

An application's creator code is used by the Finder to associate files created by that
application to that application. This system makesit possible for a double-click on afileto



result in the launching of the creating application and the opening of the clicked-on file.
Registering a Creator Code With Apple

At Apple's developer site (http://devel oper.apple.com), you'll find alink to atechnical
support area (http://devel oper.apple.com/products/techsupport/) that includes links to pages

that offer information about specific programming topics. The Registrations link takes you
to a page (http: //devel oper.apple.com/dev/cftype) that includes information about

registering a creator code (or application signature) for your own application. Click the
Find link to move to a page that |ets you enter one or more creator codes and then search to
see which are available.

In Chapter 5, | mentioned that | had registered a creator code for one of this book's
example programs. Figure 10.7 shows the result of my search to see whether the creator

code SPRB was available. It was, so the next step was to register the code with Apple.
Clicking the Register new creator/file types link (see Figure 10.7) is how the registration is

done.

Figure 10.7. Searching at Apple'ssitefor the availability of a creator code.
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The registration is short and simple. Y ou enter alittle information, such as your name and
mailing address, and then you click the Submit button. That'sit. If the creator code
availability search told you that your code of interest was available, you now can consider
it yours. Absolute confirmation is supplied in a couple of days. That's about how long it
takes to receive a confirmation email notice from Apple.

Assigning a Creator Codeto Your Program


file:///Volumes/Extra%20Schijf/New%20Downloads/Cocoa/BUSY/MacOSXProgramming/pages/ //developer.apple.com
http://developer.apple.com/products/techsupport/
http://developer.apple.com/dev/cftype

After you've found an unused creator code and registered it with Apple, you can assign that
creator code to your application. That's done from within Project Builder. Open the project
that's used to build your application and click the Targets tab in the column of tabsin the
project window. Click the target in the Targets area (the SuperBeepl con target is selected
in Figure 10.8), and then click the Application Settings tab from the row of tabs. As shown
in Figure 10.8, you then can set the application's signature. Just type it into the Signature
field. Inthisfigure, you can see that I'm using the SPRB creator code that |'ve registered
with Apple. Leave the Type field set to APPL. It stands for application, which is the type
of file you're creating.

With the signature set in the project, each build you perform results in an application with
the specified signature.



Application Icons

From the desktop, every application is displayed as an icon. Each real, shipping application
has its own unigue icon, one that displays an image that might provide a hint about the
nature of the application. For instance, the TextEdit text editor application that is bundled
with Mac OS X has an icon that looks like a piece of paper with writing on it and with a
pen laid acrossit.

When you build an application in Project Builder, that application is given a generic icon.
By now, you should be familiar with this application default icon, but if you need to take a
look at it, look at the icon for the BasicShapes program on the far left side of Figure 10.9.
Although every application needs an icon, you probably won't want to go through the work
of creating a uniqueicon for your short test programs. Thus, this Project Builder-supplied
icon turns out to be a handy solution. When the time comes to build a"rea" version of
your program, though, you'll want to associate a “real" icon with that program. In this
section, you see how to do that.

Figure 10.9. Application icons (top) and document icons (bottom).
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On the desktop, an icon represents afolder or afile. If theicon represents afile, it can be
for an application or a document created by an application. Figure 10.9 shows icons for

four applications and two types of documents.

The four iconsin the top row of Figure 10.9 are application icons, while the two iconsin
the lower row are document icons. The leftmost icon in the top row of Figure 10.9 isthe

generic icon assigned to any program that doesn't explicitly define its own icon. Looking
back at this book's examples reveals that every example project builds an application that
sports thisicon.



The next two iconsin the top row of the figure are theicons for real programs. TextEdit is
Apple'stext editor that comes bundled with Mac OS X, while Internet Explorer is, of
course, Microsoft's web browser program.

Thelast icon in the top row istheicon I've created for one of this chapter's example
programs. In the bottom row, the leftmost icon is the one TextEdit assignsto its
documents, while the rightmost icon is the one Internet Explorer assigns to its Hypertext
Markup Language (HTML) documents.

Apple recommends that every application have a custom icon that provides some visual
clue asto the purpose of the program. The icon for Apple's TextEdit application conforms
to that guideline. Theicon for Microsoft's Internet Explorer doesn't (at least | can't make
out much of a correlation between alowercase e and a program used to browse the World
Wide Web [WWW]).

You'll find that numerous applications don't abide by Apple's guideline. Rather than
provide feedback on the nature of the program, an application's icon might instead include
some image that's already firmly set in the public eye. It also might be some version or
adaptation of the software company's name or logo. In that spirit of rebellion, theicon I've
created for this chapter's SuperBeepl con program (shown at the far right of Figure 10.9)

has nothing to do with sound or beeping.
Note

Other reasons that | chose to use adigitized image from my camcorder as the
basis for an application icon include the fact that | don't have anywhere near
the level of artistic skills necessary to create an interesting, professional-
looking icon, and because I'm too cheap to pay a graphic designer to do the
work of designing such anicon!

The following three sections discuss the steps you'll perform to assign an icon to an
application. In short, those steps are as follows:

1. Create animagein agraphics program and save it as a .pict or .tiff file.
2. Convert that graphic fileto aniconfile.
3. Include theicon filein aProject Builder project.

4. Within Project Builder, specify that thisicon file be associated with the application
that results from performing a build.



Creating an Image for an Icon

New to Mac OS X isthe 128x128 pixel icon size. This very large pixel size means an icon
can be designed with alot of detail and ook much better than ever before. Also new to
Mac OS X is powerful scaling technology that enables alarge icon to be accurately scaled
down.

Typicaly, you'll create alarge 128x128 pixel icon and leave it to the system to scaleit to
the size the user prefers for the display of desktop icons. However, if you find that your
large icon loses important detail in scaling, you can design intermediate-sized icons that
assist the system in scaling. Those other sizes are 64x64 pixels, 32x32 pixels, and 16x16
pixels. In this chapter, I'll create just one icon-the 128x128 pixel size- and leave it to the
system to handle all icon scaling.

In the design of anicon you (or, more likely, a graphic designer) can use any graphics
program that provides the desired results. If you're using a digitized image, you can use a
graphics program to simply crop the image to isolate the portion of interest and then scale
that image to 128x128 pixels. If your image is to be designed from scratch or if it isto be
an collage or adaptation of clip art, you'll use graphics programs such as Adobe Photoshop,
Adobe LiveMotion, and so forth.

When you have an image with which you're satisfied, saveit in afile of type .pict or .tiff.
For this chapter's SuperBeepl con example program, | saved some output from my
camcorder to my iMac and copied one frame to the Clipboard. | then launched a graphics
program (the shareware program GraphicConverter, which is discussed in Chapter 2,
"Overview of Mac OS X Programming"), created a new, empty document 128x128 pixels
in size, and pasted that image into the document. | dragged the pasted image around until
the portion of the image of interest was centered in the document, and then | saved the
document as a.pict file. That gave me a 128x128 pixel image, but it didn't give me a
128x128 pixel icon.There's one more program to run to accomplish that conversion.

Saving an Image asan Icon

After you create an image that's to be used as an icon, you need to import that image into
the Icon Composer application. Icon Composer is another free development application
from Apple. You'l find it in the Applications folder inside the Developer folder on your
Macintosh.

With your image created and saved as a 128x128 pixel .pict or .tiff file, launch Icon
Composer. Choose Import Image from the File menu. As shown in Figure 10.10, the
window that appears enables you to move to the folder that holds the image that's to be
converted to an icon. Move to that folder now. Choose Thumbnail 32bit data from the
Import To pop-up menu located at the bottom of the window, and then select the file of
interest. Y our actions tell Ilcon Composer that the file you're about to select holds an image



that's to be used as a 128x128 pixel icon. Now double-click the name of the file that holds
the image.

Figure 10.10. Importing an image into | con Composer.
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After you select afile, Icon Composer responds by placing that file'simage into the
Thumbnail box at the bottom of the icon window, as shown in Figure 10.11. Note that if it
turns out that the file you saved as a 128x128 pixel image varies by even one pixel in either
dimension, Icon Composer will ask you if you want the image scaled. Go ahead and let
Icon Composer do this. The change won't be noticeable, unless your imageisin fact of a
Size that varies quite a bit from the 128x128 pixel size of athumbnail.

Figure 10.11. Thedisplaying of an imported image in |con Composer.
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Now choose Save from the File menu. The file name can be of your choosing, but don't add
an extension to the name. When you click the Save button, Icon Composer will add an
extension of .icns to the name you entered. Save the file to the project folder.

Adding thelcon Fileto Your Project

Before the contents of afile can be used by a project, that file needs to be added to the
project. In the Chapter 2 example of HelloworldPict, you saw this was the case for
including a picture in a program window. The same holds true for an icon. After using Icon
Composer to convert an image to an icon and saving that icon to afile, you need to add the
resulting file to a project. Open the Project Builder project that's to use the icon and click
the Resources folder in the Groups & Fileslist in the project window (that selection
determines where the added file will end up). Now choose Add Files from the Project
menu. Select the .icnsfile to use and click the Open button. When prompted to specify
which targets to add the file to, click the Add button.

Figure 10.12 show how the SuperBeepl con project (discussed ahead) |ooks after an Icon
Composer file named SuperBeepl conA pp.icns has been added to it. For organizational
purposes, the icon file typically is kept in the Resources folder, although it doesn't have to
be there for the icon to become associated with the application. If the icon file doesn't end
up in the Resources folder, simply drag it there now.

Figure 10.12. Adding an icon fileto a project.
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Adding the .icnsfile to the project is one of two steps to getting a project to recognize the
file'sicon. Now you need to name the same file in the Application Settings of the project.
Begin by clicking the Targets tab in the column of tabs in the project window. Click the
target in the Targets area (the SuperBeepl con target is selected in Figure 10.13). Click the
Application Settings tab from the row of tabs. Now scroll down to the Icons section and
type the name of the .icnsfilein the Icon file text box. In Figure 10.13, you see that the file

name matches the name of the .icnsfile added to the project back in Figure 10.12.

Figure 10.13. Associating an icon file with an application in a project.
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At this point, theicon in the .icnsfile will replace the generic icon that Project Builder uses
when no icon is specified. Now when you build the application from this project, the
resulting application will display the icon that'sin the .icnsfile.

Viewing the Results

When you build an application from a project that includes a .icnsfile, that application
displays the icon at the desktop. Unless you've specified otherwise in Project Builder,
building an application from a Project Builder project places the executable in the build
folder in the project folder, so you'll look in that folder to see the application.

In Figure 10.14, you see the result of associating the icon shown in Figure 10.11 with the
project shown in Figures 10.12 and 10.13. If your application isn't sporting the new icon,

don't be alarmed. It might just mean that your desktop isn't updating promptly. If you built
the application once without the new icon, the desktop might still associate the generic
application icon with your program. Try thisto remedy the situation: click the application



icon in the build folder and copy the application to another folder. The duplicate
application should now have the new icon.

Figure 10.14. The newly added icon isdisplayed on the desktop.
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The size of theicon your program uses is adjustable by the user. Because you've created a
large, detailed icon, the desktop is capable of accurately scaling that icon to asmaller size.
To test this, you can copy the application from its folder directly to the desktop and then
choose Preferences from the desktop menu. Drag the Icon Size slider control to different
settings and watch the application icon (and al other icons on the desktop) change in size.
Figure 10.15 shows desktop icons being increased to their largest size.

Figure 10.15. Resizing icons (including your application'sicon) on the desktop.
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Super Beepl con Program

The purpose of the SuperBeepl con program isto illustrate how a custom icon is associated
with an application.

If you haven't already guessed, the preceding sections have walked you through this
example. | used the Chapter 5 RadioButtonGroup project as the starting point for this
exampl€e's project, nib resources, and source code. However, you can use any existing or
new project because the resources and source code are entirely unimportant in the
associating of an icon to an application. In the following short sections, I'll summarize how
to create an icon and associate it with your application.

Create a 128x128 Pixel Image

To practice the adding of an icon to an application, you can start out easy. Focus on the
process of creating and adding the icon to your program. Don't initially get caught up in the
particulars of creating an intricate image. After you know how to add an icon to a program,
you can easily repeat the steps later after you've obtained the best possible icon for your
application.

Begin by launching your favorite graphics program and opening a 128x128 pixel
document. If your graphics program doesn't let you specify an initial document size by
pixels, open anew document and resize, or trim, it to this size. Then add some simple
graphicsto it, such as a couple colored rectangles. Thisis atest, so any graphicswill do for
now. Now save the document as either a.pict or .tiff file.

Convert thelmage Fileto an Icon File

Convert the graphic image to an icon by importing it into lcon Composer. Launch the Icon
Composer program and choose Import Image from the File menu. Select the Thumbnail
32hit data item from the Import To pop-up menu located at the bottom of the window.
Then choose the graphics file to import. Choose Save from the File menu and provide a
name for the file. Leave off the file name extension, as lcon Composer will append a.icns
extension to the name you supply.

Add thelcon Fileto the Project

Open the project of interest in Project Builder and choose Add Files from the Project menu.
Select the .icnsfile to use. Click the Open button and then, when prompted to specify to
which targets to add thefile, click the Add button. Now specify the name of this samefile
in the project's application's settings. Click the Targets tab, click the target in the Targets
area, and then click the Application Settings tab. Scroll down to the Icons section and enter
the name of the .icnsfilein the Icon file text box.



Build the Application

The next time, and every subsequent time, that you build an application from the project,
that application will bear the icon you've added to the project.



For More Information

For more information about this chapter's topics, visit any of the following web sites:

Creator coderegistration: http:// devel oper.apple.com/tools/

I con softwar e: http://devel oper.apple.com/ue/resources.html

I con routines: http://devel oper.apple.com/techpubs/macosx/Carbon/
HumanlnterfaceT oolbox/I conServUTtili/iconservicesandutilities.html


http://developer.apple.com/tools/
http://developer.apple.com/ue/resources.html
http://developer.apple.com/techpubs/macosx/Carbon/HumanInterfaceToolbox/IconServUtili/iconservicesandutilities.html
http://developer.apple.com/techpubs/macosx/Carbon/HumanInterfaceToolbox/IconServUtili/iconservicesandutilities.html

Chapter 11. Porting Mac OS 8/9 Codeto Mac OS X

IF YOU HAVE SOME MAC OS PROGRAMMING EXPERIENCE, you'll want your
previous programming efforts to run on Mac OS X. Fortunately, without any modification,
most of your Mac applications will make the transition. Unfortunately, they'll run only in
the Classic environment of Mac OS X. That is, when a user of one of your Mac OS 8/9
applications copies that program to his or her Macintosh running Mac OS X and then
launches that application, the program automatically runs under Mac OS 9. There will be
no Aqua interface, no protected memory, and no other features that are integral to Mac OS
X. If you want users of your previously developed efforts to experience your program as a
native Mac OS X application, you need to port its code to Mac OS X.

Adding new Mac OS X features, such as support of the new Carbon Event Manager, to
your program can take afair amount of programming effort. However, the benefits of Mac
OS X make those efforts worthy of the time expended. In addition, before you jump into a
full-scale conversion, you can alter your older project's code to be Mac OS X compatible
and then recompile that project's code to develop a native Mac OS X application. Doing
that means a double-click on your application’'s icon launches the program in Mac OS X,
places that application’'s code in its own protected memory space, and paints the Aqua ook
on the program's interface elements. After you've reached that point, you then can decide
which new Mac OS X features to add to your program. After you decide which features
that you want to add, you can read this chapter to find out the basic steps for turning your
Mac OS 8 or Mac OS 9 code into an application that's launched in the Mac OS X space!



Carbon Dater: Getting Ready for Carbon

You'll want to have a plan before jumping in and making changes to the code of your
existing Mac OS 8/9 application. In particular, you'll want to know which Macintosh
Toolbox routines are no longer supported and which are supported for now but might not
make the cut to Carbon. (Remember that the Carbon API isn't yet finalized.) To this end,
Apple supplies developers with the Carbon Dater. If you're porting code to Mac OS X, this
free, easy-to-use utility isamust.

Carbon Dating Your Code

Carbon Dater isasmall application available for downloading from Apple (http: //

devel oper.apple.com/macosx/carbon/dater.html). After obtaining the Carbon Dater.sit
folder and unstuffing it, drag and drop your application onto the Carbon Dater - Drop App
here file that resides in the Carbon Dater folder. Note that you're inputting the actual
application you've built, not its source code or the project from which the application was
built.

The Carbon Dater application analyzes your application's code and takes note of the
Macintosh Toolbox routines your application calls. It then compiles those routine namesin
alist. The Carbon Dater can al so recognize some coding practices that you might use that
might not be supported by Carbon. These practices are saved along with the function name
list and stored collectively in asingle text file. When Carbon Dater is finished, this text file
is created and given the name of your application with an extension of .CCT (for Carbon
Compatibility Test).

The contents of the text file aren't in aformat that's of much use to you. The file's contents
are ready, however, for more analysis and formatting by Apple. You'll attach thistext file
(preferably compressed using the Aladdin Stufflt program that's included with Mac OS X)
to an email message and send it to Apple at CarbonDating@apple.com. Y ou don't need to
supply a subject or include any text in the body of the message.The .CCT fileis all that
Apple needs. Don't worry about this being a time-consuming process; no human
intervention is needed on Apple's end. Thefileis analyzed and a Carbon compatibility
report in Hypertext Markup Language (HTML) format is generated and sent to you through
email, usually within hours.

Reading the Carbon Dater Report

When you receive Apple's Carbon compatibility report, open it in your web browser of
choice. Figure 11.1 shows a part of one such report.


file:///Volumes/Extra%20Schijf/New%20Downloads/Cocoa/BUSY/MacOSXProgramming/pages/ //developer.apple.com/macosx/carbon/dater.html
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Figure 11.1. The Carbon compatibility report.
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Apple notes each Macintosh Toolbox routine that your application calls and compares each
one to the Carbon API. Theresult isthat every function call is categorized as Supported
API, Supported But Not Recommended, or Unsupported API.

If acall to aMacintosh Toolbox routine is supported, you know that this original Toolbox
routine now exists in the Carbon API. A good 70 percent of more of the Macintosh
Toolbox functions are part of Carbon. Such routines are fully supported, so you don't have
to make any changes to those calls, and the Carbon compatibility report offers no more
information on them.

If acall to aMacintosh Toolbox routine is unsupported, you know that this original
Toolbox routine is not a part of the Carbon API. If you leave such acall in your source
code and rebuild your application targeting Mac OS X (as occurs when building a project
in Project Builder), acompilation error will occur. You need to replace such acall with its
newer Carbon API counterpart. If no such Carbon routine exists, you need to rewrite your
code to eliminate the one Toolbox call and replace it with calls to perhaps two or more
Carbon routines that collectively provide your program with the result that was provided by
the one call to the original Toolbox routine. Because the unsupported routine necessitates a
code change, the Carbon compatibility report offers suggestions and tips on what you can
do.

Figure 11.2 shows a couple memory-related comments that might be found in a Carbon

compatibility report. The figure also shows an example of how an unsupported function is
listed. Here you seethat Vax Appl Zone, aroutine commonly used to allocate an
appropriately sized block of heap memory for an application, isn't supported. Mac OS X
memory management is set up differently than in previous versions of the Mac OS, and no
such call is needed. Here the solution is ssimple; Apple states that you might want to omit
this call from the source code.



Figure 11.2. An unsupported routinelisted in the Carbon report.
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If acall to aMacintosh Toolbox routine is supported but not recommended, you still can
use this original Toolbox routine, but it might not work at alater date. The Carbon APl isa
work in progress, and some original Macintosh Toolbox routines that now are part of the
Carbon API could be replaced in the future. Here Appleis strongly hinting that your best
move is to replace such calls now so that your program won't break in the future. Because
the supported routines might become obsolete, the Carbon compatibility report offers
feedback regarding alternate routines you can use.

Figure 11.3 shows a couple memory-related tips in a Carbon compatibility report, along
with an example of how a Supported But Not Recommended routine is listed. Here you see
that Vor elVast er s, which isaroutine used to reserve memory for anew block of master
pointers, is supported. Note, however, that its use isn't recommended. The report provides a

better way of doing things:. replace the call to Vbr eVast er s with acall to the newer
routine Vor eVast er Poi nt er s,

Figure 11.3. A supported but not recommended routinelisted in the Carbon report.
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Note



A master pointer isfixed in memory and points to arelocatable block of
memory.

Y ou'll want to focus on the routines in the Carbon compatibility report that are
Unsupported or Supported But Not Recommended. However, you'll also want to read the
report from start to finish. Apple includes plenty of commentary on major and minor
porting issues that are of concern to any developer.



Tipsfor Handling Major Porting I ssues

The larger and more complex your application, the more "gotchas" you'll encounter as you
move the code from Mac OS 8/9 to Mac OS X. The following sections contain tips on
dealing with those gotchas.

Start with Power PC Code

Macintosh computers initially made use of 68K processors. These processors are from the
Motorola 68000 family. All Macs shipped in the last few years now include a PowerPC
processor. If your application was developed within the last few years, it probably is
already PowerPC-native. That's the starting point for moving to Mac OS X. If you've come
across some old code that you'd like to update that isn't already PowerPC-native, check it
on Mac OS 8/9 first.

Update Header Files

After ensuring that your code compiles and runs under Mac OS 8/9, don't immediately start
altering your code for Mac OS X. Instead, make sure that you're using the latest version of
the Universal Interface header files. These files include the latest prototypes for the Carbon
API routines.

The Universal Interface files are available as a single download from Apple and as a part of
the Carbon SDK (Software Developer's Kit). Apple occasionally updates both files, and the
latest version of each is available for downloading at http://devel oper.apple.com/sdk page.

When using Project Builder, useasingle #i ncl ude statement to give your project access
to the Carbon framework:

#i ncl ude <Car bon/ Car bon. h>

The examplesin this book usethe#i ncl ude statement. Doing so eliminates the need to
include individual header files (such as Dialogs.h). More importantly, it ensures that your
project has direct access to the Carbon framework.

Note

Individual header files might not work properly in the project because there
isn't adirect correlation between the individual header files and the Mac OS
X frameworks.


http://developer.apple.com/sdk page

Eliminate Direct Accessto Opaque Structures

In the past, a programmer could view the makeup of structures such as\W ndowRecor d
and Di al ogRecor d. Programmers would sometimes directly access the fields of these
structures or use routines that made assumptions about the ordering or size of fieldsin
these records. Consider this code snippet:

W ndowPt r W ndow;

Get NewW ndow( 128, nil, (WndowPtr)-1L );
Set Port( w ndow );

After creating awindow from a WIND resource, the preceding code then calls Set Por t
to make the new window's port the current port. In the past, this code compiled properly
and executed properly because W ndowPt r wasthesameas G af Pt r. The G af Por t
(graphics port) of awindow was thefirst field in the window's record, so a pointer to the
window and a pointer to the window's graphics port pointed to the same place.

Unfortunately, things have changed.Windows and dialogs are now opaque structures, so
you shouldn't attempt direct access to structure fields, and you can't use routines that do the
same. Instead, you should rely on new Carbon API casting routines that exist specifically
to perform these access tasks for you. For instance, to make awindow's port the current
port, create the window and then use the Get W ndowPor t routine:

Set Port ( Get WndowPort( w ndow ) );

Other casting functions of interest are listed in the Dialogs.h and MacWindows.h Universal
Interface files. These functions include the following:

Di al ogPtr Get D al ogFr omWW ndow( W ndowPtr w ndow );
W ndowPtr Get WndowFronPort ( CGafPtr port );

W ndowPtr CGet Di al ogW ndow( Di al ogPtr dialog );
CGafPtr Get W ndowPort ( W ndowPtr w ndow ) ;

Use New Carbon Technologies

The new Carbon Event Manager is an improvement on the original Event Manager.
Chapter 3, "Events and the Carbon Event Manager,” covers the Carbon Event Manager at
length. Apple recommends that you use the newer Carbon Event Manager routinesin your
Mac OS X application, but it's not arequirement. The use of a couple other new
technologiesis required, though. In addition, if your Mac OS X program opens or saves
files, it must use Navigation Services routines in place of the original Standard File



Package routines. If your Mac OS X program enables printing, it needs to use Carbon
Printing Manager routines in place of the Classic Printing Manager functions. Printing is an
involved topic that's beyond the scope of this book.

Note
Chapter 9, "QuickTime Movies and File Handling," introduces Navigation

Services and provides an example of its use in opening a QuickTime movie
file.



For More Information

The following web sites offers more information on some of the topics presented in this
chapter:

Carbon Dater download: http://devel oper.apple.com/macosx/carbon/dater.html

Carbon specification: http://devel oper.apple.com/techpubs/carbon/

Mac OS X porting information: http://devel oper.apple.com/technotes/tn/tn2003.
html

Universal I nterfaces download: http://developer.apple.com/sdk/

SDK download: http://devel oper.apple.com/macosx/carbon/index.html


http://developer.apple.com/macosx/carbon/dater.html
http://developer.apple.com/techpubs/carbon/
http://developer.apple.com/technotes/tn/tn2003.html
http://developer.apple.com/technotes/tn/tn2003.html
http://developer.apple.com/sdk/
http://developer.apple.com/macosx/carbon/index.html

Appendix A. Carbon APl Summary

AS YOU PROGRAM FOR MAC OS X, you might find yourself occasionally forgetting a
few of the basics. For instance, you might forget which Carbon API routine is used to
obtain areference to amenu (it's Cet VenuHandl e), or you might forget the order or data
types of the arguments of acommonly used routine, such as Set Rect . (The arguments are
al integers, and the order isleft, top, right, and bottom.) See how handy an APl summary
can be?

In this appendix, you'll find the basics. Keep in mind that the Universal Interface header
files are the definitive references to Carbon API routine prototypes. From any Project
Builder project, you can select Show Batch Find from the Find menu and search for a
Carbon API routine. Project Builder returns alist of filesin which the routine is found.
Among those files will be the universal interface file that holds the function's prototype.
For instance, a batch search for SetRect reveals that the function prototypeislisted in the
QuickDraw.h file. When you click that file name, its contents are displayed in the Project
Builder window.

The sections of this appendix loosely follow the order of appearance of the topicsin this
book. For instance, you find Interface Builder functions, such as CreateNibReference,
before QuickDraw functions, such as SetRect, because the Interface Builder material is
introduced in Chapter 2, "Overview of Mac OS X Programming,” and QuickDraw is

covered in Chapter 7, "QuickDraw Graphics."



Include Files

A Project Builder project typically requires just one include file, but in some cases, it could
require others. The two header files discussed in the following sections are the most
commonly used in Project Builder projects.

Carbon.h: Accessto the Carbon Framework

A Project Builder project needsto include the Carbon.h file to provide the project with
access to the entire Carbon framework. (You'll recall that the Carbon framework is a set of
libraries and resources that together implement Carbon.) All Mac OS X projects will
include thisfile:

#i ncl ude <Car bon/ Car bon. h>
QuickTime.h: Accessto the QuickTime Movie Toolbox

If your project makes use of QuickTime routines, include the Carbon.h file and include the
QuickTime.h header file:

#1 ncl ude <Qui ckTi me/ Qui ckTi ne. h>



Common Data Types and Functions

The Carbon API defines many data types and routines not found in ANSI C (ANSI being the
American National Standards Institute, the standardization body that develops standards for
many things, including programming languages such as C). Some are used only in specific
programming tasks; others are used throughout the Carbon API. The following sections
describe some of the more important of the commonly used types and functions.

OSStatus: Function Execution Status

The OSSt at us typeisa32-bit integer that holds an error value, sometimes referred to as an
error code. Several Carbon routines have areturn value of thistype. If a Carbon routine returns
an OSSt at us value of 0, no error occurred in the execution of the routine. If a nonzero value
is returned, your application knows an error occurred and can respond accordingly. For clarity
in checking for errors, the Carbon API defines the constant noEr r asO:

CSSt at us err:

err = RoutineName( argunent );
if ( err !'= noErr )
/'l handl e the error here

Note that if aroutine has areturn type of OSSt at us and your program has minimal error
checking (asin the case of asmall experimental program), you can choose to not only ignore
the returned value, but also to not even accept the returned value. Thus, the preceding snippet
could be written like the following:

Rout i neNane( argunent );
require_noerr: Handling an Error

The Debugging.h header file defines standard exception handling macros, including
requi re_noerr . After invoking a Carbon API routine that returns an error status, you can
cal requi re noerr todetermineif the Carbon API routine executed without error:

require_noerr(error, | abel)

Passrequi re_noerr the OSSt at us value returned by a previously called Carbon AP
routine, such as Cr eat eW ndowr oniNi b. Thesecond r equi re _noerr argumentisa
label to which execution should jump if an error did in fact occur, as shown in the following
code:



OSSt at us err;

err = Creat eW ndowFr omNi b(ni bRef, CFSTR("Mai nW ndow'),
&w ndow) ;

requi re_noerr( err, CantCreateW ndow );

/] other code here

Cant Cr eat eW ndow.
return err;



Core Foundation

Core Foundation is the part of Carbon that includes routines that provide basic, or core,
functionality to a program. Of most interest hereis CFSTR, which is amacro used to
generate a string object that can be passed to many other routines.

Many Carbon routines that require a string as an argument accept areferenceto a
CEString object (aCFSt ri ngRef) rather than to an actua string. The C=STR routine
converts a string to such an object and returns a reference to that object, as shown in the
following code:

CFStringRef dateStrRef = CFSTR("Today's date is:");



I nterface Builder Manager (Nib Files)

The Nib Manager is the collection of routines used to access nib files and to work with the
resources within such files. All the routine names that include Nib (such as
Creat eW ndowFr onNi b) are Nib Manager routines.

Note

The function prototypes for the Interface Builder Manager routines are found in the
IBCarbonRuntime.h header file.

A resourceis (typicaly) an interface element such as a window or menu. Resources are created in
Apple's Interface Builder application and stored in anib (Next Interface Builder) file. Interface
Builder archives resource information in XML format. XML (extensible markup language) isa
markup language for documents containing structured information. Interface Builder displays this
information graphically so that it's easy to create and edit. The details of how Interface Builder
stores this information is typically unimportant to the programmer; that's the reason Interface
Builder exists!

| BNibRef

To make use of the resourcesin anib file, a program needs to first open that file. Doing that
supplies the program with anib file reference value that the program can subsequently use to
access the contents of the opened file:

| BNi bRef ni bRef ;
CreateNibReference: Opening and Accessing a Nib File

Call Creat eNi bRef er ence to open anib file so that resources within that file can be
unarchived and used by the program:

OSSt at us Creat eNi bRef erence( CFStri ngRef i nN bNane,
| BNi bRef * outN bRef );

Pass the routine the name of the nib file to open, less the .nib extension.
Creat eNi bRef er ence returns afile reference, which is a variable of the data type
| BNI bRef , to be used in calls to subsequent Interface Builder Manager routines.



OSSt at us err;
| BNi bRef ni bRef ;

err = CreateNi bReference( CFSTR("main"), &nibRef );
DisposeNibReference: Closing a Nib File

When the program has finished accessing the contents of a nib file, the program closes that file by
caling Di sposeNi bRef er ence:

voi d Di sposeN bReference( | BN bRef i nN bRef );

Pass Di sposeNi bRef er ence thenib file reference received from the earlier call to the nib
file opening routine, which was Cr eat eNi bRef er ence:

OSSt at us err;
| BNi bRef ni bRef ;

err = CreateNi bReference( CFSTR("main"), &nibRef );

/'l access nib file here
Di sposeNi bRef erence( ni bRef );

SetMenuBarFromNib: Creating a Menu Bar from a Nib Resource

Create amenu bar in Interface Builder and save it in the project's main.nib file. Y our program
then unarchives that menu bar resource and displays the menu bar by calling
Set MenuBar Fr omNi b:

OSSt at us Set MenuBar FromNi b( | BN bRef I NNi bRef ,
CFStringRef inName );

Pass Set VenuBar Fr onNi b the nib file reference received from the earlier cal to the nib file
opening routine Cr eat eNi bRef er ence. The second argument is the name of the menu bar
resource, as defined in the nib file.

OSSt at us err;
| BNi bRef ni bRef ;

err = CreateN bReference( CFSTR("main"), &nibRef );
err = Set MenuBar FromNi b( ni bRef, CFSTR("Mai nMenu") );

CreateWindowFromNib: Creating a Window from a Nib Resource

Create awindow in Interface Builder and save it in the project's main.nib file. Y our program then



unarchives that window resource by calling Cr eat eW ndowfr onNi b. Note that theresultisa
window that can be referenced, but that window is not made visible. Follow the call to

Creat eW ndowtr oniNi b by acall to the Window Manager routine Show\WW ndowto display
the window.

OSSt at us Creat eW ndowFr omNi b( | BNi bRef I NNi bRef ,
CFSt ri ngRef I nNane,
W ndowRef * out W ndow ) ;

Pass Cr eat eW ndowkr ormiNi b the nib file reference received from the earlier call to the nib
file opening routine Cr eat eNi bRef er ence. The second argument is the name of the window
resource, as defined in the nib file. In the third argument, Cr eat e W ndowkr oniNi b returnsa
reference to the opened window.

OSSt at us err;
| BNi bRef ni bRef ;
W ndowRef w ndow;

err Creat eNi bRef erence( CFSTR("nmain"), &nibRef );

err = Creat eW ndowFromN b( ni bRef, CFSTR("Mai nW ndow") ,
&w ndow ) ;

ShowwW ndow( w ndow ) ;



Event Manager

An application needs an event loop that watches for events and reports those events to the program.
The Event Manager defines event type constants and event-related routines. The function prototypes
for the Event Manager routines are found in the CarbonEvents.h header file. The following sections
describe the most commonly used event-related constants and routines.

Event Class and Kind Constants

Each event type has an event class and an event kind. Some event types also have event parameters
(also called event attributes). The number, and purpose, of an event's parameters depends on the
event type in question. Become familiar with the contents of the CarbonEvents.h header file. The
more times you read through it, the better understanding you'll have of the various types of events.

All the event classes are defined in asingle enumerated list of constants:

enum { kEvent Cl assMouse = 'nous’,
kEvent Cl assKeyboard = 'keyb',
kEvent C assText | nput = "text',
kEvent Cl assAppl i cati on = "appl ',
kEvent Cl assAppl eEvent = 'eppc',
kEvent C assMenu = 'menu',
kEvent Cl assW ndow = 'wnd',
kEvent Cl assCont r ol = '¢cntl",
kEvent Cl assComrand = 'cnds',
kEvent Cl assTabl et ="thlt",
kEvent C assVol une = 'vol ' };

An event type is defined by combining an event class with an event kind. All the event classes are
listed in the preceding code. The following bulleted list contains select, commonly used event kinds.
There are hundreds of event kinds-far too many to list here. Again, refer to the CarbonEvents.h
header file for more detailed information, and refer to the " EventTypeSpec: Event Type
Specification " section of this appendix for an example of combining an event class and event kind to
define an event type.

. Mouseevent kinds:

kEvent MbuseDown
kEvent MouseUp

kEvent MouseMbved
kEvent MouseDr agged
kEvent MouseWheel Moved



Application event kinds:

kEvent AppAct i vat ed

kEvent AppDeact i vat ed

kEvent AppQui t

kEvent AppLaunchNoti fication
kEvent AppLaunched

kEvent AppTer m nat ed

kEvent AppFr ont Swi t ched

Window event kinds:

kEvent W ndowUpdat e
kEvent W ndowDr awCont ent
kEvent W ndowAct i vat ed
kEvent W ndowDeact i vat ed
kEvent W ndowShow ng

kEvent W ndowHi di ng

kEvent W ndowShown

kEvent W ndowH dden

kEvent W ndowBoundsChangi ng
kEvent W ndowBoundsChanged
kEvent W ndowResi zeSt art ed
kEvent W ndowResi zeConpl et ed
kEvent W ndowDr agSt art ed
kEvent W ndowDr agConpl et ed

kW ndowBoundsChangeUser Dr ag
kW ndowBoundsChangeUser Resi ze
kW ndowBoundsChangeSi zeChanged
kW ndowBoundsChangeOri gi nChanged
kEvent W ndowC i ckDr agRgn
kEvent W ndowCl i ckResi zeRgn
kEvent W ndowd i ckCol | apseRgn
kEvent W ndowCl i ckCl oseRgn
kEvent W ndowCl i ckZoonRgn
kEvent W ndowCl i ckCont ent Rgn
kEvent W ndowC i ckProxyl conRgn
kEvent W ndowCol | apse
kEvent W ndowCol | apsed
kEvent W ndowCol | apseAl |

kEvent W ndowExpand

kEvent W ndowExpanded

kEvent W ndowExpandAl |

kEvent W ndowCl ose

kEvent W ndowCl osed
kEvent W ndowCl oseAl |

kEvent W ndowZoom



kEvent W ndowZoormed
kEvent W ndowZoomAl |
kEvent W ndowDr awFr ane
kEvent W ndowDr awPar t

. Menu event kinds:

kEvent MenuBegi nTr acki ng
kEvent MenuEndTr acki ng

kEvent MenuChangeTr acki nghbde
kEvent MenuQpeni ng

kEvent Menud osed

kEvent MenuTargetltem

kEvent MenuMat chKey

kEvent MenuEnabl el t ens

kEvent MenuDi spose

. Command event kinds:

kEvent Pr ocessConmand
kEvent CormandPr ocess
kEvent CommandUpdat eSt at us

. Control event kinds:

kEventControlInitialize = 1000,
kEvent Cont r ol Di spose = 1001,
kEvent Control H t =1,
kEvent Control Hi t Test = 3,
kEvent Cont r ol Dr aw = 4,
kEvent Cont r ol Appl yBackground = 5,
kEvent Cont r ol Appl yText Col or = 6,
kEvent Cont r ol Set FocusPar t =7,
kEvent Cont r ol Get FocusPart = 8,
kEvent Control Acti vat e = 9,
kEvent Cont r ol Deacti vat e = 10,
kEvent Cont r ol Set Cur sor = 11,
kEvent Control Cick = 13,
kEvent Cont r ol Tr ack = 51,
kEvent Cont r ol Set Dat a = 103,
kEvent Cont r ol Get Dat a = 104,
kEvent Cont r ol Val ueFi el dChanged = 151,
kEvent Cont r ol BoundsChanged = 154,

EventTypeSpec: Event Type Specification

Y ou can use the following code to declare avariable of type Event TypeSpec and assign it an



event class and an event type to define one type of event for which your program wants to be
notified:

struct Event TypeSpec{ Ul nt 32 event d ass;

Ul nt 32 event Ki nd };
typedef struct Event TypeSpec Event TypeSpec;

The following code defines an event type to be used to watch for the occurrence of a command
event, such as an event triggered by a menu selection or aclick on a button.

Event TypeSpec event Type = { kEvent Cl assCommand,
kEvent ProcessConmand };

The Event TypeSpec isthen passed to a Carbon Events routine such as
I nstal | Event Handl er.

GetWindowEventTarget: Obtain an Event Target Reference

An event has atarget, which is something that the event acts on or affects. Thistarget oftenisa
window, but it also can be the application itself. Before installing an event handler routine, obtain a
reference to the target-asis being done here:

Event Tar get Ref Get W ndowEvent Tar get ( W ndowRef i nW ndow ) ;

The one argument passed to Cet W ndowEvent Tar get isthewindow that's to be considered the
target. Thereturned Event Tar get Ref later will be used in the installation of the application-
defined event handler routine (see the "InstallEventHandler: Installing an Event-Handler” section of
this appendix for more information).

W ndowRef W ndow;
Event Target Ref target;

target = Get WndowEvent Target ( w ndow ) ;

Cet Appl i cati onEvent Tar get returnsatarget for the application itself, as shown in the
following code. There are no arguments.

Event Tar get Ref Get Appl i cationEvent Target( void );

Other event target reference routines include Get Cont r ol Event Tar get and
Cet MenuEvent Tar get , asshown in the following code:

Event Tar get Ref Get Control Event Target (Control Ref inControl);

Event Tar get Ref Get MenuEvent Tar get (MenuRef i nMenu);



NewEventHandlerUPP: Obtaining a Pointer to an Event-Handling Routine

You'll define your own event handler routine to handle the occurrence of one or more types of events
for which your program is watching. Y our program will need a special type of pointer to that routine-
auniversal procedure pointer. The Newt=vent Handl er UPP routine provides your program with
such a pointer:

Event Handl er UPP NewEvent Handl er UPP( Event Handl er ProcPt r
user Routi ne) ;

Pass Newtvent Handl er UPP the name of your application-defined event-handling routine and
NewtEvent Handl er UPP returnsan Event Handl er UPP. This variable gets passed to

I nstal | Event Handl er (seethe"InstallEventHandler: Installing an Event-Handler" section of
this appendix). For a program with an event-handler named MyEventHandler, the call to
NewEvent Handl er UPP looks like this:

Event Handl er UPP hand| er UPP;

handl er UPP = NewEvent Handl er UPP( MyEvent Handl er );
Install[EventHandler: Installing an Event Handler

After defining an event type, creating an event target, coming up with a name for the written (or
soon-to-be-written) event handler routine, and creating a pointer to the event handler, you're ready to
install the event handler routine. Installing the event handler makes the Carbon Event Manager
aware of the routine that's to be invoked at the occurrence of an event of a particular type. The
following is the prototype for the | nst al | Event Handl er routine:

0SSt at us I nstal | Event Handl er ( Event Tar get Ref tar get,
Event Handl er UPP handl er Pr oc,
Ul nt 32 numlypes,
const Event TypeSpec* typeli st,
voi d* user Dat a,
Event Handl er Ref * handl er Ref );

As shown in the preceding code, the first argument is the target, as returned by the appropriate target-
returning function, such as Get W ndowtvent Tar get or Get Appl | cati onEvent Tar get .
The second argument is a pointer to the event handler routine to install, as returned by acall to
NewEvent Handl er UPP. The third argument, numly pes, isthe number of event typesto which
this one event handler can respond. The next argument, typelL.ist, is a pointer to the event type or
event types that this event handler routine handles. Thisisavariable of type Event TypeSpec (or
an array of elements of thistype).

Continuing our discussion, note that the user Dat a argument is used to pass a pointer to any
information that might be of use to the event handler. This most often is a pointer to the window that
might be affected by the event. Finaly, the last argument can be a pointer to an event handler



reference, which is a value that the Carbon Event Manager fillsin for use by your program. Because
your program needs to use this value only if your program will be dynamically changing the event
types that make use of the event handler routine, avalue of NULL isusually used here.

The following snippet calls| nst al | Event Handl er toinstall an event handler routine named
MyEvent Handl er . Thisevent handler's job isto process acommand (typically resulting from a
menu item selection or a click on a button).

W ndowRef W ndow;

Event Tar get Ref t arget;

Event Handl er UPP handl er UPP;

Event TypeSpec event Type = { kEvent Cl assCommand,
kEvent ProcessConmand };

target = Get WndowEvent Target ( w ndow );
handl er UPP = NewEvent Handl er UPP( MyEvent Handl er );

I nstal | Event Handl er ( target, handl erUPP, 1, &event Type,
(void *)w ndow, NULL );

MyEventHandler: Writing an Event-Handling Routine

An event handler is an application-defined routine that exists to handle the occurrence of one or
more types of events. The prototype of thisroutine is aways the same:

pascal OSStatus MyEvent Hanl der ( Event Handl er Cal | Ref next Handl er,
Event Ref t heEvent,
voi d* userData );

In the preceding code, My Event Handl er isaplaceholder. It's aname of the programmer's
choosing. Y our event handler can have any name that makes sense for your program.

The body of the event handler routine is application-specific. There isno one routine that is "right"
or that handles every type of event. However, there are afew generalities to consider. To handle a
command (an event generated by a menu selection or button click), the event handler will follow this
format:

#def i ne kTheConmand "y Cd'
pascal OSStatus MyEvent Handl er ( Event Handl er Cal | Ref  handl er Ref ,
Event Ref event,
void * userData )
{
OSSt at us result = event Not Handl edErr;

H Conrmand command;

Get Event Paraneter ( event, kEvent ParanDi rect Qbj ect,
t ypeH Conmand,



NULL, sizeof (H Command), NULL, &conmand );

swtch ( command. commandl D )

{

case kTheCommand:
My CommandHandl i ngRout i ne( (W ndowRef ) userData );

result = noErr;
br eak;
}
return result;
}

In Interface Builder, define afour-character command for an interface element such as a button. In
code, define a constant of the same character value. Then, have the event handler handle that
particular command by invoking an application-defined routine that carries out the particulars of
how this one event type isto be handled. (My ConmmandHand| | ngRout i ne issuch aroutinein
the preceding code example.) If awindow is affected by the event, that window should be stored in
theuser Dat a argument of the event handler.

GetEventParameter: Extracting Details About an Event

An event can have information other than its class and kind associated with it. This extrainformation
isheld in the event's parameters. A parameter has an event parameter name and an event parameter
type. The handling of some event types requires that the event's parameter information be known. A
call to Cet Event Par anet er inthe event handler routine reveal s that information, as shown in
the following code:

OSSt at us Get Event Par anet er ( Event Ref I nEvent
Event Par amNane I nNanme,
Event Par anType I nDesi redType,
Event Par anType * out Act ual Type,
Ul nt 32 i nBuf ferSi ze,
U nt32 * out Actual Si ze,
void * out Dat a) ;

Heresatypica call to Cet Event Par anet er inthe context of an event handler routine:

pascal OSStatus MyEvent Handl er ( Event Handl er Cal | Ref  handl er Ref ,

Event Ref event,
void * userData )
{
OSSt at us result = event Not Handl edErr ;

H Command command;

Get Event Paraneter ( event, kEvent ParanDi rect Qbj ect,
t ypeH Conmand,
NULL, sizeof (H Command), NULL, &command );



/1l rest of event handl er code here

The first argument is the event from which the parameter dataisto be extracted. Y ou use the event
argument that's passed to the event handler routine. kEvent Par anDi rect Cbj ect and
typeH Conmand arethe name and type of the parameter of interest. If the event kind is

kEvent ConmandPr ocess (seethe "EventTypeSpec: Event Type Specification" section of this
appendix), the parameter of interest most likely will have a name of

kEvent ParanDi rect Obj ect andatypeof t ypeHl Command. These values come from
CarbonEvents.h.

Thefourth Cet Event Par anet er argument holds the actual type, and it should match the value

of the third argument. Pass NUL L if thisisn't of interest to you. The fifth argument is the size of the
buffer that isto hold the parameter value that Get Event Par anet er returns. Usesi zeof with
the data type of the expected return value. The sixth argument getsfilled in with the actual size of the
returned data. Pass avalue of NULL hereif thisinformation isn't needed. The last argument isa
pointer to the memory that will receive the parameter data.

The important information returned by Get Event Par anet er isfoundinthe conmand
argument. Examine the comrand| D field of this structure to determine the fourcharacter command
that is part of the event:

swtch ( command. commandl D )
{
case kTheConmand:
/1 handle this particular conmand

RunApplicationEventLoop: Executing an Event L oop

Cdl RunAppl i cat i onEvent Loop to start your program's event loop.

RunAppl i cati onEvent Loop suspends the application's execution until an event occurs. When
an event occurs, the Event Manager system software returns information about that event to your
program.

voi d RunApplicati onEvent Loop( void );

Call RunAppl i cati onEvent Loop after your program has set up a menu bar and opened a
window:

OSSt at us err:
| BNi bRef ni bRef ;
W ndowRef wi ndow,

err
err
err

Creat eN bRef erence( CFSTR("main"), &nibRef );
Set MenuBar FronNi b( ni bRef, CFSTR(" Mai nMenu") );
Cr eat eW ndowFr omNi b( ni bRef, CFSTR(" Mai nW ndow'), &w ndow );



ShowwW ndow( wi ndow ) ;
Di sposeNi bRef erence( ni bRef );

RunAppl i cati onEvent Loop();



Window Manager

A window is created using the Interface Builder Manager routine

Creat eW ndowFr onNi b. After that, application control of the window is achieved
through Window Manager routines. The function prototypes for the Window Manager
routines are located in the MacWindows.h header file. The following sections describe
commonly used window-related data types and functions.

WindowRef: Referencing a Window

A window is referenced by way of avariable of type W ndowRef . A W ndowRef isa
pointer to awindow object. Y our program obtains such areference to awindow at the time
the window is created.

Creating a Window

A window iscreated by calling Cr eat eW ndow~r onNi b to unarchive a window
resource stored in anib file. Refer to the "Interface Builder Manager (Nib Files)" section of
this appendix for more information.

ShowWindow: Showing a Hidden Window

A window created by calling Cr eat e W ndowr o\l b isinitialy hidden (invisible). In
addition, awindow that has been the object of acall to H de\W ndowwill be hidden. In
either case, call ShowW ndowto make the window visible. Pass ShowWW ndowa
reference to the window that it should make visible:

W ndowRef Wi ndow;
ShowwW ndow( wi ndow );
HideWindow: Hiding a Visible Window

A window is made visible by calling ShowWindow. To hide (make invisible) a window,
call HideWindow. Pass Hi de\W ndow areference to the window that it should make
invisible:

W ndowRef wi ndow;

H deW ndow( w ndow );






Control Manager

A control is created as an item in awindow resource in anib file. Accessing that control from source code
is achieved by using Control Manager routines. The function prototypes for the Control Manager routines
are located in the Control.h header file. The next sections describe the main control-related types and
routines.

ControlHandle/ControlRef: Referencing a Control

A variable of thetype Cont r ol Hand! e isused to reference a control, such as aradio button. Call the
Control Manager routine Get Cont r ol Byl Dto obtain ahandle to a control:

Cont r ol Handl e nmy Radi oBut t onG oup;

Note that the Cont r ol Handl e datatypeisdefined astype Cont r ol Ref , soyour code can use
variables of these two types interchangeably.

Controll D: Specifying a Control

Y our project defines a control as an item in awindow resource in anib file. That control is given a control
ID, which is the combination of a signature and an ID. Together, the values specify one and only one
control. Your code declares avariable of type Cont r ol | Dto specify one control. Like the control itemin
the nib resourcefile, the Cont r ol | D variable consists of asignature and an ID.

#define KkControl Signhature ' Xapp'
#define kRadi oG oupControl D 101

ControlID nyRadi oG oupControl ID = { kControl Si gnature,
kRadi oG oupControl I D };

GetControlByl D: Obtaining a Handleto a Control

To obtain ahandle to a control, call the Get Cont r ol Byl Droutine:

0SSt at us Get Cont r ol Byl D{ W ndowRef I NW ndow,
const ControlID * inlD,
Control Ref * out Control );

Thefirst argument to Get Cont r ol Byl Disareference to the window that holds the control. The second
argument is a pointer to the control's 1D, as set up in avariable of type Cont r ol | D. Thefinal argument is
acontrol reference that'sfilled in when Get Cont r ol Byl Dreturns. Usethis Cont r ol Ref variablein
callsto other Control Manager routines, such asacall to Get Cont r ol 32Bi t Val ue.

OSSt at us err:
W ndowRef w ndow;



Cont r ol Handl e nmyRadi oBut t onGr oup;
Control I D nmyRadi oG oupControl I D = { kControl Si gnat ure,
kRadi oG oupControl I D };
err = CGetControl Byl D( wi ndow, &Radi oG oupControl | D,
&y Radi oButt onG oup );

GetControl32BitValue: Obtaining a Control's Value

After calling Get Cont r ol Byl D, your program has a handle to one control. Y our program can use this
handle to access the control. Accessing a control often means getting, or setting, the control's value. A call
to Cet Cont rol 32Bi t Val ue ismade to obtain the value of a control:

SInt32 Get Control 32Bit Val ue( Control Ref theControl );

The following snippet obtains the value of aradio group control. For thistype of control, the value
represents the item number of the radio button that is currently on:

Sl nt 32 cont r ol Val ue;

control Val ue = Get Control 32Bi t Val ue( nyRadi oButtonG oup );

After the control's value is obtained, take the appropriate action based on the returned value. For instance,
in the case of aradio button group, a switch statement is used to carry out the task at hand:

switch ( control Val ue )

{
case 1:
/1 handle the first, or top, radio button being the one that's on
br eak;
case 2:
/1 handl e the second fromtop radio button being the one that's
on

br eak;



Menu Manager

A program's menu bar is created using the Interface Builder Manager routine

Set MenuBar FronNi b. After that, application control of the menu bar and its menus and
items is achieved through Menu Manager routines. The function prototypes for the Menu
Manager routines are located in the Menus.h header file. The following sections describe the
most commonly used menu-related types and functions.

MenuRef: Referencing a Menu

A menu and itsitems are referenced by way of avariable of type VenuRef . A MenuRef is
the same asthe older VenuHand!| e datatype, so these two types can be used interchangeably.

Creating a Menu Bar

A menu bar is created by calling Set MenuBar Fr onNi b to unarchive a menu bar resource
stored in anib file. Refer to the "Interface Builder Manager (Nib Files)" section of this
appendix for more information.

GetMenuHandle: Accessinga Menu

Before atering the state of a menu or menu item, changing a menu item's characteristics, and
performing similar tasks, your program needs a handle or reference to the affected menu. Call
CGet MenuHand! e to obtain a handle or reference:

MenuRef Get MenuHandl e( Menul D nenul D ) ;

When editing the project's menu bar in Interface Builder, assign the menu an ID. UsethisID in
the call to Get MenuHandl| e:

#defi ne kCal cul at eMenul D 106
MenuRef gCal cul at eMenu;

gCal cul at eMenu = Get MenuHandl e( kCal cul ateMenul D ) ;
Disable/EnableMenultem: Disabling and Enabling Menus

To disableamenu item, call Di sabl elVenul t em To enable amenu item, call
Enabl eMenul t em Both are shown in the following code:



voi d Di sabl eMenul tem{ MenuRef t heMenu,
Menul t em ndex item;

voi d Enabl eMenul ten( MenuRef t heMenu,
Menul t em ndex Item;

Pass either routine a handle (reference) to the menu that holds the item to alter. Y ou aso pass
the number of the item to alter. For instance, to disable the first item in a menu, pass a value of
1 for that item number:

#def i ne kCal cul at eMenul D 106
MenuRef gCal cul at eMenu;
gCal cul at eMenu = Get MenuHandl e( kCal cul ateMenul D ) ;

Di sabl eMenul tem( gCal cul ateMenu, 1 );

To disable an entire menu (the menu title and all menu item sin that menu), call

Di sabl eMenul t emwith avalue of 0 asthe number of the item to disable. To enable and
entire menu, call EnableMenultem with avalue of 0 as the number of the item to enable. The
following code shows both actions:

Di sabl eMenul t en( gCal cul ateMenu, 0 );

Enabl eMenul t en{ gCal cul at eMenu, 0 );
FM GetFontFamilyFontName: Obtaining a Reference to a Family of Fonts

To change the font of amenu or menu item, you first need to obtain areference to the family
of the font to use. Note that afont exists as afamily in that there are different sizes, and in
some cases, different faces, associated with one font.) To get this reference, call

FMZet Font Fam | yFont Name:

FMFont Fam |y FMGet Font Fam | yFronNanme( Const St r255Par am
I nNanme ) ;

Pass F\Vet Font Fam | yNane the name of the font of interest (Arial, Geneva, Times, and
so forth), and the routine returns the font family reference associated with this name. This
reference then is used as an argument to font-altering routines such as Set VenuFont . For
legacy reasons, some API routines expect a string argument to be formatted as a Pascal string.
FMGet Font Fam | yNane issuch aroutine. When passing a font name, preface the name
with\ p and enclose the string in quotation marks. The following code example returns a
reference to the Verdana family of fonts:



FMFont Fam | y font Fam | y;

fontFam |y = FMGet Font Fam | yFronNane( "\ pVerdana" );
SetMenultemFontl D: Changing the Font of a Menu Item

The Set Menul t enfFont | Droutineis used to change the font of asingle menu item. Use
Set MenuFont to change the font of al itemsin a menu.

CSErr Set Menul tenfont | D{ MenuRef i nMenu,
SIntl6 inltem
SIntl6 inFontID);

Pass Set Venul t enfont | D areference (ahandle) to the menu that holds the affected menu
item. Then, pass the item number of the item. In this case, the first item in amenu will have an
item number of 1, the second item will have an item number of 2, and so forth. Finally, pass
the font family reference for the font to use. The following snippet sets the second menu item
of the File menu to Times:

#def i ne kFi | eMenul D 101
#def i ne kOpenMenul t em 2

MenuRef fileMenu:
FMFont Fam | y font Fam | y;

fileMenu = Get MenuHandl e( kFil eMenul D );

fontFam |y = FMGet Font Fam | yFromNane( "\ pTi nes" );
Set Menul tenfont I D( fil eMenu, kOpenMenultem fontFamly );

SetMenuFont: Changing the Font of an Entire Menu

To change the font of al itemsin amenu, call Set MenuFont , asshown in the following
code:

OSSt at us Set MenuFont (- MenuRef nmenu,
Sl nt 16 i nFont | D,
U nt 16 I nFont Si ze ) ;

Pass Set VenuFont amenu reference (handle), afont family reference (obtained from a call
to FMGet Font Fam | yFr onNane), and a constant specifying the point size of the font. For
instance, to change the font of al the itemsin the File menu to 24 point Arial, you'd use the
following code:



#def i ne kFi | eMenul D 2
#def i ne kMenuFont Poi nt Si ze 24

MenuRef fileMenu;
FMFont Fam |y font Fam | y;

fileMenu = Get MenuHandl e( kFil eMenul D );

fontFam |y = FM&et Font Fam | yFronNane( "\ pArial "

Set MenuFont ( fileMenu, fontFam |y, kMenuFont PointSize );

)i



QuickDraw

Drawing to awindow involves the Carbon API routines that are grouped in an area called
QuickDraw. The function prototypes for the QuickDraw routines are located in the
QuickDraw.h header file. The next sections describe commonly used QuickDraw routines.

SetPortWindowPort: Specifying the Window to Draw To

QuickDraw drawing routines draw to a port, which is a graphics environment capable of
maintaining its own set of graphical information. Every window has its own port, as does
the screen itself. Before drawing, call Set Por t W ndowPor t to tell QuickDraw in which
port (which window) to draw.

voi d Set Port W ndowPor t (W ndowRef w ndow) ;
MoveTo and Move: Specifying the Starting Point for Drawing

Before drawing, specify in which window to draw by using Set Por t W ndowPor t, and
specify where within that window content area drawing is to take place. Call MbveTo to
specify a starting location relative to the upper-left corner of the window in which drawing
is about to occur:

voi d MoveTo( short h,
shor t vV );

Pass VbveTo the number of pixelsto move relative to the left side of the window and the
number of pixelsto move relative to the top of the window. To specify that drawing start
20 pixels from the left side and 60 pixels from the top of the content area of a window, call
VbveTo likethis:

MoveTo( 20, 60 );

The Vbve routineissimilar to VoveTo inthat it specifies a starting point for drawing.
Vbv e, though, uses the current starting point as its reference.

voi d Move( short h,
short V) ;

Vbve moves the starting location a number of pixels horizontally and vertically from the
current location. Consider this snippet:



MoveTo( 20, 60 );
Move( 10, 40 );

Thecall to VbveTo setsthe drawing starting location 20 pixels from the left side and 60
pixels from the top of the window's content area. The call to IVov e then moves the starting
location from that position to alocation that is 10 more pixelsto the right and 40 more
pixels down. The result of executing the preceding code snippet is a starting location 30
pixels from the left of the window (20 + 10) and 100 pixels down from the top of the
window (60 + 40).

LineTo and Line: Drawing Lines
Todraw aline, call theLi neTo routine:

voi d LineTo( short h,
short V) ;

LI neTo draws aline from the current drawing starting point (see the "MoveTo and Move:
Specifying the Starting Point for Drawing" section of this appendix) to the specified end
point. Pass LI neTo the horizontal pixel end point relative to the left side of the window to
which to draw and the vertical pixel end point relative to the top of that window. For
instance, to draw a horizontal line 100 pixelsin length, starting at a point 20 pixels from
the left and 50 pixels from the top of awindow, use this code:

MoveTo( 20, 50 );
Li neTo( 120, 50 );

Note in the preceding snippet that the vertical starting point established by VoveTo and
the vertical end point established by Li neTo are both 50 pixels from the top of the
window. Thus, the lineis horizontal.

To draw aline of a specified length without regard for the starting point, call Li ne, as
shown in the following code:

voi d Line( short h,
short V) ;

Li neissmilartoLi neTo inthat it drawsaline, but Li ne draws the line without
specifying an end point. For instance, acall toLi ne( 100, 0O ) drawsahorizonta line
100 pixelsin length, regardless of the location of the current drawing starting point.

SetRect: Defining the Boundaries of a Rectangle



A rectangle is an important shapein that it is used to define rectangles, squares, ovals,
circles, and round rectangles. To define the coordinates of arectangle, cal Set Rect , as
shown in the following code:

void Set Rect( Rect * r,
shor t | eft,
short t op,
short right,
short bottom ) ;

Pass Set Rect apointertoaRect variable, along with the four rectangle-defining
coordinates. The order isl€ft, top, right, and bottom. Each coordinate is specified in pixels,
with the top-left corner of the window serving as the origin. The following snippet defines
arectangle 100x50 pixels. The rectangl€e's top-left corner is stationed 30 pixels from the left
edge and 70 pixels from the top of the window.

Rect t heRect ;

Set Rect ( &t heRect, 30, 70, 130, 120 );

Set Rect doesnot draw arectangle; it only establishes the rectangle's boundaries. To
frame therectangle, call Fr aneRect .

FrameRect: Framing (Drawing) a Rectangle

After establishing the boundaries of arectangle using Set Rect , frame that rectangle by
caling Fr aneRect , as shown in the following code:

voi d FraneRect( const Rect * r );

After you pass Fr aneRect apointer to arectangle, Fr aneRect drawsaframe around
that rectangle:

Rect t heRect ;

Set Rect ( &t heRect, 30, 70, 130, 120 );
FranmeRect ( &t heRect );

Of course there are many, many other QuickDraw drawing routines you'll want to know
about, so make sure to peruse the QuickDraw.h header file. In fact, you'd be wise to spend
some time browsing and searching through any of the header filesto learn about other
Carbon API routines not covered in this appendix.



Appendix B. UNIX and the Terminal

IFYOU'RE MOVING TO MAC OS X from a UNIX background, you might have already
discovered how to use your Macintosh to use UNIX to enter commands, create source code
files, and build applications. Someone like you might be able to skip this appendix. Y ou
should be aware, though, that UNIX in Mac OS X does vary in some ways from other
UNIX implementations-so you might want to at least skim this appendix regardless of your
level of expertisein UNIX.

On the other hand, if you're along-time Macintosh user who islight on UNIX experience,
you might never have created or edited atext filein UNIX, and you probably never ran a
compiler from the command line. Y ou might not even know how to go about using a
command line interface. If any of this soundslike you, read this appendix. In just afew
pages, you'll be moving through directories, writing source code, and compiling that code-
al from the UNIX command line.



UNIX and the UNIX Shell

Darwin is Apple's name for the lowest level, or foundation, of the Mac OS X. A big part of
Darwin is Berkeley Siandard Distribution (BSD). It isapopular version of UNIX. BSD
provides file system support, network services, multiprocessing support, and other
important operating system services.

BSD also supports the shell environment. A shell is a command-line interface that provides
ameans for acomputer user to perform system tasks. By typing UNIX commandsin the
shell, aMac OS X user can perform a multitude of tasks, including moving, renaming, and
copying files, running applications, and compiling source code files.

A person new to UNIX might think of the shell as UNIX itself, but that would be afalse
assumption. The shell is an application that enables indirect accessto UNIX. The word
"indirect" isimportant here. Enabling direct access to the core-level code that makes up an
operating system (OS) would be dangerous. A user could corrupt OS code and file data. To
counteract this possibility, the aptly named shell provides a"wrapper" around the OS
kernel. In that respect, the shell is similar to the Finder. The Finder enables a user to
perform many of the same tasks as does a shell, but it won't let a user directly alter OS
code. The Finder isashell. It just happens to be a graphics-based shell rather than a text-
based command line shell.

Most Mac OS X users won't be aware of the UNIX underpinnings of Mac OS X, and they
won't be aware of the shell that enables access to the UNIX part of Mac OS X. However,
many power-users, and many programmers, will know (or will want to know) about UNIX
and the shell. In Mac OS X, you get to the shell by running the Terminal application. Y ou'll
find the Terminal in the Utilities folder of the Applications folder. Y ou run the Terminal as
you do any other Mac application-you double-click itsicon.

If you're familiar with UNIX command line environments, you might be interested to know
that, by default, the Terminal uses atcsh shell. Other shells, including csh and bash, can be
used aswell. However, if shell environments types are meaningless to you, don't worry! To
get started with the Terminal, you don't need to know the details of the environment. Y ou
need only know afew simple UNIX commands!



UNIX Commands

A UNIX shell (the Terminal isaUNIX shell) isacommand-line interface that lets a user
interact with UNIX by typing commands. Knowing commands means knowing UNIX.

To run acommand, you enter it in the shell. A command often requires that you either
know the path to a particular directory or that you move into a particular directory. Of
course, to do anything useful with commands, you need to know at least afew of the most
important commands.

Entering Commands

Working with a shell isacyclical process. The following three steps are repeated over and
over again:

1. Shell presents the user with a prompt.
2. User enters a command and presses the Return (or Enter) key.
3. Shell executes (carries out) the command.

In Figure B.1, you see a Terminal window in front of aMac OS X Finder window. (Y ou
can have more than one Terminal window open at atimeif you feel so inclined.) I've left
the Finder window in the figure ssmply to emphasize that in Mac OS X, the Terminal is
simply another application and that using the Terminal to work with UNIX doesn't
monopolize your Mac's resources. While using the Terminal, you're free to click another
application's window and interact with that application.

Figure B.1. Entering a command in the Terminal.
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A Terminal prompt includes the username you use when you log into your Mac. Note that



when you start up Mac OS X, you log in, but you need not also log into UNIX itself when
you start the Terminal. In Figure B.1, the prompt is[| ocal host : ~] dansydow’ The

dansydow part of the prompt comes from the fact that | log into my Mac with a username
of dansydow.

Figure B.1 provides an example of executing a UNIX shell command. At the first prompt, |

typed the pwd command and then pressed the Enter key. The pwd command isthe print
working directory command. Executing it resultsin the display of the current directory,
which is the directory in which you're currently working. After the command is executed,
the prompt reappears and is set to receive the next command.

Directory Tree and Paths

The pathname, which is the listing of the location of afile or folder relative to other
folders, isimportant to many UNIX commands. When organizing files, Mac users are
accustomed to the concept of folders. UNIX users refer to these same entities as
directories. The difference in termsis simply a matter of custom, and the two terms are
interchangeable.

Asit turns out, adirectory (or folder) issimply afile that contains atable listing of the files
contained within it. In keeping with the concept of giving just about every element a
graphical presentation, the Macintosh OS displays such afile with the look of afolder.
Because the Macintosh interface is graphical, the exact pathname of afile or folder (the
chain of foldersthat leadsto afile or folder nested within other folders) isn't too important.
The user just double-clicks folders to work "down" to the folder or file of interest. In
contrast, the UNIX interface is textual, so pathnames become more important. The UNIX
user relies on the pathname to know where he or she is presently working.

In a pathname, a directory name is preceded by a dlash. Consider the example shown in
Figure B.1, where the pathname is given asthis:

/ User s/ dansydow

Figure B.1 shows that the shell repliesto the pwd command by showing that I'm currently

working in the directory named dansydow, which itself isin adirectory named Users. The
slash that precedes Usersrefersto the root, or main, directory. The root directory isthe
drive on which Mac OS X wasinstalled (typically ahard drive), so it's not represented by a
directory name, as are al directories on the drive.

The organization of folders and files can be viewed as a hierarchical tree, as shown in
Figure B.2. Inthisfigure, | show avery small subset of the folders on my computer's hard

drive. In thisfigure, the drive itself is considered the root directory.

FigureB.2. A simpledirectory tree.
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Referring to Figure B.2, you can determine the pathname of a number of directories.
Y ou've aready seen that the dansydow directory has this pathname:

/ User s/ dansydow

The Documentation directory that lies within the dansydow directory has the following
pathname:

/ User s/ dansydow Docunent ati on
Asone last example, consider that the Applications directory has this pathname:

/ Appl i cati ons
Moving into a Directory

To access afile, one needs to be in the folder that holds the file. For instance, to run a
program, you move into the folder that holds the program itself and then double-click the
program'sicon. A Mac user moves within afolder to access afile (or another folder) by
double-clicking afolder or, new to Mac OS X, by clicking afolder nameto view its
contents in a Finder window.

A UNIX user also needs to move into afolder to accessits contents. To do that, the cd
(change directory) command is used. To use the cd command, you use c d followed by the
name of the target directory.



Referring to the tree shown in Figure B.2, let's assume I'm currently in the dansydow

directory and | want to move into the Documentation directory located within dansydow.
To do that at the prompt in the Terminal window, I'd type the following:

cd Docunent ati on

If | followed that cd command with the pwd command to view the directory in which I'm
working, the Terminal window would respond with the following:

/ User / dansydow Docunent ati on

OK, that covers moving "down" thetree. That is, you've just seen how to access a
subdirectory (adirectory within another directory). However, you'll also want to know how
to move "up” thetree. That is, if you're currently in the Documentation directory, how do
you move up out of it and back into the dansydow directory? Again, the cd command is
used. To move up the tree, you don't need to remember where you came from. Instead, you
need only follow the cd command with two periods (. .). This always moves you into the
parent directory, which is the directory that holds the directory in which you're currently
working. Continuing with our example, typing cd.. followed by a pwd command resultsin
the Termina window responding with the following:

/ User / dansydow
Common Commands

A UNIX shell such as Terminal understands numerous commands-far too many to cover in
this appendix. However, knowledge of just a handful of these commands enables you to do
quite a bit with UNIX, and it give you a good base from which to explore working with
UNIX further. Table B.1 lists a number of commonly used UNIX commands. Following

the table are detailed descriptions of some of the more interesting commands.

TableB.1. Commonly Used UNIX Commands

Command Result
pwd Prints working (current) directory
cd Changes directory (moves to new current directory)
| s Lists contents of current directory
nkdi r Makes a new directory

rdir Removes an existing directory



nv Moves or renames afile (moves afile from one name to another)

rm Removes afile
cp Copiesafile
man Displays onscreen help for a specific command

apr opos Lists commands related to the keyword following apropos

who Shows who islogged into the system

pi co Runs the pico text editor

gcc Compiles C source and builds an application

gt++ Compiles C++ source and builds an application
pwd

As you move about from directory to directory, it's quite possible to get "lost," so you need
acommand that, in essence, tells you where you are. To see where you are, you can print
the working (or current) directory by using the pwd command:

pwd
cd

Use the change directory (c d) command to move from the current working directory to a
new working directory. To move down one level (to move to adirectory within the current
directory), type cd followed by the directory name:

cd directorynane

To move up one level (to move to the parent directory, which is the directory that houses
the current directory), type cd followed by two periods:

cd. .

Is

To view the contents of the current directory, use the list contents (I s) command:
| s

mv



To rename afile, you "move" it from its old name to the new name that you specify. First,
use the c d command to move into the directory that holds the file to rename. Then enter
the mv command followed by the original filename, which in turnis followed by the new
filename. After executing the command, you can enter an | s command to verify that the
filename has been changed:

mv ol dfi |l enane newfi | enane

cp

To create aduplicate of an existing file, use the cp command. Move into the directory that
holds the file to copy, and then enter the c p command. Follow the cp with the name of the
file to copy and the name of the file that should hold the copy:

cp originalfil enane newfil enane
man

One particularly nice feature of UNIX isthat user manuals are available online. If you need
help with any UNIX command, type the nan command followed by the name of the
command about which you need information. For instance, if you want to view reference
material on the change directory (c d) command, type the following:

man cd

The documentation for a command often occupies more than one screen. To display the
next screen of information, press the space bar. To display the previous screen of
information, press the B key (for "back"). Press the Q key to "quit" displaying information
(or just pressthe V key until you reach the end of the online manual).

apropos

This command is especially useful for those new to UNIX. Enter the apr opos command
(apropos being a French word loosely translating to "with regard to or concerning')
followed by a keyword of your choosing. The Terminal then will return alist of UNIX
commands related to the keyword. Find the command that most closely matches the action
you have in mind, and then use the man command to get more information on the
command's use:

apr opose keyword

Asan example, if you weren't sure how to copy afile, you could use apr opos copy and
the Terminal would return alist of copy-related commands. In that list would be the cp



command and its description of "copy files," which sounds like the command to use. Next,
you enter man cp to get adescription of how the c p command works. Then, go ahead and
use the cp command to copy the file of interest.

pico

There are severa easy-to-use text editors available for UNIX; pico is one of them, and it's
included with Mac OS X. To run aprogram in UNIX, you type the program name. For
pico, follow the program name with the name of the file to edit. If you're editing an existing
file, use the cd command to move to the directory that holds the file to edit, and then enter
pi co, followed by the name of the file to edit. If you're creating a new text file, use the cd
command to move to the directory in which you want the new file to reside, and then enter
pi co followed by the name that the new file should have.

pico fil enane
gcc and g++

UNIX has a number of freely available C and C++ compilers. Mac OS X includes a
compiler based on the GNU C compiler. Use the gcc command to compile and build a
program from a C source code file. Use the g++ command for a C++ source codefile.

For either gcc or g++, you should use - 0 (that's the minus sign followed by the |etter o)
and a program name. The o isfor "output,” and it tells the compiler what name you're
specifying for the program that results from the running of the compiler. The last operand
togcc or g++ isthe name of the source code file to be compiled. For gcc, thisfilename
should have a.c extension. For g++, this filename should have a .cpp extension. This
appendix's "UNIX Programming" section provides more information about compiling aC
or C++ source code file in UNIX. Here's the format of both the gcc and g++ commands:

gcc -0 programane Csourcecodefil enane
g++ -0 programane C++sourcecodefil enane



Moving About

For someone moving from a graphical user interface (GUI)-based operating system, such
asthe Mac OS, to UNI X, learning to move about from directory to directory takes some
getting used to. In this section, you'll see an example of how one might use the Terminal
and UNIX commandsto traverse the file tree. Additionally, you'll get confirmation that a
Macintosh program is more than just asingle application file. You'll seethat aMac
program is actually a bundle that holds several files (including the application itself).

TraversingtheTree

Starting a UNIX session begins with the running of the Terminal program. When you run
Terminal, you see a Termina window like the one shown in Figure B.3. For thisfigure, |
logged into my Mac with a username of dansydow, so the Terminal has included
dansydowxinthe[l ocal host : ~] dansydow’prompt. Your terminal will display
the username you logged in as.

Figure B.3. The Terminal window after entering the print working directory
command.

800 fhiinjtesh (etypl)

[localhost :~] damsydou® pod
Sbara S dardydou

"

To run aUNIX command, you type the command and press the Return key. A good
command to start with is pwd. Entering the pwd command resultsin the display of the
pathname of the current directory (the directory in which you're currently working). Figure
B.3 shows that I'm in a directory named dansydow, which itself isin adirectory named

Users.

Y ou're probably used to viewing directories in a more graphical manner in Mac OS X, so
take alook at Figure B.4 to see that the dansydow directory isindeed within the Users
directory, which itself isin the root directory (the drive named Macintosh HD).

Figure B.4. The path from home (Macintosh HD) to dansydow.



868 i dusdydiow =

omEsm M4 9 A

[ T5 Virm Coovpmamdy  Hpvek  Tiadimdd  Appde s
-_ﬂ Mucinigth HDH 8 applicatinan 1 danivdes Apphcalien
L Dewebipay L smaredd i Dwakiog
E.‘-Ir.—v.n.-; L4 Dotumenta |4 Drsiams rastion
B Libsany } Desiifserts
e L] LA =
& Yo Falder W LNy
L4 Temgorsry BsmiL LA ehPfrogects
A LHers # Fulals

a0 L e

To see an aphabetical listing of the current (working) directory, type thels (list directory
contents) command followed by a press of the Return key. The right-most column in
Figure B.4 shows what | seein my dansydow directory. Figure B.5 demonstrates that the
| s command typed into the Terminal window did indeed list the proper contents of the
current directory.

Figure B.5. The Terminal window after entering the ls contents command.
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To move down into adirectory, use the cd command. Follow this command with the name
of the directory into which you want to move. In Figure B.6, I've followed the | s

command withacd M/Proj ect s command. It changes the working directory to the
MyProjects directory. After moving inside a directory, the Terminal window again displays
the prompt. To list the contents of the directory that's just become the current working
directory, type another | s command. In Figure B.6, you see the content of the MyProjects

directory istwo other directories. ApplProject and App2Project.

Figure B.6. Displaying the contents of the build directory.
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The next steps were to move into the ApplProject directory (cd ApplProj ect), view
its content (| s), and then move into the build directory (cd bui | d). Look at Figure B.6

to confirm that these actions were taken.

In the last line of Figure B.6, you see two names: ApplProject.app and intermediates. Note

that in the Finder, intermediates is displayed as afolder, while ApplProject is displayed as
afile (an application file with no extension appended to its name). As discussed in Chapter

10,"Bundles and Icons," an application is actually abundle, which is a directory that holds

anumber of files. The Mac OS X Finder hides this fact from end-users, but the UNIX
Terminal doesn't. Refer to Figure B.7 to see how the Mac OS X Finder displaysthe

contents of the build folder.

Figure B.7. The content of the build folder.
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In the Terminal window, | cantypecd ApplProj ect. app to moveinto the application
directory, which is the directory that the Finder displays asafile! Near the top of Figure
B.7, you see that the contents of the ApplProject.app directory is another directory-one
named Contents. Moving into the Contents directory (cd Cont ent s) and then entering
an | s command shows four names:. Info.plist, MacOS, Pkglnfo, and Resources (see Figure

B.8).



Figure B.8. Commands and their resultsin the Terminal window.
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The actual application fileitself is stored in the MacOS directory. Figure B.8 shows the
application's name is App1Project.

Y ou've seen that to move down into afolder, you type the cd command followed by the
name of the directory into which you want to move. To move back out of a directory, type
the cd command followed by two periods (cd. . ). Look at Figure B.8 to see that | typed
cd. . to move from the MacOS directory to its parent directory (the Contents directory).
Also note that you can follow c d with a space and a hyphen (minus sign) to move to the
last directory you visited.

UNIX/Finder Integration

If you aren't completely convinced that Mac OS X is UNIX-based, the following simple
exercise should help you become abeliever. Here I'll use aUNIX Terminal window to
change the name of an existing file, and that file's new name will be displayed in both the
UNIX Terminal and inaMac OS X Finder window.

Figure B.9 illustrates the start of the experiment. In a Terminal window, I've moved to my
Mac's Documents directory and am about to change the name of afile from myNotes.rtf to
myNewNotes.rtf. To do this, | use the UNIX mv command to "move" thefile to a new
name. In the Terminal window, you seethe| s command was used to display the contents
of the Documents directory before the name change. Behind the Terminal window, you see
an Aqua Finder window that also is displaying the contents of the Documents folder.

Figure B.9. Changing a filename using the Terminal.
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After changing the filename from myNotes.rtf to myNewNotes.rtf, | typethe| s command
to see the contents of the Documents directory in the Terminal window. Sure enough, as
shown in Figure B.10, the filename has been changed. In addition, as aso illustrated in

Figure B.10, when | click the Mac OS X Finder window, the Finder window is updated to
display the new filename as well. Obvioudly, it's true that the Finder knows UNIX!

FigureB.10. A renamed file hasits new name displayed in the Aqua Finder.
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UNIX Programming

Y ou bought this book to learn to create programs that run on the Mac OS X. After reading
this section, though, you'll aso be able to use your Macintosh to create programs that can
run on your Mac and on any computer running UNIX. These programs are true UNIX
applications, so they won't sport the Aqualook, but then, UNIX isn't about a fancy
interface anyway.

Get ready-with just several minutes of work, you'll be able to perform command-line
UNIX programming, amaze your friends with your cross-platform programming skills, and
pad your resume ("' Programming Experience By Platform: Mac OS, UNIX")!

Mac OS X and UNI X

Asdiscussed in Chapter 1," System Components and Programming Technologies," BSD is

avariant of UNIX. In Mac OS X, BSD is an important part of the kernel environment. It
supports key operating system features, such as preemptive multitasking and memory
protection. The work BSD doesisinvisible to a Macintosh end-user, but BSD is accessible
to aprogrammer. In addition, because BSD is aflavor of UNIX, a programmer working on
aMac running Mac OS X can use the command line to write and build UNIX programs,
just like a programmer working on a PC running UNIX.

Back in Figure 1.1 in Chapter 1, you saw the five application environments. In that figure,
BSD is shown off to the side. This indicates that there is no relationship between the BSD
environment and any other layer of the operating system, with the exception of the Kernel
Environment. (In Figure 1.1, note the line running from the BSD box to the Kernel
Environment layer.) When you use the BSD programming environment, you're creating a
program that doesn't make use of any Macintosh-specific application program interface
(API) functions, and you're creating a program that won't be displayed in Aqua. Instead,
you use the Terminal to compile source code that runs on BSD.

Writing the C Sour ce Code

To develop aMac OS X application, it makes sense to use powerful software toolsto
create resources, write source code, organize files, compile code, and build the standalone
program. In Chapter 2,"Overview of Mac OS X Programming,” you saw that both Apple
and Metrowerks offer such programming tools. To develop a UNIX application, though,
it's not necessary to use afull-featured integrated development environment. Instead, your
work typically can be performed from the command line.

For avery simple exercise in creating a UNIX program on a Mac, start by running the



Terminal program. Now you're communicating with BSD. Y ou can create a new text file
and enter your program's code by typing pi co f 1 | enane at the prompt. | typed pi co
hel | owor | d. ¢, which ran the pico text editor that isa UNIX editor included with Mac
OS X. It then created a new file named helloworld.c.

Figure B.11 shows the complete source code listing for my simple program. Y ou can see
that it's nothing more than afew lines of code written in ANSI C. Pressing Ctrl+X (that's
the Control key, not the Command key, along with the X key) exits the pico editor. Asit
exits, pico asksif you want to save your changes. Pressthe Y key for yes, and you find
yourself back at the system prompt.

FigureB.11. Using pico to create a sour ce code filein the Terminal.
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Building an Application from the C Source Code

There are several C compilers available for UNIX programmers.A popular one, and one
that's included with Mac OS X, isthe GNU C compiler (GCC). GCCiswhat you type to
compile your C source code file and to create an executable program. After moving to the
directory that holds your source code file, type the following at the prompt:

gcc -0 hello helloworld.c

Typing gcc runsthe GNU C compiler. The - o (that's the letter 0, not a zero) option,
followed by afilename, specifies the name for the output file. In the preceding code
snippet, I'm building a program named "hello." The last operand (hel | owor | d. ¢ inthis
example) is the name of the input sourcefile.

After | pressthe Return key, the compiler asksiif it's okay to continue. Pressthe Y key and
in just amoment, the preprocessing, compilation, assembly, and linking are complete. You
can run the program, as I've donein Figure B.12, by typing . / pr ogr armane (. / hel | o
in this example). Preceding the program name with ./ tells the system that the program in
question isin the current directory (the directory from which you're currently working).



The result of running the program should be the display of the string Hel | o wor | d! in
the Terminal window. Asyou can seein Figure B.12, we're operating in UNIX, so there's

no Aqualook herel!

Figure B.12. Running the Hello world program in the Terminal.
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Programming in C++

The same GNU C compiler that you just used to compile a C program also can be used to
compile a C++ program. In fact, Apple has modified the Free Software Foundation GNU C
compiler from which this C compiler is based so that it compiles Objective-C code as well.
(Objective-C is the language used to produce Cocoa applications, and is out of the scope of
this book.)

To build a program written in C, Apple recommends ending the source code filename with
the .c extension and typing gc ¢ to run the compiler. To build a program written in C++,
Apple recommends ending the source code filename with the .cpp extension and typing g+
+ to run the compiler.

If you've had success with the ssmple C program, you might want to try building an equally
simple C++ program. To do that, create a source code file named helloworld.cpp and enter
the following code:

#i ncl ude <i ostream h>

int main( void )

{

cout << "Hello world!'" << endl:

return O;

To enable the program to interact with the screen, keyboard, and file system, we include
I ostream hinplaceof st di 0. h. Theonly other change from the C source code
listing istheuse of cout inplaceof f pri nt to generate screen output.



To create the new executable, type g++ in place of gcc. You might also want to choose a
different program name (such as hellonew) so that you don't overwrite your previous
masterpiece (the hello program resulting from the C source code). At the prompt in the
Terminal, your input will look like this:

g++ -0 hell onew hel |l oworl d. cpp

Asyou did for the C program, you can run the resulting C++ program by typing . /
filenane (asin./ hel | onew). Theresult of running the C++ program is the same as
the result of running the C program-the text Hello world! iswritten to the Terminal.

The UNIX-Aqua Connection

For these smple UNIX examples, | created and edited the source code files using pico. |
just as easily could have used a Macintosh text editor such as TextEdit (or the editor built
into Apple's Project Builder or Metrowerks CodeWarrior) to perform thistask. Figure B.13

shows aversion of my helloworld.c filethat | created in Apple's Project Builder.

FigureB.13. Usinga Mac OS X text editor to create afileto be compiled in the

Terminal.
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If you're used to working in agraphical interface environment, editing source code might
be easier using a Macintosh text editor. After doing so and then saving your source code
file, theresultisasif you'd created and edited the file using a UNIX text editor such as
pico. To compile the file, make sureit'sin the desired folder, move to that directory using
the Terminal, and then use the appropriate compile command (gcc or g++). Keep in mind
that UNIX isn't some software unit that's peripheral to Mac OS X. UNIX isthe very core of
Mac OS X. When you create afile in the Aqua Finder, UNIX knows about it. If you view a
folder's contents in an Aqua Finder window, use the Terminal to view that same directory's
contentsusing the | s command. Y ou'll see that both methods yield the same list of files.



